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About the Author

Okay, I'll admit it: I've got a strange biography. I've been a writer all my life.
My first semi-pro job was sports editor of my high school newspaper. (Go
Commodores!) After college | was a political reporter for daily newspapers in
Ohio and New York (I covered four national nominating conventions and two
Presidential campaigns) and a correspondent for The Associated Press. And
then, in 1983, I gave in to my inner geek and became the first Executive Editor
of PC Magazine, back in the days when most people asked, “What is a PC?”

These days | keep my feet planted in four arenas; that’s not an easy thing to
do if you think about it. I write books about computers, history, sports, and
travel. All told, I've written nearly 150 books and they’ve been translated into
more than a dozen languages.

For all of my professional life 've been a road warrior. I started out with a
notebook and a roll of dimes in my pocket. But by the early 1980s, [ was one
of the first users of a portable computer. That first machine was the size of a
suitcase and each owner required an extension cord, an AC outlet, and a chi-
ropractor. A few years later, though, | had one of the first battery-powered
laptops, and in more than two decades I've almost never strayed more than
an hour from home without one.

In fact, it’s the laptop and the ability to connect to the world with or without
wires that allow me to live far away from the real world: My wife Janice and I
live at the end of a lane up from the beach on Nantucket Island, 30 miles out
to sea from Cape Cod in Massachusetts.
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Introduction

our basic, truly wondrous laptop computer — a device that can take

your dictation of the Great American Novel, balance your checkbook,
sing you a song, show you a movie, and allow you to communicate with prac-
tically anyone in the world similarly equipped — weighs about six pounds.

Most wondrous of all, most new laptop computers don’t come with a full
instruction manual. (Not that those delivered with older machines were all
that good.) From the very moment of the first personal computer’s birth, it’s
always been a fact that the hardware was great, the software was amazing,
and the manuals were awful. (The fact that they called the impenetrable
prose “documentation” should have been a hint.)

It was for that very reason that the entire computer book-publishing indus-
try, including the For Dummies series, was born. We professional writers
thank the engineers every time we produce another book that translates
Geekspeak to terms the rest of us can understand.

In Laptops All-In-One Desk Reference For Dummies you find news you can use.
It’s not my goal to teach you how to make your own laptop computer from

a pile of sand and iron filings, and you’re not going to learn how to write a
software program to manage the countdown sequence of the space shuttle.

This easy-to-use, truly impressive all-in-one book weighs a shade under
three pounds. It contains just about everything you need to know to select,
set up, start up, and fix up a laptop computer.

About This Book

Each of the ten mini-books deals with a particular subject. One more

thing you do not need, then: A week’s worth of uninterrupted time to plow
through several hundred pages in sequence, from start to end — this book
is a reference tool which can be read front to back, back to front, middle to
the outsides, or with a direct dive into the page that matters most to you.
Check out our handy and quite dandy index.

How to Use This Book

If you've read one For Dummies book . . . well, you’ve not used them all, but
you have some idea of how each author tries to present particular types of
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What You Absolutely Need

information and instructions in a particular way. You can call them conven-
tions, or styles or things-that-are-always-shown-in-the-same-way. Here are a
few of them.

Technical terms

The first time that a new technical term is used in a particular mini-book or
an extended section of the book, you’ll see it marked in italics just like this.
This should help you quickly scan a page if you're looking for laptop features
and thingies like USB port or webcams.

Web sites

Whenever I can, I'll refer you to Internet web sites that have information or
utilities of other nifty things. You’ll recognize them by either of two sets of
letters: www.dummies.com is the most common form, indicating it is located
on the World Wide Web.

http://microsoft.com may be a company that does its own thing, without
regard to convention, or it may actually be a location on the Internet but not
officially on the Web. I know this sounds like a distinction without a differ-
ence ... and it probably is. Just recognize that the http:// part indicates that
this is an Internet address.

Oh, and one more thing: I've tried as best I could to avoid ending a sentence
with a Web address but sometimes it will happen. Ignore the period that may
have been appended by the typesetter; it is not part of the address. The same
thing goes for addresses that span two lines of the book; enter the whole
address and ignore any hyphenations that may have snuck into the name.

What You Absolutely Need

One of the beauties of a laptop is that all the basics are in one box: the com-
puter, its memory, the microprocessor, a screen, and a built-in mouse or
other pointing devices.

So, you need one of those.

You need an operating system, which manages the hardware and interprets
the demands of the software. This book concentrates on the two most popu-
lar modern versions: Windows XP and Windows Vista.

And you need to have some nifty software. Again, [ concentrate on the most
common options here: Microsoft Word for word processing, Microsoft Excel
for spreadsheets, Outlook Express for e-mail, and Microsoft PowerPoint for
presentations.
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What You May Want 3

At one time it seemed to make a difference to the marketing department to
call basic machines laptop computers and the smallest devices notebooks.
Even further back, a class of machines called portable computers was just
barely moveable from one place to another. Today, at least for your purposes
in this book, [ make no distinction between laptops and slightly smaller
notebooks.

If you use a different brand or type of office program, fear not. The basic con-
cepts are the same, and this book helps you get a handle on them all.

What You'll Probably Also Want

It’s not essential that you have an Internet connection for your laptop, but
I’'m not going to lie to you, either: You’ll want one. Here’s why:

4+ An Internet link allows you to easily register, update, and fix problems
with your operating system and its software.

4+ Having access to the Internet allows you to download (that means bring
from somewhere else to your machine) today’s newspaper, tomorrow’s
airline reservations, and all the music and video and stuff that’s out there
on the World Wide Web. You can’t Google or perform any other kind of
nifty search for information you never knew you needed without a
connection to the Internet.

4+ Alink to the Internet is required to send and receive e-mail, instant
messages (IMs), and (did you know you could do this?) use your laptop
as your own personal telephone system.

What You May Want

Many laptop users have everything they need in the box as delivered from
the manufacturer. They learn to use the slightly cramped keyboard and the
downsized pointing device and can keep their files and programs within
the available space on the built-in hard drive.

That’s a worthy goal — especially for those who travel a great deal with a
laptop. Simplicity is a virtue, and it also helps prevent backaches, shoulder
strains, and lost objects.

But other users might need or want to replicate their desktop wherever they
are. Here are some of the things you may want to add:

4+ An external mouse or other pointing device that offers more control or
comfort than the built-in unit on a laptop

4+ An external hard drive to add a huge extra block of storage space
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What You Don’t Need

+

An external CD or DVD drive or writer to upgrade your laptop’s facilities

A video camera (often called a webcam) that can send an image of your
face along with your words

A media reader to allow direct upload (or download) of images or music
to or from a digital camera or digital music device

A set of more-robust speakers to give some oomph to the movie or
music you play

An external monitor for use as a second display or an LCD projector to
put a presentation up on a silver screen

An extra battery that sits beneath or alongside the laptop to solve the
problem of a very, very long airplane flight or travel in places where
electrical outlets are few and far between

What You Don’t Need

You don’t need these things to be qualified to read this book:

<+
<+
+

Prior experience on the job
Parental guidance

An advanced degree in computer science (or an unadvanced degree, for
that matter)

Icons Used in This Book

Special icons in this book draw your attention to diamonds mixed in
amongst the pearls of wisdom. One icon even rings your chimes to warn you
of danger.

\\3

Stop! Here there be dragons. Well, not really dragons, but dangers and pit-
falls and problems that you don’t want to run into.

This icon suggests that you fail to forget, decline to overlook, and do not
lose recall of something important. Okay, these are things you should
remember.

This good stuff will save you time, make it easier to do your work, and other-
wise improve your quality of life.
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Into each life a little bit of complexity must fall, especially when it comes to
high technology. [ promise to be gentle, and concentrate on clearing the air
instead of fogging your mind.

How This Book Is Organized

The smart people at Dummies world headquarters call this particular
version of their best-selling series an All-In-One Desk Reference, which |
abbreviated in my planning as AIO-DR and pronounced “Yeow, doctor.”
But don'’t let its size and heft scare you; the beauty of the Yeow scheme is
that it is broken up into bite-size pieces.

The covers hold 10 mini books, each dealing with a particular subject. You
can go directly to any one of them (the index or table of contents will help)
or you can read from front to back or back to front.

Here are the books, and what they contain.

Book I: Choosing the Best Laptop

You explore the nature of a laptop and then read the important difference
between a need and a want. Then I take you a guided tour of a modern
laptop and introduce you to the essentials of microprocessors, memory,
and operating systems. And then I discuss laptop triage: When something
goes wrong, is it worth fixing or is it time to exercise your credit card?

Book 11: Setting Up Your Laptop

Are you licensed to operate a computer? I tell you what you need to know
about choosing, using, and upgrading the Windows operating system. And
[ discuss the framework used by Windows to keep all of your letters and

numbers from bumping into each other: files, folders, windows, and more.

Book I1I: Running Basic Windows Operations

What exactly can you do with this thing called an operating system? You
start with the built-in application, utilities, and other facilities of Windows.

Book 1V: Using Common Applications

Here you find the news you can use about the most common software
installed on laptops. I concentrate on the most current version of Microsoft
Office, including Word, Excel, and PowerPoint. But fear not: The same
principles apply to older versions, as well as to competitive products from
other companies.
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How This Book Is Organized

Book U: Playing with Multimedia

Man and woman do not live by work alone; sometimes we get to steal a few
moments to play, or listen to music, or watch a movie. Here I discuss all
sorts of media, including using your laptop to broadcast your own video
and audio.

Book Vl: Managing Your Power Supply

Footloose and fancy free, your laptop can carry its own source of power with
it to the beach (watch out for sand in the keyboard), on an airplane (beware
the flight attendant with the pitcher of coffee), and anywhere else you’d care
to take it (don’t let it out of your sight). In this book I discuss how to manage
your batteries and AC power supplies.

Book VII: Upgrading Your Laptop

Within the bounds of reason and the laws of physics, your laptop can be
more tomorrow than it is today. Here I tell you how you can add memory,
increase the size of the hard disk drive, and work with almost any kind of
external computing device.

Book VIII: Networking and Linking to the Internet

Your laptop is a marvelous device all by itself, but why limit yourself in that
way? Explore networking to other computers with wires and in all manners
of wireless communication. I tell you what you need to know about the
Internet, e-mail, and how to use your laptop as a telephone. Really.

Book IX: Protecting Your Laptop

Be careful out there. The world isn’t a perfect place. In this mini-book

[ discuss ways to lock down your hardware, hold on to your personal and
financial information, and protect you and your machine from the scourge
of computer viruses, spam, spyware, and other, ugly perversions of modern
technology.

Book X: Troubleshooting Common Problems

Alas, sooner or later something will go bump in the night or boom on your
screen. But not all hardware or software injuries are fatal; I show you ways
to diagnose problems, make repairs, and get back out on the road where
you belong.
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Good thing T had
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Chapter 1: Knowing What Vou
Want, Getting What Vou Need

In This Chapter

+* Comparing needs and wants
+ Knowing when the price is right

1 Deciding whether you’re an off-the-shelf or custom-fit person

Iknow what you want: a screaming-fast laptop with a gigantic hard disk; a
zippy, high-resolution DVD drive; a sparkling widescreen display the size
of an opened phone book; a pair of speakers with a deep bass subwoofer;
and a full-sized, no-compromise keyboard.

Oh, and you want the whole thing to weigh three pounds, fit into a tiny
carry-on bag, and be constructed out of bulletproof titanium.

And the cost: You could get a desktop system with all of these qualities —
and more — for about $1,000. So you want to spend that much — or less —
for a small box to take with you on an airplane, a commuter train, or from
one room in your house to another.

Figuring Out What You Really Need

Before I gently introduce you to the economics of laptops, allow me to raise
a different question: What do you really need?

You need transportation to get from home to the supermarket and back, a
distance of 3.2 miles with a local speed limit of 30 miles per hour, a task that
could be accomplished in a 1989 Yugo GVX with a 55-horsepower hamster
cage of an engine, 0-to-45 miles an hour eventually, and a big badonkadonk
hatchback with plenty of room for groceries.

You want a 640-horsepower Lamborghini Murciélago capable of going from
standstill to 60 miles per hour in 3.4 seconds. You may have room for a bag
of chips and a six-pack buckled into the passenger seat.



10 Figuring Out What You Really Need

In city traffic, both cars get you to Super Bag & Stuff in exactly the same
amount of time. One might cost you a few thousand dollars and the other a
few hundred thousand dollars. The Yugo can handle dents and scratches
and other indignities without anyone noticing; you’ll probably want to hire
an armed guard and bring a set of portable guardrails (in a separate truck)
to protect the Lamborghini from evildoers.

Obviously, in this extreme example | present a situation where the user
needs a basic machine, not an overpriced headache. But my bigger point is
this: There is no benefit to going to extremes for features that you will not
use, or that bring problems with them.

Now consider a different scenario, and this time I stick to computers

instead of cars. You want to travel with a portable version of the multimedia
megastar that you use at work or home; you truly need to edit digital photos,
and to capture and edit digital video from a camcorder or TV tuner. And

you require a device that is sturdy enough to pass through airport screening
several times a week but light enough for you to avoid a visit to the
chiropractor at the end of every trip.

In this situation, money invested in speed, capacity, and construction pays
off in true utility. And so, with great pride and apprehension I present the
first of Sandler’s rules for laptop users:

4+ Differentiate between your needs and your wants, and get a laptop
that comes closest to your requirements instead of your wishes. Buy a
laptop that meets your needs, and spend the extra bucks taking it
places.

And following close behind, Sandler’s second rule for laptop users:

4+ Whatever you buy today will immediately be outdated. Rapid obsoles-
cence doesn’t matter because the realistic useful life for a laptop (or
a desktop computer) is about 3.5 years. Capabilities go up month by
month while prices remain stable or decline over time. [ bet you had
little understanding of how you would use a laptop three years ago;
your laptop needs three years from now will be different from today’s.

That doesn’t necessarily mean that your laptop will fall apart like a
one-horse shay after four years; a well-built machine may last for many
years. However, the pace of hardware and software advancements
usually makes today’s hot new product look very old and stale after a
few dozen moons have passed.

Now: Define the difference between your needs and your wants. You can get
what you want, but not without some compromises and challenges.



Squeezing the Goods into Your Lap (top) 11

You might want to sit down and ask yourself some questions. (Be sure to do Book |
this in a private place or people will think you’re acting a bit odd, or odder Chapter 1
than usual.)

4+ Is fast good enough or do I need super-duper turbocharged faster than fast?
(The latest and greatest microprocessors are marvelously zippy, but
most laptop users may never tax them to the fullest; word processors
and web browsers work just fine with a CPU a step or two below the
fastest processors on the market. The only tax here is the price you pay
if you buy more speed than you need.)
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4+ Do I need a super-sized screen or will a more standard screen suffice?
(A big screen looks great and is easier to read, but the laptop will be
larger, heavier, and a few hundred dollars more expensive.)

4+ How many hours of battery life do I really need? (If the longest time
you anticipate being between wall outlets is two hours, don’t pay for a
larger-capacity battery. More power adds weight and cost.)

4+ Am I willing to pay a big premium to get less, or can | handle an extra
pound in my traveling case? (When it comes to size and weight, less
costs more.)

A super-powered laptop computer is going to be relatively big and heavy.

A super-lightweight, ultra-small laptop will amaze you with its size and heft,
but not with its screen size, durability, and special features. And both the
super-power and super-lightweight machines cost significantly more than

a middle-of-the-road machine.

Just one example of the highest of tech and the lowest of weight: Toshiba’s
Portege R500 series includes a model with solid state storage (a set of light-
weight memory chips that retain data even when the power is turned off,
instead of a hard disk drive) and a superb but relatively small (12-inch diago-
nal) display. Because there is no disk drive (no CD or DVD drive, either), the
laptop’s battery can be smaller because of lower demand. The bottom line: a
fast machine that weighs 1.72 pounds, and a price that is more than double
that of a middle-of-the-market laptop.

Squeezing the Goods into Your Lap (top)

In computers, smaller is more expensive than larger, and extra poundage
costs less than a well-made lightweight. The reason for this is something
engineers call integration. You can think of it as the cost of shrinking some-
thing big and complex down to something tiny and even more complicated.
It’s kind of the opposite of the economics of housing: It’s all about the real
estate, but in the case of laptops (there’s a pun in there), the smaller the
plot, the more valuable it is.
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Squeezing the Goods into Vour Lap (top )
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Evolution

The first personal computers (like the original
IBM PC that | still have stuffed deep in a closet
of my office) were the size of a suitcase — and
not the kind that could fit in an airplane’s over-
head bin. The motherboard, which held the
computer’s microprocessor brain, its random
access memory (RAM), and other supporting
chips was more than a foot square and even at
that size it was not large enough to hold all of
the computer’s electronics.

On the original personal computer, book-sized
circuit boards rose from individual slots at right

angles from the motherboard. These boards
were called adapters; despite the name, they
added essential features to the computer. One
adapter allowed the computer to display char-
acters or graphics on a monitor; another added
audio; and yet another adapted the computer
for work with a printer or an external modem.
(And just for the record, my first IBM PC — the
one that launched me on what has been a 25-
year career as a technology writer — cost
nearly $5,000 for a system that is less capable
than one of today's iPod music and video play-
ers or a cell phone with a built-in calculator.)

Everything in a laptop is squeezed down and packed tightly. Single chips
now do the work that used to be performed by dozens of circuits, and new
microprocessor families can do their amazing calculations and manipula-
tions while sipping very shallowly from the cup of electrons in the
rechargeable battery that makes a laptop truly portable.

Today’s liquid crystal diode (LCD) displays have advanced from primitive
low-resolution monochrome (single color, like white-on-black or green-on-

black) to screens that can display millions of different shades at resolutions
meeting or exceeding anything you're likely to find on a desktop.

Then the engineers have to figure out ways to protect the delicate innards
from damage while the notebook is on the move. They do this in a number of
ways including reinforced plastic cases, super-strong (and expensive) metal
cases, internal bracing, cushioning and shock absorbers, and other tech-
nologies. Among the highest-tech features: a built-in sensor that detects an
impending (or actual) tumble and retracts the read-write heads and shuts off
the vulnerable hard disk drive before impact.

Most quality notebooks are designed to survive falling off a desktop to the
floor at least once; in my experience, a more common field test is a tumble
from the exit chute of an airport X-ray machine. I'd suggest you do your
research in reviews and specifications and not conduct your own tests,
though. In this instance the best protection is a sturdy work surface and a
tight grip on your laptop at the airport.

\\J
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And there’s one more element — you can call it a factor, as in the engineering Book I
term form factor. That’s a fancy word for the laptop’s shape, dimensions, and Chapter 1
weight. The fanciest trick performed by computer designers is packing 30
pounds of computer, monitor, and accessories into a 5-pound box roughly
the size of a, well, notebook.

If you're buying apples, you generally pay by the pound. If you're buying
shelter, a mansion will always cost more than a trailer. But when it comes to
laptops, the economics are upside down. If you’re comparing laptops with
equal speed and capabilities, a two-pound laptop almost always costs more
than a five-pound model. (The rare exception: special industrialized or
militarized laptops intended for use in very dirty or rough environments.
These are built like armored tanks.)
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Designers reduce weight in several ways:

4+ Using exotic construction materials like titanium or machined aluminum
for the cases and some internal structural components

4+ Making smaller, lighter motherboards based on continually tighter
integration of processors, chipsets, and other components

4+ Removing unnecessary appendages such as dial-up modems and floppy
disk drives

4+ Using new lightweight technologies for rechargeable batteries

4+ Bucking the trend toward supersize widescreen LCDs, and instead using
smaller and lighter displays

Approaching a Laptop Purchase

Henry Ford made it so easy for buyers of his Model T, offering it in any color
customers wanted as long as they wanted black. Actually, that was only
partly true; there was a period when buyers could get off-black, shiny black,
and even a few shades of very dark green that were not quite black. But you
get the idea: He built his company on its ability to mass produce millions of
copies of the basic model at a low price.

The idea was appealing, at least at the start. Buyers had very few decisions
to make because there were very few variations. And the nearly identical
fleet made it easy for owners and mechanics to make repairs or swap
components.
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Approaching a Laptop Purchase

The first laptop computers were offered in a somewhat similar manufactur-
ing and marketing environment. First of all, users were not meant to open
the boxes. And secondly, the machines were offered in just a few basic con-
figurations. Buyers looked for a model based around a particular processor,
with a specific amount of RAM, and a particular size of hard drive.

Today, though, laptops own nearly half of the personal computer market
share. And though many retail and online stores sell “take-it-or-leave-it”
prepackaged laptops, you can also custom configure many models by direct
order from a factory or reseller. And designs now offer a wide range of sock-
ets, ports, bays, and openings for upgrades for currently used machines.

How do you know which purchase route to take?

Buying a package

A preconfigured package may have a number of advantages to offer you:

4+ You want it now. Models are usually available in stores or from online
sellers for immediate purchase. What you see is what you get, and you
can get it now (or within a couple days if it is shipped to you).

4+ You want it cheaper. Some preconfigured models are less expensive
than comparable systems that are custom ordered from a manufacturer.
The reason? Like Henry Ford, computer makers can maximize their
profit by making a whole bunch of identical models; the cost of compo-
nents goes down, as does marketing, support, and maintenance.

4+ You want it without much thought. Would you be happiest picking a
model off the shelf at an electronics store or from an online listing? It
can free you from having to make decisions.

Configuring your own

You may want full control over as many components of your machine as
possible. Why customize?

4+ You're choosy about what you want. You can get pretty close to the
exact components that you need, and exclude some that you don’t
want. As one example, if you work with a lot of graphics, you may want
to order a machine with an extra-large hard disk drive (500MB on the
road, no problem) and a customized graphics adapter within the case.

Although some preconfigured machines represent great bargains
because they are part of a large assembly line run (the Model T theory),
you may also find terrific bargains on a configure-yourself machine if
the manufacturer wants to put on a sale or if the company is clearing
out particular components.
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You want the latest and greatest. Any preconfigured machine you see
on the shelves or online was put together months ago. A machine you
custom order may offer some components that are brand new to the
market, and come with the latest software versions and updated drivers.

When customizing, you choose a base model from companies like Dell,
Hewlett-Packard, Lenovo, Toshiba, and others, and then configure internal
components such as the following:

*

Microprocessor type and speed, within the range of chips supported
by the particular motherboard used in each model.

Type, amount, and speed of RAM.

Hard disk drive size and speed, along with extra options such as
encryption and automated backup systems.

Choice of an operating system. As this book goes to press Microsoft
Windows was offered in at least three Windows XP versions and four
consumer versions and a few more specialized editions of Windows
Vista. Some users may want to use an alternate operating system, and
many manufacturers will assist you in meeting that specification.

Resolution (an LCD screen draws characters and images with millions of
tiny dots; the more dots that are packed per square inch generally trans-
lates to the sharpness of the screen and/or the amount of information
that can be shown) of the display, along with some special features such
as an antiglare surface or a high brightness level.

Choice between an integrated (built-in) graphics controller that uses
some of the system RAM to construct images, or a separate graphics
card plugged into the internal electronics of the system and equipped
with its own RAM and specialized processor.

Selection of a CD or DVD drive, with options including writing record-
able discs and using the latest technology, called BluRay, to play
high-resolution movies (which is, for most of us — at least right now —
a want and not a need).

Options to add various speeds and designs for WiFi wireless communi-
cation for Internet and e-mail, and Bluetooth for managing cordless
mice and information interchange with music players and other devices.

Selection between basic or upgraded audio circuitry, basic or high-
fidelity internal speakers, and basic or specialized sound synthesis
and playback software.

Choosing between the standard battery or a more capacious (and
usually heavier) battery that offers extended life between recharges.
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Plugging into a custom machine

The third option for buying a laptop is to find a preconfigured package that
is as close as you can get to your needs . . . and then customize the rest
yourself. Depending on the machine’s design, you might add some parts for
installation within compartments on the case. And then there is the amazing
and evolving world of external attachments.

First, consider the components that you can install into compartments on
many modern laptops:

4+ RAM. Nearly every current laptop has a small panel on the underside of
the machine that you can open to expose one or two sockets that hold
memory modules. In Book VII I discuss the process of adding memory. . .
and the unhappy fact that sometimes you have to remove perfectly good
memory to install new and larger modules.

4+ WiFi or Bluetooth communications. Some laptop designs let you install
a new wireless communication module or update an existing one by
opening another compartment or slot on the bottom or side of the case,
or by installing a new device into a PC Card or ExpressCard slot.

4+ Batteries. Laptop batteries are meant to be easily changed, usually with
the unlatching of a catch or two on the bottom. In most situations you
can replace an old battery with a new power source of the same design;
you may be able to upgrade to a battery that holds more power, allowing
for longer time between recharges.

4+ CD, DVD, floppy disk drive, and other devices. Some laptops have
bays that allow easy plug-and-play installation. This sort of swap usually
requires use of a customized part sold by the laptop manufacturer,
but there are also some third-party manufacturers that sell adapters to
allow you to use off-the-shelf drives.

Now consider the things you can do with plugs and cables. Modern laptops
now come equipped with at least two and sometimes four or more all-
purpose ports that can connect to external devices. The most common
modern port is called the Universal Serial Bus (USB), coming into increasing
use is a newer design called External Serial ATA (eSATA).

I define and discuss both of these important superhighways to your com-
puter’s motherboard in the next chapter. For the moment, allow me to offer
the following: They are both extremely flexible and very fast. You need an
extra hard drive? Insert the cable in one of the ports. An external mouse?
Plug one in.



Chapter 2: Touring a Modern
Laptop

In This Chapter

v Going inside the box
1 Seeing ports of call

v+ Knowing what goes where

Little boxes on the store shelf. Little boxes made of ticky-tacky. And they
all look the same.

Okay, all of you who weren’t alive during the 1960s — or were but don’t
remember them: There was this song by Malvina Reynolds that lampooned
the dull, look-alike suburbs that were being constructed at the time. The
song goes on, “There’s a green one and a pink one, and a blue one and a
yellow one,” and don’t you know, they all look just the same.

So what does this have to do with laptop computers? To begin, they all are
basically little boxes of roughly the same dimensions. And interestingly,
nearly all are mostly black or silver.

Flipping Your Lid

\NG/
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Unlike a desktop PC, the interior of a laptop computer isn’t intended to be
examined by mere users. Opening a case is a difficult task often requiring
specialized tools. Reassembling the case is even more difficult because the
internal parts are so tiny and so tightly integrated. (And nearly every laptop
computer manufacturer promises to void your warranty if they determine
you’ve poked around in places where you're not authorized to go.)

But on behalf of you, the reader, | have broken the secret bonds of laptops
many times; my toolkit includes weapons such as Torx drivers, tiny jew-
eler’s pliers, and other implements of miniaturized exploration. My report is
thus: A laptop’s interior is a dark and cramped place. But in the end, its guts
are not all that different from an ordinary PC — that is, if you think of a
desktop computer that has been run over several times by a steamroller.
Think thin.
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To be precise about it, a laptop is actually made up of a pair of containers:

4+ A top box that contains the screen and its supporting electronics

4+ A bottom box that holds the motherboard, memory, disk drives,
pointing device, keyboard, and one or more batteries

There’s a hinge that connects the two boxes and a set of ribbon cables that
bring power and information from the bottom to the top.

If you consider the common desktop PC, you'll realize that it is basically a
two-dimensional object — at least as far as users are concerned. The box
has six surfaces, but only two are for devices and connectors. There’s a
front, which has a power switch, one or more CD or DVD drives and some-
times a floppy disk drive; most modern machines also offer one or two USB
ports on the front for quick attachment of music players or card readers
for digital or video cameras. And then there is the back of the PC, which is
usually a thicket of ports and connectors: more USB ports, inputs and
outputs for the audio system, and a connector for the plug that brings AC
power from the wall. That’s it: nothing on the top, nothing on the bottom,
nothing on the sides.

But a laptop computer, compressed into two small boxes, has no space to
spare. Across the pair of boxes are 12 surfaces, and 8 on a typical laptop are
for one purpose or another.

Saving Your Box Top

Start your tour with the upper section and work your way down and around.
At the very top of the upper box is a latch or other device that keeps the
two halves together. When you release the latch, the laptop opens like a
clamshell (which was one of the original industry names for this type of
design — a clamshell computer).

The top half of the clamshell holds the display and its associated electron-
ics. Typical screen sizes (measured on the diagonal) range from about 10
inches for the lightest and smallest models to 17 inches for multimedia
spectaculars.

Unless you’re planning to build your own LCD some day, here’s what you
need to know: An LCD works by sending tiny amounts of electrical current
to tiny spots of a compound called liquid crystal. In most designs, a dot
becomes dark when energized and goes clear when the power is taken away.
Tiny color filters sit in front of each dot, and combinations of dots produce
various hues. In most designs, a lamp — often a version of a fluorescent
tube — provides backlighting that shines through the dots to present an
image onscreen.
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A screen needs only a small amount of space around its edges to connect a
grid of tiny wires that provide power to individual picture elements (pixels)
on the screen. This allows for more viewable real estate than on an old-style
cathode-ray tube (CRT) monitor, which required a frame of at least an inch.

LCDs are thin, perhaps one-quarter of an inch thick or less, and the screen
itself is fragile and could easily be scratched or cut. Manufacturers place a
protective surface across the front of the screen to guard against scratches
and damage. Some models include a special filter to deflect glare and some
add a privacy screen that reduces the angle of view. You probably want to
see your television screen from almost anywhere in your living room; when
it comes to your laptop, you might want not want the stranger sitting
alongside you on an airplane to have a clear view of your screen.

In addition to the frame that surrounds the display, some manufacturers add
a sturdy plastic or metal roll cage to guard against damage to the display as
the result of a fall or other insults it might suffer. Even with the cage, putting
a heavy object on top of your laptop is not a good idea — it’s not a bullet-
proof shield. And one other issue: For many of us, the biggest threat our
laptop computer faces is the sudden recline of the seat in front of us on an
airplane.

What’s the best seat on an airplane for a road warrior with a laptop com-
puter? Well, First Class isn’t bad, but if you're back with the common folk
in Economy, try to get a seat in an exit row. On most airplanes that row is
wider and the seat in front of you doesn’t recline. If you're in a regular
row, consider politely asking the person seated in front of you to give you
advance warning before reclining the seat. If that doesn’t work, wedge
your knee against the seat.

On some of the latest machines, the clamshell’s upper half is also home to a
tiny lens and digital Webcam for video or photos; one or two audio micro-
phones may be nearby. At the bottom of the upper half are the hinges and
hidden within them (or in the gap between the two pieces) is the ribbon
cable carrying power and electronic information.

Although the ribbon cable connecting the upper and lower halves of a
laptop computer is generally well engineered and protected, do not bend

the display too far back or to spread it too quickly. It is possible — trust me,
I've done it — to disable an otherwise perfectly good laptop by opening it

so wide that the cable becomes disconnected from its internal connection. It
can cost a few hundred dollars to have a technician open the case and plug
the cable back in.
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Getting to the Bottom of the Box

Let me define the surfaces for the bottom box: top, bottom, back, and
four sides.

The top of the bottom box — the upper flat surface — is home to most of a
laptop’s built-in user-input devices. What is a user-input device? It’s anything
that allows you — the user — to directly instruct the computer; I'm talking
about the keyboard, the touchpad or other mouse equivalent, and special-
purpose buttons and switches. (WiFi and other wireless communication
ports and connectors to external components aren’t user-input devices.)

The bottom of the bottom box holds several access covers. These compart-
ments most commonly hold slots for RAM, allowing the user to add more
memory without the need to have a technician open the case. On some
models, other compartments are available for enhancement or replacement
of WiFi transceivers.

Many laptop owners dream of the day when they can upgrade their graphics
adapter through an externally accessible compartment; such a design may
be offered some day. Until then, only a handful of laptops let you change

the graphics adapter, and the process requires opening the case, not just a
compartment. If you need high-speed graphics, shop for a laptop with that
capability right from the start.

The sides of the bottom box are typically for quickly, temporarily attaching
plug-in devices. You may also find a volume control for audio systems on the
side; other designs place the volume control on the front or on top, near the
keyboard.

One some models, the bottom back is primarily for attaching devices when
the laptop is in repose on a desk. These attachments begin with the power
connector for the AC adapter and typically include a monitor’s video output
and modem and Ethernet cable connectors. Many of the latest machines
have cleared the back bottom of all connectors. This serves important
purposes: It lessens the chances of damage to the connectors and allows

a more robust hinge between the LCD and the bottom box, which protects
the internal electrical cabling and creates a more substantial frame.

Throughout much of this book I use a Toshiba Satellite P205 as an example
of a modern laptop. (See Figure 2-1.) This fully equipped model includes a
brilliant 17-inch widescreen LCD, a 200GB hard drive, WiFi and wired Internet
access, and a CD/DVD player and recorder. The built-in pointing device is a
large touchpad, located slightly left of center below the spacebar.

On modern machines, the AC adapter, external video port, and several sets
of USB ports are located on one or another of the sides of the bottom box.
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Figure 2-1:

Toshiba

Satellite

P205.
Top of the bottom box
The most common user-input devices are described in this section, starting
with the biggest and most obvious. (Have you guessed what that is?)
Keyboards
Modern laptops (except for super-small, super-lightweight models) offer a
keyboard almost as large as those attached to a desktop computer. (A typi-
cal desktop keyboard devotes about 11 inches to its core components — the
alphanumeric keys for letters and numbers, plus a set of F (or function or Fn)
keys, and shift keys including Alt, Ctrl, and Windows-specific keys).

QUING/ Not for the germophobic: In most homes or offices, what are the two dirtiest,

Sy most germ-laden places? One is the door handle out of your bathroom, and

the other is . . . your computer keyboard. Think about it: Everything that’s
on your fingers gets transferred to the keys, and things only get worse if you
eat at your desk. Don’t put your keyboard into the dishwasher, but do use a
clean rag or gauze dampened with an antiseptic cleaner once a week or so.
You can also use prepackaged keyboard wipes or similar products intended
to clean up after baby.

On smaller notebook computers, the keyboard doesn’t include separate
numeric keys. And you also generally find smaller keytops and — this
matters more to some users than to others — a significantly shorter travel
distance, which is one of a number of technical terms used by manufacturers
to measure how far the key has to be pushed before it makes electrical con-
tact with the tiny switch that lies beneath. What you have here is a matter

of physics. (Remember the idea of cramming ten pounds of stuff into a
five-pound box?) Keys on a desktop keyboard can be elevated a quarter-inch
or more and use a fairly robust spring (or a rubber-like dome that serves the
same purpose) to provide feedback to your fingers as you type. But on a
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Figure 2-2:
The wide
keyboard on
the Toshiba
Satellite
P205 model
includes a
nearly full-
sized
keyboard
with a
separate
numeric
keypad, as
well as a
complete set
of function
keys.

laptop, everything is shrunken, and a bit of protective space must cushion
the top of the keys and the front of the LCD when the clamshell is closed.
And so on a laptop, the keys barely rise above the surface and the travel
distance is greatly reduced.

However, a new class of widescreen laptops have arrived, and they’re
equipped with super-sized LCD screens. On the demonstration model
Toshiba Satellite P205, the oversized LCD within the top box leaves plenty
of room on the bottom box for a slightly more spread-out keyboard that
includes a numerical keypad. (See Figure 2-2.) As a bonus, these larger
laptops also often have enough space to permit a decent set of speakers.
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Courtesy of Toshiba America, Inc.

Some laptop users have no problem at all with the smaller, more tightly
spaced, and very “touchy” keys. Others, with large hands and a tendency to
punch the keys rather heavily (like me), often find that typing speed and
accuracy on a laptop are noticeably less than on a desktop keyboard. Over
time, though, you can get used to almost anything, it seems.

Function and other special-purpose keys

Computer designers have incorporated a full set of Control (Ctrl) com-
mands, and then added Alternate (or Alt) characters that don’t show on the
keyboard but that you can print. Today these special characters are usually
easier to find by choosing a special symbols font, but the old Alt shift char-
acters are still there, deep down in all current versions of Windows.



Getting to the Bottom of the Box

23

A Royal pain

Way back in the dinosaur era of computerdom,
keyboards weren't much different than a type-
writer's. As | type these words, | realize that
some of you may have never used a typewriter;
they were amazing devices, combining efficient
user input with a built-in printer. What they
lacked, of course, was what makes computers
so attractive: intelligence, storage, and the abil-
ity to delete, insert, move, and otherwise manip-
ulate text.

The first computer keyboards merged the basic
functions of a typewriter with the specialized
characters that had been inserted into teletype
and similar machines. One of the first new keys
was Escape, which was basically a way to
wave your hand in the machine’s face and say
“Stop” when things started to go awry, as they
often did. Then came the idea of adding extra
levels of shift. Pressing a Shift key typed a cap-
ital letter instead of a lowercase character.

The first new level of shift was Control (or Ctrl),
which added a whole new set of symbols

intended to give direct instructions to the com-
puter. For example, a Ctrl + M key combination
was a carriage return. (What, you may ask, is a
carriage return? Most typewriters were
designed to have the paper move from right to
left as characters were pounded onto them; at
the end of a line or a paragraph, the carriage —
which included a roller to advance the paper up
or down — was returned all the way to the right
so you could begin typing the next line.)

PCs also picked up special-purpose keys that
are part and parcel of how the computer has
gone past the typewriter. We've got Insert and
Delete (or Ins and Del) to add or remove char-
acters. To quickly move to the top or bottom or
beginning or end of a line or a page or a selec-
tion, you've got Home, End, Page Up (PgUp), and
Page Down (PgDn). To capture an image on the
screen, you've got Print Screen (PrtSc or PrtScr
on some laptops). And since the arrival of
Windows 98, many keyboards have also sported
a Windows key that brings up the operating
system'’s Start menu with just one push.

\\3

Start by pressing the NumLock key (another form of Shift) and use the

numeric keypad. Press and hold Alt while picking a number of as many as
four digits. For example, if you've got a yen to use the Japanese currency
symbol, type Alt + 157 and you see ¥. If you're wondering how to show
you've still got some cents, try Alt + 155 and receive ¢. Happy? Try Alt + 1
for ©. The Euro symbol (€), which may be of some real value to users, is
found in the latest set of additions to the codes, at Alt + 0128.

But all of this is just prelude to what is (thus far) the ultimate in hardware

expansion of the keyboard: the function, or Fn, keys. Designers at first added

ten keys; modern keyboards offer an even dozen. You can assign function

keys to a particular purpose within a program; for instance, F1 usually calls
forth an application’s Help screen. F12 often invokes the Save As command.
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On a laptop, though, function keys are often assigned all sorts of special
functions that exist outside the operating system and applications running
under it. In Table 2-1, you can see the special assignments (called Hot
Keys by Toshiba) given nine of the function keys on the Toshiba Satellite

P205 laptop.
Table 2-1 Toshiba Hot Keys
Key Function
F1 Activates the Security Lock. The screen
a clears and the user login screen appears.
\ You must log back in to use the computer.

Displays available power options.
Pressing the key cycles through
options.

Puts the laptop in Sleep or Standby mode.

Puts the laptop in Hibernation mode.

Toggles among sending video output to
the built-in LCD, an external monitor, or both.

Decreases the LCD screen brightness each
time you touch it. You can see the brightness
level as a number or as a position on a
slider onscreen.

Increases the LCD brightness each time
you touch it. You can see the brightness
level as a number or as a position on a
slider onscreen.

Enables or disables installed wireless
facilities, including WiFi a Bluetooth.

Enables or disables the touchpad or other
built-in pointing device.

Images courtesy Toshiba America, Inc.
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You can keep an external keyboard on your desktop and plug it into your
portable computer as a substitute for the built-in facilities when you’re
off the road. You can attach external keyboards to USB ports or to a PS/2
connector if the laptop maker provides one.

Touchpads, pointers, and mini-mice

Techie-types like to rhapsodize over the latest GUI, which they pronounce
gooey. It may sound like a sticky candy, but they’re talking about a graphical
user interface, better known as one or another form of Windows.

At the heart of a GUI is the ability to electronically reach onto the screen and
move or manipulate text, images, icons, buttons, and other elements.

This works because the computer maps every viewable piece of the screen,
and the computer can detect actions performed at particular locations.

The means to use a GUI is an onscreen cursor that you can move from place
to place by a pointing device; a set of buttons that you can click to indicate
a selection or initiate an action. On a desktop computer, the most common
type of pointing device is a mouse which is moved around on a mouse pad
or on the desk itself to cause a similar movement on the screen. The second
most common desktop pointing device is a frackball which remains station-
ary but translates the manipulation of its large ball into movement on the
screen.

With a laptop, of course, the emphasis is placed on squeezing everything
into a very small space, and that doesn’t allow room for a standard mouse
and mouse pad. Instead, the common designs for pointing devices on a
laptop include the following:

4+ Pointing stick. This little pencil-eraser-sized nub is embedded into the
keyboard (often in the triangle in the midst of the G, H, and B keys). It
functions something like a joystick: Pushing it up moves the onscreen
cursor toward the top of the screen. A bit of intelligence in the computer
can tell the difference between a small push and a determined shove,
translating that into small or large movements.

On IBM and Lenovo laptops, the pointing stick is often called a
TrackPoint; on some Dell machines a similar mechanism is called a
TrackStick. The pointing stick works in conjunction with a pair of
mouse-click buttons in front of the spacebar.

4+ Touchpad. This common replacement for a mouse on a laptop is an
electrically sensitive rectangle of several square inches usually mounted
just below the spacebar. These devices work by sensing changes in the
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very low power electrical charge on the pad caused by a finger move-
ment. Moving the finger to the right causes the onscreen cursor to move
in that direction; as with a pointing stick, the computer senses the differ-
ence between a slow move which is translated as a small movement
onscreen and a quick sweep, which moves the cursor a greater distance.

Some touchpads add a second sensor beneath the tiny pad that detects
a finger tap. The pad can be programmed to interpret a single tap as
calling for highlighting of a word or option, and a double tap to mean
“execute” a command. In any case, touchpads are accompanied by a
pair of buttons that are the equivalent of a left or right mouse button.

Got sweaty fingers? Some touchpads don’t properly respond if your fin-
gers are wet, sweaty, or inside a glove. Nothing personal, but they need
the touch. If you have problems using a touchpad, consider adding a
clip-on trackball as an alternative.

4+ Touchpad with a pointing stick. Some laptops offer double for your
money, letting you to choose whichever device works best for you all
the time or for a particular assignment.

4+ Clip-on trackball. If you're averse to the built-in touchpad or pointing
stick, you can easily attach a clip-on trackball; it connects to the laptop
through a USB port and attaches to the side of the machine. Make sure
the attaching mechanism doesn’t damage your laptop case and be very
careful not to close the clamshell with the attached trackball in place —
you could end up damaging the LCD.

4+ External mouse. If you've got the space, perhaps when your laptop is
being used on a desktop in a motel or in the office of a client, you can
attach any standard external mouse to a USB port and use it. You can
also purchase a mini-sized mouse, about the size of a matchbook.

Power switches

Unless you've got one of those very rare foot-pedal-powered laptops with a
windvane turbo assist, you're going to need electrical power to energize the
microprocessor, its memory, storage, and other devices. Since I'm talking
about things you will likely find on the top of the bottom box, let me start
with the all-important power switch.

On most modern laptops, the on/off button is located somewhere on the
top side; proper design puts it in an upper corner where you are unlikely to
accidentally hit it while typing or making other adjustments. The switch is
thus also protected against accidental pushes when you close the clamshell.
A generally bad design: putting the on/off switch on the side of the laptop
where it could accidentally be touched.



Figure 2-3:
Two
versions of
anicon for
a laptop
power
switch.
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A common design for the on/off switch is a circle partly split by a vertical
line. (See the left of Figure 2-3.) Another version uses an off-center arrow
within a circle. (See the right of Figure 2-3.) One possible explanation for the
less-than-obvious symbolisms: they combine the ancient computer markings
of 0 for off and 1 for on, an extension of binary mathematics.

Other designers may be more obvious: a switch clearly marked with an On
label. On one of my fancy new laptops, the button glows neon blue when the
machine is powered up and changes to a mellow green or strident yellow,
respectively, when the computer is in Standby or Hibernation mode.

OO

Courtesy of Toshiba America, Inc.

One more thing: Modern laptops make multiple use of their on/off switch.
For example, pressing and holding it for a second while the machine is off
may turn on the power; pressing and releasing it quickly while the machine
is running may put the system into hibernation. And you may also be able
to initiate an automated orderly shutdown of a running machine by pressing
and holding the button down until it changes color. When all else fails,
consult your instruction manual for details.

Multimedia controls

The distinctions between a portable music device, a battery-powered

DVD player, a digital recorder, and a laptop computer have nearly vanished.
Today, nearly all capable laptops include a CD or DVD player and either a
sound card (better) or sound card-equivalent software (not quite so good).

[ discuss sound card hardware and software in Book V. Here I focus on
buttons and controls on the top surface of the bottom box of a laptop, and
quite a few are found.

The most basic of controls is for volume, and here you find several possible
designs and locations:
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Figure 2-4:
A
multipurpose
Escape key
with audio
mute
functions.

4+ A Shift-Function Key control on the keyboard. For example, on some
machines you may be asked to press and hold the Ctrl key and then tap
F9 to reduce the volume or F10 to increase the volume.

4+ A toggle switch built into the top side of the bottom box. Hinged at the
middle, you lower the volume by pressing the left side of the rectangular
button and raise the noise level by pressing the right side.

4+ Arotary dial that raises the volume when rolled in one direction and
reduces it when turned the other way. On most machines that use this
design, the rotary dial is on one of the two thin sides; the Toshiba
Satellite P205 moves the dial to the front edge of the lower box.

4+ An instant mute button or a function key that serves the same instant-off
purpose. On the P205 model and some other machines, the Function-Esc
key combination turns off the sound; depending on your machine’s
design, the mute may turn off only the sound system’s output to the
laptop’s built-in speakers, or may also disable headphones or external
speakers attached to the computer. See Figure 2-4.

Courtesy of Toshiba America, Inc.

The next level of multimedia controls is your basic CD player; the controls
are sometimes alongside the keyboard, while other machines place a set of
tiny buttons along the very front edge of the bottom box — more or less
below where your wrists rest while typing.

On some laptops, including Toshiba models, you may find a button that
truly blurs the line between sophisticated laptop computer and basic CD
music player: a Music CD button that activates a simple media player in the
computer, allowing you to play music CDs without turning on the rest of

the machine. So if you're cruising at 29,000 feet and too tired to do any more
work on your spreadsheet, you can play the latest Dixie Chicks CD for hours
while your computer gently sleeps.

Other multimedia CD buttons include your basic play, pause, next track,
previous track, and stop. Most of the icons came from DVD players, which
adapted them from VCRs, which took them from tape recorders.
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Figure 2-5:
Atypical

icon

representing
a laptop’s
hard disk

drive.
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Courtesy of Toshiba America, Inc.
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Indicator lights

If you're of a certain age — or are a fan of old science fiction movies and TV
shows — your mind'’s eye will have an image of blinking lights and indica-
tors. (One of the more animated computers was the robot on Lost in Space,
famous for his to-the-point warnings for the intrepid young hero: “Danger,
Will Robinson! Danger!”)

You'll likely find these indicator lights on most modern laptops:

4+ Hard disk drive indicator. A fluttering lamp, usually marked by an icon

that looks like a stack of tiny dishes, tells you when your computer is
reading from or writing to its internal hard disk drive. (See Figure 2-5.)
Think of your laptop’s hard disk drive as a can of data and you can relate
to the simple icon used by most designers; sometimes the can is shown
stacked, a representation of the multiple platters that exist within many
cans of data, err, hard disk drives.

This is more than mere entertainment: It tells you that your computer is
alive and at work, even if nothing is happening on the screen. Don’t turn
off the power to a computer that is reading or writing to the hard drive;
doing so could corrupt data or damage essential Windows registry and
other files required for startup.

4+ Power status indicators. Depending on your model, you may have little

green or red (or other color, I guess) lights that tell you such important
things as: Is the power on? Is the laptop receiving AC power from the
wall? [s the laptop receiving power from its rechargeable battery?
Designers often use a small pictogram of an electrical plug to indicate
that the laptop is receiving power from an AC wall outlet — through an
adapter that converts the current to DC, to be precise. (See Figure 2-6.)
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Figure 2-6:
One
designer's
icon
represents

a laptop
receiving AC
power from
a wall outlet.

Courtesy of Toshiba America, Inc.

Some machines include a bit of extra information, like changing colors
on a lamp that tells you whether the battery is fully charged, half
depleted, or in dire need of a few hours plugged into an AC outlet. On my
most modern Toshiba machine, the respective colors for these three
conditions are soothing green, anxious amber, and urgent flashing red.
(You can see an example of a battery icon in Figure 2-7.)

Figure 2-7:
A version of
the symbol
for a battery
is used by
laptop
makers to
indicate that
the machine
is running
on its own
battery-
stored
energy.

Courtesy of Toshiba America, Inc.

Bottom of the bottom box

The underside of the laptop is a place that you can’t access while you're
using the machine — unless you’re in zero gravity. For that reason, it houses
compartments and access hatches meant to be accessed on rare occasions
and not while the machine is powered up.
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The modern Toshiba Satellite P205 offers four ports of access; see Figure 2-8.
The rechargeable battery is located in a large pocket. To release it, unlock it
on the left and then release the latch on the right. The system’s two user-
accessible RAM module slots are beneath a cover near the middle of the
machine. The large bay in the bottom of Figure 2-8 is for this particular
system’s WiFi adapter; it has room for other electronics in future designs.
The bay to the left holds this model’s tiny 200GB hard disk drive.

Release rechargeable
battery pocket here
Rechargeable
battery pocket
Unlock rechargeable
battery pocket here

[H]q —

Figure 2-8: @
Access to
compart- —
ments mY ___®
onthe
underside of C )
modern
laptop. o

Hard disk

drive bay

Cover for two user-accessible
RAM module slots

WiFi adapter bay

Courtesy of Toshiba America, Inc.

These common ports of entry are on the bottom of a laptop:

4 Access to RAM modules. Most modern laptops offer two tiny sockets to
hold memory, usually provided on a tiny SODIMM module not much

larger than a postage stamp.
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Your machine may have come with one or both of the memory sockets
already populated with memory. Unfortunately, sometimes you must
remove one or both perfectly good memory modules if you need to
upgrade the amount of RAM in your system. If you do end up with super-
fluous RAM, consider donating the modules to a school or a program
that redistributes high-tech devices to those in need, including inner-city
students and third-world nations. Or, if you must, there’s always eBay.

Try to anticipate your memory needs at the time you purchase your
system. You can take one of two strategies here: Order the system from
the manufacturer with a full load of memory installed (at least 1GB,
although Windows Vista works much better with 2GB), or order the
system with the absolute minimum memory and plan on removing

the insufficient RAM and replacing it with larger modules you purchase
on your own. Depending on market conditions, sometimes doing it
yourself is less expensive and sometimes it’s a better deal to accept the
manufacturer’s package deal.

4+ Rechargeable battery. On many laptops the battery is held in place by
a latch, and sometimes an additional sliding lock-like device. On some
laptops, access to the battery may be from the side.

While you’re looking at the bottom of the bottom box, note the various stick-
ers placed there by the manufacturer. You will likely find the model number
for the laptop itself, along with a serial number for your specific unit. You
may also find the product key for your Windows operating system. Other
details may include information about the wireless LAN in your system.

Take the time to record all the important numbers you find. You may need to
recite them to a support technician one day when you call in for help . . . and
you might need them to file a missing laptop report. You can use the ancient
technology they call “handwritten notes on paper.” Or you can go modern
and use a digital camera to take close-up photos of the stickers. However:
Don’t store the only copy of that photo on the laptop and don’t keep your
handwritten notes in the laptop case. If the laptop stops working or goes
missing, the picture or the notes won’t help you at all.

While you’re looking at the bottom of the bottom box, note the little rubber
feet or nubs that hold the laptop a fraction of an inch above the desk. I tend
to lose at least one of these every six months or so. To replace a small nub,
try carefully gluing on a pencil eraser; to replace a larger rubber standoff,
you may have to carve your own standoff from a larger eraser or other soft
but sturdy object.
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Sides of the bottom box

On one side of the laptop computer you usually find the access to the built-
in CD or DVD player or recorder. Some laptops also have a bay designed to
hold an ultra-miniaturized hard disk drive; you can easily replace or upgrade
these drives, although you have to use a drive that includes matching con-
nectors and guide rails. (The connectors bring together the laptop’s and
drive’s data and power lines; the guide rails allow the drive to slide into
place securely.)

Upgrade parts for laptops are sometimes particular to a manufacturer. For
example, the rails and connector location for a slide-in hard disk drive for a
Toshiba machine may be similar to but incompatible with those intended for
a Lenovo laptop. A number of third-party resellers offer upgrade and
replacement parts. The more popular your laptop brand, the more likely a
reseller offers a line of parts for it.

On the other side of the bottom box you may find as many as a dozen small
connectors for various temporary assignments. Here’s the set from one
Toshiba model:

4+ Volume control dial. Rotating the dial one direction or the other raises
or lowers the volume. Your laptop also includes volume controls that
are part of Windows as well as any specialized audio software, including
Sound Blaster and similar programs.

If your sound system makes no sound, even if the volume dial is all the
way to its maximum, see if audio has been turned all the way down

(or muted completely) in onscreen Windows control panels or by other
software components on your system.

4+ WiFi power switch. You must have a way to turn off the WiFi transmitter
and receiver on a wireless system. Why? Because some places frown on
unauthorized or unwanted radio signals: airplanes in flight, hospitals,
the front lobby of the Central Intelligence Agency . .. that sort of place.
A second reason: The WiFi subsystem uses electrical power any time
it is switched on, and you’ve no reason to deplete the storage in your
battery when you don’t need WiFi.

Some laptops place the WiFi on/off switch on the top of the bottom
box, up near the function keys. The WiFi switch and some of its
controls are marked by a symbol that shows waves radiating out from
an antenna; see Figure 2-9. Laptops use internal wiring rather than
external antenna.
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Figure 2-9:
Aversion

of a WiFi
symbol used
on modern
laptops.

A\

Figure 2-10:
Many
laptops use

a drawing of

an antique
microphone
as the
symbol for
microphone
input.

(((ﬁ))

Courtesy of Toshiba America, Inc.

In addition to the hardware on/off switch for the WiFi system, most lap-
tops include wireless control software provided by the wireless system
manufacturer; this software may have a feature to enable or disable the
transmitter. Shutting off the WiFi system at the software level makes it
impossible to use the wireless facilities but might not end the hard-
ware’s draw on the battery. Use the on/off switch instead.

Audio input. Depending on the design and capabilities (and any extra
sound adapter software you ordered as an option), your machine may
have one or more audio input jacks. Most common is a microphone
input, used — you guessed this, right? — for recording directly from a
microphone. Many laptops use an icon of an old-style microphone to
indicate this input; see Figure 2-10. A line input port is another type,
used to record from an amplified source such as a tape recorder, digital
recorder, or home stereo system.

Courtesy of Toshiba America, Inc.
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4+ Audio output. Again, you may see one or more output plugs for use with Book I
headphones or as an output for use with another electronic device such Chapter 2
as a home theater system or a tape recorder. One of the simpler icons on
many laptops looks like an earmuff for a housefly: a tiny set of head-
phones; see Figure 2-11.

Figure 2-11:
The audio
output port,
often a set of
headphones,
can provide
a low-power
signalto an
amplifier for
use with
external
speakers or
a stereo
system.
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Courtesy of Toshiba America, Inc.

4+ USB 2.0 port. This near-miraculous piece of technology when it was
introduced is still pretty nifty: The Universal Serial Bus is capable of two-
way communication with almost any type of external device. You want
to add a mouse? Plug it into the USB port. Need an external hard disk
drive? Get one that attaches to a USB port.

One commonly used icon for a USB port is meant to indicate its multi-
purpose functions; the signal can go directly to a device or to a hub that
splits into multiple paths. See Figure 2-12. Depending on your laptop
design, you may find only one or two USB ports on the side of the box,
with another two on the back. The versatile (and comparatively large)
Toshiba Satellite P205 series offers a pair of USB ports on each side

of the box.

Figure 2-12:
One version
of anicon

for the USB.
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The first version of the USB standard was quite appropriately called USB
1.0, which was quickly replaced by USB 1.1. As this book goes to press,
the much-faster USB 2.0 is state-of-the-art, and that’s what you want to
buy. Anything slower is just a waste of good electrons. If you have an
old machine that offers USB 1.1, shop for an adapter that plugs into a

PC Card or Express Card slot and delivers much-improved USB 2.0
functionality.

iLink, i.Link, FireWire, or IEEE 1394 port. Introduced at about the same
time as USB, this other near-miraculous piece of technology (under
whichever name you choose to call it) is primarily used by digital video
cameras. This technology was originally Apple’s FireWire; Sony was
behind a miniaturized version mostly used in connection with video
cameras and other home entertainment devices.

Don’t feel badly if your laptop doesn’t have one of these ports; if you
need one, you can add one . . . with an adapter that plugs into a USB
port. The iLink icon is a stylized lowercase i; the icon for FireWire is a
stylized Y. If your laptop has one of these ports, you can more easily
spot it based on its shape rather than looking for a particular icon; the
miniature port looks like a smaller version of a USB rectangle, with a
U-shaped indent in the top. It’s like a dented pizza box.

eSATA port. This miraculous piece of technology arrived on PCs in 2007
and laptops in 2008. This port is an extension of the high-speed internal
bus that connects hard disk drives, CD or DVD drives, and other such
high-demand storage devices. The original ATA standard was a parallel
technology, meaning that eight or more wires were required to send

a signal to represent a single computer word; the advanced SATA con-
verted that to serial technology, with one bit of information moving
behind the other and requiring just two wires. Then eSATA brought
SATA outside the box to an external port. SATA and eSATA have icons,
but you're just as likely to see the letters themselves on the case near
the port.

PC Card slot. Another way to add functions to a laptop is through the
use of a credit card-sized circuit board. WiFi cards and broadband cellu-
lar modems are among devices you can use in this plug-and-play slot.
This older technology is rapidly being replaced by external USB devices,
but is still useful for upgrades or as a workaround for certain failed
components. Cards have three possible thicknesses: Type I, Type II, and
(the least-common) Type Ill. Most modern laptops with PC Card slots
are intended for Type II cards.

ExpressCard slot. The latest incarnation of a plug-and-play upgrade slot
for laptops is the ExpressCard, which is a higher-speed, more versatile,
and smaller version of the PC Card. Two card sizes are in use today: the
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ExpressCard/54, which is the same width as a PC Card at 54mm or Book |
2.125 inches (although its depth is shorter and its connector is smaller),
and the ExpressCard/34, which is not much bigger than a stick of gum at
34mm wide, about 1.3 inches. See Figure 2-13.

As with PC Cards, an ExpressCard slot is a good way to add an internal
upgrade or workaround to a laptop computer; devices designed to
this specification include eSATA adapters, advanced WiFi cards, and
broadband cellular modems.
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Courtesy of Toshiba America, Inc.

A workaround is a way to deal with a broken or outdated element of your
laptop without having to replace it or repair it. For example, your laptop
may have been delivered with a relatively slow and outmoded 802.11a
WiFi system, and you want to use more modern 802.11n communication.
(Don’t worry about the alphabet jungle; I'll define 802 dot whatever in
Book VIII, Chapter 2.) A workaround is like this: Disable the built-in WiFi
system through Windows or other control software, and install an
upgrade in the PC Card or ExpressCard slot.

Media card reader. Some laptops offer a tiny slot capable of accepting
one or more types of flash memory as used in audio players, digital
cameras, and other devices. The problem here is that these media come
in so many different forms, among them CompactFlash, SmartMedia,
Secure Digital, Micro Secure Digital, XD, Memory Stick, and others. And
each requires its own particular size of slot and internal connectors.

If your laptop doesn’t have a direct read slot like the one shown in
Figure 2-14, you can add an external card reader that attaches to a USB
port or use an appropriate cable to connect the camera or player to a
USB or iLink port on the computer.
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Figure 2-14:
Many
laptops can
directly
acceptone
or more
types of
flash
memory like
the ones
used in
digital
cameras
and music
players.

e

Courtesy of Toshiba America, Inc.

Back of the bottom box

On most laptops, the back side of the bottom box is for devices that you use
for a while — for example, devices that you leave behind on the desktop
when you travel.

If you're buying a larger laptop, like the Toshiba Satellite P205 machine [ use
as an example of a current machine, you may find that the back of the laptop
is clean and empty; the large 17-inch LCD screen allows for extra room on
the sides of the laptop for ports and connectors. The advantages of this
design include protection against breaking off parts attached at the rear.
The disadvantages of a larger screen include shortened battery life, extra
weight, and a very tight squeeze on an airliner’s tray table.

You can expect these sorts of ports on the back of the bottom box on
some models:

4+ Power connector. The business end of the AC adapter connects to most
laptops on the back plane of the bottom box. One end of the adapter
plugs into a wall current and the other end delivers DC voltage to the
computer.

Be cautious where the power connector protrudes from the back. If the
laptop tumbles or tilts too far back, if the power block falls from the
table, or if a frozen block of blue ice drops from a jet flying 30,000 feet
over your head, the connector can snap off. According to one service
company I consulted, this repair is expensive and one of the most
common causes of laptop damage.
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RGB monitor output. This 15-pin female port mates with a 15-pin male
cable that can connect to an external video monitor, an analog LCD dis-
play, or an LCD projector. The most advanced of current laptop models
(and many coming machines, [ expect) add a digital video output for use
with external LCDs that receive that sort of signal.

S-video output. This alternate form of video output isn’t common. For
most uses and users, the RGB output offers superior performance; if
you’ve absolutely got to use an S-video output to send a video signal
from your laptop to a particular device . . . well, here’s your connector.

RJ-11 modem port. If your laptop has a built-in dial-up modem, the
cable connects here. Most users would rather undergo root canal
surgery without Novocain, but if you find yourself in a situation where
you can’t possibly connect at high speed over a wired or wireless
broadband connection, this may be the route you must take. [ suggest
you accept the Novocain for the dentistry . .. or for the ssslllooowww
dial-up connection.

RJ-45 Ethernet LAN port. The connection for a high-speed wired
Ethernet looks confusingly like the one for an ordinary telephone wire
for a slow dial-up modem,; the difference is that the Ethernet port
(and its associated cable) is about 25 percent larger. It’s impossible to
squeeze an Ethernet cable into a modem port, but a truly determined
user might be able to force a telephone connector into an opening
expecting an Ethernet cable. You have been warned!

USB ports. Some modern laptops offer several more USB ports on
the back side of the bottom box. They function just like the ones on
the sides.
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Chapter 3: Microprocessors,
Memory, and Operating Systems

In This Chapter

1 Meeting the mother of all boards
v Delving into a bit of binary
v+ Deciding whether to get the latest operating system

ou can see the external hardware — the screen, the keyboard, the ports —

and you know the software’s name and capabilities. But these things
that you can see and touch are mere slaves to three essential masters: the
CPU, the memory, and the operating system.

The central processing unit (CPU), also known as the microprocessor, is the
engine. The bigger, faster, and more efficient it is, the more powerful the
computer; think in terms of horsepower under the hood.

The memory (also called random access memory or RAM) is the brain, the
place where work gets done. Too little memory means the microprocessor
either has to make notes on “scratch paper” (by writing things to the con-
siderably slower hard disk drive) or that the memory is simply overloaded
and likely to throw a temper tantrum, start a petition drive, or otherwise
diss you in public.

And the operating system: It’s the boss of the hardware. Facing one direction,
it tells the microprocessor where to go and helps manage the huge block of
memory. Looking the other way, it maintains an index of all data and pro-
grams stored on the hard disk drive, and it receives requests from the soft-
ware for the use of the display, the disk drive, and anything else attached.

The executive team actually has a fourth member, and it’s one that most
buyers never see: the motherboard, which holds everything together and
paves the pathways between them with streets of gold. Or copper. Or tin
and other conductive metals.
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Truth: Some motherboards actually use industrial-quality gold plating on
some of the electrical contacts. Gold is an excellent conductor and doesn’t
rust over time. At one time nearly all motherboards used the magic metal —
a little bit can go a long way, but today you’re only likely to find real gold
used in machines intended for use in extreme humidity or on mission-critical
devices. Laptops and desktops tend to reach the end of their useable life
after three to five years, well before rusting should become an issue.

Feeling the Need for Speed

The more work you expect your laptop to perform in a short period of time,
the more horsepower you need under the hood.

Today’s modern laptops deliver higher and higher resolutions (details) on
their screens, millions of colors (hundreds of thousands of hues at various
intensities of brightness), high-fidelity audio and high-definition video, and
run an operating system with a graphical user interface (also known as a GUI,
and pronounced gooey) that lets you interact with the machine by pointing
at almost anything on the screen and clicking a mouse.

All this wonderful stuff requires the creation, recording, management,
and movement from place to place of billions of 0s and 1s per second. The
following principal components deliver the horsepower.

Macromanaging the microprocessor

Today, nearly all laptops use a CPU designed and built by Intel or AMD. The
CPU is where the numbers are crunched, received in one form and con-
verted to another; sent out as a command to another piece of equipment or
software, or transmitted to a storage device.

In general, faster is better than slower. Once you're past a certain point,
though — say a speed of 1 GHz or more — other factors come into play. The
CPU has to be matched with a fast bus (a superhighway of wires) that can
move data around the machine quickly, and it has to work with memory that
can keep up with its demands. Otherwise you’ll be doing the equivalent of
trying to load and unload ten pounds of data with a five-pound bucket; it
won't all fit at once and you’re going to quickly develop a huge backlog at
each end of the process.

Laptops use the same sort of processors that desktop machines use, and
sometimes identical models. Because laptops run on batteries and because
heat buildup within a closed little box can lead to problems, designers
generally use modified CPU designs that use less power, can switch features
on/off, or can adjust their speed (and thus power draw and heat generation)
as needed.
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Bringing binary to the CPU

Imagine a building with, oh, 150 million or so
on/off switches plus wires that run between
them and amongst them. Each switch’s on or off
position can be set, read, or changed as fast as
two or three billion times per second. And even
with all of that activity, this building only con-
sumes perhaps 30 or so watts of power. And
then imagine that this building is smaller than a
postage stamp and about as thick as a slice of
pepperoni.

There. You've got a sense of the size of the
microprocessor, the brute force miracle that
makes computers possible. Why do | say itis a
“brute force” device? Because, in the end,
modern computers are very dumb but very, very,
very fast.

If you spot me in an airport waiting for The
Grace L. Ferguson Airline (and Stormdoor
Company) to patch together an airplane to get
me home within two or three days of my sched-
uled arrival time, buy me a drink and I'll explain
how binary math works.

In the meantime, for your purposes here, you
need to know that a computer knows only two
numbers: 0 and 1. And it only knows how to add.

How does a computer subtract 12 from 157 It
converts the numbers to something called a
two's complement and then adds them together.
And how does your laptop multiply 7,345 times
15,237? Well, obviously: It adds 7,345 to 7,345

again and again — 15,236 times, to be precise.
Like I said, very dumb but very fast. Buy me that
drink and we can discuss the elegance and sim-
plicity of the world of binary math.

What does your laptop do with all of those 0s
and 1s? In a word, it makes words out of them.
Each of those Os or 1s is called a bitand in com-
puterese, a 0 means none, no, or off while a 1
means one, yes, or on.

Depending on where it sits within a computer
word, it can indicate (from right to left, not left
to right as most of us humans count) either a 0
or a 1 or any other even number. (It only takes a
single 1 to convert an even number to an odd
number, right? And if the first bit is set at 1, the
seventh hit to the leftis also set at 1, and all the
other bits are 0s, that means this particular word
means one 1 and one 64.) You and | might call
that 65, but to the computer, 01000001 could
mean the number 65. Or, it could mean the
alphabetic character A. It could also indicate a
very dark and dull shade of blue if that is the
value assigned to the blue component of an
RGB (Red-Green-Blue) computer color chart. Or
it might mean to place your Ultimate Alien Life
Form at a spot onscreen that the computer’s
memory represents as location number 65.

Okay, so maybe you only have to buy me a small
drink since I've already spilled some of the
details. But that's the general idea of how a
computer does the voodoo that it do so well.

Figure 3-1 shows an advanced laptop CPU. One of the most advanced CPUs

for laptops, as this book goes to press, the Intel Core 2 Extreme Mobile
Processor contains a pair of cores, or processors, each packing 291 million

transistors into less than one square inch. The processor runs at a speed of

2.6 GHz and can slow the speed (and power use) when not needed.
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Figure 3-1:
Hidden
within a
plastic cover
and mounted
onthe
motherboard
encased
within the
shell of your
laptopisits
micro-
processor.

3

Intel’s current families of laptop CPUs also include, in order of most to
least powerful:

4 Intel Centrino Duo, which is based on the Intel Core 2 Duo used in
desktops; a quad-core version of the processor is expected in 2008,
based on four-processor CPUs offered for desktops.

4 Intel Centrino, which is a variation of the Intel Pentium 4.

4+ Intel Celeron, which is at the low end of the company’s product line
today.
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AMD’s families of laptop CPUs includes

4 AMD Turion 64 X2 Dual-Core processor; as with Intel, a quad-core ver-
sion is due.

4 Mobile AMD Athlon is a mid-level processor.

4 Mobile AMD Sempron is another mid-level processor.

You'll have a hard time finding processors made by companies other than
Intel or AMD on current mainstream laptops. Like it or not, Intel CPUs are
the standard and AMD is the only major manufacturer whose processors are
essentially completely compatible with operating systems and software
designed for Intel-based systems. If you're offered an alternative, make cer-
tain it supports whatever operating system you choose to use.
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Taking a walk down memory lane

If the microprocessor is the engine, RAM is the factory floor. Although
memory chips are tiny, about the size of a fingernail, they contain a huge
amount of real estate within.

Think of a memory chip as a very large chalkboard divided into millions or
billions of tiny cells. Each cell has an address, like a house on a street. An
index keeps track of which particular bits of information (0s and 1s) are
placed where.

While I'm writing these words on my computer, they are resident in a section
of RAM as individual characters; at the same time, the microprocessor works
with the graphics processor to create the information that allows the LCD
screen to display a picture of all the characters (using specific fonts and
styles) as well as icons, menus, and an onscreen cursor and pointer.

On some systems, the graphics processor has its own block of memory used
for onscreen image construction; this is generally the fastest way to generate
an image, especially for high-speed games or complex digital pictures. Other
laptops allocate a portion of main system memory to the graphics proces-
sor; this saves a small amount of money but may be the slowest and least
flexible arrangement. In the middle: systems that give the graphics proces-
sor its own memory but let it borrow some system memory when needed.

Bossing your machine: The operating system
And I bet you thought you were in charge, huh?

You've got all this great hardware: the microprocessor and its associated
chipsets that deliver graphics, audio, storage device management (like
hard disks and CD or DVD drives), the memory, the keyboard, and dozens
of other things that install into bays or slots. And you’ve got all of this great
software to handle word processing and other office tasks (spreadsheets
and databases among them); e-mail and instant messaging software keep
you in touch whenever, wherever, and however you want; and high-tech
power tools to edit digital images, video, and audio.

But who’s the boss? In the simplest of terms, think of the operating system
as a great big box of rules and regulations that sits in the middle of your
laptop’s computing universe. Above it are software applications, the key-
board and mouse, and you. Below it are all of the pieces of hardware that
do the actual work.
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Driving my °

Drivers are the key to the way Microsoft
Windows works with so many hundreds of
thousands of available pieces of hardware and
software. Think of them as customized inter-
preters. When you connect a fancy new scan-
ner to your laptop, its manufacturer also
provides (either on a disk or online) a device
driver that describes all of its particular capa-
bilities (for the edification of the operating

‘carmputer”

system). In this way, a hardware maker can add
custom features (or limitations) to the basic
commands. Similarly, a piece of software can
teach Windows new tricks by supplying a soft-
ware driver. In Book Il | explain how you can
make sure your system has the latest drivers
and show you how to update — or retreat to a
previous version if problems arise.

In theory, the operating system could be built into your laptop’s hardware.
Or, your software could be designed to directly control the hardware. But
for most of us, that isn’t a good solution. Here’s why: Not all hardware is
the same, and you can install nearly an infinite number of combinations of
devices. And, although one company’s digital photo editor may be very

similar to another, each is written differently and wants to interact with the
hardware on its own terms.

Here, then, are the main jobs assigned to the operating system.

Managing the hardware

When a piece of software asks for data conversion, for image display, or sub-
mission of product over the Internet, it sends out a series of commands. The
operating system receives the orders (with the helpful assistance of a device
driver; see the handy and quite dandy Technical Stuff note) and translates
the command into something that the hardware can understand.

Managing the software

When a company (more precisely, a squadron of programmers) writes a
piece of software, it has no idea what kinds of hardware is installed on
customers’ machines. They can make general assumptions and publish
requirements, but they can’t possibly take into account every type of
microprocessor, chipset, hard disk drive, graphics adapter . . . or any other
type of part. What they can do, though, is specify a particular operating
system, and let the operating system read the software and device drivers
and make everything hunky-dory in Computerland.



Feeling the Need for Speed 4 7

Am [ saying that modern operating systems eliminate all conflicts and confu-
sion between and among various combinations of hardware and software?
Yes, and they can establish world peace, end hunger, and reverse global
warming. Well, actually, no, they can’t. But a well-written operating system in
combination with properly constructed device drivers and software drivers
and competently designed hardware can work together pretty well, and each
new generation of these components smoothes the rough edges.

In other words, Windows Vista and Windows XP, and software and hardware
designed for either, aren’t perfect, but they're a lot better than what users
had to deal with. And you can hope for ongoing improvement. And that
other stuff too: peace, food, and an environmentally sound planet.

Managing stored data

Where’s your passport? Where are your car keys? The receipt and UPC code
for your two-year-old printer that needs repair? And don'’t just say, “They’re
on my desk.” Your computer must find every last bit of information you’'ve
ever stored since the beginning of time (or at least from the beginning of its
time in your home or office). And it needs to find it almost instantly. And
then remember where it returned the data after editing.

The operating system is boss of the files index, including data (words,
images, music, and numbers included), software, drivers, settings, and the
thousands of operating system files themselves. The computer’s filing
system uses NTFS, which stands for New Technology File System.

The machine that currently serves as my assistant has a 200GB hard drive,
and when on my desk (the computer, not me) I plug it into not one, but two
external backup drives. (I'm a belt-and-suspenders kind of guy; [ make back-
ups of my backups.) The last time I paid attention to the numbers crawling
across the screen of my computer as my antivirus scanner did its work,
there were nearly 1 million files spread across the three drives.

Just to make things even more complex when it comes to tracking what data
is placed where: Sooner or later nearly every file ends up broken into many
smaller pieces stored — not necessarily in sequential order — all over the
surfaces of a hard disk. I discuss fragmentation in Book IIl. For now, here’s
what you need to know: Fragmentation happens, and eventually wastes
space and slows down your computer. The cure, quite naturally, is called
defragmentation, and I show you how to use a software utility.

Putting on a pretty face

Many a user cares all about looks. With all of the hard work that goes on
beneath the surface — the hardware, the software, the drivers, the data,

and the operating system — the most important thing is the GUI appearance
onscreen. The image on the display has to be attractive, orderly, and easy
to use.
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Running with the Biggest Operating System Dogs

With a GUI like Windows, the screen is alive. You can highlight a word and
pick it up and move it elsewhere. You can drag an icon from one place to
another. You can click a button and make your laptop sing “Cheekah Bow
Wow” by the Vengaboys.

For much of your interaction with a laptop, you don’t have to type in a
command, issue a verbal order (“Open the pod bay doors, Hal”), or even
create your own list of possible actions. All you need to do is point and
click at an option suggested by the operating system or a piece of software,
or use the mouse to pull down more options and choose one of them.

Running with the Biggest Operating System Dogs

Some people (guilty, your honor) need . . . or at least want . . . to always
have the latest and greatest technology. How can you look yourself in the
mirror knowing that the guy in the next cubicle is running Vista Premium
and you’re stuck with XP Home? Well, yes, he’s a dork, and you’re much
more productive, and handsome, and due for a raise. But he’s got a newer
operating system.

As this book goes to press, the most current version of Microsoft’s operating
system is Windows Vista in its various versions. Nearly all new systems
delivered from now on are likely to use Vista. However, millions of machines
are already in use that happily employ one or another earlier operating
system from Microsoft. At the end of 2007, nearly 80 percent of desktop and
laptop machines used Windows XP and just over 5 percent used an Apple
operating system. The remaining machines use either an antique version of
Windows (including Windows 98, Windows NT, or Window ME) or one of the
alternative operating systems, including Linux.

Why hang on to an outdated version of Windows? Two reasons:

4+ Inertia. It takes a few hours and a bit of money and sometimes some
gnashing of teeth and wailing to upgrade from an older operating system
to a new one. If your system is working properly with Windows XP and
you can run all of the software and hardware you need, it isn’t illogical to
stay with what you've got for as long as you can.

4+ Incompatibility. Many older machines are simply incapable of running
operating systems that weren’t available at the time they were intro-
duced. Each successive version of Windows is more demanding on the
system hardware — upgrading may require a faster processor or more
memory or a more capable graphics card.

And you may find out that not all of your existing hardware or software will
run properly with a new operating system, or you may have to purchase a
software upgrade to bring them screaming and kicking into the new age.



Daring

Chapter b: Doing It Yourself versus
Calling in the Cavalry

In This Chapter

v~ Fixing your own laptop
v~ Calling in the experts

1+ Sending in the special forces

A laptop computer’s essential nature is its construction from a pair of
relatively small, densely packed, and (most notably for this chapter)
tightly sealed boxes. By comparison, most desktop PCs are easily opened,
and anyone with a bit of nerve can remove the covers and examine the
innards, make changes to internal cards or drives, or even perform major
surgery to replace a motherboard, fan, or power supply. (I used to say,
“anyone with a bit of nerve and a screwdriver,” but the most modern of
PCs no longer require the use of tools for many repair jobs.)

But very few owners ever see the inside of their laptops. You can read the
specifications and run software utilities that reveal the manufacturer, brand,
and speed of the microprocessor, but you'll never see it. You know the
machine has a graphics controller and a sound card or subsystem because
you can see images and hear music or tones, but again, they’re out of

your sight.

And you can enjoy the sharp and colorful images shown on the LCD screen.
But it’s not even close to easy for the average user to repair or replace that
display if it fails, grows dim, changes color, or is snapped in half when the
6-year-old zooms the airline chair back the same way he does when he plays
around on grandpa’s lounge chair.

to Fix Your Own Laptop

Can you fix your laptop? Ah, a perfectly simple question that requires an
uncertain, qualified, and equivocal answer: yes, no, or maybe. Oh, and it
depends on the situation.
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Daring to Fix Your Own Laptop

Although modern laptops are generally quite sturdy and reliable, savvy
users always act as if the next time they try to bring the machine to life, it
will play dead. Or the lights may flash and the screen may light up, but
instead of a friendly (or at least familiar) Windows desktop, you’ll see an
uncharming, barely comprehensible fatal error message: Your hard disk
drive can’t be found (it’s there — you can see it — but the computer can’t)
or your system files or file allocation table have been corrupted.

If the computer hardware is functioning properly, you can fix most problems
with software, operating systems, and settings. In the worst possible case,
you can reinstall the operating system, software, and data (if you’ve made
backups of the data to an external device or to removable media like a

CD or DVD).

Hard times for hard drives

If the hard drive has suffered a hardware failure, on most modern laptops
you can remove it from an externally accessible bay or pocket built into the
side or bottom of the closed lower box. With this sort of design you can
easily install a replacement drive purchased from the laptop manufacturer;
depending on the popularity of your machine, you may find a replacement at
a third-party retailer and web site.

Any time you replace a laptop’s primary internal drive, you need to install
the operating system, software applications, and any backups you have of
data files. Be sure to keep your Windows and application installation disks in
a safe place, and get in the habit of making regular backups of your essential
data files on a removal media like a CD, DVD, or external drive.

Your hard drive or another component of your laptop will die one day.
Maybe today, maybe years from now. The proper preparation: clean living,
good thoughts, and a full set of backup CDs or DVDs of your data files as
well as the system discs provided by the laptop manufacturer when you
bought it.

Seedy CDs and dud DUDs

On certain laptop models, the CD or DVD drive installs in a bay that you
can access with the removal of a few tiny screws or the withdrawal of a
latch. This allows easy substitution — within a range of devices approved
and supported by the laptop’s maker — of a replacement optical drive of
the same specifications or an upgraded model.

Devices such as CD or DVD drives must be accompanied by the proper
device driver; this snippet of software must match the operating system as
well as the particular hardware in your machine.
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Feeling powerless at a time of need Book
If your machine doesn’t power up, several possible causes may be to blame.
Three points of failure can be fixed from outside the box, and one cannot.
Here are the possibilities.
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AC adapter problems

The adapter plugs into wall current at one end and the computer at the
other; in between is a sealed box that converts 100 to 240 volts of alternating
current (depending on the laptop design) to about 15 to 20 volts of direct
current. If the adapter (or the cord that plugs into wall current, or the cord
that goes from the adapter to the laptop) is working improperly, the com-
puter won'’t receive power and its battery won’t recharge. The good news is
that you can purchase a replacement adapter from most manufacturers or
from third-party sources.
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Here are the possible points of failure when it comes to power sources:

4+ All things electronic have a finite life; they will eventually fail. They may
receive dirty power that stresses components. They heat up and cool
down each time you use them. Internal parts may corrode. With luck,
your adapter won'’t reach its moment of mortality before the laptop
itself retires.

4+ The converter in the sealed box could become fried from a power surge
coming in from the AC line.

4 The cable from the converter to the laptop could come out of the
machine. (This one’s easy: Reattach the plug.)

4 The detachable plug from the wall to the converter could become
dislodged at its point of connection to the converter. (You know what
to do here, right? Lodge it.)

QNING/ 4+ The detachable plug could break or the cable itself could become cut or

Yy shorted out. (Stop. Don’t attempt to use an electrical device with obvi-
ous damage, especially on the AC side of the adapter. If you're lucky you
can purchase a replacement cable.)

4+ The cable from the converter to the laptop could come out of the
machine.

Failing batteries

Batteries can fail, or over time can lose their ability to hold a charge. You can
usually determine if a bad battery causes the problem by removing it from
its bay (on the bottom or side of the laptop) and running the machine from
the AC adapter only. If the batteryless machine runs properly when con-
nected to the adapter, the battery has most likely kicked the bucket, shuffled
off its mortal coil, and otherwise become defunct.
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You can further test this hypothesis by substituting a known-good battery
from another machine of the same model. You may be able to borrow a
coworker’s battery or take the laptop a cooperative retailer’s repair counter.

On the other hand, if a batteryless machine doesn’t run when connected
to the AC adapter, either the adapter or the laptop’s internal electronics
have failed. Again, if you can borrow a known-good adapter, use it to see if
the problem is caused by the cords or converter or if the issue lies deeper
within the laptop itself.

Failing electrical system

The electrical system inside the case of your laptop can fail, which is almost
always bad news. Here are the usual suspects:

4+ Physical damage to the connector. The little hole and attachment
point on most laptops is one of the most vulnerable places. While most
everything else on a laptop is carefully packaged within a closed case,
anywhere a plug attaches from the outside world, the chance of serious
damage is there. If the laptop falls even a short distance with something
plugged into a port or other opening, there’s a good chance that the
connector could snap off or be damaged. The connector from the AC
adapter could break, or the internal connection could be bent or broken.
(Replacing an AC adapter is easy and relatively inexpensive; repairing a
broken internal connector on the laptop itself usually requires a visit to
the repair shop and doesn’t come cheap.)

4+ Damage to the internal connector and its associated electronics because
of a surge or spark that penetrates the box. The adapter itself protects
against most of these problems because it converts the AC to low-
voltage DC. However, a high-voltage static electricity spark that jumps
from your fingers on a cold, dry day can damage a laptop or other
electronic device.

4 A cooked motherboard damaged by overheating. If a component mal-
functions or if the internal cooling fan goes on the fritz, the laptop’s
circuitry or individual chips could fail. Sorry, but this one’s got to go
back to its maker for retooling.

Lacking power

The most embarrassing but not-all-that-uncommon reason a laptop isn’t
receiving power from the AC adapter or battery is that the wall outlet isn’t
delivering the juice. Check to see that it is live by plugging a radio or a
lamp into the outlet. And don’t use an outlet controlled by a wall switch;
these outlets are for floor lamps, not electrical devices that need a
continuous flow.
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[ recommend that any expensive electronic device . . . or any inexpensive
electronic device that you connect to an expensive one . . . use a surge
protector between the plug and the wall. Although in theory the converter
in a laptop’s AC adapter may absorb some level of power surge, a major

hit could fry the adapter and in very rare situations even pass along high-
voltage AC or DC to the laptop. A basic surge protector: about $10. A typical
laptop: about $1,000. You do the math.

Senator, | Do Not Recall That Incident
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Modern versions of computer memory are generally quite robust. And RAM
modules are tested pretty thoroughly by manufacturers before shipping.
That said, if a stick of memory goes bad, it usually happens within the first
weeks of use. After then, they just sit there and remember things for as long
as they receive electrical power.

However, if a memory module isn’t properly installed in its slot, or if the
laptop takes a major tumble, a block of memory could come out of its
connector. Open the cover to the RAM (located on the bottom of most
laptops) and ensure that the one or two modules installed in slots are
properly seated.

One other possibility: If the memory seems to work some of the time but not
all, you may have corroded contacts on the connector that holds the RAM
module. If you open the hatch to the memory and an ounce of water trickles
onto the desktop, you might have a real problem. All seriousness aside, the
corrosion is usually obvious when you inspect the modules.

You can try carefully cleaning the modules with a fresh pencil eraser,
being very careful not to leave crumbs of rubber on the memory or in the
slot where it mounts. You can also purchase a special liquid cleaner at an
electronics supply store; don’t use a general-purpose solvent, which could
make the situation worse by removing some of the conductive metal on
the module.

Drive, He Said

Some are hardware people and some are software people. Rarely does one
designer work on both essential elements of a modern computer. Sometimes
(most of the time, actually) the hardware comes out first and then the soft-
ware people scramble to come up with an operating system or a piece of
programming that best uses the hardware.
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Calling the Experts to Your Aid

Occasionally a new operating system or a new application is a step or two
ahead of the available hardware; it can’t provide full functions until the
chips catch up. Either way, hardware and software improvements are like a
constant game of electronic leapfrogging.

In a perfect world, any new piece of hardware would come with device driv-
ers that make it work without flaw with the latest operating systems and pro-
gramming. And any new program would be delivered with software drivers
that instantly translate its commands so that any hardware can immediately
act upon them. Sorry to have to break the bad news, but this is not a perfect
world. Instead, what we have is a situation where you have to put in a bit of
work to make sure that your drivers are up to date.

Most major manufacturers of hardware and software issue driver updates to
deal with significant changes like a new operating system introduction (the
arrival of Windows Vista brought forth a parking lot full of device drivers for
hardware, while the arrival of a new class of microprocessors demanded
adjustments to software drivers for many programs).

Locate the Update button (part of many software applications); give it a try
anytime your machine is connected to the Internet and you’ve got nothing
else to do. In most situations, this should keep your programs up to date.

Cheap, Brand-X hardware can sometimes cost you more in the long run than
a device from a company that is likely to stay in business for the lifetime of
your laptop and its components. I've got a closet full of once-nifty devices
sold by companies that took the money and ran, without maintaining an
online or telephone support department and without offering necessary
driver updates.

And visit the web sites of the manufacturers of any hardware you add to
your laptop (either as a component in an internal bay, or as external device
attached to a USB, eSATA, or other connection). Check for updates specific
to your configuration; if you're running Windows XP, you don’t need to
update a driver written for Windows Vista, for example.

Calling the Experts to Your Aid

For the vast majority of users, if you determine there is a problem that lies
within the sealed case it is time to Stop and Do No Further Harm. If your LCD
is cracked, your motherboard is fried, a connector is broken off, or a fan is
no longer fanning, it’s time to reach out and touch someone who has the
tools . .. and the skills . . . and (if the machine is still under warranty) the
permission to open the hood.



QUING/

Calling the Experts to Your Aid 55

I'm old enough to remember the days when the TV repairman would come
to the house to fix a Philco on the fritz. In fact, you could even run down to
the neighborhood drugstore or hardware store and test the tubes yourself.
More to the point, I can also remember a time when you could call up your
personal computer’s manufacturer and talk to a real human who offered
knowledgeable repairs advice.

Alas, today you'll find it nearly impossible to speak with a real human
being about problems with your laptop, at least at first. Instead, you have
to navigate through a thicket of maddening automated telephone systems,
online chat support, e-mail Q-and-A, and often useless lists of frequently
asked questions that have nothing to do with your particular problem.

Passing the buck

When it comes to customer support today, the basic philosophy of most
laptop manufacturers is this: “Don’t Ask Him, Don’t Ask Me. Ask That Fellow
Behind the Tree.” The support line offered by many laptop manufacturers
goes to great lengths to screen out calls they really don’t want to deal with
(or don’t have to, according to the terms of the warranty).

First of all, most laptop makers refuse to assist you if they determine (or
believe) that your problem is caused by any hardware or software you've
added to the machine if they didn’t supply it or specifically include in your
warranty. Secondly, you may find yourself between a hard and a soft place
if you run into a problem with the operating system, even if it was supplied
by the laptop manufacturer with the machine.

One of the biggest problems with calling a hardware maker about a problem
with the operating system is that many times their preferred solution is to
have you reformat your hard disk drive and reinstall Windows and all of your
software applications. That may well solve problems related to corrupted
registries, missing files, and bad device drivers, but you will lose any data
files you've not backed up to other media. In some cases this is the equiva-
lent of using a sledgehammer to install a pin; it works, but it may also cause
a great deal of damage.

Start with Microsoft, the maker of Windows of all flavors; in general, that
company doesn’t offer free support to users who receive their operating
system preinstalled on your laptop by the hardware maker. That’s because
Microsoft sells manufacturers deeply discounted licenses allowing Windows
installation on thousands or millions of machines at a time; you get a great
deal on the cost of the operating system but Microsoft doesn’t want to have
to devote resources to supporting your system.

Book |
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Now move on to the laptop maker: Although most offer some level of assis-
tance with problems related to the operating system, they cut off support if
they believe you've modified the supplied software or hardware. “Not our
problem,” they’ll tell you.

And then there is a third line in the silicon: If the company suspects or deter-
mines that you or anyone else has opened the covers of the laptop without
permission, they’re quite likely to put their hands in their pockets, turn their
back, and otherwise get all huffy about your serious transgression.

Lest you think there’s no harm in just opening up your laptop by yourself to
have a look-see, you should be aware that most makers include seals and
other indicators that tip them off to unauthorized access. Nearly every
laptop warranty declares itself null and void if the box has been worked on
by someone not on the official list of repair people with secret decoder rings
and special tools.

Buying factory warranty services

If you are the semi-proud owner of a name-brand laptop from one of the
major makers — including Acer, Apple, Compagq, Dell, Gateway, HP, Lenovo,
Toshiba, and a few others — your first call should probably be to the
manufacturer. It’s time to begin the warranty dance.

I’'m not meaning to exclude any particular other manufacturer from this list.
Some less-known companies have fine machines on the market, and you may
also find some generic machines imported by retailers from Asian sources
(where nearly all laptops originate) and labeled Cougar or Rabbit or Orange
or some other name spinoff. But before you buy a Ferguson 5151, make an
effort to find out not only what kind of warranty is promised but what sort of
resources stand behind that promise.

Nearly every laptop comes with at least a one-year limited warranty. At
various times, some manufacturers have tried to cut corners (and prices) by
offering warranties as short as 90 days. As this book goes to press, the mini-
mum coverage period has generally crept back up to a year, although some
makers offer a very short period of support on certain “bargain” machines.

Whatever the length of support provided at the time of purchase, though,
you usually can buy a longer limited warranty: two, three, or four years. And
the warranties come in different colors or levels or fancy names.
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Basic, standard, and limited warranties

Like it says, a limited warranty isn’t complete, total, and without strings.
Here, let me grab a copy of a “One Year Standard Limited Warranty” from
one of the biggest laptop manufacturers. Got it: 15 pages of “disclaimers and
limitation of remedy.”

The following is a true example of the terms of a limited warranty, but please
don’t assume that the limitations here are exactly the same as the limitations
that come with your particular brand and model of laptop. You're going to
have to read the fine print yourself. | recommend preparing with a strong
light and a stiff drink.

The warranty starts on the date of purchase, which may or may not be the
day you receive a machine or first put it into use. And this particular war-
ranty applies only to customers in the United States and its territories, Latin
America, and the Caribbean; those fine folk in Canada and Europe and Asia
have their own small print to peruse.

The company promises — in its sole discretion (that means, whether it’s
your preference or not) — to either restore a machine to its original factory
specifications or replace it with a product at least equivalent to the one you
bought. Any parts used by the company in repairs may be new, or they may
be reconditioned parts equal to or superior to original equipment.

Here’s one of my favorite sections: “Customer must read and follow all set-up
and usage instructions in the user guides and manuals.” First of all, if those
manuals were any good (and you know they’re not), there’d be no need for
books like the one you're reading now. And in any case, this is part of the
gigantic loophole they carve for themselves: It’s not our fault, it’s yours.

The data on your machine is your responsibility, not the manufacturer’s. If
the laptop (or its hard drive) dies a premature death, the company will
replace or repair the machine, but if you don’t have a backup copy of the
data, that’s your problem.

As for the work the machine does: The product isn’t for assignments like life
support, nuclear facilities, or commercial transportation, and therefore the
company isn’t responsible if you set up a nuclear-powered self-propelled
heart monitoring system. Got that, Mr. Burns?

What isn’t covered? Any service made necessary because of accident (fire,
power failure, power surge and the like), misuse, abuse, neglect, or improper
maintenance. Also, any cosmetic damage including scratches, dents, and
faded keyboard keycaps.
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Calling the Experts to Your Aid

Phew! It’s hard to find things that are covered. Basically, it comes down to
this: If a part breaks all by itself they’ll fix it. If they can figure out a way to
blame you, me, or the guy behind the tree, they’re off the hook.

Extended warranties

Most manufacturers allow you to purchase extra years of warranty coverage.
In general, you must buy the extended warranty while the original warranty
is still in effect; for example, if your machine comes with a one-year limited
warranty, you must buy an extension within that first year.

If you buy an extended warranty, be aware that sometimes you can more
cheaply get a three-year warranty with the original purchase instead of
adding two years on later. Check to see if the manufacturer offers any special
incentives or rebates.

Going to a third-party warranty

Nearly all “generic” laptop makers — companies that sell machines that
retailers and web sites rebrand — don’t offer repair and maintenance serv-
ices of their own. Instead, they offer contracts from national companies,

or a chain of retail stores may provide warranty services on its own.

You may be offered a third-party warranty in another instance. Some retailers
may offer an extended warranty for a brand-name laptop computer. These
contracts kick in after the initial coverage period from the manufacturer but
you must purchase while that original warranty is in effect.

[ don’t mean to paint all third-party warranty companies with the same
brush; your local store may have demonstrated its trustworthiness. But hey,
you’re buying this book because you’re looking for the voice of experience.
An expert who knows what he’s talking about. Someone who’s been down
the road. I guess that’s me.

Be very cautious if you choose to consider third-party warranties. Some of
these companies are more like insurance companies; they bank your money
and hope that you don’t make a claim. If you do have a problem — and if it
fits their definition of a covered repair — they may hire an area repair com-
pany to do the work. Is that local company good at what it does, and will it
use first-quality parts? [ don’t know; do you?

And you also run the risk that the warranty company (or the retailer who
resold it to you) may not be in business a few years down the road. In
theory, these policies are supposed to be backed up with some kind of finan-
cial bond, but that may not be much help to you if you need quick service.
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Explaining Repaitrs

Okay, so your LCD has stopped amazing you with 16-million colors spread
across 17 inches of screen and instead you see a small flickering box of
sickly shades of green. The machine is 6 months old and still under war-
ranty. You never dropped the laptop, didn’t take it out in a lightning storm,
and carefully avoided using it as the countdown controller for the space
shuttle liftoff. You're covered.

Now, how do you get the screen fixed?

You call the service telephone number and manage to convince the support
department that your LCD really is dead and that the problem is theirs and
not yours. Depending on the manufacturer and, increasingly, depending on
the level of purchased protection, your laptop may be repaired three ways:

4 On site. The manufacturer sends a technician to your office or home and
the repair is done while you wait. You don’t have to worry about ship-
ping your machine, and the sensitive data on the hard drive is, in theory,
safe from unauthorized eyes.

Some companies promise next-day service, and even — at the highest-
priced contract level — same-day service. This is all theoretical, though;
read the fine print and you’ll discover that some companies don’t prom-
ise to provide on-site service everywhere. (For example, only a handful
of companies promise such service to my extremely rural location and
in that situation, next-day becomes several days.)

4+ Depot service. You have to package up your laptop (that’s why you held
on to the special box and the foam cushioning that it arrived in, right?)
and ship it to a service center. Depending on the plan, the cost of ship-
ping to the depot may be your expense, or the company may send a
prepaid label for use with FedEx or UPS or another carrier. Turnaround
time may also vary from a day to a week or more.

I'm not accusing technicians of prying into your personal affairs, but any
sensitive material on your hard drive is out of your control while it’s at
the depot.

One way to guard private information, including banking and financial
statements, is to password-protect individual files or entire folders. You
can do this with built-in Windows XP or Windows Vista facilities; you can
also purchase third-party encryption programs. Just don’t forget the
password . . . and don’t write it on a sticky note attached to the bottom
of the laptop, either.

4+ Carry-in service. Many major laptop makers have regional service cen-
ters where you can personally deliver your machine. That doesn’t mean
you can take a seat in the waiting room while the laptop is immediately
repaired; however, if the repair is something simple like swapping a
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failed battery for a good one, you may be able to take care of business in
one trip. It’s likely, though, that a maker might have a center on the West
Coast and another on the East Coast; if it’s not an easy drive, you're
back to depot service.

Calling in the Special Forces

The good news: Laptop prices have gone down as capabilities have gone up.
The bad news: Among the ways laptop makers have sought to save money
is by reducing (or eliminating) much of their product support services.

Years ago, laptop makers would maintain well-trained support departments
available to spend hours on the telephone helping a user get past a hard-
ware or software problem. The best of the companies offered these services
almost without limitation; if you had one of their machines, you could call in
with a question. Today, though, you're more likely to find severely limited
support options. You may be allowed to make free requests for support only
for the first few months after you receive a machine, or you may be allowed
to make a specified number of calls.

And nearly all laptop makers have outsourced their support services. I've
spent quality time with quite a few generally polite and sometimes helpful
young men and women in India, the Philippines, Costa Rica, and other
places.

Some laptop makers have also switched over to an online chat system

for dealing with problems. Although this can result in quick and direct
answers — in writing — it can also be rather frustrating. To begin with, if
your laptop doesn’t work or doesn’t connect to the Internet, you can’t

use it to chat. (If you have another computer, you can use that one to com-
municate.) A second problem with chat lines is that the representative
you’re communicating with is usually dealing with more than one customer
at a time, rotating from one to another like a chess master who takes on a
room full of players by running from table to table. Sometimes it seems as if
the chat expert is extremely dense; more likely, he’s got too many problems
on his plate.

And yet another option: online programs that allow a support department to
reach into your computer over the Internet to run diagnostics or to change
to settings or configurations. It’s a great idea when it works, but they can fix
relatively few problems — mostly operating system issues — this way.

If limited or impersonal service seems inadequate to you, well, for a few dol-
lars more you can upgrade to a personal consultant or get priority in the
waiting line. Some typical special support services follow:
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4+ Unlimited Support. Subscribers receive a special phone number and ID
code that permits them to dial in for assistance on either a specified
type of problem (hardware, for example) or for support on any possible
problem, including difficulties with the operating system and installed
software.

4+ Support Bundles. Some companies sell a “bundle” of a specified number
of support incidents. When the block of cries for help is exhausted, sub-
scribers can purchase more access. (Most plans works so each problem
is treated as an incident; if one call doesn’t solve the problem, additional
calls to the support line are treated as part of the same incident.)

4 Per-incident Support. Some hardware and software companies (includ-
ing Microsoft for Windows operating systems) sells access to an expert
on a per-call basis. It’s kind of like a computer game of Truth or Dare. For
a fee, you get to ask a question about a single problem, error code, or
incident. And the expert is supposed to stay with you, telephonically or
by chat line, until the problem is solved.

4+ Setup Services. Some retailers and online sellers dispatch a technician
to your home or office to set up or configure your new system. It’s a
pricey option, but for those users who are completely clueless — and |
submit that doesn’t include anyone smart enough to buy this book — it
may be worthwhile. Note that this sort of service is bound by geogra-
phy; if you live way out in the boondocks or on a sandy island (or both,
like me), you will likely find that you’re out of the local coverage area for
personal service.

4+ Rent Your Own Geek. In many communities you will find knowledgeable
computer experts — sometimes, dare I say, a mere kid — who comes to
your home or office to fix a problem. You have to determine for yourself
if you trust a person to enter your home or workplace, and once again,
remember to safeguard any personal or financial information on your
computer from unauthorized eyes.

Expanded or deluxe warranties

As prices for laptops have declined over the years, manufacturers have
looked to find ways to add value to their products; that’s a fancy way to say
that they’re on the hunt for ways to create additional streams of income
beyond the cost of the hardware itself. One way to do that is to sell
“expanded” or “deluxe” warranties, which are less-limited versions of the
standard protection.

Before you buy an expanded warranty, take to time to determine the specific
differences between a standard, limited warranty and any extra-price “plat-
inum” or “gold” or “deluxe” plans. What’s covered under the premium plan
that isn’t protected by the regular warranty?
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You may find these features in a deluxe plan:

4 Accident protection. A standard warranty doesn’t cover damage caused
by a crash to the floor or a spill on the keyboard; some expanded
coverages pick up (or clean up) the pieces.

4+ Priority repairs. A standard plan may say that machines will be repaired
or replaced within ten days or two weeks; an expanded plan may offer
two- or three-day service, or even send you a replacement unit by
overnight express if the company determines that your machine is
beyond repair.

4+ On-site repairs. Some plans promise to send a repair technician to your
home or office within a specified amount of time; confirm that your loca-
tion is within the normal coverage area. (I know for a fact that my home
and office is on the far side of nowhere and I cannot expect on-site repair
no matter what some salesperson says.)

4+ Special support lines. For the extra money you pay, you might be
granted access to real live human beings who answer questions and
assist in troubleshooting. Or you may be granted priority access, which
means you can jump to the head of the line, leapfrogging over people
who'’ve been listening to recorded “Thank you for your patience; your
call is important to us” announcements for three hours.

Refurbished, remanufactured, or open box

Some people seek to save money by purchasing a laptop from a source that
sells machines that are a bit less than brand new:

4+ Refurbished. What happens when someone purchases a laptop and
then decides it’s to too heavy, too slow, or too hungry when it comes to
battery power? Most retail and online outlets offer a period during
which you can return the laptop for a full refund (or sometimes for the
purchase price minus a restocking fee).

If the seller is honest . . . and most, but not all, are . . . they won’t resell
this machine as if it were new. Instead, they’ll refurbish it. This usually
includes electronically wiping the hard disk clean, reinstalling the oper-
ating system and applications, checking to see that all the parts are in
the box, and running basic tests on the hardware. And then they sell

it at a discount.

4+ Remanufactured. What happens when someone buys a laptop and
returns it because it’s defective in some way? The fault may be minor,
such as a broken key cap or a failed indicator light. Or the problem may
be more significant, such as an inoperative or faulty hard disk drive or
DVD drive.
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Instead of throwing away the machine, the retailer (or the original manu-
facturer) may repair the laptop to bring it up to full specs. A bad hard
drive can be replaced with a good one, for example. Again, though, the
seller should notify the buyer that this machine has been electronically
reborn.

4+ Open box. When you visit your neighborhood big-box computer store,
you see row after row of laptop out for display. For days, weeks, or
months, every other passing customer punches at a key or flicks at the
screen.

Eventually, the model reaches the end of its shelf life and in this situa-
tion a scrupulous dealer offers the machine for sale as an open-box item.
If it has any cosmetic marks that don’t effect the operation of the laptop
itself, it might be marketed as a scratch-and-dent special.

Should you buy any of these machines? In a word, maybe. The first thing I'd
determine is the type of warranty offered by the seller. Is it the full year or
two offered with a new machine, or is it a more limited 90-day or 30-day
what-you-see-is-what-you-get policy?

Speaking for myself,  wouldn’t purchase an open-box machine unless it
came with a full warranty and then only, if the price were significantly less
than a new machine. I say this for the same reason [ don’t recommend pur-
chasing a used car from a rental fleet; | know how the cars have been driven.
How do you know whether an open-box laptop has ever tumbled to the floor
or had a lollipop inserted into the CD slot?

The decisions on refurbished or remanufactured machines are a bit harder
to make. Again, I would consider buying one only if it had a full warranty and
a deep discount. But at least you have reason to expect that the machine has
been checked out; in fact, some remanufactured machines may have been
subjected to more rigorous testing than those right off the assembly line.

The bottom line is this: The price of a current laptop is so comparatively
low that I prefer to take my chances on a sealed box instead of paying for the
privilege of spending time with a partner with an uncertain past.

Accident and theft insurance

A laptop computer is fairly expensive, and is, by its very nature, portable.
That means laptops are a prime target for thieves. Laptops are snatched in
airports, hotels, Internet cafes, and from homes and offices. And laptops

can suffer expensive damage that isn’t covered in a limited warranty: a fall to
the floor, a drink spilled on the keyboard, or a cracked or fractured LCD.

[ talk about laptop locks and software-based laptop recovery systems in
Book IX, Chapter 2.
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But your friendly laptop manufacturer may have a solution for you. . . for
a few dollars (actually, a few hundred dollars) more. Accident and theft
insurance is now offered as an expansion of the standard warranty or as a
separate but related product.

Most companies require that the term for the insurance match the number
of years the machine is covered under warranty. In other words, you can
only buy three years of theft and accident coverage if you've also purchased
three years of warranty. In addition to bringing in more money to the
computer maker, this offers the manufacturer some protection against
unscrupulous users who might be less than honest in their claims.

Be sure to read carefully the terms of any insurance to understand what’s
covered. Determine if the company will replace a laptop that can’t be
repaired, and see if your data has any coverage value — there usually isn’t.

Finally, check with the insurance company that covers your home or office
to see if your laptop is protected already. If it is, find out if your policy
provides replacement of a stolen machine (that’s good) or merely a check
for its depreciated value (not very good).
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A Windows Ultimate Extras [More]

Install and use any supported language with the Multi-Lingual
User Interface (MUI) [More]
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BitLocker™ Drive Encryption [More]

<
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with a Trusted Platform Module (TPM) 1.2 chip

w. Protect confidential files with Encrypting File System [More]
| Restore lost or edited files with Windows shadow copy [More]

Restore your entire computer with Windows Complete PC
Backup and Restere [More]

¥ Access your PC from anywhere with Remote Desktop [More]

To automatically scan your laptop, go to the Windows Vista
Upgrade Advisor on the Microsoft web site.
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Chapter 1: Installing or Upgrading
an Operating System

In This Chapter

v Clearing up Windows

v+~ Upgrading to Windows XP

v+~ Upgrading to Windows Vista
v Gradually updating Windows

Orlce upon a time there was DOS, the Disk Operating System that was the
internal geek-in-charge of the first IBM PC. DOS (pronounced dahss) was
amazing for what it was: a way for a personal computer user to directly
instruct a machine to do something.

But it was hardly what you might consider user friendly. Trust me, [ was
there at its birth, as one of the first editors of PC Magazine. Hold on for a
second while I get up from the keyboard and dig out one of the old manuals
from the deepest recesses of my library.

Okay, I'm back. Sorry for the delay; the dust was an inch thick and the manual
(an impressive hardcover binder that came with its own slipcover box) was
heavy. And I fell asleep for just a moment as I reacquainted myself with a few
of the commands that used to occupy so much of my time.

Clearing Up Windows

Nearly every laptop user (and most everyone else) understands the basic
idea of Windows: The program is a view (a window) into your computer that
you can touch, manipulate, and change with an electronic hand. That hand
can be the cursor you move around the screen via mouse or touchpad; on
some machines the cursor can move by other means, including the human
finger (think of your bank’s ATM for an example) or spoken commands.

But more importantly, Windows is a graphical user interface (GUI). Unlike the
dark days of DOS, modern users are working with what amounts to a live
screen. You can click an icon to open a file or start a program; you can pull
down a menu from a piece of software and initiate a command by clicking
the one you want; and you can reach in and change text or even draw a picture
using a mouse to move an onscreen tool.
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And Windows also makes possible the amazing world of the Internet. The
very nature of Microsoft’s Internet Explorer (as well as other Web browsers
such as Mozilla Firefox and other capable but less-popular competitors) is

based on the Windows GUI.

The dark days of DOS

When you turned on your machine, the floppy
disk drive (which could hold the entire operat-
ing system) booted the system. When the code
was loaded you were given the following excit-
ing and self-explanatory greeting:

A:

That's right. The machine was telling you that it
was ready to rock and roll, with all of its atten-
tion focused on drive A of your machine. Right
away any youngsters are in alien territory: many
people are completely unfamiliar with the con-
cept of a drive with that name. On a modern
laptop or desktop, hard disk drives begin with
the letter designation C and go deeper into the
alphabet from there.

The A disk, of course, is the first floppy disk. Or it
was, anyhow; very few modern laptops come
with a floppy drive today.

But pretend. Under DQS, if you wanted to know
what data or programs were stored on the A
disk, all you had to do was type:

A: DIR

and press the Enter key. The floppy disk drive
spun for a few moments; the monitor displayed a
list of files on the top level of the disk, and also
told you the names of any subdirectories placed
atalower logical level. Say you'd created a sub-
directory called DUMMIES. (The command to
create that would have been MKDIR \DUM-
MIES.) To drill down a level to that group of files,

you'd type

A: CHDIR \DUMMIES

as in Change Directory, and then press the Enter
key. Then you could ask for a directory of the
files.

And now, one last simple command: Rename a
file. Using the verb REN (for rename), you'd type
the name of the file you wanted to work on and
then the new name for that file. Like this:

A: REN OLDNAME.TXT NEWNAME.DOC

That's the drill, folks. Users had to learn a com-
pletely new language, a very specific and
unforgiving grammatical syntax, and keep track
of where they were, how the machine was
organized, and what was it that they had
wanted to do in the first place.

If the days of DOS (which ran from about 1981
until about 1990) had a single bright side, it was
this: Installation was a snap. You received a
master copy of the operating system (along with
that big binder of instructions) and you could
format as many floppy disks with the system
tracks as needed to boot your computer to life.

A few years into the history of the personal
computer came the first hard disk drives, and
the process was similar: Format the drive with
the system tracks and you were off and run-
ning. DOS had no copy protection, and though
the license pleaded otherwise, there were
entire offices, dorms, and small towns that
shared the same copy of the operating system.
That's just a fact.
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The dark side of DOS? You've just seen it. It was
a command-driven operating system. You had
to type commands to make something happen,
and the more sophisticated the user (or the
command), the more complex and lengthier the
instructions.

And the command structure carried over to the
software programs that operated under DOS,
too. One of the more popular word processors
of the time was WordStar, and everything came
from the keyboard, too. Ctrl + KP meant print,
Ctrl + KS meant save and resume, and Ctrl + PB
meant begin (or end) a block of boldface.

The software required the operating system to
run, but there was very little, if any, consistency
between programs. Commands were different

with each piece of software. Menus — if they
were used at all — were not the same. And
nearly every program had its own file format.
There was a whole subindustry in conversion
software that made it possible to exchange
certain types of data files between programs.

And, in the end, the biggest deficit in DOS was
the fact that it relied on characters and com-
mands. To give credit where credit is due, it
was the designers at Xerox's Palo Alto
Research Center who developed the first
usable graphical user interface (GUI) and the
engineers at Apple who brought it to market.
Once the Apple Macintosh was introduced, it
was obviously the way to go for personal com-
puters, and by 1985 Microsoft brought out the
first version of Windows.
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Over the past 20 years or so, you could call your PC’s GUI Windows (from
versions 1.0 through 3.11, with more than a few minor numbers along
the way), Windows 95, Windows for Workgroups, Windows CE, Windows

ME, Windows NT, Windows 98, Windows 98 Special Edition, Windows 2000,

Windows XP, and Windows Vista. Heck, you could even call it Bob. (Yes,
Microsoft once tried to put a cute, human face on its GUI; Bob was a bust.)

Today is a moment of transition. In early 2008, Windows XP holds sway on
more than 75 percent of all personal computers, while the newer Windows
Vista is beginning to take over the market for the newest, highest-powered
machines. Meanwhile, about 5 percent of machines still in productive use
run one of Microsoft’s older operating systems.

Microsoft will support Windows XP for the next few years, but eventually
Windows Vista will be the chosen one . . . until the next great new thing is

offered.

Why doesn’t everyone immediately install and use the latest and greatest
version of Windows? You might not for one of these four good reasons:

4 Because you can’t. Windows Vista’s advanced features require the most

powerful microprocessors, large amounts of RAM, and the most
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sophisticated graphics adapters. Most machines designed or manufac-
tured before 2007 may be unable to run Vista or may offer only mediocre
performance when they do.

Because of other software. Not every piece of software written for earlier
versions of Windows works properly with Windows Vista. Some manufac-
turers may offer updates (for free, or for a fee) or provide new drivers to
registered owners. But some users may not want to risk adding problems
to software that functions properly.

Because of hardware problems. Some older hardware may require new
device drivers to run with Windows Vista. Again, some users may not
want to risk losing the use of hardware that works fine with an older
operating system.

Because you don’t need to. Windows Vista is flashy and smooth and offers
some exciting new geegaws and advanced security features. But if your
existing operating system and all of its installed software and hardware is
functioning properly, you may make the distinction between a need and
want. Sometimes the wisest decision is: If it ain’t broke, don't fix it.

Windows XP

Microsoft offered five major editions of Windows XP. The vast majority of
machines ran the Home version, even in offices, which aren’t usually homes:

4+ Windows XP Home Edition. Smoother and more dependable than earlier

versions of Windows, it offers improved digital media management for
photos, video, and music.

Windows XP Professional Edition. Intended for power users, it includes
all the functions of Windows XP Home plus additional security, privacy,
and recovery features. Added components include the Remote Desktop,
which allows you to access your computer from another Windows PC
and built-in file encryption and access control.

Windows XP Tablet PC Edition. An adaptation of Windows XP Home
intended for use with laptops and special monitors that include touch
screens and voice recognition.

Windows XP Media Center Edition. An enhanced version of Windows XP
Home that adds an integrated set of controls for use with TV tuners and
other multimedia devices.

Windows XP Professional x64 Edition. A supercharged version of Windows
XP Professional intended for use with microprocessors and software
applications that can make use of 64-bit computer words (instead of the
more common 32-bit designs).
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News you can use: A machine, operating system, and software that can move
around 64-bit words can (in theory) calculate and manipulate at twice the speed
of 32-bit computers. But other things can choke the speed: the capability of the
bus that interconnects components, the capabilities of the memory and the
hard drive, and the nature of the work being done.

Windows Vista

Microsoft also offered five versions of Windows Vista when it was introduced
in 2007. (Actually, to be precise, it also announced plans to offer a simplified,
lower-cost Starter version that is expected in developing nations and to edu-
cational and charitable organizations taking computers to places where they
haven’t been seen before.)

As with Windows XP, the most common version is likely to be Vista Home
Premium; that version and the three preceding it offer the strictly cosmetic
but very pretty Aero graphics scheme. All five consumer and business ver-
sions can support as much as 4GB of RAM in 32-bit versions:

4+ Windows Vista Home Basic. The new look and new “engine” of Vista is
here, without the Aero appearance and also missing the Media Center,
Windows Movie Maker, and Windows DVD Maker. Also absent: advanced
rights management, scheduled backup, and drive encryption.

4+ Windows Vista Home Premium. This version and all others beyond Home
Basic include the Aero desktop experience. To the features of Basic, it
adds the Media Center, Movie Maker, DVD Maker, and scheduled backups.

4+ Windows Vista Business. This entry-level version is for business users; it
lacks the media, movie, and DVD features but adds remote desktop,
rights management, and other advanced features.

4 Windows Vista Ultimate. The kitchen-sink version, it includes the Media
Center, Movie Maker, DVD Maker, and every other advanced technical
and security feature.

4+ Windows Vista Enterprise. Sold as a multi-unit license to large organiza-
tions (enterprises), it includes all of the features of Vista Business plus
BitLocker drive encryption and a few other advanced features. No multi-
media, though.

Seeing the Window's Experience

Are you experienced? Have you ever been experienced? Have you ever heard
Jimi Hendrix’s guitar wail? You should be able to answer “Yes” to all three
questions at some time in your life. And if you’ve got a laptop running
Windows Vista, you should also find out your Windows Experience Index.
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As already noted, rarely in the history of personal computing have new hard-
ware and software capabilities been in sync. Often, new hardware — including
microprocessors and chipsets — tantalize with their potential for years before
software catches up. With the release of Windows Vista in 2007, it was the other
way around: Some of the features and the look-and-feel of the operating system
only work with the latest, most advanced hardware. That’s not to say that
Windows Vista can’t be installed and used on a machine slightly behind the
curve, but some of the bells will be muted and a few whistles won’t sound
quite right.

The Windows Experience Index is a component of Windows Vista. While not
really a tool, it’s more of a snapshot assessment of your machine’s power
and capabilities. But the Index is very valuable if you need to understand
how well your laptop will work with Vista, or whether a new piece of soft-
ware will perform adequately if you install it. See Figure 1-1.

The Index number is automatically calculated by the operating system when
you first install it, and you can check the number through the Control Panel.
If you later install more memory or adjust the hardware, you can go back
and see if the system has determined that your work was of any value. Later,
if you suspect your machine is operating beneath its original speed, check
the Index to see if it has changed.

When you first receive your new laptop, or immediately after you upgrade
your operating system, check the Windows Experience Index via the Control
Panel and write down the results somewhere where you can find it again; I
usually place notes about hardware and software installation in the original
box the machine came in.

Rating your Experience

The bottom line of the Experience Index is the base score. For reasons that must
have made sense to someone in marketing, the lowest possible score is 1.0

and not 0. The highest possible score — at the time Windows Vista was first
introduced — was 5.9. Microsoft says that it expects to raise the ceiling when
new and improved hardware is available.
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The
Windows
Experience
score fora
zippy
Toshiba
Satellite
P205 lands
rightin the
middle, at
3.1, because
of a merely
adequate
graphics
system.
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The base score is set at the lowest of a series of subscores. The Index rates
the following components:

4 Random Access Memory (RAM); operations per second
4 Microprocessor (CPU); calculations per second

4+ Hard disk; data transfer rate for the primary disk

4 General graphics performance

4+ 3D graphics capability

The base score won’t be higher than the lowest subscore; it isn’t an average.
If the microprocessor is your laptop’s weakest link, with a score of 2.8, that’s
as high as the base score will go. (And since upgrading a microprocessor
within a laptop is nearly impossible — or ridiculously cost-ineffective —
that’s the end of the story.)

Let me put that another way: When I'm talking about scores for the micro-
processor, the chipset, and the graphics adapter, the best way to have and
hold a laptop with a high Index score is to buy one with the number you
want in the first place. Desktop machine owners have much more flexibility
when it comes to upgrading things like the graphics adapter and sometimes
the microprocessor itself.

ESEr=3=)
@\../'l. » Control Panel » Pedformance Information and Tools ~ [ 42| [ search £
Tasks e
Rate and improve your computer's performance
B Manage startup programs
v Mot sure where to start? Learn how you can improve your computer's performance.
(¥ Adjust visual effects
& Adjust indexing options Your computer has a Windows Experience Index base score of Eﬂ
£ Adjust power settings
Component What is rated Subscore Base score
& Open Disk Cleanup
Processor: Calculations per second LE:]
B Advanced tools
Memory (RAM): Memory operations per second 44
Graphics: Desktop performance for Windows Aero 31
Gami hics: 3D business and gaming graphics ¥
9 performance S Determined by Book Il
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Primary hard disk: Disk data transfer rate 45 Chapter 1
View and print details What do these numbers mean?
Learn more about the scores online © Update my score -g
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Last rating: 11/15/2007 9:44:52 AM =
“Zo
@D =
3
. Problem Reperts and Solutions

10 Buijeisuj



74 Seeing the Windows Experience

On the other hand, if the amount of RAM or the hard disk drive’s speed or
capacity is holding back your Vista Experience, you may be able to boost the
score a few tenths of a point. (Even if it doesn’t, more RAM generally
improves your laptop’s performance, and upgraded hard disk drives are like
closets in your house: It’s nice to have more space to hold your stuff.)

As the market for Windows Vista software begins to mature, expect to see
new applications labeled with Windows Experience ratings as part of their
requirements. You may find that a graphics-intensive program lists a score of
3.0 or higher as a necessity for the full experience.

\\J

Going inside the numbers

Windows Vista installs and runs on almost any current laptop. But not all
machines can deliver advanced features. Table 1-1 roughly compares base

scores.

Table 1-1 Windows Vista Experience Numbers

Number Translation

1.0-29 Good enough for the office. Enough power to perform most

general computing assignments, including office applica-
tions and basic Internet browsing. Don't expect experience
Windows Aero or advanced multimedia functions.

30-39 Got game? Say hello to Windows Aero, and many of the

other new Windows Vista features. This is the middle of the
road, though; not all advanced features perform at a satis-
factory level. For example, there might not be enough power
to display Windows Vista at high resolution on multiple
monitors or you might be able to display digital TV but not
high-definition TV.

40-59+ Do you want it all? A machine with a base score in this
range should deliver all the new Windows Vista features,
including Windows Aero and multimedia experiences such
as multiplayer and 3D gaming, recording and playback of
high-definition TV, and be ready for new features that are
added later.

As this book goes to press, most current consumer-grade laptops are going
to be in the range of 3.0 — 3.9. They are limited by the graphics card or built-
in graphics facilities of their motherboards. You can expect a boost in the
Experience in years to come. If high-end graphics are your highest priority,
shop for a laptop that includes an advanced graphics adapter.




Figure 1-2:
An
examination
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subscores
that lie
beneath the
base score
for the
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helps
pinpoint a
machine’s
weakest
link.
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Checking your machine’s scores

The Windows Experience is less an experience and more like a viewing. You
can see your computer’s score by going to the Control Panel and clicking the
Performance Information and Tools icon. Then read the report.

An example of the subscores for a Toshiba Satellite P205, shown in Figure
1-2, shows very high scores for its Intel Core 2 Duo microprocessor, its fast
hard disk drive, and the installed RAM. But the fact that the machine relies
on the built-in graphics chipset — standard fare for many laptops — drops
the base score to mere ordinary.

The score is automatically calculated when Windows Vista is first installed
on your machine; it isn’t dynamic — it doesn’t go up or down as you use
your machine or add software. But if you have recently changed — such as
adding RAM or installing an improved hard disk drive — you can instruct
Windows Vista to recalculate the score to reflect changes. (Remember,
though, that the final score will never be higher than the lowest subscore.)

8 | Performance Information and Tools |
St my computer Print this page

Component Detais Subscore Base score

Processor IntelR) Core(TM2 CPU T5300 @ 1.73GH: 43

Memery (RAM) 199 GB 44 -
-

Graphics Mokie Intel(R) S45GM Exuress Chipset Famdy 311 o

ing grapti 224 MB Total svaiable graph £ Detereined by

lowst jubscore

Primary hard disk 139G8 Frea (185G8 Total) 45
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Upgrading to Windows XP

Upgrading to Windows XP

W

A\

Say you’ve decided to upgrade to Windows XP from one of its relatively young
cousins (Windows 98, Windows Millennium Edition [Me], or Windows 2000
Professional). I discuss the process for Windows Vista later in this chapter.

Before you buy a new version of the operating system, and certainly before
you even think about starting to install it, determine the following:

4+ Does your laptop meet at least the minimum hardware requirements
for Windows XP? An Intel Pentium or Celeron, or an AMD K6, Athlon, or
Duron microprocessor or a compatible CPU, running at least 233 MHz
(with 300 MHz a more realistic speed), at least 128MB of RAM (although I
suggest 512MB or 1GB as the least amount of memory), and a video
adapter capable of at least SVGA resolution.

You can visit one of two Microsoft web sites to see if your existing
machine should work with XP. Try www.microsoft.com/windowsxp/
home/upgrading/checkcompat.mspx to learn about XP Home Edition
compatibility. To see if XP Professional stands a chance, visit www.
microsoft.com/windowsxp/pro/upgrading/checkcompat.mspx.

4+ Can you reasonably expect that your major software pieces — pur-
chased for use with an earlier operating system — will work properly
with Windows XP?

4+ Will your installed internal and external hardware devices work
properly with Windows XP? In general, you want to use a device driver
that’s been updated to match your operating system; sometimes a more
modern OS works with a driver from the previous generation, but I
wouldn’t bet the family supply of blank CD-Rs on it.

The Microsoft Windows XP Hardware Compatibility List (HCL) is available at
www.microsoft.com/whdc/hcl/default.mspx.

Hoping to upgrade your 0S

You can change the operating system on your laptop two ways. One is to
upgrade the existing system. The other is to perform a clean install. Okay,
there’s a third way, too: Buy a new laptop with the operating system
installed and donate your old one to a school, a charity, or one of your kids.
You’ll have to migrate your old software to the new one (if you can), or buy
new programs. Does this make sense? Some of you are nodding in agreement
and the rest . . . well, you were smart enough to buy and read this book, so
you're smart enough to make an informed decision about whether upgrading
is worth the time, effort, and expense.
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The advantage of keeping your existing hardware and upgrading the operat-
ing system is that you may be able to keep your current software, utilities,
and data and merely replace the operating system. Take the time to consult
the web sites and support desks for your software to see if they offer neces-
sary updates for newer operating systems.

If you're going to have to pay for new software, include that cost in the total
price of upgrading. Is the purchase of a new operating system plus new soft-
ware plus time and effort justified?

The disadvantages of upgrading: Any viruses, corrupt files, file system
damage, or other problems with the underlying logical structure on the hard
drive may (or may not) be solved by the upgrade and could come back to
haunt you.

Even though an upgrade theoretically allows you to hold on to your existing
data and software, make sure you have a full set of data backups (on CDs,
DVDs, or an external hard disk drive) just in case of a problem. You should also
gather all your software program discs so you can reinstall them if necessary.

Never attempt to upgrade a laptop that is experiencing problems with its
existing operating system. That’s just begging for new headaches. Get the
old OS running properly, or abandon the thought of an upgrade. Keep the
system you’ve got or go for a clean install.

Microsoft only permits upgrades to Windows XP from certain versions of
older operating systems. You can’t upgrade from Windows 3.1 or Windows
95 or anything older than those systems, or from any evaluation versions of
Microsoft operating systems. Windows NT 3.51 is also incompatible with an
upgrade.

Your laptop must be running Windows 98, Windows 98/SE, or Windows Me in
order to upgrade to Windows XP Home Edition. To go to Windows XP
Professional, you can come from those three earlier operating systems plus
Windows NT 4.0, Windows 2000 Professional, and Windows XP Home.

Safety first: The upgrade rules

If you're like me, you're very cautious when it comes to the essentials of life.
(My father calls this a “belt-and-suspenders” strategy.) Microsoft offers the
Windows XP Upgrade Advisor for download to create an audit of your com-
puter’s current status and a report of any known incompatibilities between
hardware and software.

[ suggest you do this extra step after you've investigated your machine. After
you determine that it meets (or even better, easily exceeds) the hardware
requirements and after you closely look at the running software (and checked
with the programs’ makers to ensure they certified that it runs under
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Windows XP), then you can run Microsoft’s tool. It’s a belt-and-suspenders
approach, but I'd rather you thank me for the trouble you avoid than blame
me for the disaster you find.

Here, then, are Sandler’s Five Rules for Operating System Upgrade Safety.
I'm talking here about Windows XP, although the same principles apply to
the newer Windows Vista:

4 Rule 1: Before you do anything else, perform your own assessment of
your laptop’s hardware and software.

4+ Rule 2: Check with the manufacturer your laptop and any devices
you’ve added on your own to determine if they support an upgrade to
Windows XP.

4 Rule 3: Determine from the laptop maker if the BIOS needs to be
updated. (I explain more in the following section.)

4+ Rule 4: Do the same with your software makers. Apply all available updates
to programs, and consider the cost effectiveness of paying for any required
upgrades to software necessary to run under a new operating system.

4 Rule 5: Run the XP Upgrade Advisor. If it gives you (your laptop, actually)
a clean bill of health, cautiously proceed with an upgrade to Windows XP.
On the other hand, if Microsoft notes any compatibility issues with hard-
ware or software, stop. Do not pass go. Do not attempt to upgrade.

If you resolve all the compatibility issues uncovered by Microsoft’s tool, you
can proceed. If you can’t satisfy the tool (a scary thought), I recommend
either not attempting an upgrade or seeking professional assistance from
Microsoft or the maker of your laptop.

Some computer retailers or repair shops evaluate your machine for a fee or
for free; they do so with the hope (or expectation) you’ll buy software or
hardware from them in return.

Updating your laptop’s BIOS

Depending on your laptop’s age, it may be necessary to upgrade your
machine’s BIOS chip. A computer’s Basic Input-Output System (BIOS) code is
exactly what it sounds like: the lowest level set of instructions used to bring
an inert box of silicon, metal, and plastic to life and, once running, to manage
the essentials of things like interpreting keystrokes from the keyboard, clicks
from the mouse, and getting the computer otherwise able to deal with the
operating system, the microprocessor, and you.

Your laptop manufacturer can tell you if it has any available and necessary
BIOS updates. (A good manufacturer should have been in touch with you on
their own to advise an upgrade, but. . . .) Follow carefully the instructions to
download the BIOS update from the Internet and to flash the chip in your
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laptop. (Flashing has nothing to do with sudden exposure of skin to an unsus-
pecting passerby; it means to send an electrical signal to a special kind of
rewritable non-volatile memory to save new code where once there was old.)

NNG/ Flashing your BIOS with the wrong update, or performing the process incorrectly,
can make your machine unable to go on with life; you may damage the BIOS or
even the motherboard itself. If you have the tiniest doubt about the process,
consult with your laptop maker . . . or don’t fix something that isn’t broken.

@‘“‘NG! Make sure your laptop is plugged into an AC adapter and has a fully charged
S battery before attempting to perform a BIOS flash operation; this belt-and-
suspenders protects against a power failure or low battery power that could
leave you with a crippled machine.

Running the Windows XP Upgrade Advisor

To run the Microsoft tool, click on “Download the Upgrade Advisor” from
this web site: www.microsoft.com/windowsxp/home/upgrading/
advisor.mspx.

The advisor will generate a report that describes any “blocking issues”
(think of them as headaches, stomachaches, and other reasons you might
want to reconsider upgrading to Windows XP). You can see the opening
screen in Figure 1-3.

B Microsoft Windows XP Upgrade Advisor
7z Welcometo
Microsoft® Windows® XP Upgrade Advisor

How Upgrade Advisor can help you

Figure 1-3:

Microsoft's

Windows Upgrade Advisor reviews your computer hardware and software and tells you the next steps

XPU pg rade to take to ensure a smooth upgrade to Microsoft Windows XP.

AdVISO.I',- a For best results, connect to the Internet before running Upgrade Advisor. On the Internet,

free Utl|l'[y, Upgrade Advisor will get the latest files for reviewing your computer hardware and software,

examines If you don’t connect first, Upgrade Advisor will try to connect automatically. However if a
connection is unavailable or does not work, Upgrade Advisor can still assess your system

your comj

. patibility.

machine to

see if

installed To close Upgrade Advisor and connect to the Internet manually, click Cancel.

hardware To continue, click Next.

and

software

are upgrade Next B8] Cancel [X]
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Taking final steps before upgrading

You're really going to do this? Here’s the preflight checklist:

1.

ST 1 & W

Make sure the laptop is running from the AC adapter and not its internal
batteries.

You don’t want to run out of juice in the middle of an upgrade.

. Turn off any built-in power management settings on your machine.

You don’t want the LCD shutting off or the hard disk drive spinning
down during periods of inactivity. This is one situation where you want
all power, all the time.

. Run a full antivirus scan on your files.
. Empty the Recycle Bin.
« Run a full drive defragmentation.

. If you have a hard disk maintenance program, scan the disk for errors.

Otherwise, use the built-in Windows error-checking facilities accessible
by going to My Computer > Properties = Error-Checking.

. Disconnect your machine from the Internet (unplug an Ethernet cable

or shut off a WiFi link).

You need to reconnect later on in the process to register the operating
system and download updates, but you don’t want anything to interfere
with the early steps of the upgrade.

. Disable any antivirus programs on your machine.

Don’t worry — it’s safe to do this now that you’re disconnected from the
Internet. You should re-enable the antivirus once the installation is
complete.

. Start the upgrade and go watch a ball game.

Come back every ten minutes or so to see if you're needed to fill in a
name, password, or make option selections. The whole upgrading
process should take a few hours; enjoy the ball game.

Installing Windows XP

The safest way to install a new operating system is to make a clean install
onto a new hard disk drive or onto an existing hard disk drive that is refor-
matted and completely wiped clean of any vestiges of the old.

The downside: All your existing data files, settings, configurations, and program
files are scrubbed away to make that clean slate. (Make backups of your data
and settings on CDs or DVDs or on an external disk drive or other media.
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Software applications can always be reinstalled; you did keep the original
discs along with license keys and instruction manuals, right?)

Making a clean installation of Windows XP

The same advance planning applies as that I recommend for an upgrade:
Make sure your laptop more than meets the minimum requirements for
Windows XP before you take the first step toward clearing the hard disk
drive and installing the new operating system.

Once you install the OS, install your software applications and test them out.
The final step is to load your data back onto the drive; putting the data on
after the software is installed gives you the chance to clean up any problems
related to inconsistent data storage you might have under your previous
operating system.

Installing XP as a second operating system

You can have it both ways: running both Windows XP and an earlier operat-
ing system on the same hard disk drive. You just can’t do both at the same

time. It’s called dual booting, and it works like this: As the machine starts, it
pauses and asks whether you feel like a Windows XP kind of kid or whether
you're in a retro mood and want to load an oldie from the spinning platter.

Why would you want this option?

4+ Some users need to hold on to and use older software that just won’t
work under a newer operating system, and this is one way to go back
from the future.

4+ Some users are very, very cautious (belts, suspenders, and safety pins)
and like to have both the old and new available at least while they test a
new operating system.

To install Windows XP to a new folder (also known as a parallel installation),
you have to start up the machine from a boot disc supplied by Microsoft —
not from the hard disk of an already functioning machine. Any of the follow-
ing can start the machine:

4 Microsoft Windows 98 or 98SE startup disk

4 Microsoft Windows Millennium Edition startup disk

4+ Windows XP boot discs (created by the user from within the operating
system as an emergency way to start the computer)

4 Windows XP CD-ROM installation disc
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To start your machine from a CD you must instruct the Setup screen of your
laptop to boot from the CD or DVD drive if it finds a disc there. Consult the
your machine’s instruction manual for details on displaying the setup screen
before the system boots.

Performing a parallel installation

Setting your machine up with more than one operating system available
begins as if you were making a regular installation. However, this is where
you start these steps:

1. Press the F8 key at the EULA screen.

This screen contains Microsoft’s bestselling, enthralling piece of popular
literature known as the End-User License Agreement (known to friends as
EULA).

2. Select the partition where you want to install Windows XP and then
press Enter.

3. Select the Leave the Current File System Intact (No Changes) option
and press Enter to continue.

4. Press Esc to install to a different folder.

The Setup program should detect the presence of another operating
system and prompt you to enter a name for the new folder after the back-
slash. A good and obvious and safe choice would be \WINXP. (If no other
operating systems are detected, the Setup program automatically creates
a folder called \WINDOWS, but if no other OS is detected and you know
there is one . . . well, you've got a problem and should contact Microsoft
for support for your newly purchased legal copy of Windows XP.)

5. Follow the more-or-less straightforward instructions to install the
second operating system.

Seeing to a Windows Vista Upgrade

With each successive improvement in speed and capability for operating
systems, the demands upon computer hardware become greater and greater.
And just to make things interesting, the two sides of the equation — hard-
ware and software — almost never advance evenly.

Most of the time, the hardware gets way out in front of the software. For
example, Intel and AMD are constantly pushing microprocessor design
boundaries. The latest, greatest thing is multicore CPUs which give the com-
puter two, or four, and eventually even more separate workspaces in the
same chip. It will probably take several years before software, and the oper-
ating system itself, can make full use of the hardware’s advanced features . . .
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and by then there will almost certainly be new chips with new capabilities
waiting to be used.

Upgrading editions of Windows Vlista

Sometimes the version of Windows Vista that comes preinstalled on your
laptop computer may turn out to be less of an “experience” than you desire.
Or your needs for advanced features may change over time.

Not to worry; Microsoft has made it easy to change (for a fee) the version of
Windows Vista on your machine. Upgrading editions (from Vista Home to
Vista Home Premium, for example) is a relatively simple process — much
less daunting than changing operating system versions (from Windows XP to
Windows Vista, for example).

In many cases, the installation or backup DVD for Windows Vista actually
contains the code for all the available consumer editions. To go from one
edition to another you’ll need to purchase a software key to unlock the soft-
ware. Some users may need to download the new edition over the Internet.
See Figure 1-4.

@Q'lﬁ « Windows Anytime Upgrade + Comparison Matrix

- -
*» Windows*Anytime Upgrade -
& &,‘ Your operating system is:
A convenient and affordable way to upgrade Windows - Windows Vista™ Home Premium
5 2 Windows Vista
Upgrade Comparison Chart Windows Vista™ Home Premium Ultimate
Product Feature

(A Windows Ultimate Extras [More]

[T

o Install and use any supported language with the Multi-Lingual
= User Interface (MUT) [More]

) Get the best data p ion available with Wind v
BitLocker™ Drive Encryption [More]
May require additional hardware: a USB Flash Drive and a computer
with a Trusted Platform Module (TPM) 1.2 chip

V Protect confidential files with Encrypting File System [More] ¥ 4

| Restore lost or edited files with Windows shadow copy [More] v

= Restore your entire computer with Windows Complete PC v

= Backup and Restore [More]

»| Access your PC from anywhere with Remote Desktop [More] v, -
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Sizing up computer words

One of the elements of hardware evolution has been the increase in the size
of the computer “word” that can be operated upon by the CPU and other
components. What’s in a word? A word is the unit of data manipulated by the
computer, a particular number of individual bits that are grouped together.

Let me try an analogy that isn’t about cars. A hungry alligator can open its
jaws wide and quickly snap off a large chunk of, well, just about anything. A
tiny piranha can do the same, but only with little nibbles. If they’re both
eating at the same speed — matching bite for bite — then the alligator is
guaranteed to win. (What a natural contestant for a hot dog—eating contest,
don’t you think?)

Some situations — in the computer world as well as in the Amazon River —
have even the small mouth (or small-word computer) taking much smaller
bites but operating at a much faster speed than the big mouth. But for most
of us, it’s true that most modern laptops have both a big mouth and a fast
mouth at the same time.

A computer microprocessor’s design is linked to its word size. The registers
(storage locations within the CPU) are usually word sized. The amount of data
moved between the CPU and the computer’s memory, or out of the computer
to another device, is usually one word at a time. And software is designed to
describe colors, characters, sounds, and other information with words.

The PC world arrived in the 32-bit age (words from 0 through 4,294,967,295)
with the introduction of Intel’s Pentium CPUs. Today most processors use
that design. Just a handful of consumer-grade machines use 64-bit proces-
sors, paired with 64-bit versions of Windows XP or Windows Vista, but the
future surely lies in that alligator’s mouth. Many current programs for use
with a 32-bit version of Windows work under a 64-bit operating system,
although they may run slower or not play well with other applications. A
handful of laptops are now on the market using AMD Turion 64 processors,
with Intel equivalents in the pipeline.

Speeding to a graphic processor

All versions of Microsoft Windows (as well as competitive systems including
Apple Macintosh operating systems and Unix and Linux variants) are GUIs.
And as GUIs they depend heavily on the speed and power of your laptop’s
graphics adapter and any specialized or shared graphics memory.

With each successive Windows version, the need for graphics adapter speed
has increased. Windows XP was very demanding, and Windows Vista is very,
very demanding.
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Take a bit

The original mass-market PCs, mostly built
using the Intel 8088 processor, limited to words
made up of 8 bits, were very limited in the
number of colors and type of graphics they
could display. Then came 16-bit systems, which
ruled the universe for more than a decade.
Today most PCs are capable of working with 32-
bit words, and the cutting edge for consumer-
grade machines are systems that know what to
do with a 64-bit word when they see one.

An 8-hit word can represent a value from 0 to
255; more than one word must be connected to
another for values higher than that, although
each is evaluated and processed separately. A
16-bit word can represent a number from 0 to
65,535. Among 16-bit processors, the most
commonly used was Intel’s 80286.
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Before you buy a new laptop on which to run Windows Vista, and especially
before you consider upgrading an older model to run Vista, make sure the

graphics adapter is up to the task. Here is one place where laptops present a
challenge not faced by desktop owners: In nearly all laptop designs, you
can’t replace or upgrade the built-in graphics adapter.

If you're buying a new laptop, make sure it is certified for use with Vista (if
that’s your intended operating system). If you're hoping to install Vista on an
older machine, check with the laptop manufacturer for advice.

Although Windows Vista is “certified” to run on a fairly wide range of graph-
ics adapters, you may find that some older, slower pieces of hardware, or
those with insufficient amounts of dedicated or shared graphics memory,
may be unable to deliver all of the Vista features. The first feature to go may
be the advanced Desktop Experience Microsoft calls Aero.

Verifying your machine’s capabilities

Microsoft, which is, after all, in the business of selling you its operating
system, offers several tools that can help you determine if an existing
machine’s hardware is compatible with Windows Vista. To run an automated
scan of your laptop, go to the Windows Vista Upgrade Advisor on the
Microsoft web site. See Figure 1-5.

The direct route to that Web page is www.microsoft.com/windows/
products/windowsvista/buyorupgrade/upgradeadvisor.mspx.Or you can go
to www.microsoft.com and search for Upgrade Advisor.

Book

Chapter 1

wajsig Hunesadg

ue buipesfdn
10 Buijeisuj



86

Figure 1-5:
The good
news in
Microsoft's
report is
that my
computer
canrun
Windows
Vistaif |
upgrade.
The bad
news
comes in
Devices and
Programs,
where the
utility tells
me of some
incompati-
bilities.
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Upgrade Advisor

By J Your computer can run Windows Vista

‘J Based on our scan of your system, Windows Vista Home Basic appears (o be the
= 1 best editicn for you. For infermation about cther editions, click the edition names

Vo Basic in the left pane.

Ultimate

Windows Vista Home Basic, a good fit for your PC, is for basic home computing
needs from writing e-mail ta brawsing the Internet. You can upgrade from
your current version of Windows and keep your files, settings and programs.

Home Premium

Consider Windows Vista Home Premium for terrific entertainment experiences
or Windows Vista Ultimate for the most complete edition of wWindows.
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Home Basic
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Gallery
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Instant Search

Read below for important installation and system upgrade information:

System Requirements B

v

There are no known system issues preventing you from upgrading
to Windows Vista.

| See petails |
Devices

A

We recommend you review your device issues (1).

To read about the system requirements for Windows Vista, go to the System
Requirements page on the Microsoft web site. To head there directly, enter
the following into your Internet browser: www.microsoft.com/windows/
products/windowsvista/editions/systemrequirements.mspx. Or you can go
to www.microsoft.com and search for Windows Vista system requirements.

Once you’ve run the report, study its results carefully. The Microsoft utility
that examined my laptop found a problem with a nifty little piece of hardware
I plug into a USB port, which lets me work with an antique special-purpose
printer that insists on an old-fashioned serial port. It also reported several
utilities that needed to be replaced or updated if I chose to update to Vista.
See Figure 1-6.

You can fix some incompatibilities by obtaining updated device drivers;
others may require buying new software or hardware. If so, you need to
decide if upgrading is worth the cost in time, effort, and expenditure.



Figure 1-6:
The detailed
report of
Windows
Vista
Upgrade
Advisor
shows that
the
operating
system is
incompatibl
e witha
particular
piece of
hardware.
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& Windows Vista™ Upgrade Advisor 1.0
—— —

" Windows Vista Upgrade Advisor

| —_——

€ - 1=1 Print task list ™ Save report

Report Details: Windows Vista Home Basic L

System Devices Programs Task List

Device details:

») Review these device issues for Windows Vista
Check the following table for device issues you should address to ensure they will work properly
with Windows Vista.

Issue Type Categary Madel Manufacturer Action Required
ﬁ Keyspan MPR Keyspan This device will not worlc in
4" Serial (MPRQI) Windovs Vista. For more

information, please go to the
device manufacturer's vabsite,
Windove Markstplace, or

contact your retailer.

@) ? Cannot find information on these devices
- ®  The following table contains devices for which we have no information.

Installing Windows Vista

A classic cartoon is regularly used in business, design, and other training
classes. (I know, because I use it all the time when I consult.) You don’t even
need to see the pictures; the words alone tell the story.

Ready?
Fire!
Aim.

Yup, the point is that people who plunge into a project without preparation —
and that includes installing or upgrading an operating system — are just
asking for a headache that can range in intensity from mild annoyance to a
complete failure of all personal and business systems. Stop, look, listen, and
think before you act, and you save yourself a lot of time and effort.
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Doing first things first

In the spirit of aiming before you fire, take these logical steps:

1.

Plug your laptop into an AC outlet.

You're going to use a lot of power over a period that could extend to
several hours, and you don’t want your battery to run out of juice in the
middle of an installation — that could be disastrous to the process.

Even better, allow your laptop’s battery to receive a full charge overnight
before attempting an installation. If you do that, you should have a few
hours of battery time to complete the installation or interrupt it at a proper
moment in case the AC power fails.

. Update your antivirus program.

Make sure you have the latest version of your antivirus utility — and
that the utility is compatible with Windows Vista. If your protective soft-
ware isn’t intended to work with Vista, uninstall it.

. Connect to the Internet.

Make sure your system is properly configured and able to get online. If
you can do this using the original operating system, Windows Vista can
pick up the information it needs to access the Internet without your
help. And as installation begins, Windows Vista can automatically go
online and download drivers, updates to the operating system, and
other elements it may need.

. Scan your system.

Conduct a full system scan for viruses, spyware, and other nasties. You
don’t want to install a new operating system on top of old problems.

. Update your system BIOS.

If your machine was built before the release of Windows Vista, it may require
a BIOS update to work with the latest operating system. See “Updating your
laptop’s BIOS,” earlier in this chapter, for advice. And be careful.

. Back up your data files.

Make copies of any word processing, spreadsheets, databases, music,
photos, videos, settings, and any other data you don’t want to lose. (You
should be doing this on a regular basis anyway, just in case your hard
disk drive were to fail. But before you install a new operating system,
prepare for the possibility that data may be accidentally lost.)

. Disable your antivirus program.

This allows the operating system to install and configure itself without
tripping on elements of the antivirus program intended to prevent
changes to Windows. (Do, though, remember to re-enable the antivirus
program once Windows is up and running again.)
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Gathering the essentials

Let me go over the ingredients necessary for this Windows Vista pie:

4+ A Vista-compatible laptop computer. That means it meets all the require-
ments for processor speed, amount of memory, hard disk storage space,
and a DVD drive to hold the installation disc.

4+ The Windows installation DVD. With Windows Vista, Microsoft began
shipping its operating systems on DVD media. This allows the entire
system to fit on one disc; in fact, Microsoft includes all four of the most
common versions of the OS on the disc. The box you buy includes a key
number that unlocks whichever version you purchased.

\P
) If your laptop has a CD drive but not a DVD drive, you can contact

Microsoft and order (for an additional fee) a replacement set of discs in
CD format.

4+ Your product key. You'll find this code number on the disc holder inside
the box you purchase. On a laptop that comes delivered with Windows
Vista installed, the product key should be found on a label attached to
the bottom of the machine.

4+ Your computer name if it is connected to a wired or wireless network in
your home or office. You'll need to instruct Windows on how to find and
work with your machine as part of the installation.
\\J
If you don’t know your computer name, here’s how to find it on an existing
network:

1. Start your laptop.

2. Click Start.

3. Right-click My Computer.
4. Click Properties.

You find the computer name displayed on the most logically labeled
Computer Name tab.

Oops, 1 Did It Again: Vista Installation Problems

Installing Windows Vista on a properly functioning laptop is pretty much of
an automatic process. Follow the instructions on the package or on the DVD
itself; on many machines you need to reboot the computer with the DVD in
the drawer.

If you're attempting a full recovery of an existing installation (resetting the
machine to the condition it was in when you received it from the manufac-
turer), you may be asked to power up the computer while holding down the
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Oops, 1 Did It Again: Vista Installation Problems

C key, releasing it when the name of the laptop manufacturer appears on the
screen. Several hardware makers configure their restoration discs this way;
you may find slightly different instructions with your machine.

You may encounter some other problems.

Missing product key

If you obtain a copy of Windows Vista as a demo from Microsoft or a retail
store ... or borrow someone else’s copy . .. you can probably install it on a
Vista-capable laptop. However, you must purchase a new product key and
activate the OS within 30 days. If you don’t, the machine won’t explode. . .
but the operating system will stop working.

Problem copying files

If the installation process starts but doesn’t finish properly, several possible
reasons exist, including

4+ The Windows installation disc is scratched, dirty, or otherwise defective.
You can try cleaning the disc with a slightly wet, soft cloth. (Use only
water.) Gently clean the disc by rotating the cloth around the platter as if
you were moving around a clock face; don’t move in from the outer edge
or out from the center hole. Allow the disc to dry completely before
attempting to use it. If the problem continues, you can get a replacement
from Microsoft. Go to www.microsoft.com and search for Replace Lost,
Broken, or Missing Software.

4+ Your CD or DVD drive isn’t working properly. Try playing an audio music
CD or using another disc you know to be in good shape. If they won’t
load properly, the drive hardware is malfunctioning.

4+ You're using the wrong drive. If your laptop has more than one CD or
DVD drive, make sure you're using the proper one. Try installing the
Windows disc in the other drive. You might try disabling one of the
drives from within Windows so that the system only thinks there is one
in the machine.

4+ You have a virus in your computer. You should have dealt with this prob-
lem by running an antivirus scan before you attempted the installation;
if you didn’t, do it now.

Blue (or black) screen of death

If installation comes to a stop and your laptop screen sits there with an
exceedingly dull and uninformative blue or black screen, the first thing you
should do is . . . wait. A lot of work may be going on behind the scenes.
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Take the dog for a walk. Watch a few innings of a Red Sox game. Talk to your
significant other about the depth of your feelings. Or just sit and wait for
about ten minutes. Keep an eye on the hard disk drive activity light found on
most laptops. If you see it flicker from time to time, the process is probably
still going on even though the screen is still blank.

If you’'ve waited ten minutes and nothing at all seems to be happening, you
may have a failed installation. Shut down the laptop and remove the
Windows installation disc. Try to bring it back to life. If you can’t get to the
previous version of Windows, follow these steps:

1. Uninstall any antivirus program.
Book II

2. Restart the computer. Chapter 1
3. Try installing the new operating system.

If you successfully install the new operating system, or if you go back to the
previous version, don’t forget to reinstall the antivirus program.

If you still can’t install the new operating system, you may have incompati-
ble hardware in your laptop. Check again at the Microsoft web site to con-
firm your machine and all its parts are compatible.

wajsig Hunesadg
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If your computer is supposed to be compatible and you've tried the preceding
steps, contact your computer manufacturer or retailer for assistance.

Error message mid-installation

Okay, this one should be pretty obvious: If you receive an error message,
read it carefully. If you're lucky (not always the case, alas) it just might tell
you what you need to do to fix the problem.

Otherwise, take these steps:

1. Make complete notes on the error message.

2. If you can get online, go to www.microsoft.com and search for
information about the error.

3. Make a call depending on your installation type:
e If you're installing new, call Microsoft.

¢ [f you're restoring, call your laptop manufacturer.

weeg  Losing power mid-installation

SO Always perform an installation with your laptop plugged into an AC outlet
and with a fully charged battery in place. This belt-and-suspenders approach
should protect you in case the power goes out.

10 Buijeisuj
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Uninstalling Windows Vista

If your machine does shut down in the middle of installation, Windows
attempts to go to the previous operating system the next time you try to start
it up (although some features may not work or may not offer full function).

If you have to start over, your best bet is to perform a clean installation.
Start over from the beginning and reformat your drive and install Windows
again. (You do have your data files backed up and your software programs
available for reinstallation, right? Good for you.)

Failed program or piece of hardware

You absolutely, positively checked your hardware and software for compati-
bility before attempting installation of a new operating system. Sometimes
even those who follow all the rules run into problems.

1. Reinstall the program or device.

Windows Vista may recognize it’s missing the latest hardware or software
driver and go online to find it. If not, proceed to Step 2.

2. If you can, visit the hardware or software’s manufacturer web site and
look for a solution posted there.

3. Call the program or device’s manufacturer.

Uninstalling Windows Uista

What do you do if you go through the entire process of installing Windows
Vista and you find that

Your machine can’t handle the pressure?
or

Your software or peripheral hardware won’t work properly with it and can’t
be updated?

or
You just plain don’t like what you see in Vista?

First you scream, then you read the next sentence of this book: You can’t
uninstall Windows Vista.

Wait! Don’t panic.
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You can reformat the hard disk, erasing Windows Vista in the process, and then
reinstall the previous operating system. You do have the original installation
disc or discs from the earlier OS, right? If you don’t, now is the time to panic.

Reformatting the hard disk also takes away all your software applications, as
well as any data stored on the drive. That’s why you made backups of all your
data and gathered all your software installation discs in the first place. Right?

Activating and Registrating

A\

All sorts of people have all sorts of beefs with Microsoft about one thing or
another and [ sometimes agree with them some of the time. But here’s where
[ differ: I firmly believe that users should pay for the right to use someone
else’s intellectual property.

As much as [ would love to dispense my pearls of wisdom and offer solutions
drawn from my decades of experience as a computer writer, editor, and con-
sultant for free, I can’t do that. This book is my work product, and it is
offered for sale and its success feeds the mouths of my family, the staff of the
publisher, and your friendly neighborhood bookstore. The same goes for
software, in my opinion. We all need to pay our share, or else the market will
offer no innovation.

Enough preaching to the grumbling choir. Here’s the news: Microsoft now
requires all users to activate their software. It’s intended to keep users from
installing and using software for which they don’t possess a proper license
or attempting to use illegally copied software.

That license may come when you purchase software or an operating system
through a retail store or web site. Or the license may come along with the
laptop as part of the package supplied by the manufacturer.

Beginning with Windows Vista (and other current application software such as
Office 2007) you're required to activate your product within 30 days of installa-
tion; if you don’t accomplish activation, the operating system or software is
partially or fully disabled.

If your laptop can get online, you get activate your Windows Vista software
that way as part of the installation. An alternate way to activate Microsoft
software is to do so by telephone. Consult the instructions that come with
the product.

Microsoft promises that the information collected as part of the activation
process is used only for the stated purpose — to validate the software —
and not to contact you or sell your name to advertisers.

Book I
Chapter 1
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Figure 1-7:
Reinstalling
Windows
froma
recovery
disc
restores
your
machine to
the way it
came from
the factory;
that means
all added
programs,
utilities, and
files are
wiped out.
You've been
warned!

Reinstalling Windows on the same computer

You can reinstall Windows on the same computer as many times as neces-
sary. The activation process pairs the Windows product key with informa-
tion Microsoft gathers about your laptop’s hardware; if you significantly
change the system’s hardware (such as adding a new hard drive or more
memory), you may be asked to activate Windows again.

Reformatting a hard disk drive erases your activation status. But, of course,
you would have to reinstall Windows anyway.

When all else fails — which could mean your operating system is hopelessly
corrupted or you've installed a new internal hard disk drive — you may have
to recover the original Windows installation. Nearly all laptop manufacturers
supply a disc with all that you need, along with in-your-face warnings about
the fact that all data files and settings on your drive are about to go to bit
heaven. Stop, read, and think before pressing Yes or OK or What the Heck.

In Figure 1-7 you can see an example of a not-subtle warning that Toshiba

includes in its reinstallation process; if you miss this little detail, you're
moving way too fast for this life.

TOSHIBA Recovery Wizard

Warning!

When the re Y IS cuted, all data will be deleted and rewntten

If you are ok etob ) portant
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“&N\BER Be sure to follow all instructions displayed on the recovery disc. Reinstalling
& Windows from a recovery disc can take an hour or more, depending on your
machine’s complexity and component speed. Don’t interrupt the process; doing
so may cause file corruption. Always power the laptop from an AC adapter so
you avoid running out of battery power mid-recovery. See Figure 1-8. Another
possible cause of the need for reactivation: a virus that corrupts your hard
disk drive.

Checking your Windows activation status

You know your copy of Windows has been properly activated if it keeps
working 31 days after you installed it. But if you want to assure yourself that
you and your machine are in good standing with Microsoft, check your
status this way:

1. Click the Start button, then click Control Panel > System and
Maintenance > System.
2. View your activation status under Windows Activation.

You can also change your product key by clicking Change Product Key.

Obtaining a new product key

If you lose the product key number that came with your copy of Windows, or
if you try to activate Windows with an invalid key, you have to purchase a
new code from Microsoft. You find information about how to do this on the
Microsoft web site.

TOSHIBA

Figure 1-8:
Are you Applying Final Configuration®
paying
attention?
Never

Please wait...
This may take several minutes:
interrupt the S}{.qtem will reboot upon completion.

process of
recovering
an operating
system or
installing a
new one.
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Registering your software

Activation is required because it benefits Microsoft. Registration, which is
mostly to the benefit of you the user, isn’t required . . . but you really should
register. When you register your software and provide information such as
your street or e-mail address, you are eligible for certain levels of product
support, tools and tips, and updates.

Updating Windows Over Time

\NG/
V?‘“

It’s always in your best interests to keep your Windows operating system
completely up to date. Like it or not, you need to obtain and install the latest
patches for newly discovered flaws or security vulnerabilities. This is espe-
cially important if you use your machine in regular or permanent connection
to the Internet. That group now includes most users, and is an example of
the two-edged sword that is the World Wide Web: Evildoers are constantly
dispatching viruses, malware, and other electronic nuisances.

Think of viruses and malware as burglars sneaking up your street at all times
of day and night looking for unlocked doors. Microsoft and other companies
are constantly looking for ways to bar the doors, and miscreants are staying
up late trying to pick the locks. It’s like an unfunny version of the carnival
game Whac-a-Mole, but it’s a game we must all master. I discuss antivirus
and other security software in Book IX.

You have two ways to keep your Microsoft Windows installation updated,
and they’re interlinked. It all begins with turning on Automatic Updating.

Automatic updating

If you want to be assured of having your machine kept up-to-date any time
it’s connected to the Internet, instruct Windows to look for and install new
updates automatically. The settings for this free Windows feature are here:

1. Click the Start button and click Control Panel.

2. Click Windows Update; then choose Change Settings.

3. Choose among the options given.

Under Windows Vista, you have two main choices, helpfully labeled with
a green check mark in a shield or a menacing red X. See Figure 1-9.

¢ Do you want the system to automatically check for, download, and
install updates on a schedule you set?

¢ Do you want updates downloaded but not installed until you approve?



Figure 1-9:
In the
Change
Settings
menu, you
can instruct
Windows on
how you
want to
handle
updates as
they're
available.
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e Would you like a list of available updates?

The options are discussed further in the following sections.

Install updates automatically (recommended)

If you select this option, your machine seeks out and finds critical updates,
downloads them to your machine, and installs them. You can pick a particu-
lar time every day for this to happen, or limit the process to a specific day of
the week.

For most users, handing this task to Microsoft and crossing it off your list of
things to worry about is best; you might want to select a time of day least
likely to interrupt your work — early in the day, late in the day, or during
lunch hour, for example. | usually break for a midday precisely at noon (I
start earlier than most people) and so I use that time setting for my machine.
Certain types of updates require your computer to reboot, and I'm perfectly
happy to have all of the toing-and-froing go on while I'm chowing down on a
turkey bacon, lettuce, and tomato sandwich on sourdough bread.

e B e |

v | % || Search L

Choose how Windows can install updates

When your computer is onfine, Wind can aut; ally check for imp updates and install them
using these settings. When new updates are available, you can also install them befere shutting down the
computer.
Understanding Windows automatic updating

a| @ Install updates icall d)

Install new updates:

(Everyany. 7 o (120000
Deownload updates but let me choose whether to install them
Check for updates but let me choose whether to download and install them
QI MNever check for updates (not recommended)
4 Your computer will be more vulnerable to security threats and performance problems without the

latest updates.

Recommended updates
[¥]Include recommended updates when dewnloading, installing, or netifying me about updates

Mote: Windows Update might require an update before you can install updates for Windows or your
programs. For more information, see our privacy statement onling,

[[®oxk || cancel |
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About once or twice in each operating system’s life cycle, Microsoft usually

\3

) offers a major package of updates and revisions called a Service Pack (SP).
An SP can be about as close to a completely new version of Windows as you
can get. Most cautious users — and that includes me — usually put off
installing a Service Pack for a few weeks after its release to the public. Call
me crazy or call me very cautious, but I prefer to allow other people to try it
out and look for any major incompatibilities.
Download updates but let me choose whether to install them
Your system will communicate with the mothership at Microsoft, and suggested
downloads are sent to your machine. But you are asked whether you really,
really want to have any or all of them installed on your machine. See Figure 1-10.
The latest important Windows updates (plus a few optional ones) are auto-
matically applied during the middle of the night (or the next time you turn
on the machine after choosing this setting). You also have the option to
install updates immediately.

. (=] & )
rf'sylg:eh;:g: @Qvl'&" + Control Panel » Security » Windows Update ~ 42| search £ :
updates for P Windows Update ¢
Windows Change settings .

Vista View update history @Y Download and install updates for your computer
downloaded Sestors Nedenpaae Totak: 28 important updates, 13.6 MB Cinsaispaute: ]
to your i :::!‘::';::requentl;- e Aleopialablie 3 optional uptates View available updates
machlne but i’r‘m‘:f:;:‘:o::‘z‘.::dﬂﬁ to enhance your computer’s
not
immediately Most recent check for updates:  Yesterday at 8:20 PM
installed, Updates were installed: Today 3t 10:54 AM. View update histary
You have Wind, setto: A ally install new updates every day at 3:00 AM
you can (recommended)
reVieW You receive updates: For Windows only.
proposed Y/ Get updates for more products
changes
before
they're
applied at
the
specified
time.
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Why might you choose this option?

4+ Because you are very, very cautious about accepting Microsoft’s opinion
on what to install in your machine. Every once in a while, a Microsoft
update introduces problems to a group of computers that might have a
particularly unusual combination of hardware and software. Some users
prefer to wait a day or so after Microsoft’s delivery of an update before
actually installing it; in the meantime they can watch the Internet chat
pages and computer sites for reports of problems. Or,

4+ Because you may want total control over the timing of any patch instal-
lations. You can choose the moment that’s best for you: when no critical
operations are occurring, when nothing is downloading, or when an
automatic or manual reboot (if one is required) won’t cause disruption.

Check for updates but let me choose whether

to download and install them.

This approach is the most conservative. Your machine communicates with
Microsoft, but all you receive is a list of recommended updates. If you choose
to download and install any or all, you can instruct the system to do so.

If you choose the option shown in Figure 1-11, you can examine proposed
changes to your system one by one and check off those you want installed.
Click any suggested update to learn more about its details, including whether
it’s an optional update or a critical one, and whether it’s intended to fix a
problem with hardware or software that you don’t have, need, or want.

Never check for updates (not recommended)

This option is pretty extreme; until you re-enable the update feature, your
machine’s vulnerable to any new threats or newly discovered problems with
Windows.

The only good reason to turn off the check for updates is if you're in the
middle of trying to repair a problem with Windows or with an application
that causes OS difficulties. It is generally the best practice to isolate your
system from any changes while you're trying to make repairs; you can either
turn off the update option or disconnect your machine from the Internet if
access isn’t required while you’re making repairs.

Many third-party programs and utilities offer regular updates to their prod-
ucts. These updates may last for the product’s life (generally until a new ver-
sion is released) or a specific period of time; products like antivirus
programs typically come with a one-year subscription to updates. Make sure
you register your software properly and check regularly with its maker to
keep programs current.
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Figure 1-11:
Microsoft is
offering a
repair for a
relatively
obscure
problem:
search
errors for
users who
aren‘t using
the
Gregorian
calendar.

= B B
S T SO — " —
@-u-v = * Control Panel » Windows Update » View available updates w | 43 | | Search P
Choose the updates you want to install
Total available: 12 updates
MName Windows Update &

[ Windows Vista (3)
| Realtek - Netwaorking - Realtek §
Synaptics - Other Hardware - Sy Download size: 124 KB
Update for Windows Vista (KB33.| You may need to restart your computer for this update to take effect.

Update for Windows Vista (KB929733)

Office 2007 (9) Update type: Optional
¥ . Securily Updste for Microsoft G Install this update to resolve an issue that prevents Windows Search from retuming a complete set
#| Security Update for Office 2007 of results when a search is performed using the date option and a non-Gregorian calendar is in use.
¥]  Security Update for the 2007 Mi Move infarmmation:
V| Security Update for the 2007 Mi hitp://go.microsoft.com/fudink/ILinkdd=80403
4] Update for 2007 Microsoft Officd |  Help and Support:
J|  Update for Office 2007 (KB934 http://support.microsoft.com
4| Update for Office 2007 (KB934
¥ Update for Office 2007 (KB934
¥l Update for Word 2007 (KE9341

Total selected: 9 updates

| Install l. Cancel

Microsoft Update

The latest wrinkle in support is the Microsoft Update web site, which works
in conjunction with Automatic Update to keep not just Windows, but also
many other programs, current. It adds automated updates for most of the
components of Microsoft Office, Microsoft Exchange Server, and Microsoft
SQL Server.

If you turn on Automatic Updates, your computer maintains scheduled con-
tact with this page. If you want to go to Microsoft Update on your own, you
can zoom there in one of two ways:

4 Click the Windows button, then click All Programs => Windows Update.
or

4+ Open your Internet browser and go to www.update.microsoft.com.
As this book goes to press, the Microsoft Update site supports Windows XP
and Windows Vista, as well as current versions of Microsoft Office applica-
tions. If your machine is running relatively antiquated programs from

Microsoft, including Office 2000 and older software, visit the Office Update
web site at http://office.microsoft.com/en-us/downloads.
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If you go to the Microsoft Update page on your own (as opposed to
Automatic Update) you're offered two options:

4+ Express (recommended). The site looks for all high-priority updates for
the programs installed on your machine and presents you with a list.
You can click a single button to install all of them; some updates,
though, must be installed in a particular sequence and may require
rebooting between various items on your list.

4+ Custom. The site prepares a list of high-priority and optional updates.
Use the pointer to tick the check box for individual items (or the entire list)
and install them with one click; as with the Express option, you may have
to install certain priority updates individually with a reboot between items.

In the list of optional material, you can select Don’t Show Me This Update
Again. If you do, the list of options is reduced. If you want to restore a
“hidden update,” Microsoft has you recovered. On the web site, click Restore
Hidden Updates, and that’s exactly what it does.

If you hide a high-priority update, the system regularly reminds you that
your system is missing a critical update. And if you later accept an update
that requires a component you chose not to install, the web site brings the
earlier update back to the list.

Optional updates are, well, optional. They may address minor issues that
might not apply to your system or to the tasks you perform, or they may add
some functions to your computer that you may not need or want. Read the
optional updates’ descriptions and make your own decision whether to
bring them to your machine.

To read more about the nature of each update, click its name in the list. To
read about system requirements and support information, click the Details
link in the description.

Some updates, generally those that add new functions, may require you to
accept one of Microsoft’s highly entertaining and informative EULAs (pro-
nounced YOO-lah by those in the know). The End User License Agreement
protects Microsoft’s patents and rights; it’s a take-it-or-leave-it proposition
for you the end user.

And certain updates require you to shut down any running applications (be
sure to save any open data files first) and then reboot the system so Windows
loads with all changes applied. If you've given Windows permission to down-
load and install updates on its own, you may return from a trip to the refriger-
ator to find that your system has rebooted by itself. See Figure 1-12.

Book

Chapter 1

wajsig Hunesadg

ue buipesfdn
10 Buijeisuj



102 Losing Support

Figure 1-12:
Some
updates
require a
reboot. If
you
download
and
automatic-
ally install
updates,
your system
may have
shut down
and
restarted.
You did save
all your
work before
you left,
right?

Windows Update

o - . .
K‘j Restart your computer to finish installing
important updates
Windows can't update important files and services while the
system is using them. Make sure to save your files before
restarting.
Restarting in: 1 min, 24 sec
A —

Remind me in: [1!] minutes

7]

[ Restatnow | [ Postpone |

Opening the door to Update

If you're very strict about your computer’s security level, you may need to
manually unlock the door to let Microsoft Update keep your operating
system updated. To add this facility to your list of trusted web sites, open

Internet Explorer and do the following:

1. Click Tools = Internet Options.

2. Choose the Security tab, then click Trusted Sites = Sites.

3. Type www.update.microsoft.com/microsoftupdate in the space labeled

Add this Web Site to the Zone.
4. Click Add = OK.

Losing Support

Microsoft’s support for older versions of Windows only goes so far.
Eventually the engineers move on to newer challenges, and you're left to fly

through the air without a safety net.




Here’s the official word from Microsoft: When you buy a product, the company
promises to offer a minimum of five years of support for most operating systems

Losing Support

and office applications, and three years of support for products released in
annual versions (such as Microsoft Money, Streets & Trips, and the like).

Here’s what Microsoft means by support: During the “mainstream” support

period, the company maintains a team of engineers to patch any security
breaches and repair any newly discovered problems or incompatibilities.

The repairs are automatically delivered and installed on your machine if you

use Automatic Update, and are available for manual installation from the

4+ The support period begins with the product release. If you're the very
last person to buy an operating system that a newer edition has
replaced, the period of support is shortened. However, that five-year
period has also proven to be a rolling deadline; when the release of

Windows Vista was delayed, Microsoft extended its support for several

4 Once the active support period ends Microsoft maintains web sites with
previously released patches and updates, as well as its Knowledge Base

&,N\BER Microsoft web site if not.
&
Keep these points in mind:
of its older operating systems.
@QAL STy, of repairs for known problems.
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Today’s specials

As this book goes to press, Microsoft is only offer-
ing active support for three operating systems:

v Windows Vista: in all its various flavors.

+* Windows XP: in all editions, but only for
operating systems that have been updated
with Service Pack 2; if you haven't installed
SP2, that major update is available from
Microsoft.

v+ Windows Server 2003: for operating systems
updated with Service Pack 1.

v Windows 2000: for operating systems
updated to Service Pack 4.

That means users still getting useful work out
of laptops running Windows 98SE, Windows
Me, and earlier operating system can rummage
through Microsoft's online closet for old
patches and repair tips, but won't receive new
updates. And Windows 2000 is shuffling off
toward retirement.

Book I
Chapter 1

wajsig Hunesadg
ue buipesfdn
1o Buijjeisuj



10 4 Losing Support

\NG/
s

It isn’t a perfect system, but it works pretty well for most users. If you have a
machine and an operating system that work properly, and you don’t need
each and every new hardware and software advancement, you've no need to
change your operating system.

And, in fact, many users see no point in making a radical change like going
from Windows XP to Windows Vista; the newest operating system requires
hardware capabilities that weren’t offered when XP was introduced. And as
we have already explored, most laptops have only limited areas in which
their hardware can be upgraded.

More to the point: Although modern laptops are generally very well put
together, their useful life is probably somewhere in the range of three to six
years. Even if the hardware is in near-perfect shape after that period of time,
you'’re eventually going to grow weary of lugging around an obsolete model.
If you catch yourself casting envious glances at the machine in the aisle seat
of row 24, or across the coffee shop at the table with the Dulce de Leche
Latte, it’s only a matter of time.

Microsoft warns (and it may well be correct) that users who continue work-
ing with retired operating systems are at risk of security breaches. However,
it’s also true that the bad guys move on: If someone is going to sit down and
write a virus, he’s more likely to attack the latest operating system — not
one being used by fewer and fewer people every day.



Chapter 2: Painting Flames on the
Operating System: Customizing

In This Chapter

v+ Choosing the Windows that match your decorum
v Picking a peck of pretty pixels
v+ Pointing with pride

It’s called Microsoft Windows, but for most accomplished users the goal is
to make it your very own: My Windows, My Computer, My Colors, My
Fonts, and My Sounds.

Microsoft does a pretty good job of building a soft machine that you can cus-
tomize, adapt, rearrange, and decorate in nearly infinite versions. Just beneath
the surface of Windows XP and Windows Vista (as well as older versions of the
operating system) lies a full set of tools that give you the Power of Self-
Configuration.

For your own convenience, and just because you can: Go forth and cus-
tomize. [ show you how.

In this chapter and throughout this book I use Windows Vista as the sample
operating system; the basic concepts of customization are the same for all
Windows versions. Where needed, I point out Vista-only facilities.

Making New Screen Resolutions

Your laptop’s screen is a tabula rasa, which is a highfalutin way of saying it’s
a blank tablet. Within the laws of physics, you can draw shapes (including
letters and numbers) of any size.

It comes down to the screen resolution. Pardon me for a brief excursion into
the land of technicalities; in computer terms resolution is determined by how
many picture elements (or pixels or dots) your screen displays across its
width and down its length. The more dots it has, the finer the level of detail;
however, some of the details may be so small that they’re hard for you to see.

If you want to get real, think of resolution in terms of this page, the one in the
book in front of you. You can’t change the width and length of the piece of
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paper; the same is true of your laptop’s screen. However, the fine design team
who put this book together could have used very large letters to make it big
enough to read from across the room. The problem is, though, that only a few
words would fit on each line. Or they could have chosen to save a forest full of
trees by using eensy-teensy characters that allowed a few thousand words on
the page. The problem with that? You might not be able to read these pearls of
wisdom.

Getting back to computers, there’s one other issue involved: A high-resolution
display, one that uses millions of dots, requires a great deal more processing
power and a lot more memory. And laptops have one additional issue: LCD
screens are less flexible in their ability to work at various resolutions.

LCDs generally have one native resolution, and any other selection is created
through some fancy electronic footwork, which may or may not yield the
best possible picture.

The base resolution for what is now an old-fashioned cathode ray tube (CRT)
monitor on a desktop computer was 640 x 480 dots (a total of 307,200
pixels), although most users worked at higher resolutions, typically 1,024 x
768 (more than double the number of pixels, at 786,432). Today, most LCDs
start at 1,280 x 800, and many can go much higher. And LCDs are now offered
in widescreen versions that allow you more real estate to work with.

Our example of a current laptop, the Toshiba Satellite P205, has a native resolu-
tion of 1,440 x 900 (1,296,000 pixels). If you go to the Control Panel and select the
icon for this particular machine’s built-in graphics adapter (an Intel Graphics
Media Accelerator Driver for Mobile), you find that you can downgrade the
resolution to 1,280 x 800 or 1,024 x 768 (as well as several intermediary steps).
A multimedia or gaming superstar may offer a native resolution of 1,920 x 1,200
on a widescreen version that allows you more real estate.

Going away from a laptop’s native resolution usually results in a muddy and
unappealing image onscreen — very different from the crisp image you see
when you accept the default setting.

Picking a pretty palette

One setting you can change on your laptop LCD is the number of colors used
to construct images. The standard setting for most laptops is 32 bit, which
allows for use of colors from a palette of 16,777,216 hues and intensities; in
most systems, 32-bit color actually uses 24 bits to define the color and an
additional 8 bits of information for other arcane details like transparency
and texturing. You might pick up a few milliseconds of speed if you choose
to downshift the color setting to 16 bits. Me, I leave this setting the way it
came from the factory.



Figure 2-1:
The
standard set
of controls
offered by
Windows
allows you
to select
resolution
and high or
medium
levels of
colors, as
well as
other
settings.
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Displaying the graphics control screen

Most laptops have two (sometimes complementary, sometimes superfluous)
control panels to adjust screen resolution. Every version of Microsoft
Windows includes a Display Settings window as part of the Control Panel,
and this usually lets you change screen resolution and number of colors. An
Advanced Settings tab may open the door to more technical adjustments.

The second set of controls is provided by the manufacturer of the graphics
adapter or the chipset built into your laptop’s motherboard. You may find
that this window offers additional features; at the very least it’s customized
to the particular hardware in your machine.

To work with the generic graphics control window, click the Start button and
choose the Control Panel. For an example, see Figure 2-1.

If you're running Windows Vista, follow these steps:

1. Click Appearance and Personalization > Personalization => Display
Settings.

2. Under Resolution, click the slider and move it to a setting of your choice.

For an LCD screen, the default is usually the highest resolution.
If your machine is using Windows XP, follow these steps:

1. Go to the Control Panel.
2. Click Display Properties and choose the Settings tab.

& Display Settings (=X
Morstor

Drag the icons to match your moniters. Iddentify Monitors

1 2

1. Genenic PnP Mondtor on Mobdle Intei(R) 345GM Express Chipset Family =

Resclution: Colon:

Lew | High Haghest 32bit) =

1440 by 900 pinels

Advanced Settings...

O Coxel
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3. Adjust the Screen Resolution slider.

To work with the customized control panel provided by the graphics adapter
or chipset maker, look for an icon in the Control Panel that has the manufac-
turer’s name. It may be Intel or ATI for chipsets, or you may see the name of
a graphics card like Radeon or nVidia. Sometimes graphics adapters makers
place an icon in the taskbar’s notification area; clicking opens a utility that
allows you to adjust settings. See Figure 2-2.

Figure 2-2:
The LCD
Display
Settings

" intel®

Graphies Medi
pan9| l::.lu::u ovlu.u A Notebook Scheme Options

for meblle

offered by

Display Devices [[FuSsr ™ » | Rotation
many . ) = — ¥ Enable Rotation
gra ph ics Display Settings Screen Resolution .
adapter or Refresh Rate
Color Correction

ChIpSEt Display Expansion X

makers e c 1

offers
specific and @
more
detailed
choices
than the [ Information ] [ Video overlay ]
generic
controls that
ship with
Windows.

[ Laumnch Zoom lj 30 Settings l

[ oK H Cancel || Apply

Clarifying your view with ClearType

Microsoft offers a special technology that enhances the way text looks on an
LCD screen; this special form of magic essentially manages to make something
out of nothing. When you enable ClearType on an LCD screen, the system can

use the individual vertical color stripes that make up each pixel on the screen.

It all comes down to adding an almost-invisible extra bit of thickness or thinness
to letters onscreen, making use of fragments of pixels. ClearType almost always
improves the appearance of text, especially on fonts with serifs. Serifs are the
little lines like the shoulder pads on the letter T or the extra horizontal marks on
a'V; serif fonts also have varying thicknesses of certain parts of letters. The top
half circles of the letter C may be thinner than the main part of the letter. Serif
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Figure 2-3:
Enabling
ClearType
adds a small
but
noticeable
improvement
in the
quality of
characters
displayed on
an LCD.

Making New Screen Resolutions 10 9

fonts are vestiges of old type styles, and we continue to use them because
they’re usually easier to read than sans serifs (without serifs) typefaces, which
are considered more modern. In the book you'’re reading, the main text uses a
serif font while the captions are in sans serifs style.

Do you have any reason not to enable ClearType on your laptop? Not as far
as I'm concerned, although that’s just my opinion; turn it on and see if text
seems sharper and easier to read. If it looks worse to your eyes, turn it off.

ClearType is for use with flat-screen LCDs like that on your laptop. It gener-
ally doesn’t offer any noticeable improvement when used with a standard
CRT monitor, although you can experiment with it turned on. And it has
nothing to do with the appearance of type when you send a file to a printer.

To enable use of ClearType on your LCD, follow one of the following sets of
instructions based on your OS.

For Windows Vista systems:

1. Click the Start button.

2. Click Control Panel = Personalization = Click Window Color and
Appearance = Open Classic Appearance Properties.

3. Click the Effects tab.

4. Make sure this option ha a check mark: Use the Following Method to
Smooth Edges of Screen Fonts.

5. Choose ClearType.
See Figure 2-3.

B Appesrance Settings b4
Appearance
Jnactive Wind. e |

Active Window =R |

Window Tesd
Coke scheme: & Efects fie]
WidowsAeo A
\Windows Vista Basic 7| Use the following method to smooth edges of saeen fonts:
Windows Standard | [ || | oo = :
Windows Classic = - : ClearType =|
High Contrast White | Effects.. |
High Contrast Black - — 7| Show shadows under menus
igh Contragt £2 Advanced.isy 7] Show window contents whie dragging
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Book |
Chapter 2

Huiziwoysny :wajsig

funesadg ay) uo

sawe| bunuieyd



1 70 Themes Like New or Old Times

A\

For Windows XP systems:

1. Go to the Control Panel and then click the Display icon.
2. Choose the Appearance tab and then click the Effects button.

3. Look for the dialog that asks: Use the Following Method to Smooth
Edges of Screen Fonts.

4. Make sure the check mark alongside is enabled and then choose
ClearType.

Once you install ClearType on your machine, you may be able to kick it up a
notch by going to the Microsoft typography web site and following the
instructions for tuning the technology to match your particular combination
of graphics adapter and LCD.

Themes Like New or Old Times

Both Windows XP and Windows Vista presented significant changes — some
say improvements — over previous versions. Windows XP made a number of
major changes compared to Windows 98, while Windows Vista buffed and
polished Windows XP.

But what may seem new and refreshing to some users is unfamiliar and uncom-
fortable to another. And so Microsoft offers users the option to go back to the
past — at least in appearance — by selecting the Windows Classic theme, which
presents an updated but recognizable version of the Windows 98 Control Panel,
settings windows, and other features. You gain all the advantages of the improved
engine without having to deal with a new appearance.

For Windows Vista users to select a theme, follow these steps:

1. Click the Start button and click Control Panel => Appearance and
Personalization > Personalization => Theme.
2. Under Theme, select the design you want and then click OK.

Each person who has an account on the computer can choose his or her
own theme.

For Windows XP users to select a theme, follow these steps:

1. Go to the Control Panel.
2. Click Display and choose the Themes tab.

3. From the Theme drop-down menu, choose one of the available designs.
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Securing a Screen Saver 1117

Most laptop manufacturers offer their own themes, usually centered around
an obnoxious display of their company name or logo. You may also find
themes offered as freeware or for sale; never download or use software or
settings from a web site you don’t trust.

You can start with someone else’s theme and modify it to your preferences.
Or you can create your own theme, with its own desktop background, color
selection for windows, and assigned system sounds.

Make your changes by following these steps:

1. Go to the Control Panel.

2. Click Display and choose the Appearance tab.
3. Click the Advanced button and select options.
4. Return to the Themes tab.

5. Click Save As.

6. Enter a name for your custom theme.

7. Click Save.

Securing a Screen Saver

A\

Every screen deserves to be safe; it’s your responsibility as a laptop owner.
I'm not talking about protection from ridiculous Nigerian lottery scams that
come in by e-mail or the bizarre cow-tipping fetish web sites you visit when
no one is watching.

No, I mean your screen should be protected against the serious scourge of
burn-in. That’s what happens when a program displays the same icon or
image in the same place for a long time. The danger is that the display will
become permanently etched with that particular symbol.

You should note that burn-in is much more of a danger to what is now con-
sidered the old-fashioned CRT that desktop computers used. LCDs used on
laptops (and increasingly, with desktops) are more resistant to burn-in.
However, you can cause a problem to LCDs if you display an unchanging,
unmoving image for an extended period. I consider 24 to 48 hours or more to
be worthy of concern.

Many LCDs are self-repairing; if an image is burned in, try solving the problem
by turning off and rebooting. Sometimes it may require several on/off cycles
before the liquid crystals return to their original condition.
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How to protect against burn-in? The simplest solution is to enable a screen
saver that comes on after a preset period of time and replaces the unchang-
ing image with either a blank screen or moving image. Another advantage to
using a screen saver: It keeps others from seeing the data on your screen. ..
unless they lean in and press a character on the keyboard to clear the saver.
(Some screen savers can be set up to require a password before they go
away and the data returns.)

Many laptop owners enjoy setting up their machine to display unusual
images. For a while, flying toasters were all the rage. Today, many users
allow the laptop or OS maker to use the space for floating advertisements.

Now here’s the bad news: A screen saver uses power to generate and move
the image. It also requires power to illuminate the backlight, an essential ele-
ment of an LCD. If your laptop is plugged into an AC electrical source, that’s
not an issue (except for your electrical bill and your personal contribution to
global warming). However, if you're traveling, a full-color image of a waltzing
cow is going to shorten the time you can run your machine off the battery. It
might be a few minutes, but sometimes every minute counts.

On my laptops, I set up the screen saver to simply blank the screen to black,
which results in a small draw on battery power. I can tell that laptop is still
powered up by the little lighted battery icon on the front edge.

Never use a screen saver sent to you by someone you don’t know, or down-
load one from a source you cannot be certain is legitimate. A screen saver is
a piece of active code and could easily be designed to include a virus or
other malicious programming.

Changing your screen saver

To set or change a screen saver, perform one of the following sets of
instructions.

Follow these steps on a Windows Vista system:

1. Click the Start button.

2. Click Control Panel = Appearance and Personalization =
Personalization => Screen Saver.

See Figure 2-4.
On a Windows XP system, go to Control Panel => Display = Screen Saver tab.

Under either operating system, look through the available images (including
Blank) in the drop-down list and select one. You can see a preview of the
design, and select the period of time of inactivity before the screen saver takes
over the screen. Some of the screensavers also offer user-configurable settings.



Figure 2-4:
Windows
offers a
variety of
screen
savers, from
the demure
to the
flashy. You
can setthe
time period
before the
screen
saver
becomes
active and
make other
adjustments.
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Ribbons - Preview

Settings...

Wai: 40D

minutes [ On resume, display logen screen
Power management

Conserve energy of maximize pefarmance by adjusting display
brightness and other power settings.

Cancel

Creating your own screen saver

Notwithstanding my recommendation to use a blank screen when you’re run-
ning on batteries, you can create your own screen saver using pictures or
videos.

Follow these instructions if you're on a Windows Vista machine:

1. Click Control Panel.
2. Click the Personalization icon.
3. Click Screen Savers > Photos.

This creates a slideshow from all images in the Photos folder.
Follow these instructions if you're on Windows XP:

1. Click Control Panel.
2. Double-click Display.
3. Choose the Screen Saver tab.

The Screen saver drop-down menu appears.
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4. Choose My Pictures Slideshow.

This option automatically cycles through images it finds in the My Pictures
folder. (Make sure you're okay with displaying anything that’s there; if you
have a picture that is much too personal for this use — and you know what
I mean, right? — move it out of that folder to keep it off your screen.)

Deleting a screen saver

The basic screen savers provided by Microsoft as part of Windows are yours
to keep whether you like them or not; you can’t remove them. However, if
you’ve added a screen saver on your own and you want to be rid of it, that’s
easy to do.

Under Windows Vista, follow these instructions:

1. Click the Start button.

2. Click the Control Panel.

3. Choose Programs => Programs and Features.

4. Highlight the screen saver you want to remove.

5. Click Uninstall.
For Windows XP users, follow these instructions:

1. Go to the Control Panel.

2. Click Add or Remove Programs.

3. Highlight the screen saver you want to remove.
4. Click Uninstall.

Customizing the Tiny Picture on Your User Account

a\

Windows users can add the ultimate in personalization to the little picture
next to your user account (as well as on screens or menus that list your user
name, including the Welcome Screen and Start menu). You can choose any of
the generic images supplied with the operating system, or you can use a
photo or drawing of your own.

If you want to use your own art, save it to your machine as a GIF, JPG, or
BMP image format. The picture is going to be very small onscreen, so you
can save space by saving it at a small size — about 1 x 1 inch — and at a
screen resolution of 72 dpi.
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On a Windows Vista machine, follow these steps:

1. Click the Start button.

2. Click Control Panel > User Accounts (called User Accounts and Family
Safety in certain editions of the operating system).

A list of available user account changes appears.
3. Click Change Your Picture.
4. Perform one of these steps:
¢ Select the picture from the supplied images.

¢ (Click Browse for more pictures and locate the image you want to use.
On a machine using Windows XP, follow these steps:

1. Open the Control Panel and click User Accounts.
2. Choose an account to modify.
3. Click Change My Picture.
4. Perform one of these steps:
e Select the picture from the supplied images.

¢ Click Browse for more pictures and locate the image you want to use.

Hanging Wallpaper on the Desktop

Some people — starting with me — like a simple black background behind the
icons on the desktop. (I prefer simple elegance without distraction; whatever
the male equivalent of a little black dress with pearls is, that would be my
choice in fashion.) But then there are those who like plaid and madras and
spinning bowties with LEDs. | suspect these same people like to dress up their
desktop with pictures of their children or their pets or their significant others.

To meet this pressing need, Microsoft allows you to change the desktop
background. It’s actually called wallpaper, and you can choose one of the
backgrounds provided with Windows, use a digital photo of your own, or use
a solid background color.

To change the background, follow the set of instructions that match your OS.

On a Windows Vista machine:

1. Click the Start Button > Control Panel => Appearance and
Personalization ~>Personalization => Desktop Background.

Book I
Chapter 2

Huiziwosny :wajsig
funesadg ay) uo

sawe| bunuieyd



116 Seeking Sidebars, Gadgets, and Doodads

2. Choose the picture or color you want for wallpaper.
If you want to use an image of your own, use the Browse function to
locate the file on your computer. Double-click the image you want to use.

On a Windows XP system:

1. Go to the Control Panel and click the Display icon.
2. Select the Desktop tab and choose an image.

Otherwise, use the Browse function to locate the file on your computer.
Double-click the image you want to use.

3. Decide whether to

e Have the picture fit the entire screen (an option that may result in
distorting the picture)

e Center the image on the screen
\P
) Another way to make wallpaper out of any image stored on your computer,

or nearly any image you’re currently viewing, is to right-click the picture and
then click Set as Desktop Background.

Seeking Sidebars, Gadgets, and Doodads

Okay, there’s nothing officially called a doodad (or a geegaw or a thingam-
abob), but Windows Vista offers a growing variety of things called Sidebars
and Gadgets. What are they? Why, they’re high-tech doodads.

A Sidebar adds new levels of active miniprograms and utilities being con-
stantly updated from within your computer or from a source out there some-
where on the Internet. For an example, see Figure 2-5.

Your first assignment is to decide whether to use the Sidebar at all. Then
decide whether to display it, hide it, and keep it on top of other windows.
Finally, you can add or remove gadgets in the Sidebar; you can even detach
individual gadgets from the Sidebar and place them on the desktop as items
of their own.

Opening and closing a Sidebar
Follow these steps to open Windows Sidebar:

1. Click the Start button.

2. Click Programs > Accessories ©>Windows Sidebar.



Figure 2-5:
In my
Windows
Vista
Sidebar |
monitor the
weather in
three places
of interest to
me, watch
the
fluctuations
in the
exchange
rate for
Danish
krone, keep
tabs on the
stock
market, and
more.
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Or, you can follow these steps:

1. Click the Start button.
2. Enter sidebar in the Start Search window below All Programs.
3. Press Enter.

To close, right-click the Sidebar icon in the taskbar’s notification area
and then click Close Sidebar.

Exiting Sidebar closes the applications and gadgets and also removes the
Sidebar icon from the taskbar’s notification area. To get out, right-click
the Sidebar icon and click Exit.

Hiding and seeking with Sidebar

If the information the Sidebar shows is of paramount importance, you can
have Vista display it on top of other windows. If you make that choice, any
programs you open and maximize are automatically butted up against the
Sidebar on the left or right side of the screen but not displayed over the top.
(This works especially well on a widescreen laptop LCD; you can run your
word processor or Internet browser at nearly full size, and keep an eye on
sports scores, temperatures, exchange rates, or whatever gadgets you
installed in the Sidebar.)
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Figure 2-6:
Sidebar
properties in
Windows
Vista
include
placement
and gadget
display.

To make this setting:
1. Right-click the Sidebar or the Sidebar icon in the taskbar’s notification
area.
2. Select Windows Sidebar Properties

3. Click to add a check mark to Sidebar Is Always on Top of Other
Windows.

See Figure 2-6.
From the same properties screen you can instruct the system to always start

Sidebar when Vista is loaded. You can also choose whether Sidebar is dis-
played on the left or right side of the screen.

And if you have a second monitor attached to your laptop, you can instruct
the system whether to display Sidebar on one or the other display.

Start Sidebar when Windows starts

Arrangement
| Sidebar is always on top of other windows

Display Sidebar on this side of soreen:
@ Right
Left

Display Sidebar on monitor: |1 ™

Maintenance

View list of running gadgets

A\

Adding a gadget
You can add any installed gadget to your Sidebar. You can even add multiple
copies of the same gadget. (Why? Perhaps you need to be constantly up-to-the-
second on the time of day in Longyearbyen, Norway, as well as Papeete, Tahiti.)
1. To add an installed gadget, right-click Sidebar and click Add Gadgets.
You see a display of the Gadget Gallery. See Figure 2-7.
2. Double-click the doodad you want to use.

To download a new gadget to your machine, consult Microsoft’s official site
at http://gallery.live.com.
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Figure 2-7:
The Gadget
Gallery

shows '
gadgets that
come 1 P

standard accuwgmer.r_.J
with '
Windows
Vista, as
well as
those you've
added on
your own.

You may also find other gadgets offered for free or for sale at other web sites.
Be very cautious about accepting one of these bits of active code from any sup-
plier you don’t know and trust; an evildoer could easily embed a virus in one.

WING/
&

Detaching a gadget
You can fiddle with gadgets quite a bit. To release a gadget from the Sidebar
and place it somewhere else on your desktop, follow along:

1. Right-click the gadget and choose Detach from Sidebar.
2. Click and drag the gadget to the location you prefer.
To reattach the gadget, right-click it and then choose Attach to Sidebar.

To search for gadgets installed on your computer, locate the plus sign (+) at
the top of the Sidebar and click it to open the Gadget Gallery. If you've installed
just a few dozen or so, you see all their icons displayed; if you have more
than can be shown at once, you can move from page to page by clicking the
arrows at the upper-left corner of the Gallery. You can jump directly to a gadget
if you know some or all of its name; enter it in the Search All Gadgets box.

Mousing Around

At the heart of the concept of a GUI is the ability to reach in and move things
around on the screen. Now, I'm assuming you realize that the “things” you're
moving around aren’t real — they’re just two-dimensional pictures constructed
out of illuminated dots. And you're not “reaching in” and touching anything;
instead, you're using the computer’s power and the operating system’s
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intelligence to identify and act upon these virtual objects as if they were
three dimensional.

All this is related to the creation of a bitmap, something like a gigantic
checkerboard that allows the system to give an address to every part of the
screen. The address is constructed from the intersection of numbered verti-
cal columns and horizontal rows.

A computer bitmap is essentially an electronic version of Cartesian coordi-
nates. Allow me to save you a trip back to your dusty old high school geome-
try textbooks. French mathematician René Descartes conceived of a system
that allowed the determination of any point on a plane based on X (the hori-
zontal axis) and Y (vertical axis) coordinates. In eighth grade, when you
drew a chart of average temperatures across a week or month, you were
using a form of Cartesian coordinates.

As you move your mouse, pointing stick, or any other similar device from
location to location, the operating system maps its location by its column
and row coordinates and makes note of what lies beneath — a button you
can push, a check box that you can check, or part of an alphanumeric char-
acter or a picture.

Enough technobabble. The great thing about modern laptops is that you don’t
have to know about things like bitmaps, virtual objects, hot spots on the screen,
or even how a touchpad or mouse works. (You don’t need to know how an
engine works in order to drive a car, but you do need to master the controls:
the gas pedal, the steering wheel, and the brakes being most important.)

Configuring your pointer

Mouse Properties sounds like a real estate directory for rodents. It’s not, of
course: It’s the screen (or set of screens and advanced settings) that allows
you to customize the way your laptop’s pointing device responds to your
touch and implements your commands.

Because laptops are essentially an all-in-one-box solution, nearly all models
come with their pointing device installed. You may have a touchpad, a point-
ing stick, or some other variant.

New systems, delivered with Windows preinstalled, have the proper device
driver in place. If you update your version of Windows (from Windows XP to
Windows Vista, for example), the operating system automatically detects the
installed device and locates a device driver for it (or asks you to provide it
from a resource disc or from the Internet).

An example of a Mouse Properties screen for a built-in touchpad can be seen
in Figure 2-8. The Synaptics Touchpad is used in laptops from many major
makers including Toshiba, as well as Acer, Dell, Gateway, HP, and Lenovo. Most
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control panels let you choose the button actions (favoring lefties or righties,
for example) and adjust how fast your double-clicking finger needs to be.

Many control panels for pointing devices let you customize the pointer itself.
You can adjust the acceleration — how quickly the pointer travels in relation
to your movement on the touchpad. One nice feature that works well with

most applications and many web sites is a Snap To function, which automati-

cally moves the pointer to whatever onscreen button is marked as default or
most important in a dialog box. (This is often the OK or Next button, but in
some instances programmers try to prevent accidents by setting the Cancel

\3
button as default.) See Figure 2-9.
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Figure 2-10:
Advanced
pointing
device
controls
include
adjustments
to sensitivity
of the
touchpad
and the use
of “tap
zones” to
issue
commands.

Advanced mousing

Some manufacturers allow even greater customization of your mousing expe-
rience. Look for an Advanced button on one of the settings dialog boxes. For
example, in Figure 2-10 you can see the highly customizable features of the
Synaptics Touchpad installed in the Toshiba Satellite P205 laptop.

Another situation where you may find highly specialized controls is on a
laptop where you choose to add an external pointing device such as a clip-
on mini-mouse, an external full-size mouse, or a drawing tablet. These
devices come with their own device drivers and install their own set of utili-
ties in the Windows Control Panel, the Windows taskbar, or both.
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Chapter 3: Transferring Settings,
E-mail, and Documents

In This Chapter

»* Making your new machine act like your old one
v Transferring files and settings with the Windows Vista wizard
+ Going back from the future with Windows XP

Inertia is a powerful thing. 'm not just talking about how nice it is to just sit
there in your chair and not have to stand up until lunch. I'm also talking
about how wonderful it is to have your laptop finally set up exactly the way
you want it, with Internet and e-mail working properly, and all your preferences
in place; when someone offers you a brand-spanking-new high-resolution
widescreen multicore machine, the thought of having to redo all of those set-
tings is almost enough to make you say, “No, thank you.”

Almost enough.

Instead, know how to use the Windows Vista advanced features (and the
almost-as-advanced similar facilities of Windows XP) to automatically trans-
fer much of the personality of one machine to another.

Giving Your Laptop a Personality Transplant

Microsoft has made it pretty easy to bring the look and feel and technical set-
tings of one machine to another. If you’re moving information from a laptop
running Windows Vista to another machine running Windows Vista, you can
make a near-identical clone. If you're changing from Windows XP (or an ear-
lier, less-capable operating system) to Windows Vista, you get as much as the
older OS can offer, but you have to configure the newer O/S on your own.

You can copy these items:

4+ User accounts
4+ Folders and files (including music, pictures, and video)
4 Program settings

4+ Internet settings
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4 Internet favorites
4 E-mail settings
4 E-mail contacts and address books

4+ E-mail messages

What can’t you transfer? In a word, software. Okay, a few more words: And
the operating system.

Software and the operating system can’t be automatically transferred by
Windows for two pretty good reasons:

4+ It’s dangerous. You could end up moving a corrupted or outdated ver-
sion of programming to an otherwise unsullied machine. And your new
machine may be organized differently than the old machine (different
labels for hard disk drives, different folder names, a different file attrib-
ute system).

Some third-party software programs (not from Microsoft) promise to move
software from one machine to another. I've even seen them work. But I can’t
guarantee 100 percent success with them, especially as software makers
move to sophisticated validation schemes for their offerings.

4+ It’s unseemly. The license for your software or operating system may not
allow transfer to a different machine without the manufacturer’s permis-
sion. Like it or not, software makers are becoming more insistent on
treating their work as if it were a physical object; you can move it from
one place to another (with permission) but you can’t clone it so it exists
in two places at the same time.

Some software makers offer multiple-machine licenses that permit installa-
tion of their products on two or more machines. That’s a pretty good deal
for a laptop if you want to have the same program on your laptop as you
have on your desk.

Using Windows Easy Transfer

Microsoft lays it on the line with the name of their utility in Windows Vista.
Easy Transfer is supposed to be an automated tool that does all the heavy
lifting of bits and bytes and transfers them to a new machine. And to a great
degree, what they say is what you get.

Access to the transfer program is one of the choices on the Welcome Center
screen that insists on popping up every time you start Windows Vista . . . until
you uncheck the little box at the bottom of the screen to tell it not to do it again.

The other way to find the transfer utility is this:
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Figure 3-1:
The process
for using
Windows
Easy
Transfer is
spelled out
step-by-step
on
successive
screens.
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1. Choose Start => Control Panel.
2. Open the System and Maintenance folder.

Choose the System folder if you're using Classics Menu.
3. Choose Getting Started with Windows.

The Windows Welcome Center is resurrected.

Revving up your transfer

Before you can proceed with a transfer, you must shut down all running pro-
grams (except for Windows and — in most cases — your antivirus program).
If you forget to do this, the program reminds you in midstream and waits for
you to clear the decks.

You should always run an up-to-date antivirus program on all of your
machines. | recommend conducting a full system scan of your old machine
before you begin transferring files and settings to a new one; otherwise,
viruses and spyware will happily hitch a ride over to your new machine.

Windows Easy Transfer works if you're seeking to move files and settings
from a computer running Windows XP or Windows Vista to another machine
running Windows Vista. If your old computer is running Windows 2000, you
can transfer files but not settings. See Figure 3-1.

& Windows Easy Transfer

Welcome to Windows Easy Transfer

Windows Easy Transfer enables you to transfer files and settings from one computer to ancther. No infarmation is
deleted from your old computer.

During this process, you will not be able to use either computer. To ensure that program settings transfer from
your old computer, make sure the programs are installed on the new computer before you start.

Which versions of Windo

Ge onlineg to learn how to Experience

W A

Old computer You can transfer: New computer

B2, User accounts
Felders and files (including music, pictures, and video)

m
(1 Program settings
5]

Internet settings and favorites

E-mail settings, contacts, and messages
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One exception: Windows XP Starter, a version of that operating system intended
for use in third-world nations and certain other developing markets, doesn’t
work with Windows Easy Transfer. If you somehow have a copy of that limited
operating system, you have to manually copy files you want to transfer and
move them using a CD, DVD, flash disk drive, or other media.

If your source machine is running a version of Windows older than Windows
2000 (including Windows Me, Windows 98, or Windows 95), you should be
able to purchase a third-party transfer program at a computer retailer.

Your first choice when using Windows Easy Transfer is between the following:

4+ Start a new transfer. You can select files and settings to move to a new
system.

4+ Continue a transfer in progress. This allows you to resume a transfer
where you’ve already made your selections.

The program asks if the machine where you're working is your new com-
puter (the destination for the transferred files and settings) or your old com-
puter (the source). The recommended procedure calls for starting the
process on the new machine.

Getting from here to there: Means of moving
You have three ways to move settings and data from one machine to another.

4+ Easy Transfer cable. Easy Transfer cable is the Microsoft moniker for a
specialized USB cable that connects two machines; it differs from a regu-
lar USB cable because it has a large A connector at each end, instead of
the typical large A computer end and small B device end.

Start Windows Easy Transfer on the new (destination) laptop and plug in
the cable only when you’re instructed to do so. You may need to use the
Windows Vista installation disc on your old (source) computer to install
the Easy Transfer utility there; the onscreen instructions walk you
through the process.

4+ Direct transfer over a network. You must properly configure both
source and destination computers and connect them to the same wired
or wireless network. Start Windows Easy Transfer on your new (destina-
tion) computer. To transfer the files from the source computer, you're
directed to obtain a key from the program on the new machine and then
enter that key on the old (source) machine. The key serves as a pass-
word to protect files and settings moving over a shared network.
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4+ Removable media. Copy files to a USB flash drive, a CD or DVD, or an exter-
nal hard disk drive and then bring the media from the source to the destina-
tion for transfer. See Figure 3-2. As part of the process, Windows Easy
Transfer estimates how much space is needed on a removable medium.

¢ A standard DVD can hold about 4.7GB of data.
¢ A dual-layer DVD can hold about 8.4GB.
¢ A CD has smaller capacity, usually between 600 and 800MB.

¢ Flash memory devices are now available in sizes up to 16GB (and
you’ll probably see them go much higher).

Another option is to copy the files you want to transfer to an external hard Book Il

disk drive and then bring that drive from the source to the destination Chapter 3
computer. The utility can split the files into as many groups as necessary,
spreading data across more than one CD or DVD, or allowing you to use a

o \»
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flash drive as many times as needed to move all the files and settings. 2z
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. If you don't have another USB flash drive, connect the drive that you're using to your new computer, When
Seﬁlngs prompted, run Windows Easy Transfer and copy the first set of files and settings to your new computer. When the
from one transfer is complete, reconnect the empty USB flash drive to this computer to continue.
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. To help protect your files and settings during the transfer process, you can create a password for the
settingup a location where the files are stored. Make sure that you write down or save the password because

you'll need to use it on the other computer.
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Feeling choosy about files to transfer

Sometimes you want to bring over everything from your old computer, and
sometimes you want to have a nearly fresh start. Windows Easy Transfer
offers three options.

4+ All user accounts, files, and settings. This choice is recommended if you
want to essentially clone one machine to another (except for the operating
system and software applications). All users need to create a new password
the first time they log on to their account on the new computer.

If you've already created user accounts on the new computer, you can
match the new accounts to the source accounts. (The new account
names can be the same, or you can make changes in the process of
matching settings from one machine to another.)

You must have administrative privileges on both machines to use the All
User Accounts option. Administrative privileges are used mostly in large
office settings where the computer department seeks to maintain consis-
tency (and control) over all machines.

If you haven’t yet created user accounts on the new computer, you can
establish them as part of the transfer process. And again, they can be
the same user accounts as existed on the source machine, or you can
create new ones and match the data as you wish.

4+ My user account, files, and settings only. If you will be the only user of
your new laptop, or if you do not intend to set it up with separate
accounts for other occasional users, you can choose to transfer only the
information that is associated with your personal user account on the
source computer. You need to create a new password the first time you
log on to the new computer.

4+ Advanced options. If you want to get choosy, transferring some user
accounts but not others, or certain folders or program settings but not
all, then come here. (See Figure 3-3.) This is called advanced because,
well, it’s not for newbies. If you're not certain which files or folders you
need, or the nature of settings files, consult the Help section for each
program (and Windows) for assistance.

Revealing the secret beauty of a settings transfer

If you really want to be a cautious and very smart computer user, you can
use Windows Easy Transfer (or the similar File and Settings Transfer Wizard
of Windows XP) to make backup copies of your settings and configurations —
and even your files.
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Pretend you’re setting up a new computer and gather all the files from the
source machine onto a removable medium such as an external hard drive,
DVD, or flash memory key. Then put the medium on the shelf and leave it there.
In case of disaster, you can reconstruct all your essential settings and the files —
as of the date you made the copy — for reinstallation on any machine.

Windows XP Files and Settings Transfer Wizard

If your new machine is running Windows XP, you have a utility called the
Files and Settings Transfer Wizard (that performs similarly to the Windows
Vista Easy File Transfer utility). The wizard isn’t magical (a bit less polished
than the latest and greatest) but still allows most users to migrate their set-
tings and files from one machine to another.

Q&N\BER If your new (destination) machine is running Windows Vista, use the Easy
& File Transfer program that comes with that operating system. The installation
disc for Vista includes a utility that you're asked to load onto your older
machine to automate the process.

@ e Windows Easy Transfer

Select user accounts, files, and settings to transfer
To transfer files from locations other than shared folders or the Documents folder for each user, click Files in other
locations, and then select each location that you want to transfer. Windows will transfer data files in the locations
you select.
—
. 7 i 548 System and program settings (all users)
Figure 3-3: L ¥ a
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The file wizard works with any operating system from Windows XP back in
time through Windows Me, Windows 98, and Windows 95. You can transfer
data from machine to machine over a

4 Network cable
4 PC-to-PC USB cable

4+ Special form of serial cable called a null modem that can be purchased at
computer stores; some software utilities designed for file transfer
include this cable

Note that most modern machines no longer offer serial ports. You can,
though, purchase converters that make a USB port act like a standard serial
connection, or that add a USB connector to a standard serial cable. In some
designs and applications, these serial conversions operate much slower
than either standard serial or newer USB ports.

To run the wizard, follow these easy steps:

1. Connect the two machines by cable.

2. Click Start =>All Programs =>Accessories > System Tools ->Files and
Settings Transfer Wizard.

Unlike the design of the Windows Vista utility, under Windows XP you can
start the transfer process at either end — the source or the destination. You
need either your original Windows XP installation disc or to create a transfer
floppy diskette (blast from the past) or use a flash memory key or other
portable medium.

Exporting Outlook Express or Windows Mail Contacts

If you run your life by e-mail (guilty as charged, dear reader) maintaining
schedules, receipts, and confirmations in the folders of your mail client, you
may want to spend the time every week or so backing up your address
books and mail.

For most Windows XP users (as well as those people using outdated but recent
versions of the operating system including Windows Me, Windows 98, and
Windows 95) the most common e-mail client is Outlook Express, which is
provided free as part of Windows. You may also choose to use a third-party
e-mail client such as Eudora. Another option is Microsoft Outlook, which is a
full-featured e-mail, calendar, and contact-management software package sold
as part of various Microsoft Office packages. For simplicity’s sake, [ recommend
Outlook Express.
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With the introduction of Windows Vista, Microsoft differentiated between
Outlook and its basic Outlook Express. Within Vista, the free e-mail client is
called Windows Mail; that program is a slightly more polished version of
Outlook Express.

As you explore in Book VIII, two common mail protocols in use on personal
computers have an important difference.

POP3

POP3, the current version of an older Post Office Protocol (POP) that dates
back to the early days of PCs, downloads copies of all mail from wherever
the messages are located and places them in a folder on your computer.

That’s good, in a way, because you’ll know you have a copy. But that’s bad if
your hard disk drive or the computer itself dies. And it isn’t all that great for
laptop users if you download e-mail onto your desktop machine and then hit
the road without copies. And if you pick up mail while on the road, you may
need to export copies to your desktop from the laptop.

IMAP

Internet Message Access Protocol (IMAP or sometimes referred to as IMAP4)
works differently than POP3. E-mail that comes into your Internet service
provider’s server stays there, on that server. Each time you sign on to look
at your mail, a copy of the header (the subject, sender, date, time, and other
information) is sent to your computer. To read a message’s details, you
instruct your e-mail client to download the message; however, your desktop
and laptop keep no copy unless you instruct your computer to store it in a
local folder.

Why is IMAP a better way?

4+ It adds a layer of protection against viruses and spyware; you can look
at the e-mail headers sent your way and delete them from the server
before they download to your laptop. (And most e-mail or Internet
providers also scan messages at their end, identifying most viruses and
other would-be intrusions; depending on your instructions to the
provider, the nasty bits may be removed from the message, the entire
message may be discarded, or the message may be marked as Spam or
Virus to warn you of its content before you touch it.)

4+ Of particular value to laptop users is that any messages you receive while
you're traveling also show up on your desktop when you return home.
(That is, unless you move the message to a local folder on your laptop.)
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If you're given a choice when setting up your e-mail client (most commonly
Outlook Express on Windows XP, or Windows Mail on Windows Vista) I rec-
ommend choosing IMAP. If you're not given a choice, contact the Internet
provider and ask them to assist you in establishing an IMAP account.

Exporting Address Books or Business Cards

For some users, even more important than the mail itself is the address book
associated with an e-mail program. Here’s where you store (or allow the
computer to automatically store) the names, e-mail addresses, and other
information about the people with whom you correspond.

Moving a contacts list with you is valuable when you move from machine to
machine. You might also want to donate your list to a coworker or family
member; make sure you think that gift all the way through before going
ahead, though.

The process is simple.

1. Export the address book (the term used in Outlook Express) or con-
tact list (as is called in Microsoft Mail) to a file and store it on your
computer.

2. Move a copy to the new machine.

Do so over a network or by copying it to a removable media such as a
CD, DVD, external hard drive, or flash memory key.

3. Import the file into the destination e-mail program.
Windows Mail and Outlook Express support exporting the following types of
address books:
4 Microsoft Exchange Personal Address Book
4+ Text File (Comma Separated Values)
Windows Mail and Outlook Express support importing the following types of
address books:
4 Eudora Pro or Light Address Book (through v3.0)
LDIF - LDAP Data Interchange Format
Microsoft Exchange Personal Address Book
Microsoft Internet Mail for Windows 3.1 Address Book
Netscape Address Book (v2 or v3)

+ 4+ 4+
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4+ Netscape Communicator Address Book (v4)
4+ Text File (comma-separated values)

4+ Business Card (vCard)

Exporting and importing with Outlook Express
From within Outlook Express you can export address book data for use with
another installation of the same program or to the full-featured Outlook pro-
gram. The file you create can also be converted for use by Microsoft Mail
and by many third-party e-mail programs.

1. Choose Tools &> Address Book.

2. Choose File = Export.

To export an address book, follow these steps:

1. Click the address book you want to export.
2. Click Export.
3. Follow the instructions on the wizard.

4. Store the file in the location of your choice.
To export a business card, follow these steps:

1. Click the desired .vcf file.
2. Click Save.

Importing works the same, only backwards:

1. Open Outlook Express.
2. Choose the Tools menu and click Address Book.
3. From the File menu, point to Import.

4. Browse to the location of the file you want to use.

Exporting and importing with Windows Mail

To export or import with Windows Mail, you have two choices (and one

minor name change). With this program, the address book is called contacts.

To export, do one of the following:
1. Choose File > Export ©> Windows Contacts.

or
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2. Choose Tools > Windows Contacts > Export.
To import, you have two choices:
1. Choose File > Import > Windows Contacts.
or

2. Choose Tools => Windows Contacts = Import.

Exporting saved mail and mail folders

égN\BER Exporting individual mail items or entire mail folders is similar to exporting
& an address book or contacts list. However, if you have a POP3 account, the
mail itself resides on your laptop. If you have an IMAP account, the mail is
somewhere out there in cyberspace.

To export messages from Outlook Express or from Windows Mail, do this:

1. Click File => Export > Messages.
2. Perform the step based on your program:

¢ In Outlook Express: Click OK to accept the following: This will
export messages from Outlook Express Mail to Microsoft Outlook or
Microsoft Exchange.

¢ In Microsoft Mail: Select the format you want to export mail to:
Microsoft Exchange or Microsoft Windows Mail.

3. Select a folder to hold the exported messages.



Chapter 4: Managing Files,
Folders, Extensions

In This Chapter

v~ Filing your tax forms. . . and everything else
v+ Uncovering hidden filename extensions

v~ Putting files into folders and moving them about

I’m a pretty organized guy; some might call me slightly obsessive. Within
the bounds of reason, I try to have a place for everything, and everything
in its place. That doesn’t mean from time to time [ don’t build up a foot-high
pile of papers on my desktop, but when the mountain threatens to topple
over I stop production for a while to put things right.

[ sort the papers by subject and then prioritize them. I have boxes that hold
folders for things that need to be done immediately, things that need to be
done later, records of tasks already accomplished, and ideas and notes for
future projects. And I also maintain a lifetime collection of receipts, tax
forms, and banking and investments records.

New stuff goes into new folders. Items that are continuations of earlier
efforts are added to existing folders, and I place the folders between labeled
dividers in one of four filing cabinets in my office. And at least once a year, |
throw away anything that has sat around so long that [ no longer remember
why I kept it in the first place.

Now, I don’t want to name names, but there’s a woman [ know very well
whose idea of organization is to build those piles higher and higher until
eventually she has to move to a different desk. Happily, she hasn’t lost me in
more than a quarter century of marriage, but over time she has misplaced
just about everything else for at least some period of time.

Opening an Electronic Filing Cabinet

Apparently the early designers of operating systems saw the world some-
what in the way I do, because from the start the metaphor for organizing
massive amounts of information on a computer was a set of filing cabinets
filled with folders.
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The original PC operating system (OS) was envisioned as a tree with a thick
root at the bottom, a substantial trunk, and then increasingly thinner and more
distant branches. The base was (surprise) called the root directory, and the first
level of subdirectory could branch off into an almost infinite number of
subdirectories.

With the arrival of Windows, the same concept was envisioned by someone
who must have seen my wife’s desk. The graphical user interface, our friend
the GUI, asks you to think of the opening screen (after all of the advertise-
ments and advisories have come and gone) as the desktop. You can put just
about anything you want on that desktop, but sooner or later it’s going to get
crowded, making it very difficult to find particular items.

Windows designers want you to think of their electronic desktop as sitting
atop a set of broad and deep file cabinets. Back to the original computer
metaphor: The desktop is the big sunflower and beneath it the folders and
subfolders are the ever-narrowing roots.

And, with many modern computers and laptops containing more than one
physical hard drive, or more than one logical drives (a physical drive identi-
fied to the OS as if it were two or more separate drives), you have wonderful
options for a very sophisticated organizational scheme for your documents,
media, and software.

That is, if you bother to use the tools at your disposal. Let me try to help.

Rocking the Files

A file is a document, a picture, a song, a discrete piece of programming, or a
stored setting or configuration. If you think that sounds like a very broad
definition, well, you're right; in computer terms, a file is any stored block of
information that has a name or number that the system is responsible for
tracking.

A document created in Microsoft Word is a file. So, too, is a downloaded
song from iTunes. And all of the thousands of identifiable sets of program-
ming that make up software applications and the operating systems.

The Toshiba Satellite P205 that [ am using as an example of a current
machine has a capacious 200GB hard drive within its case, a piece of elec-
tronic real estate that was unimaginable for a laptop a few years ago. But
today it needs that much space for the super-sized Windows Vista OS, as
well as the many advanced purposes for which I use it, including capturing,
editing, and playing back digital music, video, and photos. That one machine
can easily build up 500,000 or more files of various sizes on it.
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Can you imagine if all of those files were lumped into a big pile, kind of like
the stack of papers on my wife’s desk? The stack would be very, very tall. It
would be difficult to find a particular file; once you retrieved a file it would
be hard to remember where to replace it (assuming you had some kind of
scheme in mind), and there would always be the possibility of a catastrophic
collapse for any number of reasons: a gust of wind, a pounce of cat, or a dis-
couraging word.

The solution is the big O, and I don’t mean origami or that other thing
(Oprah). I mean Organization.

Naming your files
You can call your file Joe, or you can call it Al, or you can call it just about
anything else that makes sense to you.

But remember a few important rules:

4+ Files are identified by three components. The most important part is
the filename, which is in the middle of the mix. The file location appears
before the filename. And after the filename (although you may not notice
this unless you go out of your way to look it up) is something called a
filename extension (explained later in this chapter).

4+ Don’t give two files the same name and filename extension . . . if
they’re in the same location. If you did that, the computer wouldn’t
know which one you wanted, right? That statement has several “ifs,”
though. You can use the same filename for files with differing filename
extensions. And you can have exactly duplicate names and extensions if
the identical files are placed in differing (sub)folders or on a different
drive inside or outside the laptop.

4+ Don’t use certain characters as part of the filename. Why? Because the
computer wants those just for itself, usually as part of the location.
Actually, this mostly irrelevant holdover comes from the days of DOS,
but the banned characters are still part of modern Windows.

The dirty near-dozen do-not-use-in-your-filename characters follow:
[\N=+[]<>:;".

The system uses the period to indicate the place where the filename
ends and the extension begins.

4+ You can use a space or an underscore in your filename. These place-
holders are one way to give meaning names to files. For example, you
could use filenames like these:

My plans to rule the world

My_Plans_To_Rule_The World
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4+ You can use CAPITAL letters or lowercase letters. This also helps make
sense of filenames. However, although the system records the name
aNyHoW you want, you can’t have two same filenames that differ only in
capitalization. For example, the system allows you to save your files
under either but not both of these names:

My Great American Novel
my great american novel

4+ Keep it brief. The filename can’t be longer than 255 characters, includ-
ing spaces, and applies if you're using a modern OS that employs the
NTFS file allocation table (FAT) system. Some OS versions older than
Windows Vista and some applications like WordPad don’t like filenames
longer than 127 characters. And if your machine uses a hard drive that is
indexed using the old FAT system, you might be all the way back to what
used to be called 8.3 filenames: eight characters in the name and two or
three characters in the filename extension.

Decoding hidden filename extensions

If filenames on current operating systems can be so long and descriptive,
why do they also need an extension? It sounds like screen doors on a subma-
rine, or training wheels on a tricycle, or political debates for and against the
Department of Redundancy Department.

By default, Windows hides the filename extension when you look at a list. It
does this, [ suppose, because the wizards behind the curtains at Microsoft
don’t want to confuse poor users with more information than they really
need. (Ha! If I had a dollar for every time a user became confused by a
Microsoft decision . . . well, I'd have almost as many dollars as Bill Gates, I
suppose.) You can usually get by without seeing the filename extension
because the OS converts that extension into a recognizable icon, and
because Windows automatically matches up most common file types with
the appropriate program.

The filename extension identifies the type of file, not its name. You should
know this for two important reasons:

4+ Literally thousands of different file types are in use on laptops, and per-
sonal computers and some are structured quite differently from another
for good reason. For example, a file that contains the description of an
image or a song may need to be laid out very differently from a spread-
sheet or a word-processing document or a program. Sometimes the dif-
ference between file formats is a matter of finding the most efficient way
to store a particular type of data; sometimes the various file formats are
unusual just because one programmer insists on it.
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4+ One of the virtues of Windows is that it maintains associations between
filename extensions and the programs they work with. This little trick is
pretty handy: Click a file with an extension .DOC and Windows automati-
cally opens Microsoft Word with that document displayed, for example.
The same works with spreadsheet files, which should open your spread-
sheet program, and digital images files, which should bring your image

editor to life.

As noted, known filename extensions come in the thousands. Table 4-1 lists
some of the more common ones and the programs they’re ordinarily associ-

ated with.
Table 4-1 Common Filename Extensions
Extension Commonly Associated With Function
Al Adobe lllustrator Vector graphics file
AVI Windows Media Player Audio Video Interleave for
and compatible software video files
BMP Most image editors Bitmap image file
DLL Microsoft Windows Dynamic Link Library of
shared fonts, icons, and
definitions
DOC Microsoft Word Document
DOCX Microsoft Word Office 7 document file
EPS Encapsulated Postscript Printer image file
JPG or JPEG Most image editors JPEG File Interchange
Program (compressed
image)
MP3 Audio players or editors MPEG music file
(compressed)
MPEG Video players or editors Motion image file
(compressed)
PDF Adobe Reader and compatible Portable Document File
graphics-editing programs
PSD Adobe Photoshop Native image format
TIF or TIFF Most image editors Tag Image File Format
(uncompressed image)
XT Word processors Simple text file
and simple text editors
ZIP Windows or Unzip/Zip utilities Compressed file
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When you install many programs, you're given the option of making that
application the default association for a particular filename extension. For
example, if you have more than one digital image-editing program on your
computer (I have four on my laptop), you can assign the most sophisticated
to automatically open with a complex TIFF file, the quickest and simplest to
the most basic GIF file, and a specialized program to work with RAW files
produced by a particular brand of digital camera.

The bidirectional nature of Windows means that even if a particular filename
extension is associated with a particular program that doesn’t mean you
can’t open and use that file by loading a capable program and then opening
a file from a selection box.

If a program has somehow added the wrong extension to a filename, you can
change it by following the same instructions I give later on in this chapter for
changing the filename itself. Just add a period and the extension you want, as
in .TIF for a TIFF image file. Note that changing a filename extension doesn’t
change the format of the file itself, but in certain rare situations, changing an
extension solves a problem that’s preventing you from opening a file with a
particular program.

Exposing those hidden filename extensions

To its credit, those same Microsoft engineers who tried to make things
simple by hiding filename extensions also let you see them if you must. The
process is easy, but be careful: You don’t want to click the wrong box and
make the Windows gods unhappy.

Here’s how to instruct Windows to show filename extensions in all folders
and other places that use the Windows Explorer system. These instructions
apply to Windows XP; the process for Windows Vista is similar.
1. Click Start = My Documents (or double-click any folder).
This opens Windows Explorer, the system that displays files and folders.
2. Choose Tools = Folder Options = View tab.
You get into the super-secret hidden area of Advanced Settings.

3. Locate the Files and Folders section, and then find the Hidden Files
and Folders section.

™

. Click the Hide Extensions for Known File Types check box.
5. Click OK.
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While you’re in the neighborhood, if you really want to be master of your
Windows file and folder universe, you can also click the nearby button that
says Show Hidden Files and Folders. Doing this instructs Windows to display
the usually hidden system folders and files scattered here, there, and every-
where on your hard disk drive.

Showing hidden files is interesting to some users because, well, they love this
sort of stuff. For most users, it’s a bit overwhelming and not of much use.

One time you’ll find it valuable to see hidden files and folders is if you get
error messages complaining that Windows can’t find a particular file. You
can search for the file using the Windows built-in Search facility or you can
conduct a folder-by-folder manual hunt — if you’ve turned on the display of
hidden files and folders, that is.

Changing a filename association

Suppose somehow your computer thinks it can open and edit a graphics file
in a word processor? If you went down this road, you’d mostly likely see a
screen full of Os and 1s or other symbols and characters that are anything
but words to be processed.

Or, suppose you have several graphics programs on your laptop. Say you
have one or another of the utilities supplied with Windows (Windows Paint
and Windows Photo Gallery) and you've also added a photo editor that
came with your digital camera as well as one of the advanced tools from
Adobe such as Adobe Elements, Adobe Photoshop Album, or the profes-
sional’s tool, Adobe Photoshop. Which one should automatically open if you
double-click a TIFF file? Many programs let you set them as the default appli-
cation for particular filename extensions. You might choose, for example, to
have all photos open in Photoshop.

Check the help screens for your program to see if you can assign filename
associations. The other way to accomplish the same thing is to make an
adjustment to the settings of Windows itself. Slightly different steps allow
you to accomplish this in current versions.

Changing filename associations in Windows Uista
Follow these steps to change the association in Vista:

1. Click the Start button, and then click Default Programs.

You see a window that allows you to Choose the Programs That
Windows Uses by Default.

2. Click Associate a File Type or Protocol with a Program.

See Figure 4-1.
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The system displays the Set Associations window. The three columns
show all the filename extensions Windows Vista is aware of; the list is
updated over the Internet from the mothership in Microsoft and
includes both common and obscure. (In most cases you also see the
little icon assigned to the filename extension.)

3. Click a filename to highlight it.

You can see a description of the file type that uses the extension and the
current default association for the extension. In some cases the exten-
sion doesn’t have an association, or it may be marked as an unknown

application.

4. Click the Change Program button.

You see a window with the unusually simple title of Open With. See

Figure 4-2.

5. Select the program you want to set as the default for this extension.

6. Click OK.

N — — ______ —
e
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Changing filename associations in Windows XP
To change or set filename associations (also called Registered file types) in

Windows XP, follow these steps:
1. Open either the My Computer or the Windows Explorer folder.

Windows Explorer isn’t the same as Internet Explorer. You can find
either, but My Computer is usually right there on the taskbar as well as
the Start menu. See Figure 4-3.

2. Click Tools > Folder Options = File Types tab.

3. In the list of Registered File Types, click a file type you want to assign
to a program or one that needs to be reassigned.

4. Click Change.
The Open With dialog opens.

5. Select the program you want to use and then click OK.
The Folder Options dialog opens.

6. Click OK.
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Figure 4-3:
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Putting Everything in Its Place:
Making and Using Folders

She’s got this huge pile on her desk. When it comes to the files on her com-
puter . .. she wants to keep them on the Windows desktop, too: all 500,000 of
them. Oh, the trials and tribulations of a modern high-tech marriage.

The solution is to use folders and subfolders and sub-subfolders. Figure 4-4
shows just one example of how you could organize your system. In this par-
ticular design, all files are kept inside folders and subfolders within a top-level
folder (think of it as the file cabinet) called My Documents, which is one of
the folders Windows automatically creates for you. One level down from My
Documents are two major folders, one called Business Files and the other
Personal Files. They hold, respectively, business files or personal files . . . but
you figured that out already, right?

Another level down, the business and personal files branch off again. On the
business side, to folders dedicated to letters, financial matters, and (since my
particular line of work involves publishing) manuscripts. On the personal side,
folders are set up to hold private letters, financial documents, and digital
audio and video.

There’s no right and wrong way to organize your computer, and you can
make the structure as simple or complex as you like. All that matters is that
it makes sense to you . . . and that it gets the big pile of files off your desktop.
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The programmers at Microsoft really, really want you to get organized, too.
That’s why they instructed Windows to create at least a basic structure to
hold your files. You can use their scheme, adapt it more to your liking, or
create your own.

And many software applications install one or more special folders to hold
files created with their program. Again, you don’t have to use their sug-
gested locations, but if you choose to store files somewhere other than the
default location, make sure you keep track of where you place them.

These three top-level basic folders are automatically created by Windows XP.

My Computer

Windows also sets up subfolders called Shared Documents (for files you
identify as ones you want available to others on a network) and Insert Your
Name Here’s Documents. (It’s not really called Insert Your Name Here; the
computer creates a subfolder for each user account and places that person’s
name on the folder.)

If your laptop has only one user account, then this folder is just for you. If
you allow the kids (why, oh why?) to use your laptop, be sure to set up a user
account for them. Not only will it help keep any files they create separate from
your own, but it also permits you to create different themes and settings for
each user. That is, unless you want to come to the board room with your annual
financial planning presentation and let the CEO see that your laptop’s desktop
has a huge, pulsing picture of SpongeBob SquarePants.
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My Computer (on Windows XP systems) or Computer (on Windows Vista
machines) also includes icons that represent storage devices such as the
hard disk drives and any attached external devices. If you burrow down into
the list of devices, you gain access to the folders they hold.

My Documents

You can customize to add subfolders galore to this general top-level folder.
Windows automatically creates subfolders including My Music, My Videos,
and My Pictures. (And I bet you can guess the intended contents of each of
those subfolders.) If these folder names make sense to you, leave them
unchanged; many programs automatically dispatch files to those folders,
even if you prefer to keep them somewhere else.

On my system, [ add subfolders to distinguish between files [ declare In
Progress, Completed Assignments, and Archives. Once I finish a particular
job and ship it to a publisher or a client, I move it from In Progress to
Completed Assignments where it sits happily for a few weeks or months or
even years until 'm certain that I don’t need to do anything more with it.
Then I move it to Archives where it just sits.

The advantage of a three-stage process like mine? Organization and tracking.
I can easily find projects that I need to finish, and then I can readily find
older projects if [ need to change them or recycle parts for other purposes.
And finally, I can easily copy Archives files to DVD or to one of my several
external hard disk drives for deep, deep storage. (Trust me, you never know
when some situation will arise where you find that you need to look at a file
you created ten years ago. Go to the archives . .. .)

My Network Places

Okay, this one isn’t really a folder. At least, it isn’t one located on your
laptop. This listing is any location on a local area network (LAN) available to
you. Permission can be granted to read files only, or to write new or modi-
fied files to that location. (Network places can connected by Ethernet wires,
available on a WiFi wireless network, or even locations available somewhere
out there on the Internet.)

Windows Vista has a similar but not quite identical set of folders. The most
current OS automatically creates the same group of folders for each user.
The top level folder is the User Account folder, and is named . . . for the user.
Thus, there is a folder called Corey and within that folder the OS creates
these subfolders:

4+ Contacts. Any time you use the Windows Vista Mail program, the e-mail
address and other details of anyone you correspond with are added to
an address book here. Certain other applications, from Microsoft or
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other software companies, may also use this folder to hold information,
settings, and other details of your electronic correspondence.

The creatively named Mail is a replacement for Outlook Express, which
was part of most earlier versions of Windows.

Desktop. Although your laptop’s desktop looks as if it is one big spread-
out place, actually all of its documents, shortcuts, and subfolders live
within this top-level folder.

Documents. This is where your (say it along with me) documents are
supposed to go. You can (and should) create all sorts of subfolders
within this folder to help you organize your stuff.

Because each user account has its own Documents folder within
Windows Vista, you can keep others from viewing, changing, copying, or
deleting your documents. All you need to do is to apply a password to
your user account.

Downloads. The default location for files brought to your laptop from
the Internet is here, which makes them easy to find and manage.
However, some web sites may insist on placing their downloads on the
desktop or elsewhere on your computer; in addition, you may be able to
Save As and place a download somewhere that is especially pleasing or
logical to you.

Favorites. Here Internet Explorer (the browser that helps you find, display,
and interact with web sites) can store places you've visited and to which
you hope to return. The favorites are listed on a menu within Internet
Explorer, but stored here. (And because Windows allows you to open a file
with a program, or a program with a file, you can go directly to a favorite
site by double-clicking an icon or filename listed in this folder.)

Links. One of the sorta-kinda new features of Windows Vista is the
Navigation Pane on the left side of folders. It displays a list of your most
frequently used folders and items. The upper part of the pane lists links
to folders you use often; the lower half allows you to pop open the con-
tents of those folders to display them in a branching tree format. (The
broadest folder is atop the tree, and the various folders and subfolders
beneath it spread out like thinner and more distant roots.)

Music. Any digital tracks copied from CDs using the Windows Media Player
are ordinarily stored here, in a folder after the CD’s title (if the maker of the
CD labeled the disc properly). Some other audio programs — music players
as well as editors — may also use this folder to store tracks.

Pictures. Are you getting the picture here, yet? Yup, this folder is the
official place to store digital images from your digital camera, a scanner,
screen captures from a web site, or from your own computer. Many digi-
tal editing programs seek out this folder for image placement unless you
instruct them otherwise. On my machine, I add several layers of subfold-
ers to divide the thousands of digital photos. I've got a folder called
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Europe, for example, and below that are individual folders for countries,
and one layer down the folders are identified by month and date.

Saved Games. You're much too busy to waste time on games; there’s
work to be done. Spreadsheets, word processing, e-mail, Minesweeper,
Spider Solitaire, FreeCell. Those last three aren’t games, boss: They're
mental exercises to keep me sharp and creative. So when you do play
one of the games offered by Windows Vista, the OS stores any saved in-
progress sessions as well as high scores and settings here. And some
other games you install on your own may use this folder to store saved
sessions. Or so I'm told.

Searches. If you use the facilities within Windows Vista to search the
files within your laptop, the saved results of that inquiry are stored here.
Certain other third-party search utilities may also use this folder.

Videos. Downloaded videos from the Internet or from a camcorder are
ordinarily placed here. You can add subfolders to manage different types
of files: for example family, travel, and “none of your business.”

Many software programs insist on placing files you create in the folders that
made sense to the programmers. However, in most programs you can change
the default location for files. Check the Options menu from within the program.

Another way to manually instruct a program to place a file in a particular
place is to use the Save As command. Save As is a command with its roots all
the way back to the early days of computing, which explains its somewhat
less-than-obvious name. When you tell the computer to Save As, you're going
around any automatic settings for the program. In the instance of a word-
processing program, you can

+

<+

<+
+

Save the file under a name other than one the program automatically
generates.

Save an additional copy of the file under a new name.

Save an original version of the file in a folder other than the default. This
includes folders on your machine or, if your laptop is connected over a
LAN, on another machine. (You must be granted permission to access to
folders on networked computers.)

Save a copy in a folder other than the default.

Save the file in a format other than the program’s standard.

You can explore some of these options in more detail in Book IV about office
software.
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It’s all done with a flick of the finger: point to a folder and double-click it to
open it and examine its contents. Do the same to open a subfolder. Or, if
you’d prefer a slightly less aggressive method, point to a folder and give a
gentle touch to the right mouse button. Then select Open from the menu
that appears.

Want yet another way to get to a file? Every Windows program ties into the
operating system’s file index through the Open command. Most work like
this: If you open the program and then seek to open a file, the Open com-
mand takes you to whichever folder has been identified as the default “look
here first” folder. You can browse from there to any other folder on the
machine. And you can change the default folder from within the program by
going to its Options menu.

If you click Open from within most Windows programs after saving or open-
ing a file, the folder you see is where the most recently used file is located.
Again, you can navigate from that location to anywhere else on the machine.

Seeing what you see

When you open a folder you see a list of files as well as any subfolders
placed within. That’s about all I can tell you in general terms, because
Windows allows you a tremendous amount of display customization.

To begin with, you can show the contents of a folder as follows:

4+ List. This is the simplest and is just what promises: a list of files and sub-
folders. You see the filenames and folder names, accompanied by what-
ever icon or symbol you or the program associate with it.

4 Details. The same list, but this time presented with a great deal more
information — as customized by you. For example, in addition to file-
names and folder names, you can see the size of individual files (indi-
cated in KB, meaning thousands of bytes). Other available information
includes Type (such as File Folder, Microsoft Office Word file, Microsoft
MapPoint map, or Adobe Acrobat Document), Date Created, Date
Modified, Date Accessed, and much more.

In Windows Vista you can add Tags to files to describe a file’s contents.
Tags are particularly useful with digital image, music, or video files. You
can add a few words to describe a digital camera picture (for example
NEIL, LAMPSHADE, NEW YEAR). Years later, when you want to find that
picture of Uncle Neil with the lampshade on his head you can search for
any of those words and come up with a list of images that fit the bill.
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4+ Icons. Since you’re working in a gooey GUI, it is appropriate that soft-
ware designers stick symbols alongside the words that name a file or a
folder; I'm talking about icons. The icons are automatically applied to
files because of the filename extension. Any software maker who plays
by the official Windows rules can instruct the OS to display a custom
icon for certain file types. That’s why you see a small picture of a printed
sheet of paper with a W to indicate a Microsoft Word file, or a musical
note for an MP3 audio file.

You can also personally select a little icon for folders (for example, a tiny
camera to indicate pictures, a miniature projection screen to hold
PowerPoint presentations, a small group of miniature people to tell you
that family matters are within). Icons also identify programs (or desktop
shortcuts that lead to their location on your disk), and clicking them can
launch the program.

4+ Tiles. If you know exactly what you’re looking for (and have customized
the heck out of your personal folders), you can look at a folder’s con-
tents as tiles: just the icons (a bit larger than in the regular view). Click
any one of them to open the subfolder. (And just to be nice, if you hover
your mouse over a tiled icon, a little screen tells you the nature and size
of the folder or the file, and in the case of the file you learn the date it
was last modified.)

4+ Thumbnails. And now for the really big show. (This would have been Ed
Sullivan’s favorite; if you don’t know who he was, ask the nearest
geezer.) Instruct the system to show you a folder’s contents as thumb-
nails, which are really big icons. Plus, any images — digital photographs,
scans, PDFs — appear as small versions of themselves. Switching to
thumbnail view is a great way to quickly examine your photos. Open a
folder’s thumbnail by clicking it; clicking a file’s thumbnail opens the file
within the software program with which it’s associated.

Giving your folder a makeover

To select any of the available viewing options within an open folder, click the
View menu and then use your mouse to select one of the available options:
Thumbnails, Tiles, Icons, List, or Details. That’s all there is to it.

Now, if you want to customize a particular folder’s appearance, the process
is also simple, but requires a few extra steps. If you're running Windows XP
(Windows Vista is similar enough that you can figure it out from these
instructions), here’s how to assign an interesting, eye-catching, or meaning-
ful icon to a folder:

1. Click the current icon for a folder to highlight it, then right-click the
folder.
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2. Select Properties.
The Properties dialog appears.
3. Click the Customize tab.
4. Under Folder Icons, click Change Icon.

Wow, that’s a lot of icons to choose from. Windows comes supplied with
several dozen little pictures, and some programs add their own to the
system. You can also download or purchase icons from designers; if you
download one from the Internet make sure you're dealing with a rep-
utable source to avoid viruses.

5. Select the icon you want and click OK.

Back at the Properties page you see some other options, including the
kind offer to use this folder type as a template for other folders. You can
experiment here or (as I do) individually assign icons as I need them.

6. Choose steps based on your decision:

¢ Click Apply to assign the icon if you want to stay on the Properties
page and do other things.

¢ Click OK to assign the icon and close the dialog.

Renaming your folder or file

As you’re probably beginning to figure out by now, you can usually accom-
plish a particular task under Windows two or three different ways. The OS
designers tried to anticipate different types of users and different types of
situations.

Here, then, are three ways to change the name of a file or a folder:

4+ Click the current icon for a folder or a file to highlight it. Click a second
time on the box containing the filename to highlight characters. Type in
a new name and press the Enter key to accept it.

4+ Click the icon for a folder or file to highlight. Then right-click. From the
menu that appears, chose Rename and give it a new name.

4+ Click the icon for a folder or file to highlight. Then right-click. From the
menu that appears, chose Properties. In the upper part of the box you see
a box with the current filename; click in the box and change the name.

You can also change a filename from within a program by using the Save As
command and inserting a different name; if you take this route, you end up
with a copy of the file. You can keep both, or you can go in and delete one or
the other version.
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Moving on up

Sometimes you put something in the wrong place. Or the darned machine
goes and stores a file or makes a folder somewhere other than where you
want it.

Before you change the machine, try moving the file or folder. And yes, you
have multiple ways to do this:

4+ Open the folder where you want to move the file or subfolder. Then
locate the folder or file you want to move. With both windows open
(source and destination), click and drag the file you want to move. When
the icon is where you want it, release the button. It’s there!

4+ Locate the folder that holds the file or subfolder you want to move and
highlight the item you want. On the left side of the folder is a set of File
and Folder Tasks and, wouldn’t you know it, one that offers Move This
File. You're shown a complete listing of top-level folders where you can
move the item.

Being Wary of the Metadata

In case you thought your personal work on your computer was personal,
consider this: The system tracks when a file is first created, most recently
modified, and most recently looked at (accessed), even if nothing was
changed. The program records the user who created the file as well as
anyone else who made comments on the file, and the comments themselves
are tracked. It also records the total amount of time spent with a particular
file open and the number of times it was worked on. This information is
called metadata (info about info, you know) and is silently inserted into your
file every time you open, save, or close it.

Does metadata sound like something that might become of interest to an
attorney in a lawsuit, or a detective, or a government agency? “You claim
you never sent a stock tip to your friends and relatives before March 1? How,
then, can you explain the following . . .?”

With the advent of Office 2007, Microsoft took a partial step back from edge
of Big Brotherdom. It’s called the Document Inspector, and you can scrub
your files of any metadata you’d rather not share through the Prepare menu.
Here’s the drill:

1. Click Microsoft Office Button =>Prepare > Inspect Document.

The Document Inspector dialog opens.
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2. Select the check boxes to instruct the program what to look for.

3. Click Inspect and review the results

4. Click Remove All to scrub the file.

5. Save the file either as an original or as a copy.
[ say Document Inspector is a partial step back because it helps you create a
“clean” file that you can e-mail or otherwise send to another user. This
process doesn’t necessarily remove all the information that may be con-

tained in the original file on your hard disk, any backups you have made, and
any earlier versions that might be scattered about anywhere else.
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Chapter 1: Opening Windows

In This Chapter

+ What you see is what you want
+* Becoming a pop icon master
v Taming the taskbar

v Out to launch

Once upon a time, life was simple. In my first “real” job, I showed up for
work to face an inbox on one side of the desk and two outboxes on the
other. In between was an empty patch of desk. On the floor was a black
rubber trash can.

My assignment was to take the top piece of paper from the inbox, examine it
to see that all questions had been answered properly, add up the numbers
(using a mechanical adding machine the size of a sewing machine), and deface
it with my rubber stamp that said “Approved.” Sometimes I had to use a differ-
ent stamp; this one put a large red “Disapproved” mark on the page. Next step:
Move the paper to the proper outbox: winners, losers, and the occasional trash.

Once or twice a day, someone from the mailroom would come by pushing a
rumbling old cart. All of the approved papers would go in one large con-
tainer and the disapproved into another; and then the clerk would refill my
inbox with a stack of new forms. At night, the janitor would take away the
trash; sometimes | imagined the garbage was being recycled into the inbox
of the next desk to mine.

My job was very clearly defined. One paper at a time. Every question was
either correct or incorrect. Everything progressed in one direction, from

inbox to outbox. Garbage went in the trash can. And the computer? That

would be me.

Today even the most basic of jobs bears almost no resemblance to my old
job. First of all, regardless of what you think of your own native intelligence,
when it comes down to it you're a computer operator. And though you may
have lots of pieces of paper spread around your work area, most of the real
labor takes place on that computer’s screen. The cable or wireless connection
is your inbox and outbox. And your desktop is virtual, a box of glowing dots.
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Even though it usually stands upright facing you, the work surface of
Windows is called the desktop. Here you choose programs, open files, move
folders, and otherwise perform your work. It’s been like that ever since the
dawn of Windows time, even though the desktop has become fancier and
more sophisticated with each new version of the operating system.

Windows is designed so you can get where you want to go in any number of
ways. For example, you can click a program and then open a file from within
the application, or you can locate a file in a folder (or on the desktop) and
double-click it to open the file within the program that created it. The same
sort of wonderfully loosey-goosey logic applies to most Windows configura-
tion controls; you can go to the central collection in the Control Panel or
make adjustments from several other places within the operating system.

Now consider two appendages to the desktop. Think of them as electronic
versions of remote controls: the Start menu and the taskbar.

The Start menu is one of several doorways that gives you access to your
installed programs:

4+ You can click any program to open it and create a file or load one you’'ve
saved to your hard disk. You can also jump directly to a selection of
commonly used major folders that hold documents, pictures, music, or
other specific types of files. See Figure 1-1.

4 You can hop to the Computer folder (called My Computer in earlier ver-
sions of Windows). From there you can burrow your way down to any inter-
nal hard disk, any folder on any disk, or any other attached storage device
(including external hard disks, flash memory keys, and memory located
within attached devices such as music players and digital cameras).

4 A one-click connection to the Network folder lists any other computers
and linked devices (such as printers) that are part of a wired or wireless
network.

4+ From the Start menu you can also gain quick access to the most important
customization and adjustment tool of Windows: the Control Panel.

Now consider the taskbar, which is a customizable list of programs and files
you're currently working on. (With the arrival of Windows Vista — and only on
those machines that have the horsepower to show off advanced features —
hovering your cursor on one of the taskbar items displays a thumbnail image
of what’s going on in each program.) You can set up the taskbar to display all
the time or only when you take the cursor down to its location. And you can
anchor it at the bottom of the screen or along the sides of the desktop.
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And then — only in Windows Vista — you have the sidebar, which you can

equip with your own selection of gadgets. Do you need to know the temperature
in Whapmagoostui at all times? Do you need to know — right now — the current
currency conversion between Icelandic Krona and Estonian Krooni? How about

live feeds of traffic on I-5 in Seattle? I discuss gadgets in Chapter II, Book 3.

Uncovering Your Desktop

Whether it’s upright or laid flat, the desktop is the metaphorical surface that
presents your work. You can place things on the desktop (individual files or
folders that contain many files) and you can place shortcuts to commands
(icons that, when clicked, start a program or initiate an Internet connection,

for example).

You can assign colors and styles to the desktop, use a drawing or a photograph
as the background, and enable automated features such as screen savers. You

can arrange the location of the files, folders, and shortcuts as well as the

taskbar. Want a peek at my desktop? See Figure 1-2.
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In my office, the top of my desk is sometimes invisible; it gets covered with
books and mail and sheaves of paper covered with notes that seemed very
important at the time [ placed them there. A similar situation occurs with a
Windows desktop. It’s there, although most of the time you have it com-
pletely covered with your Internet browser, a word processor, or something

P really important like Spider Solitaire.

You can restore your view of the desktop three ways:

4+ The fastest, all-in-one zippy solution is to bring the onscreen cursor to
your taskbar (usually at the bottom of the screen) and find the little icon
called Show Desktop. If you don’t recognize the icons by their design,
just hover the cursor over them for a moment; the name appears.
Clicking Show Desktop nearly instantly minimizes all open programs and
folders and displays your desktop.

4+ The slower way to accomplish the same thing is to minimize each open
program, file, or folder. To minimize something that’s open on the
Windows desktop, click the — symbol in the upper-right corner of the
program, file, or folder.

4+ Close any open programs, files, or folders by either clicking the X
symbol in the upper-right corner or clicking Close.

You can quickly restore minimized items by clicking their icon in the taskbar.
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Working with Desktop Icons

You've got this desktop. What do you do with it?

Just about the same things you do with a horizontal plank of walnut. You open
up folders, you spread out files, and you apply intelligence to your work.

But the nice thing is how the computer can help you keep a neat workplace.
All your folders and all the files within them represent the real thing; you can
move them around, organize them almost any way that makes sense to you,
and put them away in a secure place.

The Windows desktop is populated with icons, which are tiny, usually mean-
ingful, pictures or symbols. A folder with a digital camera icon most likely
means photos are contained within; the commonly used Microsoft Word
uses a stylized W.

Windows comes equipped with a large supply of icons that it automatically
applies to many popular programs and file types. Your laptop maker may
have added some other icons for utilities and special features, and many
applications you install on your computer come along with their own icons.

Here’s the first and most important thing to know about an icon: Icons aren’t
just pictures. They represent an active zone on your desktop. Double-click-
ing a desktop icon starts a program or opens the folder represents. And if
the icon marks the presence of a file, double-clicking it opens the document
within the program with which it’s associated.

Adding, removing, and moving

On the desktop itself you see icons, the small pictures that represent an
item, program, or action. The standard set of desktop icons usually includes
the Recycle Bin (to hold files that you've “deleted,” although that is an
imprecise term; I explain how the recycle bin works in Book IIl, Chapter 3).

Depending on choices made by you, your machine manufacturer, and the
maker of software you install on your laptop, your desktop may come fes-
tooned with other items. Typical icons include shortcuts to commonly used
programs such as your word processor, a Web browser like Internet
Explorer, and an e-mail client such as Outlook Express.

Icons that represent programs also are usually shortcuts. The shortcuts are
linked to the location of the program itself. You can create shortcuts to fold-
ers or files. Once again, the shortcut isn’t the item itself, but a pointer to its
location. Shortcuts look similar to other icons, with the addition of an arrow.
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See Figure 1-1 earlier in this chapter, which points out a couple of shortcut
arrows. The arrow tells you that the program’s located elsewhere, but that
you can still get there from here.

Some users like a clean and simple desktop; call it the “cluttered-desk-is-the-
sign-of-a-cluttered-mind” mentality. Others choose to fill up the desktop with
icons for all their current assignments and essential programs. There is no
right or wrong methodology. Whatever works for you is fine. I do, though,
recommend devoting ten minutes or so every few days to cleaning up your
desktop.

Giving a desktop icon the boot

To clear an icon off your desktop, follow along:
1. Use your cursor to highlight the icon.
2. Right-click with your pointing device.
3. Click Delete.

Windows Vista users have another way to add or remove common (not
custom) desktop icons:

1. Right-click anywhere on an empty area of the desktop, and then click
Personalize.

2. In the Personalization window’s left pane, click Change Desktop Icons.

3. Click next to the common desktop icons you want to appear or delete.
Selecting or deselecting the icon makes it appear or disappear, respectively.

4. Click OK.

You can add or remove these common desktop icons with this method:

Computer (or My Computer)

Network (or My Network)

Recycle Bin

Control Panel

Internet Explorer

Personal folders set up to hold your documents

An alternate way to remove any icon from the desktop is to right-click it and
then choose Delete from the menu that appears.
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Adding a shortcut to the desktop

Follow these steps to leave a shortcut:

1. Locate the item.

The item you want to shortcut can be a file, a folder, or a program. You
may find the item in the list of programs accessible from the Start
button, or by burrowing through the folders on your hard drive using
the My Computer (Windows XP) or Computer (Vista) or My Documents
(Windows XP) or Documents (Vista) mega-folder.

2. Use your cursor to highlight the item, then right-click with your point-
ing device.
3. Click Send To = click Desktop (Create Shortcut).

You can remove shortcuts from your desktop by dragging them to the Recycle
Bin or by highlighting them and pressing the Delete key. If you delete a short-
cut you remove only the pointer to a program or piece of data, not the item
itself. You can still start the same program other ways: from the taskbar, from
the Start button, from the folder on your hard drive, or by double-clicking a
file created using the program and set up to be associated with it.

Putting icons where you want them

If you allow Windows to do its own thing, it stacks icons in columns that
build out from the left side of the desktop. You can, however, change that
and move icons around yourself.

Do this to tell Windows to automatically arrange icons on the desktop:

1. Right-click an empty area of the desktop.
2. Click View = Auto Arrange.
To turn off that instruction, deselect the Auto Arrange check box.
Windows tries to keep your desktop as neat as possible, placing icons along
the columns and rows of a grid; the lines exist only in the computer’s inter-

nal map of the screen — you can’t see them. If you want a more free-form
arrangement or want icons closer together, turn off this feature.

To turn on or off the icon grid, do these things:

1. Right-click an empty area of the desktop.
2. Click View > Align to Grid.

If a check mark is already there, clicking Align to Grid turns off the grid (and
removes the check mark); if the box is empty, clicking turns on the grid.
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Selecting multiple icons
You have two ways to move or delete multiple icons in one step.

To highlight a group of icons next to each other (in the same column or row,
or in adjacent columns and rows), follow these steps:

1. Click an empty area of the desktop near one of the corners of the icon
group.

2. Keep pressing the left button and drag the mouse to draw a box
around all the icons you want to act upon.

3. Release the mouse button.

4. Click in the box of icons and drag them where you want them.
That could be another location on the desktop, to another folder, or to
the Recycle Bin.

To select more than one icon when they’re not next to each other, do this:

1. Click the first icon and release the mouse button.

2. Press the Ctrl key while clicking other icons you want to add to
your group.

3. Release the Ctrl key and then click once more with the left mouse button.
4. Hold the mouse button and drag the icons where you want them.

You can move them to another spot on the desktop, to another folder, or
to the Recycle Bin.

Hiding desktop icons
If you want to temporarily clear your desktop of all icons without actually
deleting them, follow along:

1. Right-click an empty area of the desktop.

2. Click View = Show Desktop Icons.

This clears the check mark from that option. To reverse this operation,
click Show Desktop Icons.

3. Highlight the file or folder you want to move.

4. Press and hold the left mouse button and drag the item from its cur-
rent location to the desktop.

5. Release the button to place it on the desktop.
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I can think of two very good reasons you might want to temporarily clear the
desktop of icons. One is to present a blank background if you're capturing a
picture of a program or file displayed on the desktop using Print Screen.
Another reason: to keep prying eyes from seeing the icons on your desktop.

Moving icons about on the desktop

It’s your desktop, and you can allow it to get as messy as you’d like. But by
default, Windows is going to try to make some sort of order from your chaos.
The standard arrangement is for icons to be stacked along the left side of the
desktop. You can rearrange icons by clicking and dragging them to a new
location anywhere on the desktop (except for the hot zones occupied by the
taskbar and the sidebar).

You can also instruct Windows to automatically perform housekeeping on
your desktop. If you’re running Windows Vista, follow these steps:

1. Right-click an empty place on the desktop.
2. Click View > Auto Arrange.

Your icons are neatly stacked along the left side of the desktop and
locked into place. To unlock them, click Auto Arrange again and clear
the check mark next to that instruction.

Note that Windows uses a built-in, invisible grid to align items on the desk-
top. If you want to be less rigid, or if you want to move items closer together,
click View and deselect Align to Grid.

The process is similar under Windows XP, although different terms are used:

1. Right-click an empty place on the desktop.
2. From the menu, select Arrange Icons By => Auto Arrange.

This places orders and locks items; to unlock them, repeat the process
and deselect Auto Arrange.

Bringing the desktop to the front

Once you start running programs or opening folders, the desktop can be
quite hard to find. It’s still there, but like your real desktop it’s completely
covered with stuff.

To quickly see the whole desktop without closing or manually minimizing
your open programs or windows, click the Show Desktop button on the
taskbar. To maximize (make full screen) all the programs or windows, click
the Show Desktop button once again.
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Exploring the Taskbar

A narrow ribbon of information is usually located at the bottom of the
Windows desktop. The ribbon is called the taskbar, and among its multiple
purposes is to show you which programs are running and allow you to
switch between them with a mouse click.

The taskbar is one of the most flexible Windows tools. You can place it just
about anywhere on the screen, make it appear and disappear on command,
and decide whether it takes precedence over work in progress or hides out
of the way until you need to use it.

You also can drag the taskbar to the top of the screen or to the left or right
sides. Right-click the taskbar and click Lock to hold it in place.

Managing the taskbar display

Right-click anywhere in the taskbar and then click Properties to display the
controls for how the taskbar is managed.

Click the check box to turn on or shut off any of these options:

4+ Lock the Taskbar. Prevents inadvertent or unwanted changes to settings.

4 Auto-hide the Taskbar. The taskbar appears any time you bring the
onscreen pointer to it, and hides when you’re working elsewhere
onscreen.

4+ Keep the Taskbar on Top of Other Windows. This ensures the taskbar
is always visible, even when you’re running a program in a maximized
(full-screen) window.

4 Group Similar Taskbar Buttons. All items opened with the same program
are grouped into one button on the taskbar.

4 Show Quick Launch. The Quick Launch bar makes it easy to point and
click your way to any open program.

The taskbar, left to right

The taskbar is made up of four sections:

4 On the left: The Start button is at the left end (when it’s at the bottom or
top of the desktop) or at its top (when it’s along one or the other side).
As part of Windows Vista, Start has been reduced to a colorful gumball
of an icon containing a stylized version of the red-green-blue-and-yellow
Windows flag; in Windows XP a less flashy flag sits alongside the very
obvious label “start.” The XP version looks something like this: .



Figure 1-3:
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4+ To the right of the left: The Quick Launch Toolbar holds icons that let
you load and run a program with one click.

4 The middle: This area lists open programs and documents, permitting
you to quickly switch between them with a click of the mouse. (Under
Windows Vista, machines powerful enough to deliver a Windows
Experience that includes Aero graphics display a thumbnail version of
what you see onscreen if you maximize that program.)

4+ The right: The notification area, appropriately enough, notifies you of
things you might want to know. These include a clock as well as icons that
convey the status of running programs (mostly utilities). For example,
look here to see if your antivirus program is enabled or to check if new
mail has arrived in your inbox.

An example of a slightly crowded Windows Vista taskbar is shown in Figure
1-3. At far left is the Start button, which opens the door to installed pro-
grams, the Control Panel, and other important elements. In the Quick Launch
area are icons that include Internet Explorer, AOL, Adobe Photoshop Album,
Microsoft PowerPoint Viewer, and others. The middle shows that Internet
Explorer and McAfee Security are running and folders for some of my lec-
tures and pictures are open on the desktop. The notification area at right has
utilities including a wireless network manager, a control panel for the laptop
touchpad, and the volume control for the built-in audio system. Just to the
left of the notification area is a Google search bar, an optional utility that
investigates the contents of your computer as well as the Internet.

Start button Running programs Google search bar

Quick Launch area Notification area

One of the beauties of Windows is that it allows you to have many programs
and utilities open and running, each in its own little space; otherwise, [ sup-
pose, the operating system would have had to been named Window. Saying
that all these programs are running at the same time, though, isn’t quite accu-
rate; instead the microprocessor has a case of electronic attention deficit. It
very quickly rotates its attention from one running application to another,
parceling out bits of time and energy as needed to keep each current. It all
happens so quickly that we slow humans don’t notice the tiny gaps.

smopuip Buiuadg



168 Exploring the Taskbar

Adding a toolbar to the taskbar

Windows Vista and earlier versions come equipped with a set of standard
toolbars, including Quick Launch and several others. As you enable certain
utilities (such as Windows Media Player) you may add the toolbar to the
available selection. Certain third-party applications may insinuate them-
selves into the list as part of their installation process.

You can, though, make your own choices here. It’s more than just a question
of your right to keep your life (and your taskbar) simple . . . or less complex
than it might otherwise be.

To adjust the list of enabled taskbars:

1. Right-click an empty area of the taskbar and choose Toolbars.
2. Click any item in the list to add it to the taskbar.

If you click an item that already has a check mark, you remove it from
the taskbar.

Feeling smart with the Start button

The Start button sounds very important, but some users hardly ever go
there. Once again, this is an example of Microsoft’s Department of Redundancy
Department. Everything on the Start menu can also be found at least one place
elsewhere and sometimes in four or five other places; whatever works best for
you is fine and dandy. Figure 1-1 shows you a Windows Vista Start menu; the
equivalent menu from Windows XP is shown in Figure 1-4.

Pinning it to the left

Clicking the Start button opens up the Start menu, which seems logical enough.
There you find a display that makes it easy to choose from the usual suspects.
Here’s what that means: In the upper-left corner of the menu is a space where
you can pin the program or application you want there. This space is separated
from the other icons by a thin, horizontal line.

Some users put their most commonly used programs there, like a word
processor or e-mail client; other users prefer to pin their most obscure appli-
cations here — the ones they have a hard time finding elsewhere.

To pin a program to this critical Start button corner, follow these steps:

1. Find the program icon anywhere on the computer.

The icon may be on the desktop, in a folder, or in the list of All Programs
that branches off the Start menu.

2. Highlight the icon with your cursor.



Figure 1-4:
A Windows
XP Start
menu.
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3. Right-click and choose Pin to Start Menu.

To unpin a program and free up space in the corner, highlight it where
you find it on the Start menu and then right-click to bring up the sub-
menu. Click Remove from This List.

Below the horizontal line on the left side of the Start menus is space for
other programs; the more items you pin, the less room you have for other
icons. In whatever space is left, Windows automatically places the most
recently used programs. If you have four programs pinned above the line,
you may have room for six or seven temporary listings below.

A nice little feature here: If you hover your cursor over an icon on the left side
of the Start menu, a little window pops up and describes what the program
does. (A handful of software companies don’t take advantage of this little
bonus, although I'm sure overwhelming demand from satisfied users will force
them to add a line of code in their next versions.) For example, if you hover
over Windows Sidebar (a component added to Windows Vista) you can read
the following: “Displays personalized slideshows, news feeds, and other cus-
tomized information on the desktop.”
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Figure 1-5:
Click All
Programs to
expand the
Start menu
into a listing
of all
installed
applications.
Some icons
hold a
submenu of
utilities and
settings.

Use the left panel of the Start menu in whatever manner makes the most
sense to you. You might want to pin ten programs there so you always know
where to find them. Or you might want to have no programs pinned and
instead know that you can always go to the Start menu to find the applica-
tions you most recently used.

At the bottom of the list of pinned or most recently used programs is the key
that unlocks the door to the grand list of installed applications and utilities
on your machine. For such an important key, it bears such a simple name: All
Programs.

Click All Programs and the Start menu blossoms into a full list, as you can
see in Figure 1-5. You may be amused, amazed, or disturbed by the number
of items that end up on the list over the lifetime of your laptop. But you'll
also appreciate knowing that the list is there.

Click any icon to open that program; some icons have a caret or arrow to the
right or left of its listing (depending on where the icon is in the list). Clicking
that icon opens a submenu of associated programs. For example, the sub-
menu may include an uninstall command or direct access to a utility for the
main program.
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Windows Vista has an added element at the Start menu’s bottom-left pane.
Enter a bit of relevant text into the box marked Start Search and then click
the magnifier glass icon. This leads you to a continually updated index of vir-
tually everything on your computer. (You can install a similar function to
Windows XP, although it won’t appear on the Start menu.)

For example, if you type PowerPoint (or powerpoint, or just power) into the
search box, the operating system would very quickly come back with a list
of all programs and utilities that include the phrase in their title, all files that
were created with any of those programs, all files that contain the word, and
all e-mails or e-mail headers stored on your machine that include the phrase.

Sticking it to the right

Move over to the right side of the Start menu. Here you find one-click access
to the main folders for documents, pictures, and music. You can also jump to
windows that open to a view of the contents of your hard disk drive as well
as network-connected devices in the Computer and Network windows (My
Computer and My Network Places under Windows XP). You also have access
to the personal folder, which bears the name of the person who’s currently
logged onto Windows; on my laptop, that is me, and that is why I see a Corey
Sandler folder as a Documents folder.

A Recent Items element appears in the Start menu'’s right pane. Clicking
Recent Items opens a list of files you have opened recently; the listing is
updated every time you open something else, with oldest files going away
first. Near the bottom of the pane is a quick jump to the Windows Control
Panel and to Windows Help and Support.

As with elements on the left side of the pane, hovering your cursor over one
of the items here should produce a pop-up window that describes the won-
drous things that lie beneath the simple names.

And finally, just to make things interesting for the very literally minded, Start
is also the doorway to Stop. By clicking the icon, you have access to the
Windows shut down, log off, restart, sleep, and hibernate commands. The
icons branch off the bottom-right corner of the Start menu.

Going out to launch

The taskbar area immediately next to the Start button holds the Quick Launch
toolbar. You can’t order fast food here; rather, you can launch (some might
prefer to say starf) any of a selected group of programs with a single click.

Your laptop may have come with one or more programs already listed in this
area. And some programs you add on your own may insinuate themselves
into place here, with or without your permission.
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By default, Windows XP and Vista installations have a Show Desktop button,
which does exactly what it promises — and in the process minimizes all
open programs (but doesn’t close or save open files). Vista adds a second
button, Switch Between Windows, which similarly does what you think it
would do. (Under Windows Vista, if your laptop has enough power to display
Aero graphics, Switch Between Windows displays a nifty onscreen image of
all open programs floating in space in an electronic effect Microsoft calls
Windows Flip 3D. It’s just for show, but a nice effect.)

<® Windows XP and Vista users can switch between windows by pressing the
Alt + Tab keyboard combination. Press the Alt key and tap Tab to switch
between open programs. It’s like playing a game of musical chairs:
whichever program is shown when you let go of both keys is maximized.

Follow these steps to add a program to the Quick Launch area:

1. Click the Start button.

2. Highlight the program in the Start menu.

3. Right-click with your pointing device.

4. Click Add to Quick Launch.
To accomplish the same thing, find the program on your desktop or in
any window, highlight it, and then drag it into the Quick Launch section.

To remove an icon from the Quick Launch toolbar, follow these steps:

1. Highlight the icon with the cursor.
2. Right-click the pointing device.
3. Click Delete.

You can resize the Quick Launch toolbar:

1. Right-click an empty area of the taskbar.
A submenu appears.
2. If there is a check mark next to Lock the Taskbar, clear the check mark.

3. Click the toolbar sizing handle and move it to expand or contract the
space.

The sizing handle appears when you hover on the toolbar’s border and
is a double-headed arrow.
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Making the most of the middle

The taskbar is designed to display all open programs or files, but if you run
multiple programs, sooner or later you're going to run out of real estate. The
taskbar first shrinks the display section for each program and squeezes a
few more across. Eventually, though, it uses one or both of a pair of space-
saving techniques.

Assume you're running Microsoft Word, for example, and have three sepa-
rate files open for editing. When the taskbar has no more space, it stacks all
three icons under a single program name. Clicking the button shows you the
names of each open file, and you can then choose one to jump to. Windows
does this for any group of similar items: multiple images open for editing
under Paint or another graphics program, for example.

To close all the items in a group, right-click the group’s taskbar button, and
then click Close Group.

The other way the taskbar deals with too many demands on too little space?
It expands vertically into a hidden space. I'm not talking about magic here;
instead, the operating system adds a set of arrows (2)) at one end of the
taskbar to indicate that you can display more items. Click the arrows to
open a display.

Keeping track of your windows

Any time you open a program, folder, or a document, Windows adds a button
and icon to the taskbar. You can quickly see what programs are running and
which folders are open. Every open program, utility, or process eats up
somewhere between a tiny bit and a significant amount of your machine’s
processing power. It also demands a chunk of available RAM. Add to that the
very large demands of Windows itself.

The good news is that modern laptops have very powerful processors and a
lot of memory; the not-so-good news is that sooner or later your machine is in
danger of slowing down because too much is going on for it to handle grace-
fully. If you’re not using a program that demands a lot of resources (graphics
editors and games are among the biggest hogs on the lot), close it down.

Each button shows the icon and the name of open programs. As you open
more programs, the amount of space devoted to each is automatically
reduced and the program name may be cut off from view; to read the full
name, hover your onscreen pointer over each button.
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Figure 1-6:
A thumbnail
of an
Internet
pageona
Windows
Vista
taskbar.

Any active programs appear indented, as if they were pushed in. To switch
from one program to another — changing it to active — merely click its
button. Conversely, when a program is active, clicking its taskbar button
makes it inactive and minimizes its window. Minimizing a program or folder
doesn’t close it or delete its contents or insult its sense of pride in any way;
it merely removes it from the desktop and drops it down to the taskbar.

Windows Vista Aero preview

One of the interesting bells and whistles of Windows Vista — available only
in Premium versions of the operating system and only if your laptop has suf-
ficient graphics horsepower and available memory to display the specialty
Windows Aero features — is the taskbar preview, also known as a thumbnail.

If your laptop meets the necessary “ifs,” when your onscreen pointer hovers
above a taskbar button, a miniature picture appears of what lies beneath. If
it’s a word processor, you get a tiny view of any open document. If you have
a graphics editor running, you can check in on the image. And the neatest of
all: If one of your windows has a video or animation running, you can sneak
peeks at it in the thumbnail view. See Figure 1-6.

Windows Vista Aero 3D desktop tiles

Windows Vista Home Premium, Business, and Ultimate editions users get a
special treat — again, only if your system is robust enough to display Aero
graphics. It’s called Windows Flip and Windows Flip 3D, and they’re as cool
as a snow cone in an ice storm . . . in a technogeeky kind of way.

Windows Flip lets you flip through images of all your open windows and fold-
ers. And Windows Flip 3D, well, it does the same thing only in something that
is about as close to 3D as you can currently hope for on a 2D display.
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Windows Flip is a Windows Vista update of a similar but much less flashy

P way to move among open programs and folders: Press Alt and tap the Tab
key. Let go of the Alt key to switch to whichever window is highlighted
within the box. See Figure 1-7 for a view of the Windows XP version. The
arrival of Windows Aero technology allows live thumbnails instead of icons.
And the most advanced version, Windows Flip 3D, shows not only thumb-
nails but live processes such as streaming video. On an Aero-capable
machine, press and hold the Start key and then tap Tab to move through
open windows. See Figure 1-8.
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Notifying your intentions

Look to the notification area for messages of support, notices of threat, and
the time of day. This section of the taskbar delivers important status
updates, regularly updated by your essential utilities.

When you hover your cursor over an icon in the notification area, you see
the name of the utility it represents and (in some designs) a quick report:
Your antivirus program is enabled, you have new mail in your inbox, a WiFi
signal has been detected, or your toast is burning. (The toast monitor isn’t
available in all areas and is subject to federal restrictions on air quality,
gluten content, and your willingness to let this one slide by.)

Double-clicking an icon in the notification area usually opens the utility or a
report generated by it. For example, the antivirus program may report on
the status of all of its components or it may open the entire application so
you can run scans or change settings.

Some items in the notification area are there just to alert you to something.
For example, if you plug a device into a USB port on your laptop, a message
may pop up to tell you that your system has recognized and is ready to use
the device, or that it has detected a new device and needs to configure itself
to accept it.

If you (or the laptop computer) don’t use a particular item in the notification
area for a while, the system automatically stops displaying its icon. The util-
ity is still there and still available; it’s just hidden until you use it next. If you
want to see all possible icons, click the Show Hidden Icons button, a small
left-facing chevron like this: <.



Chapter 2: Using Built-in Window's
Applications and Gadgets

In This Chapter

v Gadgets, widgets, and doodads

v Editing text without a word processor
v+~ Painting a picture

v Getting those nice, bright colors, without Kodachrome

erdows, in any of its versions, isn’t intended as a program all by
itself; it’s an operating system that constructs the framework for

applications to run. Most users start out with Windows and install a word
processor, a graphics program, a spreadsheet — just about whatever you
want to use your computer for.

That said, from the very beginning, Microsoft has included a set of simple
software as part of its operating systems. No one would confuse the basic
functionality of WordPad — the “free” text editor included with Windows —
with the amazing set of features in the extra-cost Microsoft Word program.
The same applies if you compare the included Paint utility to the spectacu-
lar facilities of Adobe Photoshop.

However, you could write an entire book using WordPad and you could draw
a picture in Paint. It wouldn’t be quite as easy, and most users eventually
find they need the extra power and features available only with products
sold separately.

On the other hand, sometimes the mini programs included with Windows
are so quick and nimble that they offer advantages over gigantic multipur-
pose programs. One quick example: The easiest way to store a copy of a
screen capture (a picture of something that appears on your screen) is to
press the Print Screen button on your keyboard, paste the image into Paint,
and save it as a file.

Inspecting Your Gadgets

Gadgets were amongst the bells and whistles that arrived with Windows
Vista. You can add these mini programs to your desktop for highly special-
ized functions. Earlier in this book I cite the example of keeping a continuous
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Figure 2-1:
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Vista
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tracking
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exchange,
the stock
market, and
today’s
calendar.

eye on weather in a remote location; parents like me who have children living
away from home understand the appeal. You could also track

4 An airline flight
4+ Astock

4 The price of a doodad in an online auction

For the record, Apple introduced the concept of Gadgets — they call them
widgets — a few years before Microsoft proved the adage that imitation is
the sincerest form of flattery.

You can turn on or off the display of Gadgets at any time, and customize them
with selections from one supplied with Vista or added from other sources. A
sample of some of the Gadgets on my system are shown in Figure 2-1.

The Gadgets generally reside in a newly staked-out area of the desktop that
is called the Sidebar. As you no doubt guessed, that means a vertical strip
that parks at one side of the screen; the standard position is at the right
side, although you can put it on the left. You can detach Gadgets, though,
from the Sidebar and allow them to free-float.
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The base set of Gadgets that comes with Windows Vista offers a bit of

4+ Weather

News

A photo viewer
Web clips

A to-do box

A calendar

R

A desktop search box

As the operating system matures, Microsoft will likely add to the standard kit
through updates.

You can change the order of Gadgets within the Sidebar by grabbing hold of
its handle by clicking it with the onscreen pointer and dragging it to a new
location.

Some Gadgets include a + to indicate that you can expand them with a fly-out
that provides additional information or customization. For example, a stock
ticker may fly out with more details of averages or specific trades. Other
fancy features include a weather Gadget, such as one based around
AccuWeather.com, that warns of severe weather. (As I'm writing these words,
that particular Gadget on my laptop is warning me of high winds tonight;
time to go out and tie down the garbage cans.)

You can’t adjust the width of the Sidebar; Windows sets that. Depending on
your laptop LCD’s width and aspect ratio, it usually spreads about an inch
off the right or left border of the screen.

Configuring the Sidebar

The key to adjusting the Sidebar’s appearance and operation is the Sidebar
Properties window; you can get to it with these steps:

1. Click the Start button.

2. Type Sidebar Properties into the search panel.

Another way to the same window: Click the Sidebar Properties icon in
the Control Panel.

The properties window includes a direct link to a set of help screens;
click How Do I Customize Windows Sidebar? for answers to frequently
asked questions, as well as a few you might not have thought to ask yet.
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Closing and exiting the Sidebar
Closing the Sidebar is equivalent to minimizing a program; the various

Gadgets are still active and continue to occupy slices of your computer’s
processing time and memory. However, the Sidebar disappears from view.
1. Right-click the Sidebar.

2. Click Close Sidebar.
Do this to open Sidebar again:

1. Right-click the Sidebar icon in the notification area of the taskbar.
2. Click Open.
Exiting Sidebar closes the utility and all its Gadgets. It also removes the
Sidebar icon from the taskbar.

1. Right-click the Sidebar icon in the notification area of the taskbar.
2. Click Exit.

Keeping the Sidebar and Gadgets on top of other windows

If you want to keep an eye on the various Gadgets in your Sidebar while
working on other things — that is, of course, the purpose of Windows —con-
figure it so it permanently occupies one side of your screen even when other
programs are maximized.

Running applications expand up the outside vertical border of Sidebar.
To keep the Sidebar on top, follow along:

1. Choose Start => Control Panel Open Windows Sidebar Properties.
Or press Start and type Sidebar Properties into the search panel.

2. Select the Sidebar Is Always on Top of Other Windows check box.
A check mark appears there.

3. Click Apply.
To change this setting, click again to remove the check mark.

You can also toggle the Sidebar between being topmost or lower down
by pressing @ + spacebar.
A\
A permanently displayed Sidebar works especially well if your laptop has a
widescreen LCD.
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Figure 2-2:
To setup
your Gadget
display,
choose from
the set of
installed
mini
programs.

181

Inspecting Your Gadgets

Adding or removing a Gadget

To add a Gadget to the Sidebar, you have to first install the Gadget on your
computer — either as one of the default mini programs that ships with
Windows Vista or added from another source. An example of a gallery of
installed Gadgets is shown in Figure 2-2.

To add an installed Gadget, follow along:

1. Right-click the Sidebar.
2. Click Add Gadgets.

The gallery of available Gadgets appears.
3. Double-click a Gadget.

You can add two or more of the same Gadget to the Sidebar. (You might
want to check on weather in two places at the same time, for example.)
Just add the Gadget multiple times.

It appears on the Sidebar.
Remove an element from the Sidebar this way:

1. Right-click the Gadget.
2. Click Close Gadget.

1 Pagelofl » | Search all ¢

Calendar Clock Currency Feed Headlines
Notes Picture Puzzle Weather
Contacts 1.1.0.0
See a list of Windows contacts, search for a contact, or select a contact to My Microsoft Corporation
see e-mail address and phone numbers. K ©2006

Windows' www.gallery.microsoft.com

(4 Hide details & Get more gadgets online
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Putting a Gadget elsewhere on the desktop
You might prefer to detach a Gadget and place it as a free-floating item on

the desktop:
1. Right-click the Gadget.
2. Click Detach from Sidebar.

3. Drag the item where you want it to be.
To return a detached Gadget to the Sidebar, do this:

1. Right-click the Gadget.
2. Choose Attach to Sidebar.

Changing individual options for a Gadget

Certain Gadgets allow you to change their own settings. For example, a
weather report may offer you the choice of displaying temperatures in
Celsius or Fahrenheit; a stock ticker may permit you to choose particular
indexes or individual equities to track.

To change a Gadget’s options, do this:

1. Right-click the Gadget.
2. Click Options.

If you don’t see that choice, you can’t personalize the Gadget this way.

Getting more Gadgets

Microsoft has opened up the code for Gadgets, and you can expect all sorts
of offerings from amateurs and professionals. It used to be that the differ-
ence between those two was that the former worked for free, but that isn’t
always the case today. Some amateurs offer their work as shareware, seeking
contributions from users; some professionals offer free products (freeware)
that promote their web sites or other products they’re selling.

Microsoft has established Live Gallery and stocked it with some intriguing
Gadgets. You can visit it at http://gallery.live.com. See Figure 2-3.

One thing is certain: You must be very cautious accepting and running any
Gadget that comes from a source you don’t know and trust. It’s very easy for
someone to insert a virus into a Gadget. Your antivirus program should be
able to detect such nastiness, but why take the chance?



Figure 2-3:
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Sweating the Small Stuff: Text Editors

What'’s in a word? Or in Word? Or WordPad?
Oh, and let’s throw in Notepad while we’re at it.

Well, they’re all text editors, allowing you to create documents that you can
read, edit, print, and give to others in electronic form. A text editor is a basic
manipulator and storage mechanism for characters, words, and symbols. All
the way over at the other end of the spectrum is a word processor, which
does the same thing but adds a dizzying array of special features to allow
you to format, design, research, and otherwise automate the process of
preparing a document. (Just about the only feature missing from a word
processor is the one I really would love to see: a button that says “Press here
to have the computer finish this chapter for me.”)

In theory, I could have written this entire book using WordPad or the even more
fundamental Notepad. It would have been a slog, but it could have been done.

Wrap your mind around this for a moment: All word processors are text editors,
but not all text editors are word processors.

Book I
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[ can think of all sorts of analogies to explain the difference between a text
editor and a word processor: You could

4+ Dig a swimming pool with a spoon or a backhoe.
4+ Get from Boston to San Francisco on foot or by jumbo jet.

4+ Cook a six-course meal using a wood fire and one tin plate or on a grand
stainless-steel restaurant stove with eight burners, a griddle, an oven,
and a built-in electronic sous-chef in the drawer.

But if you're already familiar with the capabilities of a computer when it
comes to managing documents, displaying fonts and pictures, and its
modern direct connection to the World Wide Web (the “old” name for the
Internet), then here’s one more somewhat self-referential set of analogies: a
text editor is like a pencil with an eraser. With that tool you can write, you
can make changes, and you can draw stick figures. It’s very easy to use
(Have you ever studied the instruction manual for a pencil?) and cheap.

A word processor? Well, it’s got those same pencil and eraser features. But it
also adds some fantastic power tools. If William Shakespeare had access to
Microsoft Word, he might have written 100 plays instead of a mere 38. (And
he could have cleaned up his spelling and grammar and maybe annotated
his work with references to contemporary culture and classical texts.)

Here are some of the features of a typical word processor:

4+ Fonts, sizes, styles (normal, bold, italic, and the like), and colors

4+ Management and application of styles to chapter and section heads as
well as blocks of text

+

Advanced layout of text including columns, embedded art, headers and
footnotes

Spelling and grammar checkers
Dictionaries and thesauruses

Indexing and tables of content generators

. s+

Mail-merge and form-letter functions

You can easily use Microsoft Word as an example of a word processor because,
well, almost everyone uses it. Microsoft Office (which includes Microsoft Word)
owns about 75 percent of the market. Would-be competitors, which include
Corel’s WordPerfect Office and Apple’s iWork, are quite capable products. ..
and they essentially mimic or duplicate Word'’s features, as well as its look and
feel.
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Word processors have three important disadvantages:

4+ In most cases they’re not free. You have to pay for the right to use the
program either as a component of the package that comes with your
laptop or as a product you install on your machine. That said, free or
shareware word processors are showing their faces.

<® Among the more intriguing word-processing freebies: Google Docs from the
people at Google (you guessed that, right?), which allows you to use a
word processor and a spreadsheet that reside on a computer somewhere
out there on the Internet. You can save your files in a free account at
Google, or store them on your local hard disk drive. And you can share
files from one machine to another because Google Docs can store files in
the Microsoft Word format, as well as other formats including RTF, PDF,
and Open Office (a shareware product). Google will eventually seek to
make money through the sale of ads, which may or may not bother you.
On the plus side, you won’t have to install a word processor on your laptop
or bother to keep it updated if you use their application over the Internet.

4+ They’re complex. Over the years, word processors have added more
and more features; some call it bloatware. The fact is that most people,
including professional writers who spend nearly every waking moment
of the day in front of a keyboard, use only a tiny fraction of the available
features of a word processor.
Book llI

The good news is that Microsoft (yes, the company with the overwhelm- Chapter 2

ing market share) has begun to rethink the way in which it offers all of
those tools. You will now find context-sensitive menus that pop up with
the click of the right mouse button, and the most current versions of
Microsoft Office (beginning with the 2007 edition) also present a chang-
ing selection of commands at the top of the screen; the computer
attempts to anticipate your needs based on the sort of work you're
doing. All the functions are there, but they’re not all waving their hands
for attention at the same time.
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4 Files tend toward large. Because word processors include all sorts of
information about things like formatting and styles and multiple versions
of a file or changes proposed by other users or accepted by the original
author, a simple document can be quite large. Again, Microsoft has begun
to address this with the latest versions of its Office suite. But in any case,
a word-processing file will, by definition, be larger than a text-editing file,
even if they contain the exact same number of characters.

Notepad

It’s better than a typewriter. And it’s almost as easy to use as a pencil and
paper. You can type, move, print, store, and transmit characters to other
users. You can’t, though, get fancy.

It served a purpose — and for some users still does —where all you want is
the information. Just the characters, ma’am. (See Figure 2-4.)
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Figure 2-4:
Notepad is
the most
basic of text
processors,
supplied
with all
current
versions of
Windows.
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1| Untitled - Notepad =S
File Edit Format View Help

Notepad includes only the
most basic of functions.
Any formatting applied to a
single character or block of
text is assigned to the entire

file.

Notepad works very well in writing programs, creating notations for online
calendars, or for those people who can appreciate the fact that a Notepad
file of several hundred words can demand only a few hundred bytes within a
container of 4KB; an equivalent WordPad file requires twice as many bytes,
while the functional minimum size for a Microsoft Word file — even one
made up of a single character — will be a minimum of 12KB and often larger.
Notepad saves its files as a plain text document, helpfully labeled with a *.txt
filename extension.

Does size really matter any more? Yes and no. Today’s hard disk drives are so
large, with prices dropping by the minute. The difference in overhead between
a single Notepad file and a single Word file isn’t going to make any noticeable
difference. However, if you think about the contents of your computer in its
totality, a few thousand bytes saved here and there will quickly add up to
megabytes and gigabytes. Less is more; your machine will run more efficiently,
and you’ll help save the planet. (Think of the volts you will set free.)

Opening Notepad

You can open Notepad several ways:

4+ Click the Windows Button > All Programs > Accessories = Notepad.
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4 Click a shortcut to Notepad that you created on the Desktop, or that
you pinned to the Windows Start menu. If you've recently used
Notepad, a temporary shortcut already exists on the Start menu. Book
Ill, Chapter 1 tells you how to create a desktop shortcut.

4+ Double-click the file created with Notepad. If your computer has been
instructed to associate the file type TXT with Notepad, it opens that
program. If you have another text editor (or a word processor like
Microsoft Word), the file may instead open in that program. See Book
I, Chapter 4 if you’d like to change an association.

Jumping to a line

Actually, you can trace text editors one step back on the evolutionary path.
The very first computers processed programs and accepted data one line at
a time; data coming in or out was presented on numbered lines of a speci-
fied length. The first crude tools for working with the data were called line

editors.

Buried deep within Notepad are some of the vestiges of a line editor. The
program keeps track of information as if each line were a separate entity.

And therefore, even though the document you’re working on may not have

numbers on each line, you can jump to a particular line if you calculate its

position in the document.

Take a note

Notepad is a holdover from the very early days
of computing, back when machines dealt only
with characters and not pictures. Quick lesson:
Early computers assigned a number (called an
ASCII code, if you must know) to each of the
characters on the keyboard as well as a number
of special purpose symbols.

So, an uppercase Awas noted with the decimal
value of 65. Computer video cards knew that
when they saw a 65, they were to look up in an
index a predefined picture of an A. Computer
printers worked in much the same way, con-
verting a string of numbers into a command to
print an A. Early computer printers were

basically electric typewriters that accepted a
string of numerical commands; you might be able
to change the font by switching the type ball or
other mechanism to produce a character.

Today, though, Windows is a GUI. And as a
graphical user interface, the image you see on
screen or in hard copy from a printer is no
longer (as far as you're concerned) based on
numerical codes but instead on a map of dots in
the computer’s memory; to draw an A, the com-
puter does the equivalent of blacking in the
proper spots on a grid. And that grid can be
manipulated: converted to boldface or italics or
colorized almost without limit.

Book IlI
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Figure 2-5:
Choices of
fonts and
styles within
Notepad are
applied to
the entire
file, not to
individual
characters
or words.

Jump to a specific line in a document this way:

1. Choose Edit > Go To.
2. In the Line Number box, enter the number you want.

For example, to go directly to the ninth line of the document, type 9.
3. Click OK.

The deed is done.

Setting font style and size

Think of Notepad as a box of characters with a simple set of instructions on
the label. You can assign any font available on your computer, choose a style
such as italics or boldface, and pick a size. (See Figure 2-5.) So far, that
sounds sort of like the way a word processor works.

But here’s the difference: Whatever font, size, and style settings you make
apply to all the text in the Notepad document. No menu bar offers quick
choices for fonts; make settings by clicking Format => Font. From there you
see the list of available fonts and styles.

3 nited Notepad =8l % )
Selecting a font and style from within
Notepad.
rFont ﬁ‘
Font: Font style: Size:
jozramond Bld % [ ok ]
e e R 2 | Comed
() French # ipt MT Bold W26 |
Garamond Bold Ralic 28
Gautami 36 £
0 Georgia ‘ 48
| O Gisha i fI| | 72 7|
Sample
EaBbYVZ
Script: .4
=3 Westem - F—‘
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Special functions
Notepad includes basic cut-and-paste facilities. As with other text editors,
the process works much the same way:
1. Select text.
2. Click the Edit menu.
3. Choose based on your needs:
e Cut. To remove the text and place it in memory for insertion elsewhere.

¢ Copy. To leave the text where it is but store a copy in memory for
use elsewhere.

e Paste. To put text from memory into a document.

To back out of a cut-and-paste operation, click Edit => Undo.
Or, you can use keyboard commands to accomplish the same tasks:

4+ Ctrl + X to cut text.

4+ Ctrl + C to copy text.

4+ Ctrl + V to paste text.

4+ Ctrl + Z to undo the cuts, copies, and pastings.

Other available functions include Search and Replace, available from the Edit
menu.

And, as with WordPad, Microsoft programmers have blurred the distinction
between text editor and word processor a little bit by adding headers (lines of
text at the top of every page) or footers (text at the bottom of printed pages).

To create a header or footer, follow along:

1. Click File => Page Setup.

Both a Header and a Footer box appear. Default settings place the file-
name at the top of the page and a page number at the bottom.

2. Enter text.
You can use just the text you enter or use it with special characters that tell

the system to insert specific information. The codes in the following table
are some of the most common within headers and footers.
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Insert the date (from the computer calendar) &d
Insert the time (from the computer clock) &t
Insert the name of the file &f
Insert the page number &p
Align the header or footer flush left or flush right &l or &r
Center the header or footer &c

WordPad

You want free text editing that comes pretty close to offering the basic func-
tionality of a word processor? Every owner of a laptop running current ver-
sions of Windows can find a copy of Microsoft’s almost-ready-for-prime-time
text editor, WordPad.

Not all that long ago in the history of personal computing, WordPad
would’ve been considered a pretty capable word processor. Now it sits
somewhere between a simple text editor and one of the big boys.

WordPad documents can

4 Include complex formatting and graphics.
4+ Link to or embed objects such as pictures or other documents.

4+ Save your files. Files can be saved in RTF (Rich Text Format) and later
imported and converted for use within most other word processors,
including Microsoft Word. And you can use WordPad to open most Word
files, but you can’t re-save them in Word’s DOC or DOCX formats.

4+ Let you reopen and edit files.

4+ Print.
WordPad is more advanced than Notepad, but what does it lack? In two words:
bells and whistles. It has no spell checker, thesaurus, or grammar utility. You've

got to jump through a lot of hoops to work with images (as objects created in
other programs and brought in). And you can’t create tables.

Truth be told, though, WordPad is perfectly adequate for note taking and
even preparing simple documents.

Opening WordPad

WordPad is included in the standard set of accessories installed with
Windows. You can open it in several ways:

4 Click the Windows Button = All Programs => Accessories = WordPad.
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4+ Click a shortcut to WordPad on the Desktop, or on the Windows Start
menu. If you recently used WordPad, a temporary shortcut is already on
the Start menu. Book IIl, Chapter 1 tells you how to create a desktop
shortcut.

4+ Double-click the file created with WordPad. If your computer has been
instructed to “associate” the file type (RTF, TXT, or Unicode) with
WordPad it will open that program. If you have another text editor (or a
word processor like Microsoft Word) the file may instead open in that
program. See Book II, Chapter 4 if you’d like to change an association.

Creating a document in WordPad
To open a new document, do one of these things:

4 Click the new blank document icon on the toolbar.

4 Click File = New.
From the list of document types, choose from these types.

4+ Rich Text Document. This simple text file that includes codes for for-
matting and styles that can be used or converted by most other text edi-
tors and word processors. If you were to read an RTF file in a text editor,
you might see a line like this:

This sentence includes a {\b bold} word, enclosed within
curly brackets and indicated with a \b.

Onscreen in a word processor or printed out, the sentence looks like this:

This sentence includes a [BOLD]bold[UNBOLD] word, enclosed
within curly brackets and indicated with a \b.

4+ Text Document. In theory, a plain text file is just what it sounds like;
plain text, unadorned with any formatting or fonts. The original idea was
that files would be like typewritten text, without any emphasis or for-
matting other than paragraph marks and spaces; over the years, though,
some simple formatting and choice of fonts has been allowed. The let-
ters, though, are all simple Roman characters. Plain text files are per-
fectly adequate for composing messages that you’ll cut and paste into
an e-mail program or are used just as notes.

4 Unicode Text Document. This file type is for use with nearly any lan-
guage, not just the Roman characters of English. WordPad stores these
files using a format called UTF-16, which many other programs can use.
Unicode files allow simple formatting, including choice of fonts and
emphasis including boldface, italic, and underlining.
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Which file format should you use? For most people, the best choice is RTF. A
Rich Text Format file should be readable by almost any other text editor or
word processor.

Click View => Options to instruct WordPad whether the words you write should

4+ Wrap at the end of the displayed window

4+ Wrap at the end of the ruler on the page

4+ Not wrap at all
Most users find it much easier to work with a file that wraps the text to the
ruler or the displayed window. For certain technical uses, including writing a
program or preparing code for a web site, you may need to turn off wrapping

so that the file that is created is a pure text file. To read a file like this, scroll all
the way to the right until you reach the end of a sentence (or the entire file).

The settings you make for word wrapping affect only how the text appears
on the screen and in the raw file itself. If you printed from within WordPad or
another text editor or word processor, it would automatically format the
lines of characters to fit on the printed page.

Opening an existing WordPad document
To open a file previously created and saved using WordPad, or to open a file

created in another program but stored as an RTF, TXT, or Unicode file, do this:
1. Click File Menu => Open.
2. Click the file you want to work with.
3. Click Open.

Saving a WordPad document
When you’re ready to put away a file you created, follow these steps:

1. Click File = Save.

2. Enter a filename in the highlighted space.

3. If you want to change the file type, click the Save as Type arrow.
The file-type options appear.

Even though you were asked the type of file you want to create when you
began working on the file, you can save the document in a different format.

You can enable the Automatically Save All Files as a Particular Type By
Default check box.
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4. Ensure the name in the filename area is what you want.

If you want a different name than one it had before, change the entry
under filename before saving.

5. Click OK.

Printing a WordPad document
WordPad integrates with the settings you made for printers on your laptop.
If Windows knows of a printer and you properly installed its driver, you can
create a hard copy of a file created in WordPad:
1. Click File = Print.
2. Go to the General tab.
3. Select the printer you want to use.
You can add a printer if the one you want to use doesn’t show up.
4. Choose the range of pages to print:
e All
¢ Pages (ranging anywhere within the document)
e Current Page
¢ Just the highlighted block of text

To see what your document will look like when you print it, click File =
Print Preview. Click Close to return to the document.

5. Click OK.

Finding and replacing words

Why does a text editor include a relatively sophisticated function like find
and replace? Just like car manufacturers, programmers can’t keep their hands
off their work; with each new version of WordPad (and as of the release of
Windows Vista, there’ve been six major and many minor revisions), they pack
more and more into the box.

Anyhow, WordPad has a basic search-and-replace function. To find a word or
a particular group of characters in the file, do this:

1. Click Edit => Find.

2. Type the characters you’re looking for in the Find What box.

3. Click Find Next.

Book I
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To move past the first “find” and continue searching, click Find Next or
press F3. You can keep doing this until you reach the end of the file.

To replace specific characters or words, do this:

1. Click Edit > Replace.

2. Type the characters you want to locate in the Find What box.

3. In the Replace With box, type in the text you want to insert in its place.
4. Click Find Next.

5. When the text you want to replace appears, click Replace.

To replace all instances of the searched-for characters, click Replace All.

Embedding or linking objects in WordPad

Embedded objects (including images and other files) in a WordPad document
become part of the file.

4+ The good news is that if you give or send someone a copy of the file, the
embedded material will accompany it.

4+ The possibly bad news is that if you change the original object after
embedding it in a file, that change isn’t reflected in the WordPad docu-
ment. That is, unless you remove the original embedded object and
replace it with the changed one.

An object also can look as if it’s part of your file if you link to it. When you
link an object, the object remains in its original location but a reference to it
is created in the WordPad file.

4+ If you change an object that’s linked to a WordPad file, the changes
appear in the document when you view it onscreen or printed out.

4+ However, if you give or send someone a WordPad file that includes a
link, you have to send along a copy of the original object (or embed the
final version of the object in your document).

To embed or link an object, follow the following path:

1. Click Insert => Object => Create from File.
2. Type the path and filename in the File Box.

Or click Browse and find the file you want to embed or link.
3. To link to an object, click the Link check box.

If you want to embed the object, make sure the Link check box is cleared.
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You can also embed an object by creating or opening it in its original program
and using the Copy = Paste command. Similarly, you can link an object by
choosing Copy = Paste Special.

Formatting text
WordPad allows basic formatting, including font sizes and emphasis includ-
ing italics, boldface, and underlines.

The simplified menu bar at the top of the document is one of two pathways to
assigning formatting; you can find pull-down menus for font, size, and text
encoding. If you don’t know what text encoding is, that’s because you're so . ..
Roman. No, I don’t mean you're of Italian heritage (not that there’s anything
wrong with that).

The English language, along with most other forms of written communica-
tion, uses a character set based on Roman (sometimes called Latin) letters.
In the world of Microsoft, Roman is sometimes called Western, which is a bit
less precise. The other options for encoding offered by WordPad are Arabic,
Baltic, Central European, Cyrillic, Greek, Hebrew, Turkish, and Vietnamese.
Why no Japanese or Chinese or other such languages? Well . . . there are ways
to construct characters in those languages but they’re based on adaptations
of the Roman keyboard.

Until and unless you instruct your computer (actually, your operating
system) that you'll be working with a non-Roman character set, WordPad
always puts you back in the Western World.

Surprisingly, WordPad’s paragraph-alignment function is actually a bit easier
to use than the similar facility in some word processors:
1. Click anywhere in the paragraph you want to align.
You don’t need to highlight all the text in the paragraph.
2. Click Format => Paragraph.
See Figure 2-6.
3. Click one of the options in the Alignment section:
o Left
¢ Right

e Center
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Figure 2-6:
WordPad
includes the
basics of
most word
processing;
think of it as
bells but no
whistles.
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The WordPad text editor that is included with current versions of

Microsoft Windows offers a good range of basic writing and editing
tools.

You can choose fonts, add emphasis,
or change type size.

Basic formatting includes
alignment of text jand bullets.

Files can be saved as:

* RTF (Rich Text Format)
e Text

Text (MS-DOS), or
Unicode Text

Far Help, press F1

Similarly, to indent a paragraph, follow along:

1. Click anywhere in the block of text.
2. Click Format => Paragraph.
3. Enter a measurement in the Indentation section.

The measurement should be in inches for the amount of space you want

to the left or right (or both sides) of the paragraph. You can also choose
an indent for just the first line.

To set or remove tab stops in paragraphs, follow along:

1. Select the paragraphs you want to work on.
2. Click Format > Tabs.

3. Type a number in the Tab Stop box.

The measurement can be in inches or decimal fractions of an inch.
4. Click Set.

A new tab stop is created.
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To delete a tab stop, do this:

1. Select the paragraphs you want to work on.
2. Click Format => Tabs.
3. Click a tab stop it in the list.
4. Click Clear.
To clear all tab stops in the selected paragraph, click Clear All.
Another way to set tab stops is to click where on the ruler you want them. To

delete tab stops, click the marker for the tab and hold the mouse button down
as you drag it off the ruler. On the ruler, a tab stop looks like an egg timer.

Manipulating Images

[ don’t know much about art, but I know what I like. On my not-too-short list
of masterpieces is an astounding photograph of Pablo Picasso taken way
back in the prehistoric era. The summer of 1949, to be precise. In the photo
by Gjon Mili, Picasso sketches a phantasmagoric centaur in the air using a
flashlight. This was 40 years before PhotoShop existed as a noun, a verb, or
a computer program. But the concept remains the same: drawing with light.

The big guys:

4 Adobe PhotoShop. The Bigfoot of the image industry. It’s by far the
most popular power tool for photo editing and for painting with light
(think of your onscreen cursor as Picasso’s flashlight).

4+ Picasa by Google (free).
4+ Paint Shop Pro Photo by Corel.

A number of basic programs are included with the purchase of a digital camera.

If you're going to get serious about using a digital camera, creating your own
artwork, or capturing images of the screens you see (or the contents of Web

pages), you need to add a capable image-editing program. But the wizards of
Microsoft will get you started with a pair of basic tools included with current
versions of Windows:

4+ Paint
4+ Windows Photo Gallery (part of Windows Vista)
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Paint

Pure and simple, Paint allows you to open most existing digital images and

4+ Convert to another format
4+ Change size
4 Make simple resolution adjustments

4+ Draw on a picture (just like — well, almost like — Picasso)
On the painting side, the program offers a small set of tools including

4+ Paint brushes
4+ Pencils

4 Airbrushes
4+ Erasers

4+ Text

You can create your own masterpiece from scratch, or draw a mustache on a
photograph of the Mona Lisa.

Opening Paint
Paint is in the standard set of accessories installed with Windows. You can
open it in either of these two ways:

4+ Click Windows Button => All Programs => Accessories = Paint.

4+ Click a shortcut to Paint that you have created on the Desktop, or that
you have pinned to the Start menu of Windows. If you recently used
Paint, a temporary shortcut already exists on the Start menu.

To open an existing image stored on your laptop or on an attached networked
device, click File => Open. You can do this in one step by pressing Ctrl + O.

By default, the program looks for images in the Pictures folder that is set up
with the installation of Windows. But you can navigate to other folders by
clicking one of the Favorite Links shown on the left side of the Open screen.

Paint works with most common current file formats:

4+ BMP. Bitmap files stored with a .bmp or .dib filename extension.

4+ JPG. JPEG compressed images with a filename extension of .jpg, .jpeg,
.jpe, or jfif.

4+ GIF. GIF compressed images with a .gif filename extension.



Figure 2-7:
From within
Paint, you
can open
stored
images of
the proper
file type for
manip-
ulation.
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4 TIFF. Uncompressed TIFF files with a filename extension of .TIF or .TIFF.
4 PNG. PNG files with a .png filename extension.

4+ ICO. Icon files stored with a .ico filename extension.

Working with images in Paint

You have several options when it comes to working with images. Work on one
4 Uploaded from a digital camera
4 Taken by pressing the Print Screen key

4+ Captured from an online source
If you have an image on your computer, start work this way:

1. Open Paint.
2. Go to the image file from the Open window.
3. Double-click the image’s icon.

It opens in the editor. Windows makes it easy to find images by offering a
small thumbnail version of the picture. See Figure 2-7.
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If you open Paint without loading an existing file, you can begin work with
the paint tools immediately and then choose a storage format when you're
ready to save your work.

You can use any of the standard file formats for your masterpiece, but generally
it’s good practice to at least temporarily save your work in a high-resolution,
uncompressed format like TIFF; once you complete your work, save the file in a
smaller format like JPG or GIF.

1. Press the Print Screen key.

A copy of the memory’s image of the screen is captured. This step is just
temporary.

2. Press Print Screen again.
The first image is replaced with a later version.

You can hold onto the contents of a Print Screen command by pasting
the memory contents into an image editor, and Paint does just fine for
that purpose.

3. Open Paint.
4. Click the blank canvas.
5. Do one of the following:
e Press Ctrl + V.
¢ Click Edit => Paste.

Unless the web site developer has blocked your ability to do so, you have a
third way to capture an image from what you see onscreen:

Go to a web site.

Right-click a picture.

Choose JPEG.
This way you get obtain a high-quality copy.

1.
2.
3. Choose Save Picture As.
4.

. Select a filename.

S »n

. Choose a location for storage.

Now you can open that file from within Paint (or other image editors)
and edit it.

You can use Print Screen to grab an image of work you created on your own
laptop or capture a picture of a web site. Similarly, you can use Save As to
copy an image you find on a web site or in certain other displays. Remember,
though, many images on web sites or in programs are copyrighted; get
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Figure 2-8:
A photo
from my
personal
collection,
open for
basic
editing in
Paint.
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permission from the owner if you intend to use someone else’s intellectual
property in a work of your own.

Once you have the image within Paint, you can do the following, among
other things:

4+ Crop

4 Resize

4+ Flip (rotating it as if you were turning over a transparent piece of paper)

4+ Invert the colors from positive to negative; see Figure 2-8
The final, crucial, step is to save your image in a form that lets you use it or
retrieve and edit it in a more-capable image editor. | suggest always saving a
copy in TIFF format, which creates an uncompressed version of what you
see onscreen. When you're ready to use your work for other purposes, you
can save a second copy as a

4+ JPEG for e-mailing to someone else for further editing

4+ GIF for display on a web page or as a small image on your laptop

‘s DSC_6879 Athens Greece Silly Walks - Paint =& ﬁ‘
File Edit View Image Colors Help
OOy AEEEE EEEEN
& < | =
2 Q r O MILABNIPONCIIY L =
b A KRETAIESTPAMENH

P)w [F6 & § FTaNAgannn
VA : -

5 LICH
N ¢ MOPOBA=KOPYTEA=KAAAMA £
3 A& TOMOPGE=TPEMIEZS | NA
. I XEIMAPPA=API YPOKASTP O3
@ @ 73§ =MPOYMDE % |=KAA
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For Help, click Help Topics on the Help Menu.
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While space on a hard disk drive is a precious commodity, a number of alter-
natives are available if you want to keep images at their highest possible
quality.

4+ External drive
4+ Flash memory key
4 Burn them to a CD or DVD disc

Once an image is reduced in quality (by cutting its resolution or number of
colors or by compressing it using a lossy technology such as JPEG or GIF), it
can never be fully restored.

Painting with Paint

Enough about photography; break out the paintbrush. Again, Paint offers all
the basics of an illustration program, and I'm convinced that our friend
Pablo Picasso could use it to create an amazing work of art.

It comes with a paintbrush, which is a good place to start. And there’s an
electronic pencil and a computer-assisted airbrush. The icon for the air-
brush looks more like a can of spray paint, and that may be a very good
metaphor for this program’s capabilities: as a free basic tool, this program is
not to be confused with a full-featured program like Adobe Illustrator or Corel
Draw which allow an almost limitless number of adjustments to the width,
hardness (an electronic equivalent of the stiffness or contour of the brush,
including the amount of “paint” it applies), and other such refinements.

You can undo any action you take — drawing a line, brushing a stroke, filling
with color, or erasing a portion of an image — by clicking Edit = Undo.
Alternatively, you can click Ctrl + Z. To redo something you’ve undone
(aren’t computer’s wonderful?), choose Edit => Redo or click Ctrl + Y.

Table 2-1 has the essential tools available to artists like you and me.

Table 2-1 Paint Tools
Tool How to use it
Select Drag the tool to select any square or rectangular

portion of the image.

Free-Form Select Reach into an image to draw a line of any shape
to select a portion of the picture.

Eraser You've got this one figured out, right? Choose the
eraser (a pop-up menu shows four sizes) to
overwrite any portion of the image with the
background color.
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Tool

How to use it

Fill With Color

If you selected an area of the image, fill the
inside of that shape with whatever color you
chose from the palette. If you selected nothing,
this tool fills the entire image with the chosen
color.

Pick Color

Click this tool and choose a color from the
palette; you can assign the color as the fore-
ground or background color of the image. See
Figure 2-9.

Magnifier

Zoom in on a portion of the image; you can click
directly on the picture or use the slider that
appears on the toolbar.

Pencil or Brush

Draw straight lines or curves with an electronic
pencil or paintbrush. You can draw in color by
selecting a color from the palette; to draw using
the background color, press and hold the right
mouse button as you move the onscreen pointer.

Airbrush

Sprays paint in the color of your choice. The pro-
gram includes three spray patterns, from a small
and tight cluster to a larger and more diffuse
design. Choose a color from the palette or use
the background color by right-clicking as you
drag the pointer onscreen.

Text

Put your words into the image by clicking the A
icon; you're offered a background style and a
color palette. Click inside the picture and enter
text from the keyboard. You can move or resize
the text box; change the font, size, and format-
ting up until the moment you click another tool
and click outside of the text box in the picture;
after that the text is assigned and can't be edited.

Line tools (including Line and Curve)

Insert exactly what's promised. Choose a color
and then drag the pointer; to draw a straight line
or a curve using the background color, press
and hold the right mouse button while you drag
the pointer. The Curve tool adds an extra wrin-
kle: Start with a straight line and then click
where you want the arc. Drag the pointer to
adjust the curve.

Rectangle and Rounded Rectangle

Draw closed boxes with square or rounded cor-
ners. Drag the pointer diagonally from one
corner up or down to create a box; to make a
square hold the Shift button while dragging the
pointer. You can choose color from the palette or
press and hold the right mouse button to use the
background color.

(continued)
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Table 2-1 (continued)

Tool

How to use it

Ellipse

Draw a perfect circle or an elongated ellipse.
Click in the image to set a starting point and then
drag the pointer to expand it; to draw a circle,
hold down the Shift button while moving the
pointer.

Polygon

Make a shape with any number of sides, from
triangle to dodecagon (a 12-sided shape) and
beyond. Pick a color, drag the pointer to create a
straight line, and then click each point where
you want to add a side. When done, double-click
to turn off the tool. To create sides with 45- or
90-degree angles, hold down the Shift key while
making sides.

The Color Palette comes with 24 colors plus black and white. However, you aren’t
limited to those colors; double-click the palette to expand the choices to 48.

(1§ Untitled - Paint =lE&] = |
File Edit View Image Colors Help
& G [ ANEEEE EEEEE
P BB O E
— 2 Q :
Figure 2-9: ¥ Edit Colors =)
You can © A = .
. Basic colors:
work with N ¢ ErrErEEE 1 ?
the basic @ & ErrTEFEENE 5
colors of the 20 EEEEEE. . 4
Paint [ EfEEEEEN
palette. ENEEEEEN
Create EEEENTE
custom Custom colors:
C0|0rsby Y el %
moving an | | Set: 231 Green: 57
onscreen Define Custom Colors > ColodiSold |\ 145 Bue: 251
selector or ( Addto Custom Colors
manually
entering !
color or hue i i ;
information. For Help, click Help Topics on the Help Menu. J
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And you can go further, defining your own colors:

1. Choose the Define Custom Colors menu.

2. Click into a set of colors.

3. Choose an approximate shade.

4.

Use the slider to adjust its appearance.
Or type values into the Red, Green, and Blue boxes; in this way you can
¢ Look up a color value in a reference book.

¢ Specify to a colleague that the particular shade of blue you want to
use is created using 96, 57, and 251 in RGB values.

Windows Photo Gallery

Digital photography is one of those modern technologies that has zoomed from
Flash Gordon sci-fi to products so common and simple that even a college-
educated adult can be taught to use them. See Figure 2-10. (In fact, the once-
booming industry of film-based photography has dried up; you have to go
out of your way to find a laboratory to develop film and make prints.)

The advantages of a digital camera are immediately evident to anyone who
uses one.

+
*

The cameras are microcomputers all by themselves.

They can focus by themselves, choose the proper exposure, and other-
wise capture what you see.

The images are available immediately — starting on the screen that
most cameras have, and continuing when you upload the digital files to
a computer.

When the images are loaded onto your laptop, you can use its much
more powerful processor with advanced image-editing software to adjust

e Exposure

¢ Brightness

e Contrast

e Color intensity

¢ Picture size

You can perform other tricks that go way beyond the antique world of film:

e Sharpen the pixels that make up the image.

¢ Change colors to hues not seen in the real world.
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Figure 2-10:
Windows
Photo
Gallery
delivers
basic photo
editing.

e Ship them from one computer to another (or to a cell phone or a per-
sonal data assistant or to a television screen) over the Internet
nearly instantly.

4+ The cost of taking a picture is close to zero. You never have to buy film
or pay for its processing; if you choose to keep your images in electronic
form you don’t even need to pay for prints.

As a professional photographer, [ add one more wrinkle to that equation: I
used to keep a casual running calculation of the cost of each picture I
snapped. But now that [ work entirely in the digital world, I have no hesita-
tion shooting a few dozen versions of the same photo. I can try overexpo-
sure, underexposure, a different focus, a different lens. When I'm done for
the day, I can look at 150 images and find the one or two that [ want to keep.
All I've spent is a few penny’s worth of battery power.

What’s the hard part?

4 Sorting through hundreds or thousands of images to separate the print-
able wheat from the digital chaff
4+ Editing your images to improve color, brightness, contrast, and composition

4+ Organizing your images and finding them when you need them

@7 Add Tags

Author photo
Corey Sandler
Henry Hudson Drearms

Inwit Inukshuk Canadian Ar...

Author Corey Sandler in Nunavik
in the Canadian Arctic. during...
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A free solution in Windows Vista

Windows Photo Gallery is offered as one of the “free” components delivered
with Windows Vista. (You can download and use another version of the pro-
gram, called Windows Live Photo Gallery, with Windows XP or Windows Vista.)

This program offers many of the basic photo-editing tools that are part of
entry-level programs like Adobe Elements:

4 Auto adjust. A computer-directed set of adjustments to brightness, con-
trast, and exposure. This setting works with most images that are
already close to how you’d like them to appear.

4 Adjust exposure. Manual sliders to increase or decrease brightness,
contrast, or both.

4 Adjust color. Manual sliders to set color temperature, tint, or saturation.
Color temperature is the warmth or coolness of the overall appearance
of colors; think of the difference between the light from an incandescent
bulb and a fluorescent; or the change in the feel of colors between
midday and sunset. Adjusting the saturation is like adding more color to
the electronic paint set.

Setting color saturation all the way off effectively creates a black-and-
white or grayscale image.

4+ Fix red eye. This isn’t a cure for disease; rather, it can, in many cases,
remove the bright red spots that appear in human eyes when an elec-
tronic flash reflects back to the camera.

You can crop an image to remove Uncle Ned, or change its shape to fit a
monitor or a picture frame.

The primary purpose of Windows Photo Gallery is to prepare your images —
in a basic way — for these types of things:

4+ Displaying in an onscreen slideshow

4 E-mailing to friends and family

4+ Sending to a service bureau for prints

4 Burning a CD or DVD with copies of your pictures
The video DVD feature of Windows Photo Gallery is available only in Windows

Vista Home Premium or Windows Vista Ultimate versions of the operating
system.
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Downsides:

4+ One feature that’s absent from Windows Photo Gallery is the ability to
change file formats (from JPG to TIFF, for example). (Despite this, the
program can open and work with images of either type, as well as BMP
and PNG formats.)

4+ You can’t adjust the image resolution or its printable size. For these
sorts of functions — very important to some users — you need to pur-
chase a graphics-editing program.

Now the good news: Windows Photo Gallery can function as the equivalent
of a graphics database. If you assign tags to your images, you can use the
program to search for all photos that meet a particular criteria. For example,
you could create the following tags: family, travel, Europe, cruises, and “the
time Janice got seasick.”

After applying tags, you can search for any one particular image or an entire
group that shares the same tags. A picture of Janice, seasick on a cruise in
Europe, would probably turn up in a search for any of the tags [ identified
earlier; a search just for tags of Europe should turn up the same picture, as
well as other images taken on land having nothing to do with cruises (or Janice).

The search function doesn’t require that images be kept in any particular
folder; the program searches all hard discs and other storage media installed
within or attached to your laptop.

An evolving version of Photo Gallery

In late 2007, Microsoft introduced Windows Live Photo Gallery, a free upgrade
or replacement to Windows Photo Gallery that adds functions and can be
installed within Windows XP as well as Windows Vista. See Figure 2-11.

Among its enhancements is the ability to convert a limited number of file for-
mats from one type to another: JPG to TIFF, for example. It also adds a new
file format, WMPHOTO (with a filename extension of WDP) for use with new
features related to the world of Windows Live.

A new feature is Publish, which allows use of your images with Windows Live
Spaces and other services (such as Flickr) that establish and maintain social
networking or image and video sharing sites on the Internet.

Who Knows Where the Time Goes?

Back in the olden days, many of us kept our calendars on the wall; some of
us even had secretaries who kept our schedule in a leather-bound desktop
book. Ah, life was simpler then.



Figure 2-11:
Windows
Live Photo
Gallery
extends
image
management
features
onto the
Internet.
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Today, most of us live lives scheduled down to the minute, and we have to
keep track where the time goes all by ourselves. The calendars are off the
wall and in our pockets on personal data assistants and advanced cell
phones, and on our laptops.

As part of Windows Vista, Microsoft introduced Windows Calendar. This tool
includes a full set of tools for recording your appointments, issuing invita-
tions to other meeting participants, and reminding us to get it in gear when
we need to run down the hall or out to the airport. It can also maintain a per-
sonal to-do list; hold on while I make a note to set one up.

You can set up a personal or business calendar so you can coordinate your
entries with other family members or coworkers. With permission, you can
check someone else’s calendar — or they can check yours — to set up meet-
ings or travel.

For example, all the members of a family could have their own calendar run-
ning under Windows Vista on a single machine. Mom or Dad could check in to
find out the kids’ little league and ballet lesson schedules; the kids could find
out what time the ‘rents are due home so that they can clean up the evidence.
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In an office, a set of Windows Calendars could be shared amongst members
of a specific workgroup or department, or the calendars could be kept pri-
vate from each other but allow a supervisor to find out what’s going on and
when people can meet. The manager can reach in and place a claim on a
time slot for all the members of the department.

The Calendar system can — and should be — protected by a strong pass-
word that you give only to those you want to have access. And if someone
leaves your workgroup, change the password immediately.

As part of Microsoft’s introduction of its Windows Live online facilities, you
can publish the calendar online. This serves two purposes:

4+ It allows you to consult your schedule from your laptop (or from any
other Internet-capable device) as you travel.

4+ It allows you to give permission to others to consult or even change
your calendar from afar.

You can store it on a server at your office or at your Internet service
provider; consult your technical support desk for advice on how to do this.
Or you can use a public network (Microsoft would like users to use its
Windows Live site) for this purpose.

Windows Calendar data is stored in the iCalendar format, which a number of
other applications also use. This means you can interchange calendars even
if someone else is using different programs to develop them.
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Chapter 3: Windows Maintenance
Utilities

In This Chapter

1 Keeping your laptop’s mind and body clean and neat
+~ Healing what’s broken
v+ Dealing with device driver demons

+ Recycling, defragging, and other healthy habits

A re you the sort of person who buys a new car and then keeps it like a
museum piece for the rest of its life, vacuuming out every donut
crumb, checking the air pressure in the tires weekly, and changing the oil
every 2,999 miles before proceeding one inch farther down the road? Or do
you let the pizza boxes pile up in the back seat, let the air slowly leak out of
the tires, and allow the engine oil to turn to sludge?

If you're the first type of owner, your car is going to last longer, operate more
efficiently, and hold on to its value for a much longer period of time. If you're
not, your car will slow down day by day and one morning refuse to start at all.

It’s pretty much the same thing with laptop computers. Not the part about
the engine oil and the air in the tires: The stuff about the importance of
keeping everything in tip-top mechanical condition and how if you don’t one
day, the machine won’t go.

Keep in mind three very important concepts about personal computers:

4+ Every time you use your laptop — saving a file, deleting a file, installing a
program, making a change to a setting, or connecting to the Internet —
you leave the machine in a different condition than it was before you
started. Files are moved from place to place on the hard disk drive, they
become fragmented (more about this later), and miscellaneous pieces of
temporary files are scattered about hither and thon (think of them as
donut crumbs).

4+ Microsoft regularly issues updates, security patches, and repairs to cur-
rent versions of Windows. One way or another they’re acknowledgments
of the fact that the operating system was less than perfect when first
released and (more disturbingly) has been the subject of malicious
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attacks by hackers ever since. Those are the facts, and I'm not intending
to join the small chorus of Microsoft-maligners. The world isn’t perfect,
and some of its occupants are unpleasant folk.

4+ The makers of other programs and utilities regularly update or repair
their products. Based on the settings you establish for products you
install within your operating system, these new bits of code are either
automatically sent to your laptop over the Internet and installed or you
receive notification that updates are available.

In general, you should configure your antivirus and other security utilities so
that they’re automatically updated; this helps your system fight off the latest
viruses and other malware floating out there on the Internet and in e-mail. As
far as other programs, you can make your own decisions regarding updates.

Maintaining Windows and Applications
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We have this imperfect world with imperfect operating systems and nasty
people trying to cause you and your machine trouble. And we have a
machine that, if left unattended, will not-so-gradually lose its new-computer
smell and begin to slow down and eventually resemble a box of bricks.

What can you do to keep your computer’s operating system and software in
tip-top condition?

Happily, Microsoft and most other software makers do a pretty good job of
keeping their products up to date. But as a user you have to make sure your
machine is properly configured to accept updates, and you need to be vigi-
lant about seeking them out and managing them. I discuss methods for
Microsoft updates in Book II.

The most efficient way to maintain your software is to register your software
with the maker and establish an Internet connection to their support system.

Although in theory you may be able to have updates and patches sent to you
by postal mail on disc, that avenue is rapidly closing; today, most manufac-
turers assume that all users have a connection to the Internet that can be
used to maintain software.

As an example, Adobe offers occasional updates to its powerhouse products
such as Adobe Creative Suite or individual elements like Adobe Photoshop.
Since this is a mature (though still improving) product, the updates are usu-
ally less focused on fixing bugs and more on adding compatibility with new
file formats or integrating with features added by Microsoft to its operating
system. See Figure 3-1.
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The Adobe
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Nearly every laptop now on the market includes an Ethernet port for a wired
connection to the Internet, or a WiFi adapter for wireless communication.
Most offer both. If you don’t have Internet service at your home or office, a
public library or school may offer free service or you can rent time at an
Internet café. The software for Internet connection is built into Microsoft
Windows.

I've always marveled about how veterinarians (and pediatricians) make their
initial diagnosis of health problems with their patients. After all, neither pup-
pies nor newborns can tell the doctor, “I've got a pain in my right ear.” The
vets and the baby docs both have to start out with external observations
(poking, prodding, and magnifying scopes). If that does not provide a defini-
tive answer, then there are blood tests, X-rays, and even invasive
exploratory surgery.

Enough with the blood and guts stuff. Computers are not humans, nor the
other way around; one of the ways in which machines are in some ways
superior to animals is that in many instances they are capable of giving
themselves a checkup and sometimes even healing themselves.

Modern laptops equipped with current versions of Windows include a wide
range of tools that report on their hardware and software configuration,
their vital signs, and can often warn about impending problems.

One huge hole in the ability of a computer to report on its own condition: It
must be able to start up and run at least the lowest level of its built-in “boot”
hardware or go a bit further to load the basics of the operating system. If
the hardware can’t start, we're no better off at initial diagnosis than a
veterinarian trying to figure out what is wrong with a listless lizard.
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Figure 3-2:
A Windows
System
Information
screen
shows
details of
the
operating
system,
processor,
and memory
installed on
a Toshiba
Satellite
P205 laptop.

Before you poke around, run any diagnostics, or take a blood test, examine
your laptop’s installed hardware and software. You have several ways to do
this, including a straightforward utility called System Information. (See
Figure 3-2 for an example of a report.)

To check System Information, follow along:

1. Click the Start button in Windows Vista.

On Windows XP, choose Start &> All Programs = Accessories => System
Tools = System Information.

2. Type System Information into the Start menu’s search bar.
You may find a number of versions of the utility.
3. Click the System Information supplied as part of Windows.

If you subscribe to AOL, you may also see an AOL System Information
utility, which is also a quite capable examiner of your laptop, although it
focuses more on the operating system, firewall, antivirus, and connectivity
components of your machine — things of importance to an AOL
connection — than it does on hardware.
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Figure 3-3:
Toshiba's
information
screen
includes the
system’s
Windows
Experience
Index, its
processor
specs,
memory,
network
configur-
ation, and
phone or
online
accessto
support
technicians.
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Many laptop manufacturers add their own versions of a system information
report. These reports often serve multiple purposes:

4 Details of your system for you to examine

4+ A consistent report that can be examined over the Internet by support
technicians for the maker of your machine

4+ A bit of advertising for Windows operating system upgrades or hardware
accessories

On most current laptops running Windows Vista, manufacturer’s system
information screen can be found here: Click Start = Control Panel System
and Maintenance = System. An example of Toshiba’s screen is shown in
Figure 3-3.

(B v Control Panel » Syztem and Maintenance 1 System w | oy Wl Seaen 2

Windews edition
Windows Vista™ Home Premium
Copyright © 2006 Microseft Corporation. All rights reserved.
Upgrade Windows Vista

System
Manufacturer: ToSHIBA TOSHIBA
Modek: Satelite P205
Rating: 7] Windows brperience Index
Processon InteliR) Core(TM)2 CPU T5300 @173GHz 1.73GHz
Mermory (RAM]: 238 M8
System type: 32-bit Operating System

TOSHIBA support =
Phone numbern {BOOMS7-TTTT
Support hosre: M houre o day, 7 days 8 week
Website: Oriline support

Computer name domain, and workgeoup settings

Computer narme CoreySandles-PC i Change ssttings
Full computer name: CoreySandier-PC

Computer descsiption:

Werkgeous: WORKGROUP

Windows activation
‘Winidows is activated
Product 10 E9578-0EM-T Wi Change product ey

Learn more ealine..
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3

Figure 3-4:
A Device
Manager
window for
a modern
laptop.
Clicking a +
symbol
opens a
category to
display
multiple
items in that
section.

Device Manager: Poking under the hood

Once you have a sense of what you've got, the next important utility in
Windows is the Device Manager, which is boss of what lies beneath. This
window, reachable through the Windows Control Panel (as well as other
routes), displays all of the identifiable hardware components of your
machine organized by function. See Figure 3-4.

Jump to the dessert before the main course: When you open up Device
Manager, the first thing you should look for is one of the following:

4+ Ayellow question mark (a possible problem)

4 Ared exclamation mark (there be dragons here)

These warning icons appear alongside a category or an individual component;
double-click the item to learn why your laptop is concerned about its health.

.

=4 Device Manager || B e
| File Action View Help |
|4nep|m| H m| &

19 Batteries
! Microsoft AC Adapter
8 Microsoft ACPI-Compliant Control Method Battery
3 -f& Computer
=) (g Disk drives
.y TOSHIBA MK2035GS5 ATA Device
K Display adapters
B2 Mobile Intel(R) 945GM Express Chipset Family
iy DVD/CD-ROM drives
£ PIONEER DVD-RW DVR-KITLF ATA Device
51 o IDE ATA/ATAP] controllers
- § TEEE1394 Bus host controllers
=5 Imaging devices
=5 Chicony USE 2.0 Camera
= Keyboards
£7) Memory technalogy drives
| Mice and other pointing devices
S Modems
= I& Monitors

& Network adapters

= [ Processors
[ InteliR) Core(TM)2CPU T5300 @ 1.73GH:
[ intel(R) Core(TM)2CPU 75300 @ 1.73GH:

o B2 SD heost adapters

# & Sound, video and game controllers

&4 Storage controllers

5 -¢& System devices
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If problems are reported, they usually fall into one of these three areas:

4+ A non-responding or failed piece of hardware

4+ A conflict between two or more devices seeking to use the same
resources (interrupts, DMA channels, or memory addresses)

4+ A problem with an installed device driver
Before you accept the laptop’s report that a piece of hardware has failed, try

4 Rebooting the machine. Sometimes errors of this sort happen only after
a particularly unusual combination of commands, keystrokes, or soft-
ware events.

4+ Removing the cables. That is, if the problematic device is external to
your laptop — a hard disk drive or a camera attached to a USB port, for
example. If the machine functions properly without them, test the exter-
nal device on a different machine.

Resource sharing used to be a major headache on PCs, but with modern
operating systems (including Windows 98, Windows 2000, Windows XP, and
Windows Vista) all the heavy thinking is handled by the machine.

[ suggest you attempt to manually change resource settings only if you're
instructed to do so by a support technician for your laptop or the maker of
an add-on device.

You must be logged on as an administrator or as a member of the
Administrators group to complete procedures by using Device Manager.
That is usually not a problem for laptop users, but if your computer is set up
by a corporate or institutional computer department, you may need to seek
their assistance or obtain an Administrator sign-on.

1. Open Device Manager.
2. Double-click any device in the list.
Its properties are shown. See Figure 3-5.
3. Go to the General Tab.
4. Look for the Device Status.

“This device is working properly” is a good sign, at least as far as the partic-
ular piece of hardware’s relationship to the operating system is concerned;
its device driver is proper and its use of system resources is acceptable to
the system. What the device status screen doesn'’t tell you is if there is any
physical damage to an external device. (If you want an automobile analogy,
the status report is saying the engine and transmission are functioning prop-
erly, but isn’t providing information on whether the tires are flat.)
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Figure 3-5:
On the
General Tab
of Device
Properties,
good or bad
news is
reported in
the Device
Status
window.

Assuming you don’t see red (or yellow), you can proceed to examine in
depth the configuration of your machine and change settings.

Under Windows XP, do this:

1. Right-click My Computer.

2. Select Properties.

3. Select the Hardware tab.

4. Click the Device Manager button.

Under Windows Vista, do this:

1. Open the Start menu.
2. Right-click Computer.

3. Select Manage.

4. Click Device Manager.

This option is in the left-hand tree.
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% @ IEEE1394 Bus host controllers
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) &* Network adapters
[0 Processors
# B3 5D host adapters
4 % Seund, video and game controllers
# &7 Storage controllers
4 4& System devices
- § Universal Serial Bus controllers
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The Driver
tab of
Device
Properties
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uninstall,
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Dealing with device drivers

For many users, the most valuable use of Device Manager is the ability to

4 Identify the device drivers in use for each component
4 Install updated drivers

4+ Roll back to an earlier version of the driver if the new code causes problems
The doorway to the controls for device drivers is here:

1. Open Device Manager.
2. Choose the Device Properties window.
3. Select the Driver tab.

There you can see any specific piece of hardware listed in the Device
Manager. See Figure 3-6.

Take notes on what you've done and keep copies of the original and replace-
ment device drivers to allow reversing your steps. (If you have an external
flash memory key, this is a good place to temporarily store a copy.)

Tread carefully if you make any changes to the device drivers in Device
Manager. Be certain of these things:

4+ You're matching the proper device driver with your particular make and
model of device

4+ It's appropriate for the version of Windows you’re using (In most cases, a
Windows Vista device driver won’t work under Windows XP; going the other
direction may work, may not, or may provide only partial functionality.)

TOSHIEA MK2035GSS ATA Device Properties ==

Ganeral | Pobces | Vokemes | Oover | Dotads
TOSHIBA MK2035GSS ATA Device:
Driver Provider:  Microsoh
Driver Date 62172006
Diiver Viersion: 6.0.6000.16325
Digtal Signer. microsolt windows

| DetverDetals | Toview detais sbout the driverfles.
Update Dirver. To update the dever software for this device

Fithe device fads after updaling the dever. ol
back o the previously instaled dever

To uninstal the diver (Advanced)

OK Cancal
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Be very wary about accepting a device driver from a source you don’t know
and trust — and that includes “free” driver sites on the Internet. A corrupted
device driver can cause many problems for your system, and an infected one
can introduce nasty viruses. Your best bet is to accept assistance only from
the maker of your machine, its major components, or significant software.

Removing and reinstalling a device driver

If the Device Manager indicates you have a problem with a piece of hard-
ware, a corrupted or outdated device driver may be the cause. A first step to
attempting a repair is to remove the existing driver and reinstall it.

The most direct way to uninstall a driver is from the Properties window for a
particular device:

1. Open the Device Manager.
2. Locate the device you want to work on.

It may be flagged with a yellow question mark or a red exclamation point.
3. Click the Driver tab.
4. Click Uninstall.

You're asked if you really, truly want to remove the driver. Stop and think.
5. Click OK.
6. Restart the computer.

Windows should automatically notice that it has a device without a
driver and reinstall its copy from the original Windows installation files
or from elsewhere on your hard disk. In certain circumstances — usually
for particularly obscure devices — Windows may ask you to provide the
driver from a CD or DVD supplied by the maker of the hardware or ask
you to download it from a web site.

Once you uninstall a driver, the device with which it’s associated stops work-
ing until you reinstall its driver. Be aware that if you remove the driver for
the pointing device, you’ll have to restart without use of the mouse; try Alt +
F4 to shut down the system. If you uninstall the keyboard driver, you need to
use the mouse to shut down.

Upgrading a device driver

Sometimes the solution to a hardware problem is to upgrade to a later (pre-
sumably improved) version of the device driver. The maker of the hardware

4+ May have issued a newer version to fix a bug or incompatibility with
other hardware



Figure 3-7:
The
Windows
XP version
of the
Hardware
Update
Wizard
checks for
newer
versions of
device
drivers
installed in
your
machine.
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4+ May have issued an update to deal with a new version of the operating
system

4+ May be enhancing the capabilities of its older hardware just because,
well, they should

Your first effort should be to try the automated facilities of the Hardware
Update Wizard. (See Figure 3-7 to see the Windows XP version of this tool.)

You'll get to the Hardware Update Wizard with these steps:

1. Go to the Properties.

Do so for whatever hardware you need to update.
2. Go to the Driver tab.

Refer back to Figure 3-6.
3. Click the Update button.

Hardware Update Wizard

Welcome to the Hardware Update
Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission).

Ck

CanWindows connect to Windows Update to search for
software?

O VYes, this time only
(O Yes, now and every time | connect a device
(O No, not this time

Click Next to continue.
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If Windows Update doesn’t show you a newer version of the driver, conduct
your own search:

4+ Visit the web site for the manufacturer of your laptop.

4+ Check the web site for the specific component (an external pointing
device or an external hard disk drive).

You might be advised of the availability of an updated device driver through
an automated update utility installed on your machine. Read the instructions
you find accompanying the details of the update. Make absolutely certain
the update applies to your specific hardware as well as the version of the
operating system you’re running.

Some manufacturers will instruct you to download the device driver to your
laptop and then click on its icon for an automated installation of the new
piece of code. That’s the simplest and usually the best solution.

Occasionally you will find the device driver just sitting out there on a web
site or on a CD or DVD disc. Follow the instructions provided by the maker
of the hardware; you may be instructed to save a copy of the new device
driver to your desktop and to then install the new piece of code from the
Drivers tab.

Under Windows Vista, if you click the Update button you see a simpler but
more sophisticated wizard that asks the very appropriate question: “How do
you want to search for driver software?” Your choices are:

4+ Search automatically on your computer and on the Internet for the latest
device driver software for your device.

4+ Browse your computer for driver software. (This is an easy way to
install a device driver downloaded to your desktop.)

Rolling back a device driver

What do you do if your hardware — which had been functioning properly
before you meddled with it — suddenly stops performing properly after you
have installed a new device driver? Why, go back to the past, of course.

The trick here is to roll back the driver, which has nothing to do with turning
a used car’s odometer backwards; instead, it amounts to uninstalling the
new driver and replacing it with the one that had been in place before.

Do this to roll back a device driver:

1. Open the Device Manager.

2. Right-click the device you want to work on.
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3. Click Properties.

4. Click the Driver tab.

5. Click Roll Back Driver.

6. Accept your decision.
The driver rolls back.

7. Click Close.

8. Restart your computer.

Checking Your Hard Disk for Errors

An automated hard disk error-checking utility isn’t going to balance your
bank account, convert the faulty logic in your term paper to Pulitzer-level
insight, or correct your personality so you will meet the person of your dreams.

Here’s what the built-in utilities of Windows Vista and Windows XP do:

4+ Examine the structure of your hard disk drive to make sure everything is
properly indexed and that any problems with filenames, file attribute

tables, security descriptors, and anything else related to the proper stor-

age and retrieval of files is identified and fixed

4+ Look for one particular category of hardware problem on the disk itself:
bad sectors

CHKDSK

The error-checking utility is a modernized version of one of the oldest elements
of MS-DOS, the original operating system for PCs. From the dawn of PC time —
before Windows was a twinkling in Bill Gates’ eyes — there has been a utility
called CHKDSK (pronounced check-disk) that gives disk drives a physical and
mental examination. (See Figure 3-8 for the Windows Vista Premium version of
hard disk tools, which includes data backup; the Windows XP version offers a
nearly identical toolbox.)

CHKDSK is one of the few utilities that still exists outside the operating
system. There are two important reasons for this:

4+ Microsoft has (properly) chosen to maintain, as much as possible,
downward compatibility between the latest and greatest and the oldest
and least.

4+ As a matter of engineering it pretty much needs to do its work without
interference from any other computer tasks.
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Figure 3-8:
In My
Computer or
Computer,
right-click
the listing
for your
hard disk to
display its
Properties
window;
choose the
Tools tab to
conduct
error
checking or
defrag-
mentation.

\

& SQO04331V0S (C) Properties [ =]
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Emorcheckang

This option will check the volume for
o e

¥ Check Now,__ |
Delagmentatien

s This cption wil defragment fles on the volume.
" Dafragment how.

Baclop

o 4 This cption wilback up fles on the volume.
£
Backup Now.

oK Cancel

If you think about it, it would be rather difficult to check the organization
and the physical attributes of your hard disk while it was operating — kind
of like trying to gauge the depth and quality of the water in a shallow pond at
the same time as a speedboat passes by. There are just too many moving
parts and the mere presence of the boat (or the activities of Windows)
changes the environment too much for the test to get an accurate reading.

Instead, if you ask the system to check your hard disk for errors from within
Windows, it asks that you schedule the test for the next time the computer is
rebooted. And then the full test is run from outside Windows; although MS-
DOS no longer exists like it did when it was the operating system for early
PCs, there is a functional equivalent that underlies even the most current of
GUIs, Windows Vista.

Be aware that the larger your hard disk drive and the more files recorded on
it, the longer the CHKDSK process can take. On my Toshiba Satellite P205
test machine, a test (with the repair function turned on) required more than
two hours to complete, and I couldn’t use the laptop for any other purpose
during that time. If you need to use your laptop, consider scheduling a test,
rebooting your machine at the end of the day, and leaving it running all night.

Selecting a testing level

Do you want a relatively quick checkup, or do you want your computer
doctor to perform a detailed diagnosis and test and then reach in and per-
form any necessary surgery? The checkup is the least disruptive, but nothing
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gets fixed: All you get is a report. If the tests show nothing is wrong, you’ll
have saved a great deal of time.

Depending on which version of Windows you have, you may be offered the
option to merely scan your system for problems. All current versions go on
to allow automatic fixes of file systems errors and bad sectors. Use the
pointer to turn on the check box next to your choice:

4+ Scan. If you select no options, the system will examine the hard disk for
logical and certain physical problems and give you a report.

4+ Automatically fix file system errors. The utility will examine all of the files,
folders, and indexes on the disk and repair most basic problems it finds.

4+ Scan for and attempt recovery of bad sectors. The utility will check out
the magnetic markings on the surface of the disk that demark sectors in
search of any corrupted, incorrect, or damaged indicators. If possible,
the utility will repair the sector marking. If the portion of the disk itself is
damaged, the utility may be able to place an electronic fence around the
sector so that the system does not attempt to place new information there.

4+ To check for and repair both file errors and bad sectors, select the check
box next to both available options.

If you choose to run error checking, remember my explanation about how
the system can’t examine itself while the drive is in use. As you can see in
Figure 3-9, you're asked if you want the machine to give itself a checkup the
next time you turn it on — and before it loads Windows.

A sector is a slide of one of the circular tracks on a magnetic disk or optical
disc. Each sector is intended to hold a particular amount of data. Under
Windows, most sectors hold 512 bytes on a magnetic medium.

Managing Your Disk Drives

\\J

Be good to your hard disks . . . and they won’t die an early death. With
mechanical devices — basically anything with a motor or a moving part —
failure is only a question of when, not if.

It starts before you even take possession of your laptop. Brand-name laptops
generally use better-quality components.

One way to measure the manufacturer’s intentions is to look at the length of
the warranty. A new machine with a 90-day warranty would scare me; the
way I figure it, a company hopes to never have to pay for repairs. A longer
warranty is one indication that they believe their machine—including its
built-in hard disk drive—will stand a medium-to-long test of time.
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Name Type Totsl Size

Hard Disk Drives (1)
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Figure 3-9:
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time you
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machine.
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If you purchase a no-name or store-brand laptop, find out the maker of the
hard disk drive within. There aren’t that many backwoods disk-drive suppli-
ers for current machines, but be wary if you don’t recognize the name of the

manufacturer.

Once the laptop is in your possession, you have several ways to find out the
maker of the hard disk drive, and each of them is also the pathway to proper

& SQO04331V0S (C:) Properties =

[ General| Tools | Hardware | Shamng | Secuty | Guota
Emorchecking
_ Thes cption wil chack tha voluma for
o e,
| i Check How...
Defragmentation
&- This option will defragment fles on the volume

Backup

;V; 4 This cotion wil back up fles on the volums
- = :
Backup Now...

maintenance. Here’s how to learn about your drive:

1. Click My Computer.

2. Highlight the drive you want to investigate.
3. Right-click the drive label.

4. Choose Properties.

Back in Figure 3-5 you see the properties information about the Toshiba-
brand hard drive in this book’s sample Toshiba Satellite P205 laptop;
that’s not a surprise since that company is one of the pioneers of the

laptop industry and its drives are among the most reliable.

The Computer (under Windows Vista) or My Computer (Windows XP)
screen shows you the automatically generated name for the hard drive

in your laptop as well as the drive letter assigned to it.
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V?‘NNG! Avoid reassigning the drive letter for the first disk drive in your

machine; the laptop seeks out this device to boot the system and it’s
where Windows and many other programs expect to reside. It’s possible
to give it a different drive letter, but the potential for headache is more
than I am willing to willingly accept.

5. Get a quick measurement of the total capacity of the drive.

6. See how much of that space is still available for storage.
See Figure 3-10.

7. Go to the General tab.

8. See the file system that is in use.

Modern machines almost all use NTFS, while antiques (and certain
external devices) may be based on the less-capable, sometimes incom-
patible FAT32 or FAT technology.

If you subdivided your physical hard disk so it includes one or more logi-
cal drives, each of them is shown separately. The logical drives are
treated as if they were separate pieces of plastic, metal, and motors.

The capacity report on the hard disk drive shown in Figure 3-10 gives a great
example of creative computing mathematics. The capacity is listed as
198,475,509,760 bytes, which is more or less the raw number of recordable
computer words; alongside is a figure of 184GB, which is an estimate of its
actual usable space when overhead and other factors are included. If you
add up the numbers listed for used space and free space, you come up with
yet another number, 184.7GB, which tells you how much your particular
blend of data actually occupies on the disk. And the specifications for the
laptop when you shop for it at the store? The hard drive’s size is rounded up
by the marketing department to an even 200GB.

Why subdivide a large hard disk with logical drives? It’s all a matter of personal
organizational tendencies; I like to put things into separate boxes.

A\

If I have two drives in a laptop or desktop machine
4 lusually reserve the C drive for the operating system, programs, and my
current data files.
4 On the second drive I usually make two logical disks:
¢ One to hold backup copies of current data files
¢ One as repository for my back pages, archives of older work

N
‘é‘" And then [ make backups of both current and archival material onto an

external hard drive and onto DVDs.
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Figure 3-10:
The General
tab of the
Properties
report for
the internal
hard drive is
a reality
check: you
can see the
total
capacity of
the drive as
well as the
amount of
space that
isin use.
Note the
Disk
Cleanup
button near
the pie
chart.
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By the way, the first drive in a system is marked as location 0 and the second at
location 1. (A third drive, if one is present, would be at location 2, and so on.)

Computer designers still hold on to bits and pieces (oops, a geekish pun) of
the binary system in labels and other elements of the machines they design.
Since binary math starts with 0, so does the numbering of the various con-
nectors and pins inside your computer. So your first hard disk drive is to the
computer drive 0, and to Windows drive C, and to you whatever you choose
to call it.

Keeping a clean drive

In the world of computers, it’s not the content that matters so much as its
orderliness on the disk. And then there’s the matter of taking out the trash.

Let’s talk trash first. There’s an awful lot of it on any laptop computer that
has been in use for a while.

4 Web junk. If you use the Internet, web pages are constantly sending you
images, icons, and other stuff to display on your screen; many of those
elements are written to your hard disk as temporary files so they can be
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more quickly shown if you return to a particular page. In theory, those
temporary files are supposed to be deleted when you close your
browser; in practice, well, not all are.

4+ Updated garbage. Then there are programs and drivers and updates that
are downloaded to your machine to keep it up to date; if you're running a
proper security or antivirus program, these are only accepted with your
permission. Again, the installation packages for these files are supposed
to be removed once the programs they deliver are put in place; not all are.

4+ Refuse refusal. There is real trash, too, although on a computer things
thrown away sometimes hang around for a long time before they go away.
Say you press the Delete key to remove a file you no longer need. You'd
think that meant the file was physically erased from the magnetic surface
of your disk, but that’s not the case.

First of all, for simplicity and speed, when you “delete” a file, all that actually
happens is that its name is removed from the directory of available files that
is maintained by the computer. It’s even simpler than that: The first charac-
ter of its name is changed from a standard alphanumeric symbol to one of
the characters that the computer has reserved for its own purpose. The file
is still there, only the system ignores it when you look at a directory of files.

For most users, this is a good thing; I'd say, on average, I accidentally delete
a file about once a year. And, also on average, every few months I change my
mind about a file [ deleted and wish I could get it back.

Windows, as well as third-party add-on utilities, offers you a way to
“undelete” a file from the Recycle Bin. (Cute name, don’t you think? In early
operating systems it was called the trash basket, but now it has a more
ecofriendly name and it also hints at the fact that the stuff it holds may be
pulled back out and put to use again.) A stylized icon for the Recycle Bin is
shown in Figure 3-11.

Files stay in the recycle bin for hours, days, weeks, or even months until one
of the following events occurs:

4+ Right-click the recycle bin icon on the desktop and select Open. Once
the contents of the bin are displayed onscreen, right-click a specific file
and choose Delete, which gets rid of that specific file.

4+ Right-click the recycle bin icon on the desktop and select Empty Recycle
Bin, which dumps all files.
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4+ Your recycle bin becomes so clogged up with deleted files that it auto-
matically starts throwing away the least recently deleted files to make
room for fresher garbage. (If you right-click the recycle bin icon and
choose Properties, you can set the maximum amount of space you want
to allow the bin to set aside. The more space you devote to it, the longer
it takes before files are removed from the bin.)

Oh, and even if you do delete a file from the recycle bin, it still doesn’t mean
it is gone forever. It is only unavailable to ordinary users once the system
actually writes new data over the location it once called home. That may
happen immediately, or it may take quite a while.

Figure 3-11:
The Recycle
Binicon fills
up with
images of
crumpled
paper as
you send -l
files its way. -
When you 'I':""_:"'

empty the ~
bin, the =

trash Recycle Bin

disappears
to the
accompan-
imentof a
neat little
sound of
rustling
paper.

Retrieving erased files

As long as a file is still listed as being in the recycle bin, you can remove it
from the can and return it to its prior location.

One word of warning: If you’ve deleted a file — or if a program has automati-
cally deleted an older version of a file and resaved a current copy under the
same name — be careful not to overwrite a newer version with an older one.




Figure 3-12:
You can
undelete an
individual
file, restore
all deleted
files, or
empty the
trash from
the Recycle
Bin screen.
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If you find yourself in that situation, before you recover a file from the recy-
cle bin, rename the newer version by adding a date, number, or some other
indication that it varies from the older file. A recycle bin stuffed with deleted
files is shown in Figure 3-12.

To restore a file, do this:

1. Double-click the Recycle Bin icon on the desktop.
2. Right-click an individual file.
3. Click Restore.

Or, you can restore all the files in the recycle bin by clicking the Restore
All Items button.

Unerasing erased files

You can purchase third-party utilities that can “unerase” files that have been
removed from the recycle bin but not overwritten. This is a bit of a last-ditch
rescue effort, and you may find that not all the file is available to you
(because the file had been fragmented).

5 Name Original Lecation Date Deleted ki
n—- Documents 2% Backup and Restore 001 CAUsers\Corey Sandler\Desktop\Toshiba..  12/4/2007 £:09 PM
3 | Backup and Restore 002 C\Users\Corey Sandler\Desktop\Toshiba...  12/4/2007 4:09 PM
B Fictures & Control Panel Programs snd Festures .. C:\Users\Corey Sandler\Desktop\Toshiba... - 12/4/2007 4:09 PM
[D Musie &% Disk Cleanup Options 001 CAUsers\Corey Sandler\Desktop\Toshiba... 12/4/2007 £:09 PM
More » 2| Error Check Hard Disk Drive with mess.. C:\Users\Corey Sandler\Desktop\Toshiba..  12/4/2007 4:09 PM
Folders w | &%|Hard Disk Properties 002 CAUsers\Corey Sandler\Desktop\Toshiba.. 12/4/2007 4:09 PM
B Desktop % HDD Disk Defragmenter Scheduler 004 C:\Users\Corey Sandler\Desktop\Toshiba...  12/4/2007 4:09 PM
[ Corey Sandler 2/ HDD Properties TOOL TAB 003 C:\Users\Corey Sandler\Desktop\Toshiba... 12/4/2007 4:09 PM
J Public & My Computer HDD Properties 002 C:\Users\Corey Sandler\Desktop\ Toshiba... 12/4/2007 4:09 PM |
% Computer || Notepad 001 CAUsers\Corey Sandler\Desktop\Toshiba... 12/4/2007 4:09 PM
& Network 2% Notepad 001 C\Users\Corey Sandler\Desktop\Toshiba... 12/4/2007 4:09 PM
[ Control Panel | Notepad 002 CAlsers\Corey Sandler\Desktop\Toshiba..  12/4/2007 4:09 PM |
& Recycle Bin 2% Notepad 003 C\Users\Corey Sandler\Desktop\Toshiba.. 12/4/20074:09PM |
[B Around World Pictures Lecture 2007 2| Paint 001 CAUsers\Corey Sandler\Desktop\Toshiba... 12/4/2007 409 PM
(8 Hudson Lectures 2007 2| Paint 002 C\Users\Corey Sandler\Desktop\Toshiba.. 12/4/2007 4:09 PM
2| Photo Gallery 001 CiAUsers\Corey Sandler\Desktop\Toshiba...  12/4/2007 4:09 PM
& Windows Anytime Upgrade 001 CAUsers\Corey Sandler\Desktop\Toshiba..  12/4/2007 4:09 PM
&% Windows Update 001 CAUsers\Corey Sandler\Desktop\Toshiba... 12/4/2007 £:09 PM
2 Windows Update Available Updates 002 C:\Users\Corey Sandler\Desktop\Toshiba... 12/4/2007 409 PM
& Windows Update Choose Updates to L. C:\Users\Corey Sandler\Desktop\Toshiba... 12/4/2007 4:09 PM
(&| Windows Update Choose Updates to L. C\Users\Corey Sandler\Desktop\Toshiba...  12/4/2007 409 PM
£ Wiinstaller C\Users\Corey Sandler\Desktop 12/2/2007 3:54 PM =
] i
% f—-;"- 39 items
%
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One more thing: Law enforcement and spy agencies and some computer
techies may be able to recover some or all files that have been deleted,
removed from the recycle bin, and written over. They use super-sensitive
scanning tools that can sometimes see the magnetic shadows of erased 0s
and 1s on the disk.

Finally, there are fragments. I discuss how files get fragmented and how to
defragment them in the next section; here, though, I'm talking about dis-
carded partial files that once were part of a larger file or that have been left
behind as files were revised or updated. You can also end up with fragments
when a file is deleted and its space returned to available inventory on the
disk; the computer may overwrite the first, third, and fifth piece of the file
because they’re closest to each other or to the location of the read-write
head, leaving the second and fourth piece of the file as orphaned fragments.

Adjusting recycle bin settings

Windows includes a number of options that allow you to customize the way
the recycle bin works. One of the most important: setting the maximize
amount of space devoted to the bin.

If you're not in the habit of regularly clearing your computer’s Recycle Bin,
or if you have a lot of extra space, consider setting up a large amount of
space for its use.

Think of the size of the electronic bin as being roughly equivalent to the size
of the real trash can beneath your desk. The larger the bin, the less often it
has to be emptied. In the case of the computer’s recycle bin, when the can
reaches capacity, it starts permanent deletion of items from the bottom. In
business inventory management this is referred to as FIFO, first-in first-out. In
other words, the files that have been in the bin the longest are disposed of
before more recent additions. Very large files aren’t sent to the recycle bin,
since they would otherwise displace a great many smaller files.

Other options — not ones I necessarily recommend — include these:

4 Turning off the sometimes annoying message that asks if you really,
really want to delete a file. It’s supposed to make you stop and think, and
it just might save you from heartache one day.

4+ Instruct the system to bypass the recycle bin and just remove files from
your hard drive when you delete them. Again, I'd rather have the protec-
tive net of the bin.
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To change the Recycle Bin settings, do this:

1. Right-click the bin’s icon on the desktop.
2. Click Properties.
3. Click the General tab.

4. Select from the available customization options.

Your hard disk’s fragmented mind

A fragmented file is split into two or more pieces that aren’t next to each
other on your hard disk drive. In fact, files are commonly split up so the
beginning is somewhere in the middle and the end comes before the middle.

Why do files become fragmented, and why should you care? In the spirit of
fragmentation, [ answer the second question first.

You should care because a disk that has files split up and spread hither and yon
around its platters will operate less efficiently than one where everything is
neat and orderly.

Here’s how files get fragmented: Consider that fact that not every file is the
same length. You may write a short note to yourself — a shopping list, or

a to-do list, for example. Or you might just not have all that much to say on a
particular subject. But depending on the size of your hard disk drive and the
filing system it uses, your hard disk drive will have a minimum size for the
block of space it allocates for a file; say it’s 64KB.

If your file is only 1KB in length, it will sit within a 64KB section like the last
remaining truffle in a beautifully packaged 64-pound box of chocolates. And
if your file happens to be 65KB, it occupies one complete 64KB section plus
1KB in an otherwise empty container.

When you start a file the operating system opens a section of the disk for it
and fills it up, but when it reaches the end of the first segment the next avail-
able space may or may not be directly next door. The next block of 0Os and 1s
may be all the way across the disk, on the other side of the same platter, or
even on a different platter within the hard drive.

Then consider what happens the next time you open that file to do some
editing or add more material. While the original file might have occupied a
pair of contiguous segments, other work you have begun, copied, or edited
may have since filled in segments all around it.
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Defragmentation mechanics

For years I've made a nearly handsome living
describing how computers are very dumb but
very fast. By that | mean that they accomplish
their wondrous feats not so much by innate
intelligence butinstead by brute force and blaz-
ing speed. (To multiply 7,845 by 12,687 the
machine adds 7,845 to itself 12,687 times.)

The same applies when it comes to defrag-
menting a hard disk. There is no magical algo-
rithm or instant solution. Instead, defragging
works like this: The machine locates a block of
unused space on the hard disk. The bigger the
space, the faster the defragmentation process
will proceed.

Under control of the microprocessor, the
system picks up the scattered pieces of files
one by one and copies them from their former

location to the unused space. As the files are
rewritten they are compacted and made con-
tiguous to each other. Once all the pieces of a
file have been moved to a new location, the
former location is cleared.

As large, contiguous blocks of space are
opened near the beginning of the disk, the
rewritten files are copied again and moved to
the most efficient location available.

The process repeats itself over and over until
the disk is as close as possible to this: a clean
group of contiguous data and program files at
the logical start of the disk, a block of clean,
available workspace for the temporary needs
of the microprocessor, and a block of open
space for new files and for the creation of new
fragments as old files are edited.

If just a few files are fragmented in this way, it’s no big deal. Or if the particu-
lar set of files that are fragmented are ones that you use a great deal, it
becomes more of a problem. And fragmentation can become a real detriment
to computing if you regularly deal with very large files: digital photographs,
streaming video, and music are good examples.

Q&N\BEB
& But one thing is certain: Left to its own, every computer will eventually slow
down and lose available storage space because of fragmentation. It’s
designed right into the operating system.

Defragger rock

The bad news is that the larger your disk, as well as the more files it holds,
the longer it takes for defragmentation to be done; in some situations the
process can take several hours. The good news: you don’t have to do it yourself.

First of all, Microsoft Windows includes a capable defragmentation utility
that you can invoke from the Tools tab of the Properties page for each of
your hard disk drives.



Figure 3-13:
A
defragmen-
tation
session is
under way
in Windows
Vista.
Microsoft's
tool is
capable but
provides
almost no
information
about its
progress or
results.
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1. Click Computer (or My Computer).
2. Highlight the drive you want to work on.
3. Click Properties.
4. Select the Tools tab.
5. Click Defragment Now.
See Figure 3-13.

<
by Disk Defragmenter [E=SIE
+  Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system
+ performance, How does Disk Defragmenter help?

7! Run on a schedule (recommended)

Run at 1:00 AM every Wednesday, starting 1/1/2005 | Modify schedule... ]
Last run: 8/29/2007 2:49 PM

Next scheduled run: 9/5/2007 1:00 AM

' i ey tetom o ([ Cencel aetagmentation
; G | tati
This may take from a few minutes to a few hours ancel defragmentation

| Close |

And if you want to go a few steps beyond the basic service included in Windows,
you can buy one of several very sophisticated utilities that will generally

4+ Do the job faster

4+ May speed up your computer (using special algorithms that place the
most frequently used programs in the places where the disk drive can
find them fastest)

4+ Display a nifty color-coded chart that shows you before and after repre-
sentations of a messy disk and a cleaned-up beauty

The most advanced utilities keep your hard disk drive defragmented on the fly.
Here’s what that means: Their utility will come to life and move files around any
time it notices that your machine is not being tasked with other more immediate
assignment. So if you get up to go to a meeting or out to lunch, the defragmenta-
tion program will churn away while you're gone and then shut off the moment
you return your fingers to the keyboard or mouse.
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Among the best third-party defraggers:

4+ Diskeeper Professional from Diskeeper Corporation at
www.diskeeper.com

4+ Norton 360 from Symantec Corporation at www.symantec.com

Both of these products are intended to work in the background, essentially
keeping your disk at or near full efficiency at all times. See Figure 3-14.

Some defragmentation programs are within products such as Norton
SystemWorks, System Mechanic, and other maintenance-utility suites. These
products generally are to work on a scheduled basis; you might instruct them
to defragment your machine every Monday night beginning at 5 p.m., leaving
your computer on for the night.

Most third-party defraggers also paint a picture of the condition of your hard
disk drive before, during, and after they do their work. A seriously fragmented
hard drive shows a report that looks like the aftermath of an explosion at a
jellybean factory; afterwards you should see solid blocks of color denoting
contiguous files and sections of memory set aside for use by the operating
system for temporary storage. See Figure 3-15.

EEX

% Diskeeper, 2007 Pro Premier

Fie Action Yiew Help
B0G 0QGLO & @ o

Getting Started @ Status File System Free Space | Automatic Defr...  IFAAST Boat Time Defr. .,

718 blocd Enabled Disabled
Diskeepet and what they can do

foryou

Volume Size

Quick Start Guide

Wiew stepeby-step instructions for
gelling started vath Diskeeper.

Diskeeper Overview

[__anabze.. |[ Defragment. || Pawse |[  Swo |

Wiews the features available in

[ Feme ]
Volume: CORE DISK C Local Disk (C3)

Figure 3-14:
The main
control
panel for
Diskeeper
allows setup
of automatic
defragmen-
tation; the
utility runs
inthe
background.

quently Asked
Questions
View answers to hequently

Dashboard ]

Log | Histoy |

The Dashboard enables you to view and edit today's Automatic Defragmentation schedule and displays 1ealtime details about Automatic

arked questions.
Defragraentation IwisiT asking, petformance gairs, and the heakth of your volumes

Help F1)
View information about using

Diskeeper and where to get ~
further assistance Automatic Defragmentation Timeline

Goto Automatic Defragmentation Timeline | ¥

The Timeline shows when Automatic Defragmentation is tuned on or off for the selected volume: Click and drag your cursor to define times when
Avtomatic Defragmentation wil be tumed off, then cick Appl. Ciick Prapetties to changs the Automalic Defiagmenlation pioperties and to viewand
it the Timeline in weekly and daiy formats. For best performance from your volumes, leave Automalic Defrapmentation tumed ot ol tmes.

[ ot )1

Volume Properties

| =
@ 2
@ |
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Figure 3-15:
A post-
operative
report from
Diskeeper
shows how
nearly all
files have
been
reordered
into
contiguous
sectors. The
striped
sectionis a
portion of
the drive
claimed by
the
operating
system for
some of its
work.
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Here’s a three-in-one tip for defraggers.
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4+ If you're going to use a scheduled defragmentation utility (as opposed to
a background defragger), you will get better and faster results if you turn
off the connection to the Internet while it is running; otherwise, new
e-mail and other automatic activities that bring files to your computer

slow down the process (sometimes to the point where
mines it has to start all over again).

the utility deter-

Don’t let your drives get so fully packed that a defragger has no room to

rearrange files. In most cases, you shouldn't fill up a drive to more than
85 percent of its capacity; that means leaving at least 15 percent available
to the utility. Delete junk or move some files to external storage if you

need to open up space.

Help save the planet while running a scheduled defragmentation by turning

off your monitor. It isn’t needed for the process; you’'ll know the job is done

when the hard disk activity light stops flashing.

¥ COREDISKE DRY2Z VOL2 (E:)

Wolume Map | Job Report |

Manual Analysis Job Report

=B

Wolume map view:,

Thiz view shows the perfarmance of files on your volume with an emphasiz on the impact of fragmentation,

File Peiformance

Il Blue - high perfarming files and folders B Fed - low performing files and folders

I PFink - low perfaiming system files [ white - unused space

Greenfwhite - reserved system space

Save... Brink...

Close Help

COREDISKE  DRYZ_YOLZ (E!) Analyzed

Daone
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Figure 3-16:
Most people
should
accept only
the recom-
mended
disk cleanup
options.

Cleaning up before defragging
Before you defragment your disk using a manual program, clear away the
dead wood:

4 Cut down temporary files. There’s no purpose in defragmenting files you
don’t want to keep.

4+ Empty the recycle bin. If you're certain you won'’t need any of the files
residing in the recycle bin, throw those away before defragging, too.

Windows includes a small utility called Disk Cleanup. You'll find it on the
General Tab of the Properties for your hard disk; look for the Disk Cleanup
button like the one previously shown in Figure 3-10.

You'll be able to clean up just your files, or those of all users on the com-
puter. On a laptop, the most common setup is to have a single user account.
After the utility calculates the amount of space you can clean up, it will offer
you a report on what unnecessary files it found. Click the check box along-
side the types of files you want to clear off the disk.

For most users, it is best to accept only the recommended disk cleanup
options. If you choose to go further, read and consider the descriptions of
each before proceeding.

A sample report is shown in Figure 3-16; here I have selected deletion of 11.7MB
of downloaded program files, temporary Internet files, and thumbnails that can
be safely deleted. An additional 107MB of files occupy the recycle bin. For a
deeper level of cleanup, [ could choose to delete hibernation files, although that
would disable that function on the laptop.

7, Disk Cleanup for SQO04331V05 (C) [T
Diske Cloanue | Mose Options

‘-' “fou can use Disk Cleanup to fres up to 2.10 GB of dak
space on SGO043IIVES (£

Fles 1o delete

| ! Tempornry Inemat Fies 147MB -
5 Offle Webpages ITEHE [
2] Hbemation Fie Caaner 138GE |©
£ Recycle Bn 107 MB
) Setup Log Fles 518K8 -

Total ameunt of disk spacs you gain: 11.7 M8
Description
Windows keeps & copy of ol of your picture, video, and
document thumbnials 5o they can be dsplayed quicidy when you
open a folder. F you delete these thumbnads. they will be
automaticaly recreated a3 nweded.
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Among the options for cleanup is removal of superfluous System Restore
and Shadow Copies. If you click this option, all restore points except for the
most recently recorded one are removed.

In theory, this should be acceptable if your machine is working properly; I
don’t like the idea, though. I'd rather find other ways to clear up space on
my disk and keep a full library of restore points just in case there’s a prob-
lem [ haven’t run into yet. Some editions of Windows Vista also store previ-
ous versions of files and backup images of system files created with
Windows Complete PC Backup; these are called Shadow Copies. Again, |
would rather hold onto these just in case.

Opening up space other ways

On a desktop machine, running out of available space on the original hard disk
drive is a relatively minor problem. You can replace the original boot drive with
one of larger capacity (and transfer over the contents of the first drive). You
can add a second internal disk drive. Or you can plug in an almost limitless
number of external drives that can be hidden away under the desk or on

a shelf.

Things are less simple with a laptop. Some models allow you to swap out the
original hard disk drive with a larger replacement; transferring the contents
from the first drive may require some fancy footwork including providing a
temporary enclosure, power source, and data cable. Adding an external
drive is as easy as pie, but you may not want to lug around an extra box
when you travel.

So before [ worry myself with the details of adding more real estate within a
laptop, I try to find ways to reduce the ground clutter. A lot of this has to do
with the way I use my laptop: It isn’t my principal machine. [ use my laptop
as a traveling extension of my desktop machine, and for that reason I don’t
need to have every last piece of software nor every data file.

Here’s how to put your laptop’s hard disk on a diet: Remove any programs
you don’t need on your travel companion. Many programs offer their own
uninstall utility. Look for one as part of the application’s listing on All Programs.

The Uninstall feature of Windows also offers a Change or Repair function for
many programs. This allows you to add or remove specific components or
repair a problem by resetting the installation to its original condition. You
have no choice here — some manufacturers allow these advanced facilities,
while others give you only the chance to remove their product.

Under Windows Vista, you can uninstall many programs with this method:

1. Go to the Control Panel.

2. Click the Programs and Features icon.
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Figure 3-17:
The
Uninstall or
Change a
Program
window
allows
automated
removal or
adjustment
to installed
features of
most
software
added to
your
operating
system.

3. Highlight a program.
4. Take one of these steps:
¢ Double-click the filename.
¢ Click the Uninstall/Change option on the page.

The display includes the size of each program; you may be amazed at
the bloated amount of space demanded by some little programs. See
Figure 3-17.

Windows Vista users aren’t allowed to manually remove individual compo-
nents of the operating system. Some third-party utilities promise to do this
for you, but be very wary of using them. Microsoft may add a component
uninstall feature in future Service Pack updates to Vista.

A very similar facility is offered to users of Windows XP. The icon on the
Control Panel in that operating system is called Add or Remove Programs.
One advantage of Windows XP: There’s a command to Add/Remove Windows
Components. You can take away any program or utility that is part of
Windows that you don’t require; if you change your mind later on, you can
add it back on.

[F=Er=>=)
@thﬁ » Control Panel » Programs and Features - | d,! [ search L
Tasks 5
Uninstall or change a program

View installed updates

i . To uninstall a program, select it frem the list and then click "Uninstall”, "Change”, or "Repair”™.

Get new programs online at

Windor rketplace

View purchased software Sttt MBS 0

(digital locker) Mame : Publisher Installed 1 *

Turn Windows features on or ‘o Activation Assistant for the 2007 Microsoft Office suit.. Microsoft Corporation EHS!ZOO‘.E

off o Adobe Flash Player ActiveX Adobe Systems Incorporated 8/29/200;
il Adobe Reader7.0.9 Adobe Systems Incorporated 8/16/200 =
[ Adobe Shockwave Player Adobe Systems, Inc. B/15/200%
L= AOL Uninstaller (Choose which Products to Remove) lﬂﬁfm?f
9 Bejeweled 2 Deluxe WildTangent 8/15/2007_
BB Btackhawk Striker 2 WildTangent 8/15/2007
B Blasterball 3 WildTangent 8/15/2000
g Bluetooth Stack for Windows by Toshiba 3/1/2007
_* Camera Assistant Software for Toshiba Chicony Electronics Co., Ltd. B/15/200%
‘.' CD/DVD Drive Acoustic Silencer TOSHIBA 8/15/200%
@ Chuzzle Deluxe WildTangent 8/15/200%
ofi} Desktop Dialer 8/15/200;
DVD MovieFactory for TOSHIEA Ulead Systems, Inc. B/15/200%
@rae WildTangent 8/15/200%
@ Google Desitop Google 8/15/2007
G+ Google Toolbar for Internet Explorer 3272007
[ Intel(R) Graphics Media Accelerator Driver 8/15/200%
Jintemet Offers PeaplePC, Inc. 8/15/200; _
‘ . J L}




\NG/
g‘*‘“

Using Third-Party Maintenance Programs 2 4 ]

Make sure you have a legal CD or DVD copy of Windows XP before you
remove any Windows component; you may need to install the disc in your
laptop to add or replace a piece of software you chose to remove.

Once you have slimmed down your machine’s programs, do these things:
4+ Look for any data files that you can take off the hard disk. I keep my

archival copies of files on my desktop machine as well as on external
disk drives and DVDs attached to it.

+

Clean off any old files that have moved to your desktop machine.

4+ Look for any automatic backup copies of work in progress stored to
your disk by word processors and certain other programs; these are to
help you recover from a system crash or power outage and serve no
purpose once the completed file has been moved to your permanent
storage device and archived from there.

Using Third-Party Maintenance Programs

There’s Microsoft, there’s you and me, and then there are the third parties:
companies like Symantec, Diskeeper, McAfee, and others.

For the vast majority of the readers of this book (and for the author) our
computing world begins with Microsoft; although there are a handful of
alternatives including various flavors of Linux and even the latest Apple
Macintosh operating system. You might assume you’re using a current ver-
sion of Microsoft Windows.

But thanks to a combination of the free marketplace and a boost from the
U.S. Department of Justice, Microsoft’s operating system was pried open so
that a wide variety of utilities and extensions can be installed within or
alongside. Some of the utilities — including advanced maintenance programs,
defragmenters, and security suites — are better than those included in
Microsoft Windows and some are just different.
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Chapter 4: Honk, Honk! Windows
Backup and Restore Utilities

In This Chapter

v Automating the backup process
v Restoring files from a backup source

1 Using System Restore as a magic bullet (if you’re lucky)

Wﬂt! Before you start your day’s work, make sure that yesterday’s
efforts are safely secured.

Centering your business and personal life around your computer is a high-
tech good news/bad news story. On the plus side you benefit from the
impressive capabilities of word processors, spreadsheets, the Internet, and
e-mail that permit you to perform almost all your tasks with ease. The hard
disk drive or other digital storage is where you keep your stuff — not in a
shoebox under the bed or stacked in a drawer — and you can use your
laptop’s brain to search for and display anything you’ve placed in electronic
storage.

Data centralization is at the heart of the bad news. What would you do if
you pressed the power switch on your laptop and nothing happened? What
would you do if the laptop came to life but the hard disk drive had somehow
been erased? What would you do if your computer were infected with a
virus? And of particular concern to laptop users: What would you do if your
laptop were stolen from your office, a hotel room, or an airport?

The answer to the bad news is relatively simple, although it requires a bit of
planning and time investment: Make backups and keep them in a secure place.
If you're lucky you’ll never have to use them; if not, you’ll be very pleased
with yourself when you can reach onto the shelf to solve the problem of a
missing or corrupted file.

Backing Up Before You Go Go

A backup is an extra copy of a file or a full folder of files that you keep in a
different location than the original. (There’s not a lot of value in making
backups and keeping them on the same hard disk drive as the original, and
for that matter, it also doesn’t make a lot of sense to back up on a storage
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medium like a CD, DVD, or flash memory key and keep them in your laptop
computer travel bag; if the bag and computer are stolen, your backups will
go along with them.)

Some programs, including word processors, let you create version backups
(which aren’t the same as backups) to guard against loss of data. A version
backup is a copy of whatever file you're currently working on before you
began changing the current version. This valuable tool is for when you change
your mind and want to go back in time to that earlier version, but in most
cases the version backup is stored on the same hard disk drive as the original.

Choosing files for backup

What type of files should be backed up? The short answer is: anything of
value to you that would be difficult or important to replace.

Definitely make backups of the following:

4+ Any word-processing files for projects in progress

4+ Anything that records important personal information, financial or legal
records, and receipts

Music
Photos
Video

Important correspondence that arrives (or departs) via your e-mail
program

+ 4+ 4+

What doesn’t need to be backed up? The operating system or programs
installed on your machine. Instead, keep the original installation discs and
product keys or serial numbers so you can reinstall them in case of disaster.

Choosing frequencies for backup

The amount of time you let go by between data backups should be directly
related to your personal and professional threshold of pain. If you lost all the
work you've done today, would that be the end of the world, or merely require
you to spend a few hours re-creating the files and other documents while they're
still somewhat fresh in that other computer — the one between your ears?

If you lost all the work you did today as well as yesterday, that might be
more than you’re willing or able to stand. And if you were to lose the work of
a week or a month or a year . . . please stay away from open windows, rail-
road crossings, and tax collectors.
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Because I spend nearly my entire business day parked in front of my laptop
keyboard, I consider it essential to back up all my work daily. I use a combi-
nation of temporary backups to devices like flash memory keys, and more
permanent weekly or monthly backups to removable media including DVDs
and external hard disk drives. And most recently I've begun using the serv-
ices of automated online backup facilities that promise to keep me protected
all the time, nearly up to the minute.

Backing up manually

You can take charge of your own backup process quite easily. But you have
to promise me (and yourself) that you will be 1) diligent, and 2) organized.

Here is the manual backup protocol (a word that was in the jargon of com-
puter geeks for years before the writers of the TV show 24 decided to use it
in every other sentence of their scripts) that I follow:

Daily or anytime 1 worry

Daily, or anytime [ worry that I've just completed something that would pain
me to have to redo, I copy the specific files or folders I've been using.

[ used to do this on a CD-R disc, which has about 700MB and, bought in bulk,
costs as little as ten cents. Burning a CD requires about five minutes, and when
it is done I used a felt-tip pen and marked the date and a description of its con-
tents on the disc’s front (label side). I stored my CDs in a plastic case on the
bookshelf. If I was traveling with my laptop, I brought a box of blank CDs and
made copies that | stored somewhere other than my laptop carrying case.

Nowadays, though, I back up using a flash memory key. These little sticks of
memory are examples of the inverse pricing model of modern technology:
They keep getting larger in capacity and cheaper in price. As this book goes
to press, you can buy a 4GB memory key for about $25 and use it over and
over again.

I plug a memory key into a USB port on my laptop as I work, and every few
hours — or anytime I'm about to leave the room when I travel — I move a copy
of all of today’s work onto the key. Then I remove the little device and pop it in
my pocket or in the hotel safe or amongst my dirty socks in my suitcase.

Once a week or anytime I'm leaving on an extended trip

Once a week, or anytime I'm about to go on an extended trip, | make an incre-
mental backup of all files that have changed in the past week. If 'm working
from my office, I make a double backup: one set of files is copied to an exter-
nal hard disk drive and another set is burned to a DVD disc. The external
hard disk protects against a failure within my laptop; the DVD goes into a
storage container or a safe in my office and stays behind when I travel.
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Today’s basic recordable DVDs have a capacity of about 4.7GB and don’t
cost much more than CD-Rs. Dual-layer drives offer as much as 9.4GB. And
on the horizon: Blu-ray discs with 25GB single-layer and 50GB dual-layer media.

Most modern laptops come with DVD recorders, although some machines
may be one step (or a few dollars) behind the time and offer a CD recorder
and a DVD player. You can burn a CD in a DVD recorder but can’t create a
DVD in a CD recorder.

Once a month or anytime | finish a major project

Once a month, or any time I finish a major project — like the gigantic book
you’re holding in your hands — I make a full backup of my laptop’s hard disk
drive. I already have DVDs with the most recent data, but for this project I
make a mirror copy on an external hard disk drive.

Using an Automated Windows XP Backup Program

A\

Instead of doing it yourself, you can use the computer to take care of its own
backup processes. It seems only fair, don’t you think?

Windows XP and Windows Vista include their own utilities that let you com-
mand your laptop to copy all its files, entire folders of files, or individual
files. You can put the copies on an external hard disk drive or on any other
form of removable media, including flash memory keys, DVDs, and CDs. You
can also purchase products (from third-party utility makers) that you may
find to be easier to use, more automated, or faster than Microsoft’s tool.

Windows XP comes equipped with a basic backup program. It’s preinstalled
as part of Windows XP Professional; if you have Windows XP Home Edition,
you can add it to your system with a few extra steps.

Adding Microsoft’s backup
to Windows XP Home Edition

For reasons best understood by the marketing people at Microsoft, Windows
XP Home Edition comes with Backup on the installation disc but not on pre-
configured systems. You can easily remedy that, though.

Some laptop manufacturers have chosen to save a few pennies (or charge a
few dollars more) by not including a physical copy of the Windows installa-
tion disc with their machines. Instead, they add a compressed copy of the
installation code in a hidden partition on your hard disk drive, allowing

you to reinstall the operating system from there if necessary. [ think that’s a
terrible idea; what do you do if the hard disk drive fails? I insist on receiving
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an actual copy of the Windows installation disk with any computer I buy,
although sometimes [ have to pay a few bucks for something that’s
already mine.

Insert the Windows XP CD in the optical drive of your laptop. It should
auto-start; if it doesn’t, follow these steps:
1. Open My Computer and double-click the CD icon.

2. On the Welcome to Microsoft Windows XP screen, click Perform
Additional Tasks.

See Figure 4-1.
3. Click Browse This CD.
Windows Explorer opens.
4. Double-click the ValueAdd folder.
5. Double-click Msft.
6. Double-click Ntbackup.
7. Double-click the icon for Backup.
The file is called Ntbackup.msi.
8. Click Accept Instructions to install the program.

9. Remove the Windows XP installation disc when the utility is in place.

B Welcome te Micresoft Windows XP

Welecome to Microsoft Windows XP

£ 0 ; What do you want to do?

[ set up Remote Desktop Connection

3 Set up a home or small office network

Figure 4-1: =

. [ TIransfer files and settings
Addmg [ Browse this D
some early, [3] View the release notes
hidden, [=! Install NET Eramewaork
extra € Back
Windows

XP features.
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WING/

&
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>

Running Windows Backup

Once you install the program in either the Home or Professional version of
Windows XP, using it is the same. In its standard configuration, the program
offers a wizard that offers a streamlined pathway to the most commonly
used options for backup.

To open and run the backup program, follow along:

1. Click the Start button.
2. Click All Programs > Accessories = System Tools > Backup.

The wizard asks the appropriate question: What do you want to back up?
(See Figure 4-2.) You can back up all the contents of your My Documents
folder plus favorites and cookies, all information on the computer, or be
selective and choose particular files or folders.

This is one reason to use the recommended file folders, including My
Documents or Documents; if you use a folder of your own, it may not be
automatically backed up or you may have to take a few extra steps to add it
to the list of folders for archiving. A distinction exists between working on
your documents and settings only, or on those that belong to every user of
the computer. (Most laptops are set up with only one user.)

The option to back up all information also creates a system recovery disk
that can restore Windows to the condition as it existed on the day you made
the backup in the event of a catastrophic failure.

The backup process under Windows XP includes an Advanced feature that
allows you to set an incremental or differential backup instead of making
copies of every file it finds in the specified folders. An incremental backup
adds only those files you’ve created since the last time you ran the backup
utility; a differential backup backs up only the changes to files and folders
and settings since the last backup.

The doorway to the Advanced screen is on the last window before the
backup process begins; see Figure 4-3. You can back up only files to disks
that are current formats, including NTFS, FAT, or UDF.

You must back up files somewhere other than the disk where the files cur-
rently are; that makes sense, since the idea is to have a copy to use in the
event of the original media’s failure or corruption. Under Windows XP, you
also can’t make backups to a flash memory key or to a tape drive.
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Backup or Restore Wizard E|
What to Back Up @
You can specify the items you want to back up.
. 0
Figure 4-2: What do you want to back up?
The () My documents and settings
Windows Includes the by Documents folder, plus vour Favorites, desktop, and cookies.
XP Backup ; .
or Restore ) Everyone's documnents and settings
Wizard Inclu_des every uger's My Documents folder, plus their Favorites, desktop, and
includes cookies.
options that ) Allinfarmation or this computer
allow Includes all data on this computer, and creates a system recovery disk that
storage of a can be uzed to restore "Windows in the caze of a major failure.
ELesis;?zred (%) Let me chooze what to back up
group of
files,
folders, and
settings. < Back “ Mext » ] [ Cancel
Once you begin a backup, you can return to other tasks on the computer;
the backup goes on in the background. You may notice that your system
runs a bit slower than usual, and certain tasks involving opening folders or
moving files may take considerably longer (in relative terms) than usual. Any
files that you might change or create while the process is under way aren’t
backed up until the next time you run the utility.
\

If you make your backups to a recordable CD or DVD, be available to insert
and remove discs as needed. You should also have a felt-tip marker to label
each disc as it’s created; add a numerical or alphabetic sequence so that you
know the order of the discs should you ever need to restore data from them.

If you lose one CD or DVD in a sequence of backup discs, you can restore your
data — except for the files or folders that were recorded to the missing disc.

Certain technical restrictions also prevent storing backups on a network
device in a computer running Windows XP Home Edition. You can, however,
save from that machine to a directly attached storage device.
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Figure 4-3:
On my fast
system it
took about
two hours to
move 100GB
of data from
an internal
hard drive to
an external
unit.

The Backup utility moves most common data and settings file types. The fol-
lowing types of files can’t be backed up:

<+

TR IR IR

System files (elements of the Windows operating system)
Program files (applications added to the operating system)

Files currently in the Recycle Bin

Temporary files

Files that have been encrypted using Encrypting File System (EFS)

User profile settings

Up to this point, I've written only about backing up your files. The other half
of the utility, of course, is restore. To initiate data file restoration, choose the
obvious option: Restore. You can return files to their original location or
select a new spot; if you're restoring files to a new hard disk drive, you can
adjust the location to match its new organizational structure.

Windows Vista comes equipped with a backup program similar in appear-
ance and function to the Windows XP utility, although Vista’s runs a bit more
quickly and includes a few additional features. The opening screen for
Vista’s backup program is shown in Figure 4-4.

Backup or Restore Wizard @

Completing the Backup or

% Restore Wizard
] 0 B

YYau have created the following backup settings:

Mame: L:MBackup 120807 bkf
Description:  Set created 124842007 at 11:27 AM
Contents: Selected files and folders

Location: File

To cloze this wizard and start the backup, click Finish.

To specify additional backup optiohs,
click Advanced.

< Back “ Finish ][ Cancel ]
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Automatic file backup is not set up

When you set up automatic file backups, Windows will make a copy of the files on
your computer to a location of your choice, System and program files will be
skipped.

What file types are not included in the backup?

Afterwards, Windows will scan your system on a schedule that you specify. New or
updated files will be automatically added to your backup.
Restore Files Enabling automatic file backup will help protect your files from loss or accidental
deletion.

@ Set up automatic file backup

— Choose your backup settings and run your first backup.
Figure 4-4:
The first
step in using
Vista's
backup
facility is to
setup
automatic
backup.
Book IlI
Chapter 4
Curing Some Evils with System Restore 2 s
o =
By now every computer user knows very well that computers aren’t infalli- f_u'!_ s
ble. (That doesn’t mean that they possess an antigravity force field and are g 5
protected against falling off a table; it means that even the most carefully [ 5
guarded and well-maintained machine occasionally loses its mind or at least = %
stops performing as well as it did yesterday.) s

In addition to file and folder backup and restore, Windows offers another
backup: System Restore focuses solely on settings and configurations. It
doesn’t record word-processing, e-mail, or any other data file you create;
that’s the Backup utility’s job.
WING/

§g~ One of the major causes of meltdowns large and small? Corruption of stored
settings, Windows system files, or unintended changes to those same essen-
tial elements. How can this happen?

4+ An electrical fault. If your laptop runs out of power while saving a file or
installing a program, or if it somehow receives a power surge or static
shock, this can be the result.

4 A virus or other form of unwanted nasty code.
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4+ A poorly designed installation program. Said installation program is
one that doesn’t follow all of Microsoft’s recommendations or does not
play well with other applications.

4+ An incomplete installation. A power failure or an operating system
freeze are two interrupting culprits.

4+ A rare combination of incompatible software or hardware. Although
software makers spend a great deal of time (some more than others)
testing their products, they can’t anticipate every possible permutation
of code and device.

gMBER

‘{s«“‘ Never install a program on your laptop when it’s running off batteries. If the
power runs out before the installation is complete, the result could be
damage to the system files.

“&N\BEI; System Restore won’t run on disks smaller than 1GB, which shouldn’t be

& much of a problem for laptop owners; by today’s measure that capacity is

tiny. In any machine, you need a minimum of 300MB of free space on each
hard disk that has System Protection turned on. Similar to the Recycle Bin,
as the amount of space dedicated to restore points fills up, the computer
deletes older information to make room for new.

Using System Restore

One solution to a sudden, serious problem with your Windows operating
system is go back in time, to a point when it last worked properly. No, this
doesn’t require use of Doc Brown’s plutonium-powered flux capacitor from
“Back to the Future.” It does, though, require a Windows utility called System
Restore . . . and a bit of luck.

System Restore works by taking electronic snapshots (called restore points)
of your system files and settings at regular intervals and any time you manu-
ally instruct it to do so. If you've lived a clean life, helped little old ladies
cross the street, and haven’t done anything else to bollix up your system, it
may allow you to undo damage. A portion of the Windows Vista System
Restore screen is shown in Figure 4-5.

The utility records the status system files, programs that have been installed
to run under Windows, and the settings in the Windows registry. In certain
circumstances it can record changes made to scripts, batch files, and other
types of executable files.



Figure 4-5:
When you
restore files
and
settings, you
can try the
most
recently
recorded
restore
point or go
onto the
utility's
calendar to
selecta
specific day.
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System Properties g
[ Computer Nome [ Hardvars [ Advanced | System Prtection | Remote|
use restore points to undo unwanted system changes. How
digk; space is required? ||
& System Restore %1

System Restore helps you restd Restore system files and settings
system files to an earler point if o

Automatic restore points st o+ System Restore can help fix problems that might be making your

Create restore points automal k& computer run slowly or stop responding.

| Avaidable Disks B — S — System Restore does not affect any of your documents, pictures, or

loes System

personal data, and the process is reversible. Ho

TOSHIBA SYSTEM|
| @ &, 50004331V05 ()
9 Recommended restore:

Select this option to undo the most recent update, driver,
or software installation if you think it is causing problems.

{30/2007 9:56:38 AM H
Yoiican cioals 2 nsskoss pov 8/30/2007 9:56:38 AM Install: Windows Update

disks selected above. Current time zone: Eastern Daylight Time

[ Choose a different restore point

s To create a restore point, open System Protection.

(text> ] [ concd ]

When it comes to personal files including e-mails, documents, photos, and
music, I've both good news and bad. The good news: If they’re still on the disk,
using System Restore won’t touch them. The bad news: If they’ve been erased
or corrupted, you have to try to repair them or unerase them using other
methods. (Of course, if you're really a careful user, you've backed up copies of
your files on a different drive or on an external medium like a CD or DVD.)

A restore point records only your system files and settings. Choosing a
restore point has no effect on any data files you created before or after the
snapshot, but software or hardware installed since the restore point won'’t
likely be immediately available to you. Hold off reinstalling anything until
you're sure Windows is performing properly.

Knowing System Restore best practices

You have absolutely no reason not to set up your machine to use System
Restore. The only minor issue you must decide is how much space to devote
to restore points; once you reach the size limit, Windows automatically
deletes the oldest restore point to make room for the newest.
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When you enable System Restore, it automatically creates a restore point
every day, just as a snapshot of your up-and-running machine. It also creates
a restore point any time you add a new device driver, receive an automatic
update from Microsoft, or install certain new applications.

In my office, [ make it a point to manually record a restore point any time I
am about to significantly change settings or install a new program.
Sometimes this results in a duplicate restore point — my manual point plus
the one automatically created in certain circumstances; as far as 'm con-
cerned the duplication is no big deal. I'd rather have a pair of rescue rafts
than none.

System Restore works only with NFTS-formatted disks, which is the current
drive standard. It doesn’t protect drives with FAT32 and earlier FAT file systems.

When good intentions go bad

This section’s main title indicates that System Restore can cure “some” evils.
Alas, the utility isn’t perfect. System Restore doesn’t copy every single
system file, and sometimes the one that goes bad isn’t included. You can
restore all you want and not fix the problem.

Another situation that can arise: Something goes wrong with one or more of
your system files while the machine is running, and you keep using it for a
while before realizing you need to go back in time. In certain circumstances,
your system may endure some additional changes (or even corruption) after
the most recent restore point.

sMBER

How to defend? Backup, backup, and backup. Don’t rely on your machine to
always be there for you; make copies of essential data files on a regular basis
and store them on external drives or disks.

Restoring your system settings

Follow these steps to use System Restore:

1. Save any open files and close all programs.

2. Make sure you have current backups of essential data files.
3. Click the Windows icon.

4. Choose All Programs = System Tools => System Restore.

Alternately, you can go to Control Panel, click the System icon, and then
choose the System Restore tab.

The utility asks if you want to create a restore point (to set one manually)
or if you want to choose a previously recorded snapshot.
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Figure 4-6:
A manual
selection
offers
recent
restore
points.
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5. Choose one of the following:
¢ Create a Restore Point
¢ Restore My Computer to an Earlier Time

If you want to do a restore, you're shown a calendar; days with one or
more restore points are in bold. The Windows Vista version automatically
displays data from the past five days; you can click the check box to show
restoration points older than that. See Figure 4-6.

6. Select a restore point just before the day and time you began experi-
encing problems with your Windows installation.

N

Highlight the checkpoint you want to use and click Next.

The computer chugs along for a few moments preparing the information
it needs, and then the system reboots. You’ve nothing to do but wait. If
the restoration is successful, a screen appeared when Windows loads; if
the restoration fails, your system restarts in the same condition it was
before you attempted a fix. You can try again by selecting a different
restore point.

System Properties

[ Computer Name | Hardware | Advanced | System Protection |Remate |

=} You can use restore points to undo unwanted system changes. How

] much disk space is requined

Ll

i’ System Restore I [

Choose a restore point

System Restore helps you restd | ;
system files 1o an earber port i | System Restore will not change or delete any of your documents and the process is reversible,

HAutomatic restore points
Create restore points automal | Click the restore point that you want to use and then didk Next. How do I choose a restore point?

| Avaable Diskcs
| Current time zone: Eastern Daylight Time
| . TOSHIBA SYSTEM| | 2
| 1 & 50004331v05 €3 | | Date and Time Description
8/30/2007 9:56:38 AM Install: Windows Update
8/29/2007 3:14:40 PM Instal: Instaled Microsoft Office PowerPont Viewer 2007 (English)
11 8/29/2007 12:17:17PM System: Scheduled Checkpoint
8/28/2007 10:33:22 AM Instal: Windows Update
Vois canl cuate s st pad | B8/28/2007 9:54:45 AM Install: Windows Update
disks selected above

I

| 1| Show restore points older than 5 days
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\NG/
S

Try to choose the most recent restoration point when you knew the machine
was working properly. Going further back than necessary could result in dis-
abling updates and changes that you’d rather have available.

In normal operations, any time you choose a restore point, System Restore
automatically makes a snapshot of the day’s files so you can undo any prob-
lems you might introduce reaching further back on the calendar. However, if
you use System Restore when the computer has been booted in Safe Mode,
you can'’t directly undo the restore. Instead, you have to run System Restore
again and choose a specific previous restore point.
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Applications

The Slide Sorter window in PowerPoint lets
you see dozens of slides in a presentation.
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Chapter 1: Writing Documents

In This Chapter

v Going from typewriter to typesetter
+~ Formatting, styles, themes, and other flashy stuff
v Finding, replacing, and changing text and styles

1~ Discovering new Microsoft Office file formats

I’m going to skip right over Neanderthal cave drawings, ancient
Egyptian papyrus scrolls, the handwritten Magna Carta of 1215, and
the Declaration of Independence of 1776. And I'm not going to discuss
the first mechanical typewriters of the 19th century.

All these prior technologies were just variations of a brush and ink or chisel
on stone. If you made a mistake you had to go back and redo your work;

if you wanted to move a sentence from one place to another you had to cut

and paste (with a scissors and glue) or start over from “When in the course
of human events .. .”

It was only 40 years or so ago that engineers and programmers began work-
ing with the concept of applying computer memory and processing power
to the job of creating, correcting, revising, and perfecting an assemblage of
characters strung together into groups that had individual and collective
meaning: words, sentences, paragraphs, and entire manuscripts.

Processing Words No Matter the Program

MBER
‘x&
&

In this book I primarily use examples of office productivity tools from the
Microsoft Office suite: Microsoft Word, Microsoft Excel, and Microsoft
PowerPoint. [ have chosen these because they’re the most commonly used
applications.

You may have a different set of tools on your machine because you found
some special features that suit your needs better, or you prefer a different
piece of software because you like the way it’s organized. And some users
make decisions based on cost; you can find shareware office applications
and even free tools offered by major companies like Google.



260 Knowing What Elements to Expect

Get on my cloud

A developing trend in applications — one that mostly somewhere out there on the Internet
may or may not become the way everyone while your documents reside on your laptop or
works in coming years — is the use of Web- sit on a server maintained by the company that
based applications, also known as cloud com-  offers the software.

puting. In this design, the software exists

However, the basic concepts of word processing are the same for all of the
various tools. You type, the computer puts the words up on the screen, and
together you and the machine make them into pearls of wisdom, beautifully
typeset, and safely stored away for the ages.

&,N\BEH The most important thing to look for in any word processor is its ability to
l‘, . . . ope
exchange documents with other applications. You can do your writing and
processing in Microsoft Word and send it to someone who works with Corel
WordPerfect or Google Docs (one of the cloud computing products that exist
on the Web; see this section’s sidebar). I'd never recommend using a word
processor that can’t read files created by any major competitor and can’t
save a version of its own files in a format that the others can use.

In this chapter I concentrate on some of the less obvious or more useful
features that sometimes even the most experienced users overlook.

Knowing What Elements to Expect

The days of the manual typewriter offered a limited number of choices when
it came to the design and appearance of a typed page. You could mechani-
cally adjust the amount of white space on the left and right sides of the page
by setting margins, and you could start each page a particular distance
down from the top and end at certain height above the bottom.

Everything else — underlines, footnotes, page numbers, chapter and section
headings, and the like — were all done by hand and eye. High-school and
professional school classes devoted entire semesters to mastering the art of
manual formatting. Today, you merely have to choose from an ever-growing
menu of options. You can make your documents simple or complex; your
choices ensure consistent and neat presentation. Figure 1-1 is a sample page
from Microsoft Office Word 2007.
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Book I Choosing the Best Laptop

Chapter 1: The Difference

Between a Need and a Want

Figure 1-1: :

. In This Chapter

A chapterin We knowswhatyoureally wait

progress Knowing when the price is right )
Are Yop an off-the-shelf or a custom-fit guy or gal?

under Word

2007 ThIS Tknow what you want- a screaming-fast laptop with a gigantic hard disk, a
zippy high-resolution DVD drive, a sparkling widescreen display the size of

new edition an opened phone book, a pair of humungous speakers with a deep bass
subwoofer, anda full sized no-compromise keyboard.
added a

Oh, and you want the whole thing to weigh three pounds, fit into a tiny

C h a ng ing camy-onbag, andbe constructed out of bulletproof titanium.
ibb f And the cost: you could get a desktop system with all of the above—and
rmppon o more—for ahout a thousand dollars. So yon'd want to spend that much—or
. less—for a small box to take with you on anairplane, a commuter train, or
options that from one room in your house to another.
ad] usts to Beforel gently introduce you to the economics of laptops, allow me to raise
a different question.
the work
What do yori reaily need?
b eing You [ITAL]nzed[ENDITAL] transportation to get from home to the
supermarket andback, a distance of 3 2 miles with a local speed limit of 30
pe rformed. miles per hour, a taskthat could be accomplished in 2 1989 Yngo GVX with
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The elements of a complex document typically include

4 One or more fonts

4+ Headers and footers (labels that appear at the top or bottom
of each page)

Page numbering
Footnotes

Citations

Mathematical equations
Index

A table of contents

R IR

A bibliography

To ensure consistency across a project or for all work done in a particular
department or an entire organization, you — or a supervisor — can create a
document template to apply to any or all files of a particular type.

Book IV
Chapter 4
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My back pages

In my first job as a newspaper reporter, | began
with a manual typewriter and was thrilled when
| was upgraded to an electric version. My type-
writer, that is. But here was how my words made
it from my hand-scrawled notebook to the front
page of the Gazette: | pecked away to write
sentences on a piece of paper. If | made a mis-
take, | backspaced and Xed it out — or just
reached into the machine with a thick, soft
pencil and struck out a word or a sentence. If |
wanted to move paragraph five to become
paragraph two, | removed the sheet of paper
and, with scissors and a role of clear tape,
rearranged the paragraphs.

When the article was done, | yelled, “Copy!” and
a young kid would dash from one of the corners
of the newsroom to grab the sheaf of pages | was
holding in my hand. He or she would move over
to a shelf along the wall and tape the pages one
to another so that they were in a continuous roll.
After a copy editor had gone over the story —
penciling in corrections and doing some addi-
tional cutting and pasting— the entire roll would
be placed in a metal cylinder and sent through a
whooshing pneumatic tube down two floors to
the pressroom.

And there a typesetter (a human, not a machine)
would mount my roll of words onto a stand and
retype the characters and words into a machine
that would set type. There was one last step: A
proofreader (a person, drawing a paycheck) read
the typeset text and compared it to the typewrit-
ten, hand-corrected, cut-and-pasted original.

The first processed words

As the computer began to become relatively
common in offices in the 1960s and 1970s, the
first connection between “secretaries” and the
machine were introduced. Xerox, IBM, and
Wang were among the first companies to offer
electric typewriters that had a way of storing

words or sentences or even entire documents.
The devices began with small blocks of memory
in the machine that allowed for corrections, and
then we moved onto larger storage devices
including paper tape and eventually to magnetic
disks.

But it really was not until the late 1970s before
workstations connected to a central room-sized
computer allowed the first text editors to
replace backspacing, pencil marks, scissors,
and tape at the keyboard. And then history — at
least as it concerns the written word — was
changed forever in 1981 when the first IBM PC
was introduced.

Swept aside by technology

The first word-processing software for personal
computers (including Multimate, WordPerfect,
and WordStar) swept aside almost any reason
to hold on to rolls of paper, paste pots, and scis-
sors. Also swept aside: copy boys and copy girls,
pneumatic tubes that carry documents, typeset-
ters to retype edited manuscripts, and proofread-
ers. And in most offices, personal secretaries and
entire squadrons of workers in the “typing pool”
were let go (which was bad) or given more mean-
ingful and professional job assignments.

Look at this revolution in one other way: With the
arrival of the personal computer and its laptop
cousin, job descriptions have changed to
include a multitude of other tasks. The person at
the keyboard no longer merely writes a memo or
a letter or a ook called Laptops All-In-One Desk
Reference For Dummies. You're also correcting
your own mistakes, editing and revising the
structure of your work, and saving a copy for
future use. And in the process you're also
designing a format, setting the type, and trans-
mitting it to a printer or sending it across the
world in a stream of Os and 1s for reconstruction
at the other end.
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Starting a Document

The arrival of Microsoft Office 2007 brought a large, round button in the
upper-left corner of the editing screen; the Microsoft Office Button replaces
the File menu of previous Office versions, and you can get to many places
and do many things from that single button. See Figure 1-2.

Open a blank document and start typing:

1.

+

Click the blank page icon (part of the Office toolbar).

If you want to get there another way, try one of these methods:
* Press Ctrl + N.
¢ (lick the Microsoft Office Button, and then click New.

A menu appears.

. Double-click Blank Document.
. Click the Microsoft Office Button.

Choose from a set of options that opens:
New. Opens an empty unformatted file.

Open. Opens a previously saved file. Windows Explorer opens the folder
Word most recently used to store a new or revised file; you can also nav-
igate to any other folder or location on your laptop or on an attached
network or Internet location.

Save. Saves the currently active and open file in the same location it
currently resides.

Save As. Allows you to select a specific file format for the current file:

¢ Word Document. This new format is based on the Open XML specifi-
cation. Files are stored with a .DOCX filename extension and gener-
ally require about half the space as previous Word file formats.

e Word Template. A special form of file that can apply settings to new
or existing documents.

e Word 97-2003 Document. A way to save a file created in Microsoft
Office 2007 in the older (and larger) file format used by the previous
few generations of the program.

¢ PDF or XPS. Lets you save a file created in Word in the Adobe PDF
(Portable Document Format) specification, whose files can be viewed
or printed on other machines exactly the way you intend. XPS is a
similar fixed-layout electronic file format promoted by Microsoft.

Book IV
Chapter 4
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<® Clicking the Microsoft Office Button opens an expanded set of housekeeping
functions as well as a list of recently used documents. You can pin any of the
documents to keep it on the list for easy retrieval; it can be unpinned when
you're through using it. (To pin a document . . . wait for it . . . you click the
little push-pin icon alongside its name. To unpin, you click the push-pin
again. It’s an uncommonly logical bit of design.)

BOOKO04-01 Chapter 1 Word - Micro: d

o
— Review  View Add-Ins
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D Hew | ey % 3 Find -
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= 5 13 Microsoft PowerPoint Shortcuts 1P 4=
— & RAW Tips and Tricks for the Road Laptops g 1= [lent typically include a selection of one or
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. 2] word Options f§ X Exit Word
Flgure 1-2: Or to get to the same place using menu commands, click on the Microsoft
An Office Button and then click New. From the menu that is displayed, double-
click on Blank document.
expanded
set of (With the arrival of Microsoft Office 2007, the company’s suite of office
applications added a large round button in the upper left corner of the
house- editing screen; the Microsoft Office Button replaces the File menu of
. previous versions. Clicking on the button
keeping
functions.
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Tapping into templates

A template predefines a document’s dimensions, fonts, and text style.
A template comes in handy when you’re working on letterhead, flyers, and
other, similar items.

Creating a template
To create your own template, follow these steps:

1. Start a new document or open an existing one.
2. Include its basic elements.

3. Choose File > Save As ©> Template.

Don’t choose one of the document choices.
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4. Decide where to store the template.

You can put it anywhere you want on your system, but it helps to put it
where you can easily find it. When you start a new file and want to base
it on a template, browse to its location.

Opening a new document using a template
Follow these steps to use a template as the basis for a new file:

1. Click the Microsoft Office Button.
2. Click New.
3. Under Templates, click Installed Templates.
4. Click the template that you want to use.
The listed templates are on your computer. A new, blank

document opens.

You can download a prepared template for documents from Microsoft Office
Online; your laptop must have an Internet connection to receive a download.
You can go to the Microsoft web site and search for templates; one direct
route is to use your Web browser to go to http://office.microsoft.com/
en-us/templates/

Saving a modified template

If you create (or download) and then change a template, you can save
it on your laptop for future use. By default, customized templates are
automatically saved in the My Templates folder.

As long as you open a template, make changes, and then re-save it as a tem-
plate, all will be well. If you make the mistake of saving a template as a docu-
ment, you have to reopen and re-save it as a template for that purpose.
1. Click the Microsoft Office Button.
2. Click Save As.
The Save As dialog box opens.
3. Click Trusted Templates.
The Save as Type list drops down.
4. Select Word Template.
5. Enter a name for the template.
6. Click Save.

Book IV
Chapter 4
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Because nearly all current word processors exist in the virtual world that is
the memory of a graphical user interface like Windows, they come very
close to defying the laws of physics. You can use fonts of nearly any size or
design, run text in any direction, and add any color, emphasis, or special
effect imaginable.

The only physical constraints placed on a document created in a word
processor are those related to your hardware. For example, your printer has
limits on the paper size it can handle and some fonts may be too small to

be seen or too large to be printed. And you can specify a color that only a
bumblebee can see, which is kind of besides the point of word processing
for humans.

Setting margins
Under most versions of Microsoft Word, you can set the margins for the
entire document with these steps:
1. Press Ctrl + A.
This selects all text.
2. Right-click and choose the Paragraph menu.

3. Enter left or right indentations in inches.
Microsoft Office 2007 adds another route.

1. Press Ctrl + A.
This selects the entire document.
2. Click the Page Layout tab.
3. In the Page Setup group, click Margins.
You're offered a choice of predetermined margin settings:
¢ Normal.
e Narrow.
* Wide.
o Windows 2003 default.

¢ Custom. You can assign Custom as the new default. The Default
setting becomes part of the template on which the current document
is based; this permanently changes the template.

e Office 2007. Includes left, right, top, and bottom margins.
4. Click your preferred setting.
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What's your type?

Type sizes use an electronic version of an old
printer’'s scale that uses points as a measure-
ment. An inch has 72 points, and so a 36-point
font uses characters about  tall. (If you think
about it, though, you realize that a capital A is
taller than a lowercase a, and letters including
jand y descend below the baseline of other
characters. And some fonts get really funky, fol-
lowing rules of their own for some or all of their
characters.)

On a computer, point sizes are standardized to
mean the full size of the available space for the
character: from the top of the highest ascender

to the bottom of the lowest descender.
Therefore, a 72-point capital Mis about % of an
inch tall, and two lines of 36-point type set with-
out extra spacing between them occupy about
the same % inch space.

One other point: In printing terms, a fontmeans
a particular design for a set of characters, set
at a particular size. For example, in an old print
shop you’d say that this book is set in a font of
9.5 point Times New Roman. They needed to
use that sort of terminology because each font
(style and size) was kept in a separate drawer
somewhere.

Choosing point sizes

In electronic typesetting — which is, after all, what you’re doing when you

use a word processor on a GUI — the term font refers only to the type style,

such as Times New Roman. The operating system and its hardware deter-
mine the type size. Without modification, the standard range of allowable

type sizes under Microsoft Word is from 1 point to 1638 points, or about % of
an inch to about 22 inches high.
GMBER The size you see on your laptop’s screen is related to the LCD’s resolution as
well as to the zoom setting you chose in the word processor. Only when you
print something is a frue size used, and even then this applies only if you
don’t shrink or enlarge the printed document. Your printer has its own point

. L. Book IV
size limits. Chapter 4
Set the point size for a block of type (or the entire document) with these s
steps: =

a

1. Select characters. S
(1]

Press Ctrl + A to choose all of the text. g

[1-]

2. Type a value in the Type Size box displayed on the menu bar. =

Choose any value from 1 to 1638, and make adjustments in tenths of a
point. For example, you can set type at 9.5 or 9.6, but not 9.55.
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Follow these steps if you're using Microsoft Word 2007:

1. Select any block of type and bring your mouse pointer to it.
A mini-toolbar appears.
2. Choose one of the following steps:
¢ Directly enter a point size in the window.

¢ Click the icons for Grow Font or Shrink Font. (The icons show
a letter A with an upward-facing or downward-facing arrow.)

In Word 2007 and previous versions, you can choose a font with the
following steps:

1. Highlight a block of text.

2. Right-click to display the menu.

3. Click to select Font.

4. Choose from the window displayed in Figure 1-3.

Figure 1-3:
The full font
window
includes
typefaces,
styles, size,
colors, and
effects. The
preview
window
shows how
changes will
appear.

Font | Cheracter Spacing |
Fortt: Font style: Size:
Courier New | [Reguiar | 12 |
Copperplate Gathic Bold ~ & 7] |
Copperplate Gothic Light — | |Ttalic 9 ]
Corbel — | |Bold 10
Courier Bold Ttalic 11
(Courier New v | |-
Fort color: Underline style: I
[ awomatc %] [tnone) v
Effects
[ strikethrough [ shadow [ smal caps
[ Doutle strikethrough  [] Qutline [ allcaps
[ superscript ] Emboss [ Hidden
[ subscript [ Engrave
Freview
Courier New |
This is & TrueType font. This Font wil be used on both printer and screen,

Assigning line spacing

A line on a manual typewriter was a fixed amount of space, related to the
unchangeable size and style of the characters it pounded onto a sheet of
paper. But a word processor running under a GUI like Windows can choose
from an infinite supply of fonts of varying design and then assign a size to
the characters ranging from small to huge.
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Therefore, when you choose line spacing in a word processor, it assigns a
value related to the font and type size you chose:
1. Select the line to which you want to set a particular line spacing.
Press Ctrl + A to choose all of the text.
2. Right-click and select the Paragraph menu.
The Paragraph dialog box is shown in Figure 1-4.

3. In the Line Spacing box, make your choice.

Paragraph rilfgl
Figure 1-4: et and o | e ogn ek
The

adgprece: T v
Paragraph Quthes level: | Dody Text w
dialog box
. Inderg ston
includes W B e o
options for i S A o) :
alignmentof | ="
teXt, Lefof; ope Lipe spaang: at:
indentation, W [op @ wige W[5 B

. ] Dot et s besbweres pusringragibs o e saeme sty

spacing
between
paragraphs,
and line
spacing.

Users of Microsoft Word 2007 have an additional route:

1. On the Home tab, locate the Paragraph group.
2. Click Line Spacing.

You can enter a number such as 1.0 for single-spacing, 1.5 for line- Book IV
and-a-half, or 2.0 for double-spacing. Chapter 4

For a more precise measurement, click Line Spacing Options to display
the Paragraph window. Here you can select the particular design you
want to use.

These options are available from the Paragraph window:

¢ Single. The computer finds the largest character in a particular line
and uses that as the basis for calculating a minimum amount of
space to place between lines of type. The amount of space varies
depending on the fonts, but usually is just a few points; for example,
a 12-point typeface may occupy about 14 points of space.

syuawnao( bunupy
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1.5 lines. The computer performs the same calculations it would for
single-line spacing, and then applies 1)4 times the amount of space.

¢ Double. The computer allocates twice as much space between lines
as it would for single-line spacing.

¢ At least. A more sophisticated setting, this allows the computer to
determine the minimum amount of line spacing needed to fit the
largest font or graphic on the line.

e Exactly. If you have a specific design in mind, choosing this option
sets a fixed line spacing that Word won’t adjust. For example, the
book you're reading is set in 9.5-point text with exactly 11 points of
line spacing.

* Multiple. This option, added under Microsoft Word 2007, sets the
line spacing as a percentage of single line spacing. Entering 1.25
increases the spacing by 25 percent.

Inserting a symbol

There is no need to be limited by the 52 letters (upper- and lowercase
versions) and 40 or so numbers and symbols that appear on a typical laptop
keyboard.

A wide range of special symbols are part of the various fonts installed on
your machine, as well as half a dozen or so special-purpose fonts that con-
sist entirely of icons, symbols, and special characters. You can find a yen, a
pound, or a euro, as well as smiley faces and computer-specific symbols.

1. Click in the text where you want to insert a symbol.
2. In Word 2007, click the Insert tab and locate the Symbols group.
3. Click Symbol.

In previous versions of Word, click the Insert menu and then click
Symbol.

A drop-down list appears.

4. Click the symbol you want to insert.

If the symbol you want isn’t in the Symbol drop-down list, click More
Symbols. In the Font box, choose a different font and locate the symbol you
want to use; highlight it and then click Insert.

Some of the more commonly used fonts in Windows, including Times New
Roman and Arial, are considered expanded fonts and include extended
characters, including accent marks and special characters for foreign
languages. You should also explore the Wingdings and Webdings fonts for
unusual symbols.
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Inserting a special character

The difference between a symbol and a special character is a matter of famil-
iarity. To begin with, “special” means characters that aren’t on the keyboard.
If you're old enough to have used a typewriter, you’'ll recall that many of
them could print a cent sign, like this: ¢.

You can also insert a symbol by clicking the Insert Symbol menu item of
Microsoft Office.
1. Click in the text where you want to insert a special character.
2. In Word 2007, click the Insert tab and locate the Symbols group.
3. Click Symbol => More Symbols => Special Characters tab.

In previous versions of Word, click the Insert menu = Symbol &> Special
Characters tab.

A drop-down list appears.

4. Click the character you want to insert.

Selecting text in the body of a document

One of a word processor’s key tools is the ability to select text or items
anywhere in the document. From there you can move, delete, copy, or
change their appearance.

You can select specific blocks of text dozens of ways. Table 1-1 shows you
the power tools you should know.

Table 1-1 Selecting Text
Function Method
Selecting all text Press Ctrl + A. Under Microsoft Word 2007, you can

also click the Home tab and find the Editing group.
Click Select => Select All.

Selecting a special block of text Click at the beginning or end of a block of text and hold
down the mouse button as you drag the pointer over
the text you want to select.

Selecting a word Double-click anywhere within a word.
Selecting a sentence Hold down the Ctrl key and click anywhere in a
sentence.

Selecting a paragraph Triple-click anywhere in a paragraph.

(continued)

Book IV
Chapter 4
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Table 1-1 (continued)
Function Method

Selecting a large block of text Click at the start of a block of text. Release the mouse
button and scroll to the end of the selection; hold down
the Shift key and click the mouse.

Selecting a vertical block of text To choose a block of text that is vertical, without
extending to the end of a line, click at one corner of the
text and hold down the Alt key while you drag the
pointer down.

Moving sentences, paragraphs, or graphics

Here’s where “cut and paste” loses the scissors, paste pot, or roll of tape.
Because characters or pictures on a GUI screen are considered objects by
the operating system, you can pick them up and move or otherwise
manipulate them with a pointing device.

Follow these steps to move an item:

1. Highlight an item you want to move.
2. Press Ctrl + X.
This cuts the object and places it into computer memory.
3. Move the pointer where you want the object.
4. Press Ctrl + V.

To copy and paste an item you’ve selected, follow these steps:

1. Press Ctrl + C.
This places a copy of the object into computer memory.

2. Move the pointer to the location where you want the object.
3. Press Ctrl + V.

The item is pasted where your cursor is.
You don’t have to paste an item into the same document. Once you either
cut or copy an object, you can switch to another document and move the
pointer to a location to paste the object there.

You can also move or copy objects by dragging them:

1. Highlight an item you want to move or copy.
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2. Keep the left mouse button pressed and drag the highlighted text to
where you want it.

3. Release the mouse button.

Undoing mistakes

If you delete a block of text, change a font, move some copy from one place
to another, or perform just about any other action within Microsoft Word,
you can change your mind and undo the action. In Microsoft Word 2007,
you can undo and redo as many as 100 previous actions.

You can’t undo some actions, such as clicking any Microsoft Office Button
command (including saving a file).

The most direct way to undo an action is to press Ctrl + Z. In Word 2007,
you can also click the Undo icon in the Quick Access Toolbar at the top of
the screen. If you change your mind again and want to Redo an action, press
Ctrl + Y. In Word 2007, you can also click the Redo icon in the Quick Access
Toolbar at the top of the screen.

Applying styles and themes

Microsoft Word includes a collection of predefined styles for elements of
your document: various levels of chapter and section headings and captions,
as well as emphasis or color for particular types of content.

1. Select a block of text.

Under Microsoft Word 2007, the available set of styles is automatically
offered any time you choose a block of text. A mini toolbar appears
near the selected text.

2. Click the Styles icon.
This icon is a capital letter A with a small artist’s pen.
3. Pick the design you want to use from the Quick Styles.

An example is shown in Figure 1-5. Before you click a style, you can
preview its effect on your text by merely hovering your pointer over
one of the offerings.

The Styles list shows only those styles that you already used in the
document. If you don’t see a particular style listed in the Quick Styles
gallery, click Apply Styles or press Ctrl + Shift + S to open the Apply
Styles task pane. Then type the style that you want to apply.

Book IV
Chapter 4
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Figure 1-5:
A set of
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added to
Microsoft
Word 2007.
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Applying a theme

Themes offer a way to refine or customize the particular Quick Styles set
for a document. You can change styles, fonts, type sizes, and colors. When
you apply a new font theme, the system changes the fonts for all headings
and the body of text for the current document.

Working with a predefined style

To use a predefined style, apply it to the document you’re working on.
1. In Microsoft Word 2007, click the Home tab and locate the
Styles group.
2. Click Change Styles.
3. Choose Fonts.

4. Choose the predefined font theme you want.

Creating a custom font theme

A custom font theme is created when you define its elements and store it on
your machine under a name or description.

1. In Microsoft Word 2007, click the Page Layout tab and locate the
Themes group.
2. Click Theme Fonts = Create New Theme Fonts.

3. Select the fonts and sizes you want to use in the Heading Font and
Body Font lists.
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4. In the Name box, type a name for the new font theme.
5. Click Save.

Creating formatted lists

You can set up Word to automatically create bulleted and numbered lists
as you type, or you can add bullets or numbers to existing lines of text.

Adding a bulleted or numbered list

You haven'’t reached this point in this book without escaping from the
clutches of a bulleted or numbered list. Typographers use the term bullets
to refer to round, square, or other-shaped symbols that present a list of
information with emphasis. A special form is the numbered list, which as
you no doubt guessed, means the list uses numbers instead of bullets; the
numbered list is useful for presenting instructions in a particular sequence
or to rank items by importance.

4+ At the start of a sentence, type an asterisk (*) to start a bulleted list.

4+ To start a numbered list, type 1 at the start of a sentence. Then press
the spacebar or the Tab key. When you press the Enter key, the next line
begins with 2.

4+ To finish a bullet or numbered list, press Enter twice, or press the
Backspace key to delete the last bullet or number in the list.

Adding bullets or numbers to an existing list

If you didn’t add bullets or numbers to a list when first you wrote it, you can
add them later:

1. Select the items to which you want to add bullets or numbering.

2. Under Microsoft Word 2007, click the Home tab and locate the
Paragraph group.

3. Click Bullets or Numbering.

To see additional bullet styles or numbering formats, click the arrow next to
Bullets or Numbering.

Turning off automatic bullets or numbering

If bullets and numbering begin automatically and you’d rather they not,
follow along:

1. Click the Microsoft Office Button.
2. Click Word Options.

Book IV
Chapter 4
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3. Click Proofing = Click AutoCorrect Options => AutoFormat As You
Type tab.

4. Deselect the Automatic Bulleted Lists check box, deselect the
Automatic Numbered Lists check box, or deselect both.

The check boxes are under the Under Apply as You Type section.

In earlier versions of Word, click Tools => AutoCorrect Options. Make
the same changes noted in this section.

Running a tab

Back in the day of the manual typewriter, tab stops were physical barriers
that stopped the carriage (the mechanism that held the paper and the
rubber roller behind it) from left to right. These little clips let you set a
paragraph indent and manually create columns in a table.

The system worked reasonably well, although users often had to change tab
stops for any unusually shaped tables, and fancy formatting like hanging
indents or adjustable-width cells were very difficult to accomplish. And
advanced styles like decimal stops? Not for the faint of heart.

Displaying and using the ruler to set stops and indents

The fastest way to set manual tab stops is to display the horizontal ruler
across the top of a document and click with your pointer to insert markers
on your virtual page.

At the top-left corner of the ruler is a box that shows the currently selected
type of tab. Click in the box to cycle through the five available types. When
you see the type you want to use, click in the ruler where you want it to be.

The markers for first line indent and hanging indents are already on the
ruler. You can click and drag one or the other to where you want them.

This paragraph is set up as a first line indent. The second and subsequent
lines are set against the left margin. Back in the day of the typewriter, this
was the standard design for letters; more modern designs use no indent but
add an extra line between paragraphs.

This paragraph is set up as a hanging indent. The second and subsequent
lines are indented by a specified amount of space. It is a style employed by
some designers for emphasis, or for all the text in a document.

You can set a bar tab stop before or after you type your paragraph.

You can bring up the horizontal ruler visible on your screen three ways:
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4+ Bring the pointer up to the very top of the page of text, just below the
menu ribbon or menu bar. The menu comes down after you hold the
pointer there for a second or so.

4+ Click the View tab (in Microsoft Word 2007) or the View menu (in other
versions of Word) and enable the Ruler check box. Deselect Ruler to

remove the display later.

4+ In Microsoft Word 2007, you can click the View Ruler button that sits at
the top of the vertical scroll bar on the right side of the screen.

Choosing a tab stop or paragraph indent

Word offers five types of tabs, plus two types of paragraph indents, including
features that would have made a typist’s heart flutter. See Table 1-2 for the

available tabs.

Table 1-2

Available Tabs

Symbol Function

Purpose

I Lefttab

Sets the starting position for text that will
continue to the right.

Center tab

Sets the position for the middle of text. Text will
center on this position, adjusting to the left or
right as needed.

Right tab

Sets the starting position for text that will align to
the left of the tab.

The decimal point will remain in the set position
and numbers will align to its left for whole numbe
(integers) and to its right for decimal fractions.

Bar tab

Inserts a vertical bar at the tab position (and isn't
the same as your running account at the local
tavern).

First line indent

Choose this indent and then click in the upper
half of the horizontal ruler to set the starting
position for the first line of each paragraph.

Hanging indent

ule
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Choose this indent and then click in the lower
half of the horizontal ruler where you want all
subsequent lines of a paragraph to start.

An alternate way to place tab stops or indents is to enter the precise loca-
tion you want in the Tabs dialog box. This box also allows you to insert a
specific character as a leader between tab stops; a tab leader (often a series
of periods) fills blank space between columns of text or numbers.
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A bar tab is similar to strikethrough formatting on a line of text, but it runs
vertically through the selected paragraph or paragraphs at the bar-tab stop.

The easiest way to display the Tabs dialog box is to double-click any tab
stop on the ruler. In Microsoft Word 2007, an alternate way to display the
same Tabs dialog box is to click the Page Layout tab and then click the small
arrow at the bottom right of the tab. In the Paragraph dialog box, click Tabs.

Finding and replacing text
One of the true power tools of word processing is the ability to find a partic-

ular word or phrase and replace or reformat it. (Over the years this has also
been called search and replace.)

The uses of find-and-replace are myriad. Want to change the name of a
character in a novel? How about searching for every instance of the name
of a product and changing it to a bold italic font? And how about updating
every mention of a particular date?

Microsoft Office Word 2007 can find and replace text, formatting, paragraph
breaks, page breaks, and other items. Advanced features allow searching for
and changing noun or adjective forms or verb tenses.

Finding and replacing text
Follow these steps to the most direct route to the Find and Replace

dialog box:
1. Press Ctrl + F.
2. On the Find tab, enter the text you're looking for.

Microsoft Word 2007 has a menu route to the same place: Click the
Home tab and click Find (on the Editing group).

3. Choose depending on your preference:

¢ To find each instance of a word or phrase one at a time, click Find
Next.

¢ To find all instances of a specific word or phrase at one time, click
Find All => Main Document.

If the Match Case check box is selected, Word searches only for an exact
match; if you're looking for Red Sox, that’s what you find. Any instance
of red sox is ignored.

4. Click the Replace tab and type the substitute text.
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Say you’re changing every instance of the name Chuck with Charles. The
replacement text uses the same capitalization as the text it replaces unless
you select the Match Case check box.

Finding and highlighting text

Another option available under Word 2007 is to find and highlight every
occurrence of a particular word or phrase. This feature is an editing tool; the
highlights are gone when you save or print the file.

Why highlight particular words? Any professional writer will tell you that
every once in a while a particular word becomes much too easy to use in a
document; this is especially a problem if you've started a manuscript on one
day, added to it on several subsequent visits to the file, and then finished it
weeks later. Want to see how many times you used “manuscript” in a manu-
script? Find all instances and highlight them. The system will temporarily
encase each instance in a block of color, and the Find and Replace screen
will give you an accounting.

Do this to highlight a word or phrase in Word 2007:

. Click the Home tab and locate the Editing group.

. Click Find.

. In the Find What box, type the text you want to search for.
. Click Reading Highlight => Highlight All.

To turn off highlighting onscreen, click Reading Highlight = Clear
Highlighting. Or, just ignore the highlighting; the next time you close
the file it fades away to just a memory.

™NW N~

Finding and changing specific character formatting

Say you began a file about the barely remembered story of the great ship
“Titanic.” After consideration, you decide that you’ll follow a style that
places every name of a ship in italics, like this: Titanic.

Using Find and Replace, you can search for every use of the name, and
restyle it in italics. (Or, you could have made that particular text bold, or
changed its color to red, or just about any other combination of emphases.)
Going the other way, say you decided every time you boldfaced a word in a
document, that you really should have used italics.

Using Find and Replace, you can search for a particular formatting assign-
ment (in this case bold) and change it to italics. You're not looking for a
word but rather a typographic style.

Book IV
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1. In Word 2007, click the Home tab and locate the Editing group.
2. Click Replace and find the Format button.
You may have to click More to show additional options.

3. To search for text with specific formatting, type the text in the Find
What box.

Skip to Step 6.
To find formatting no matter what the text, go to Step 4.
. Leave the Find What box blank.
. Click Format, and then select the format you want to find and replace.

. Click the Replace With box and click Format.

NS v &

. Select the replacement format or combination of formats.

If you also want to replace the text, type substitute text in the Replace
With box.

Finally, you have the choice between a one-click automatic replacement of
every instance of the specified formatting (Click Replace All) or stepping
through each instance and deciding whether to apply the changes (click
Find Next => Replace or Find Next to move on without making a change).

Finding and replacing formatting codes

Although you usually can’t tell when looking at the screen, your text is
sprinkled with special codes that indicate formatting decisions. That’s how
the word processor knows you want a space between words, a tab at the
beginning of a paragraph, a paragraph break at the end, among others.

One common habit that some former typewriter users lapse into is putting
double spaces at the end of each sentence. That’s easily fixed: Search for all
instances of two spaces and replace them with one space.

You might also find that a file uses double paragraph breaks. This might
have happened because the original version of the file was created using
single spacing and it was later converted to double-spaced text. Again,
an easy fix: Search for any pair of paragraph breaks and substitute just a
single one.

1. In Word 2007, click the Home tab and locate the Editing group.
2. Click Find.
3. Click the Special button.



Figure 1-6:
You can use
these
special
characters
aspartofa
find-and-
replace
assignment
in Microsoft
Word.
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If the Find and Replace dialog box displays its smaller version, click
More to expand your options.

4. Click the item you want to search for.
In Figure 1-6 you can see the available special characters.

5. To replace the item, click the Replace tab.
6. Enter the substitute formatting code (or text) in the Replace With box.
7. Click one of the following:

¢ Find Next

e Find All

e Replace

e Replace All

—
Find and Replace \1\|'5_<|
Fingd \ Reglsce | GoTo |
Find what: imanuscrlpt w I
Paragraph Mark
Tab Character
Any Character
Any Digit
Search Options Caret Character
Search: | al vl § Section Character
G |
[ Match case T Paragraph Character Match prefix
[ Find whole words only Colymn Break Match suffix
[ Use wildcards Em Dash
[ Sounds like (Endlish) e Ignore punctuation characters
n Das
[ Find all word Forms (English) = Ignore white-space characters
Endnote Mark
Field
Find Footnote Mark
Graphic
Manual Line Break

Manual Page Break
Monbreaking Hyphen
Nonbreaking Space
Optional Hyphen
Section Break

White Space

You also can use keyboard characters instead of selecting from the pull-
down menu. For example, you can search for "p to find a paragraph mark,
or "t for a tab character. Table 1-3 lists a few of the common formatting
characters you can use in this way.
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Table 1-3 Formatting Character Codes
Character or Symbol Formatting Code
Paragraph mark” Ap

Tab character Morh9

Em dash (the longer dash) A+

En dash (the shorter normal dash) A=

Caret A

Manual line break AorMi

Manual page break Am

"Doesn’t work if Use Wildcards option is turned on.

Characters gone wild (card)

The most commonly used magic characters for wildcard searches are the
asterisk (*) and the question mark (?).

4+ * tells the computer to search for any string of characters at the start,
end, or in the middle of your query.

4+ ?tells the computer to find any word that has any single character at the
location of the question mark in your query.

Say you want to find all versions of the word dog in a document. If you
search for dog*, the computer comes back with all instances of these words:
dogs, doggy, doggies, doggone, dogged, dogfish, doggerel, dogleg . . . you get
the idea.

The one word that wouldn’t be found? Dog. That’s because the asterisk
extends the search to forms that include the word dog. If you want to limit
your search to the set of three-letter words that begin with do, you could ask
the computer to search for do?. It would find dog as well as dot, doc, doe,
don, dos, dot, and dow.

Searching with wildcards is very useful, but you must be as specific and
limiting as possible. For example, if you throw an asterisk in the middle of
a short word, you may find hundreds of responses that don’t give you the
results you want. For example, searching for d*d comes up with words that
meet that criteria but probably have nothing to do with what you’re hoping
to find: dad, did, disappointed, departed, and doodad among them.

It would really confuse the computer if you searched for a character that’s
defined as a wildcard (searching for question marks or asterisks, for exam-
ple). The way to clear things up: type a backslash before the character. For
example, type \? to find a question mark or \* to find an asterisk in your file.

First the basics on using wildcards in a search:
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. In Word 2007, click the Home tab and locate the Editing group.
. Click Find or Replace.
. Select the Use Wildcards check box.

If the Find and Replace window displays in its smaller version, click
More to expand your options.

. Follow one of these steps:

¢ Choose a wildcard character from a list. Click Special, click a
wildcard character, and then type any text in the Find What box.

e Directly type a wildcard character in the Find What box.

5. If you want to replace the item, click the Replace tab and enter the
substitute text in the Replace With box.

6. Click Find Next, Find All, Replace, or Replace All.

For most users, the asterisk and question mark suffice for quickly locating
a particular word in a file. However, if you're searching through a gigantic
encyclopedia, spending a few moments to create a more precisely focused

query will pay off greatly.

Table 1-4 shows a more complete list of available wildcards for searching in

Microsoft Word 2007.

Table 1-4 Advanced Wildcards

To Find This Use This For Example

A single character ? do? finds dog, don, and dot

d?g finds dig, dog, and dug

A string of characters

* d*g finds dog, dig, digging, and
disappointing

The start of a word < <(enter) finds entertainment
and entering, but not center or
centered

The end of a word > (on)> finds on, upon, and spoon,
but not once, onerous, or ono-
matopoeia

One or the other of a set [1 t[ai]n finds tan and tin but not ton

of characters

A single character in [-] [I-rlight finds light, might, night,

an ascending range and right

Any single character except [!x-z] shar[!a-l]ck finds shard, share,

for one that falls within the
specified range

and shark but not sharp
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Believe it or not, some even more complex wildcard commands are in the
word processor’s help system. You can also use parentheses to group
searches to narrow down the possibilities even more precisely.

Advancing Your Microsoft Office 2007 Functions

MBER
@Y«
&

As part of the Microsoft Office 2007 enhancements, several important new
features extend across most of the programs in the suite, including Microsoft
Word 2007, Microsoft Excel 2007, and Microsoft PowerPoint 2007. I describe
them here because most users begin with a word processor, but keep them
in mind for all your work if you're lucky enough to run the latest version of
Office on your laptop.

4+ Microsoft Office Diagnostics. This utility includes diagnostic tests that
may help determine why one or more components of Microsoft Office
(or other programs running under Windows) are crashing your system
or otherwise becoming annoying. For more details, see Book X.

4+ Program Recovery. The Office 2007 components are better able to
prevent the loss of work when a program closes abnormally (Microsoft
happy-talk for “crashes”). The latest version of Office is set up to
attempt to recover as many elements of the program’s state at the
moment of a crash. As an example, if you had several files open
when your laptop took an electronic dive, after a reboot Office tries
to come back with those same files open.

The first thing you should do when you create any type of file is give it a
name and store a copy of it; this allows your software program to store
temporary backups of the file as you work on it and makes it much
easier to recover from a crash.

4+ Merging spelling checker. Several of the spelling checker options for
Microsoft Office programs have been made global. That means settings or
options that you chose in one of the programs applies to all other soft-
ware in the suite. Examples of this include assignment of a non-standard
or foreign-language dictionary for use in all programs. You can also apply
an exclusion dictionary across more than one program; exclusion diction-
aries allow the spelling checker to find words you want to avoid using in
your dictionary. Excluded words might be ones you feel are improper or
are disallowed in your personal or institutional style guide. The spelling
checker has been enhanced to find some (but not all) contextual spelling
errors. If you type Put this book their, all of those words are spelled cor-
rectly but the word you want to use is there, not their. The latest version
of contextual spell checking works with documents written in English,
German, and Spanish.
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Formatting Files in Word 2007

Consider new ways the computer can structure the file that contains the
document itself. Unfortunately, this is confusingly called a file format. Here,
format refers to the file itself and not its contents.

Open XML file formats

Microsoft Office 2007 presents a new set of file formats for storing work. In a
few words: The new file formats are more compact. (Compared to previous
formats, they require less space on a disk — with a potential reduction of as
much as 75 percent — to hold the same amount of information.) They also
offer some advanced features for power users.

The new file format is called Microsoft Office Open XML, and it was released
along with Microsoft Office Word 2007, Microsoft Office Excel 2007, and
Microsoft Office PowerPoint 2007. According to Microsoft, the advantages of
XML include the following:

4+ Compactness. Files are automatically compressed or zipped, made as
much as 75 percent smaller in some cases. This saves disk space for stor-
age and reduces the amount of time required to send files by e-mail, over
networks, or over the Internet. When you open a file, it automatically
unzips; when you re-save a file, it automatically zips again.

4+ Improved recovery from damage. Files are structured in a modular
design to keep different data components separate from each other in
the file. In theory, this means that if one component — a graphic, chart,
or table, for example — becomes corrupt, you can open and use the
rest of the file.

4+ Enhanced privacy. Personal information and business-sensitive
information, such as author names, comments, tracked changes, and
file paths can be easily identified and removed with a utility called
Document Inspector.

4+ Improved security against macro viruses. Files saved using the ci(;:':elrv 4
default x suffix (such as .docx for Word, .xlsx for Excel, and .pptx for

PowerPoint) can’t contain Visual Basic for Applications (VBA) macros s

and XLM macros. Only files whose filename extension ends with an m =

(such as .docm, .xIsm, and .pptm) can contain macros. c.?c:

(=]

That’s the good news, and if you’re working by yourself or exchanging files g

with others who use the same new file formats, you've no good reason not to E

use the new technology. The not-quite-so-good news is that if you're sending @

your files to someone who’s using yesterday’s formats, you have to convert
the files.
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Converting Word 2007 files

It’s no big deal to get and use the compatibility pack to change over newer
files to make them useable on an older machine. Or you can save your files
in the older file format before you send them to an old-school user. The only
disadvantage is that some advanced features embedded in a file created in
the Office 2007 versions of Microsoft programs may not be available to users
of earlier software. Office 2007 includes a compatibility checker that exam-
ines files saved in an older file format to see if any features are unsupported;
you are advised of any potential problems and allowed to remove the
advanced features before continuing with a retro-save.

Microsoft offers the free Microsoft Office Compatibility Pack for Word, Excel,
and PowerPoint 2007 File Formats. You can install this conversion tool on
systems running older versions of Word; it allows them to open and use files
saved with the .DOCX filename extension. Go to www.microsoft.com and
search for Office Compatibility Pack.

By default, files created in components of Microsoft Office 2007 are saved
in XML format with new filename extensions that add an x or m to the
extensions. The x signifies an XML file that has no macros, and the m
signifies an XML file that does contain macros.

The 2007 version of Office happily accepts documents created with any
current version of Word, including Microsoft Office Word 2003, Word
2002, or Word 2000. The program automatically turns on something called
Compatibility Mode; you'll see that indicated in the document window’s
title bar (at the top of the screen).

Compatibility Mode ensures that — until and unless you convert the old
format file to a new XML file — no new or enhanced features in Office Word
2007 are available. This ensures that you don’t introduce a feature that

the original author (or others using older versions of Word) can’t use.

Controlling Microsoft Word from the Keyboard

It’s not just that some people learned to use computers in the days before
the coming of the mouse (although it’s sometimes hard to teach an old cog
new tricks). The fact is that the fastest way to accomplish a command is

to keep your hands on the keyboard rather than lifting them off and moving
a mouse, spinning a trackball, or piddling with a pointing stick.

All the keyboard commands in Tables 1-5 through 1-16 are things you can
accomplish by going to one or more menus or windows within Microsoft
Word or the Windows operating system. For many users, the best decision
is to combine the two routes to success: Memorize a few of the most com-
monly used keyboard commands and use the mouse for the remainder.
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Table 1-5 Major Commands Using Function Keys
Function Command
Get Help or go to Microsoft Office online web site F1

Start context-sensitive Help or Reveal formatting Shift + F1
Move text or graphics F2

Copy text Shift + F2
Print Preview Ctrl + F2
Insert an AutoText entry after program displays suggestion F3

Create an AutoText entry Alt + F3
Change case of letters Shift + F3
Repeat previous action F4

Repeat Find or GoTo action Shift + F4
Display GoTo menu F5

Move to the last change Shift + F5
Go to the next pane or frame; Switch between F6

Help pane and Word

Go to the previous pane or frame Shift + F6
Display Spelling command F7

Find the next misspelling or grammatical error; Check Alt+F7
Spelling as You Type check box must be selected on

the Spelling & Grammar tab

Display Thesaurus command Shift + F7
Extend a selection F8

Shrink a selection Shift + F8
Choose the Size command Ctrl + F8
Extend a selection or block; follow with arrow key Ctrl + Shift + F8
Update selected fields F9

Switch between a field code and its result Shift + F9
Insert an empty field Ctrl + F9
Unlink a field Ctrl + Shift + F9
Switch between all field codes and their results Alt + F9
Activate the menu bar; move through pull-down menus with Tab ~ F10
Display a context-sensitive shortcut menu Shift + F10
Go to the next field F11

Go to the previous field Shift + F11
Lock a field Ctrl + F11
Unlock a field Ctrl + Shift + F11

(continued)
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Table 1-5 (continued)

Function Command
Display Save As command F12
Choose Save command Shift + F12
Choose the Open command Ctrl + F12

Choose the Print command

Ctrl + Shift + F12

A\

Note that these shortcuts work with Microsoft Word 2003 and later versions;
some earlier versions of the word processor won’t support all the shortcuts.

Table 1-6 Additional Function Key Commands

Function Command
Open command Ctrl + Alt + F2
Choose Save command Alt + Shift + F2
Quit Microsoft Word Alt + F4
Display Microsoft System Information Ctrl + Alt + F1
Cut to the Spike Ctrl + F3

Insert contents of the Spike Ctrl + Shift + F3
Close the window Ctrl + F4
Restore the document window size Ctrl + F5
Restore the program window size Alt + F5

Edit a bookmark Ctrl + Shift + F5
Go to the next window Ctrl + F6

Go to the previous window Ctrl + Shift + F6
Choose the Move command Ctrl + F7
Update linked information in a source document Ctrl + Shift + F7
Run a macro Alt + F8
Maximize the program window Alt+ F10
Display Microsoft Visual Basic code Alt + F11
Maximize document window Ctrl + F10
Table 1-7 Managing Documents and Web Pages
Function Command
Create new document of the same type as the Ctrl+ N
current or most recent document

Open a document Ctrl+0
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Function Command
Close a document Ctrl + W
Split the document window Alt+ Ctrl + S
Remove document window split Alt + Shift+ C
Save a document Ctrl +S
Display Open dialog box Ctrl + F12
Display Save As dialog box F12

Display shortcut menu for a selected item such as a folder Shift + F10

or file. Use Tab to move between options or areas in the

dialog box

Table 1-8 Editing and Moving Text and Graphics
Function Command
Delete one character to the left Backspace

Delete one word to the left

Ctrl + Backspace

Delete one character to the right Delete
Delete one word to the right Ctrl + Delete
Cut selected text to the Office Clipboard Ctrl + X
Undo the last action Ctrl+2Z

Cut to the Spike to collect a group of items for Ctrl + F3
pasting in one place

Table 1-9 Moving the Insertion Point

Function Command
One character to the left —

One character to the right -

One word to the left Ctrl + «
One word to the right Ctrl + —
One paragraph up Ctrl+ T
One paragraph down Ctrl + 4
One cell to the left (in a table) Shift + Tab
One cell to the right (in a table) Tab

Up one line T

Down one line d

To the end of a line End

(continued)
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Table 1-9 (continued)

Function

Command

To the beginning of a line

Home

To the top of the window

Alt + Ctrl + Page Up

To the end of the window

Alt + Ctrl + Page Down

Up one screen (scrolling)

Page Up

Down one screen (scrolling)

Page Down

To the top of the next page

Ctrl + Page Down

To the top of the previous page

Ctrl + Page Up

To the end of a document Ctrl + End

To the beginning of a document Ctrl + Home
To a previous revision Shift + F5
Jump to the location of the insertion point when the Shift + F5
document was last closed

Table 1-10 Formatting Characters

Function Command
Copy formatting from text Ctrl + Shift+C
Apply copied formatting to text Ctrl + Shift+V
Change the font Ctrl + Shift + F
Change the font size Ctrl + Shift+ P
Increase the font size Ctrl + Shift + >
Decrease the font size Ctrl + Shift + <
Increase the font size by 1 point Ctrl +]
Decrease the font size by 1 point Ctrl +
Change the formatting of characters (Font command, Format menu)  Ctrl + D
Change the case of characters Shift + F3
Format characters as all uppercase Ctrl + Shift + A
Apply bold formatting Ctrl+B

Apply an underline Ctrl+ U
Underline words but not spaces Ctrl + Shift + W
Double-underline text Ctrl + Shift+D
Apply hidden text formatting Ctrl + Shift+ H
Apply italic formatting Ctrl +1
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Function Command
Format characters as small capitals Ctrl + Shift + K
Apply subscript formatting (automatic spacing) Ctrl + =

Apply superscript formatting (automatic spacing) Ctrl + Shift + +
Change the selection to the Symbol font Ctrl + Shift+Q
Display nonprinting characters Ctrl + Shift + *
Table 1-11 Formatting Paragraphs

Function Command
Single-space lines Ctrl +1
Double-space lines Ctrl +2

Set 1.5-line spacing Ctrl +5

Add or remove one line space preceding a paragraph Ctrl+0

Center a paragraph Ctrl+ E
Justify a paragraph Ctrl+J

Left align a paragraph Ctrl + L

Right align a paragraph Ctrl+R

Indent a paragraph from left Ctrl+ M
Remove a paragraph indent from left Ctrl + Shift+ M
Set a hanging indent Ctrl+T
Reduce a hanging indent Ctrl + Shift+ T
Remove paragraph formatting Ctrl+ Q

Table 1-12 Finding, Browsing, and Replacing Text

Function Command
Find text, formatting, and special items Ctrl + F
Repeat find (with Find and Replace window closed) Alt+ Ctrl +Y
Replace text, specific formatting, and special items Ctrl+H

Go to a page, bookmark, footnote, table, comment, graphic, Ctrl + G

or other location

Switch between documents or sections of a document Alt+Ctrl + Z

Open a list of browse options; use the arrow keys to select
an option, and then press Enter to use the selected option

Alt + Ctrl + Home
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Table 1-13 Performing Actions on Text or Objects
Function Command
Copy the selected text or object Ctrl+C

Cut the selected text or object Ctrl + X

Paste text or an object Ctrl +V

Undo the last action Ctrl+Z

Redo the last action Ctrl+Y
Cancel the last action Esc

Make characters bold Ctrl+B

Make characters italic Ctrl +1

Make characters underlined Ctrl+U
Decrease font size Ctrl + Shift + <
Increase font size Ctrl + Shift + >
Remove paragraph or character formatting Ctrl + spacebar
Insert nonbreaking space Ctrl + Shift + spacebar
Insert nonbreaking hyphen Ctrl + -

Table 1-14 Changing the View

Function Command
Switch to print layout view Alt + Ctrl + P
Switch to outline view Alt+Ctrl + 0
Switch to normal view Alt+ Ctrl + N
Switch to Reading View Alt+R
Expand or collapse subdocuments in a master document Ctrl +\

Table 1-15 Reviewing Documents

Function Command
Turn Track Changes on or off Ctrl + Shift + E
Insert a comment Alt + Ctrl + M
Close the Reviewing Pane if it is open Alt + Shift + C
Table 1-16 Previewing and Printing Documents
Function Command
Switch in or out of print preview Alt + Ctrl +1

Move around the preview page when zoomed in arrow keys
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Function Command

Move by one preview page when zoomed out Page Up or Page Down
Move to the first preview page when zoomed out Ctrl + Home

Move to the last preview page when zoomed out Ctrl + End

Print a document Ctrl+P

Finding key combos

You can find the key combinations by going back to that Symbol chart. (You
can even get to it without using the mouse; try pressing the Alt key, then the
[ key, then the S key.)

You'll find two pages of information. One presents the full range of available
characters for the current font; behind it is a tab for Special Characters. If
you see the symbol you want on the special page, look for a simple shortcut
key combination like Alt + Ctrl + R for ®. Otherwise, look for the symbol on
the full listing; when you find it highlight it and then look the preassigned
Shortcut key at the bottom of the table. For example, the keyboard shortcut
for the % symbol is Alt + 0188.

The trick here is to use the numeric keypad of your laptop to enter the
character. Turn on Num Lock, hold down the Alt key, type the number com-
bination using the numeric keypad, and then release Alt. Voila! You have
earned a %.

Some characters are more complex to invoke than others. For example,
some non-English characters require you to enter a number first and then
(without an intervening space) type a key combination like Alt + X. For
example, to get this interesting character, e, I entered 0119 and followed it
immediately with Alt + X.

Where’s the Num Lock on a laptop? Well, you're going to have to find it for
yourself, since the manufacturer could have placed it almost anywhere. On
my newest machine, you turn on or off Num Lock by pressing the Fn key and
then the F11 key. (An older machine uses F9.) Then use the numeric keypad
which is embedded in the keyboard amongst the characters on the right
side. (My new machine even has a shortcut to the shortcut; [ don’t have to
turn on and off the Num Lock. All | have to do is press and hold Fn + Alt and
then type the numbers on the numeric keypad.)

Tables 1-17 through 1-20 shows some of the more valuable special charac-
ters and their standard keyboard shortcuts (which assumes that you have
not changed the shortcuts by assigning them to a macro, something else
you can do to speed the process). I've ordered them by function.

Book IV
Chapter 4
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The symbolism of the keyboard

How the ¢ ¥aP&+| do you get Microsoft
Word to use symbols and special characters
that are not on the keyboard? Earlier in this
chapter | discussed how to use the Insert
Symbols menu items. There are several other
ways to use the extended character set of stan-
dard fonts or any of the icons or symbols or non-
standard letters that are part of special fonts.

Using the mouse to insert a ® symbol

1. At the point where you want to add the
symbol, take one of your hands off the key-
board and find the mouse.

2. Click the Insert menu.
3. Click the Symbols tab.

4. Click and hold the slider arrow on the
Symbol chart and pull down slowly until you
see the (r) symbol.

5. Release the slider arrow and click the ®
symbol.

6. Your choice:

® Double-click the highlighted symbol.

¢ Move the mouse and click the Insert button.
1. Close the Symbol chart.

8. Return your hand to the proper position on
the keyboard so you can continue typing.

Using the keyboard to insert a ® symbol

1. At the point where you want to add the
symbol, press Ctrl + Alt + R.

So, now, tell me again how using a mouse is
quicker and simpler than using the keyboard?
The key, to pardon the pun, is to know the key
combinations; they're not secret, but they are
hidden.

Table 1-17 Monetary Symbols
Symbol Command
€ Alt + 0128
¢ Alt + 0162
£ Alt + 0163
¥ Alt + 0165
Table 1-18 Punctuation and Typesetting Symbols
Symbol Unicode (Hex) ASCII (Decimal)
i 00A1 followed by Alt + X Alt + 0161
Alt + Ctrl +!
1 00B6 followed by Alt + X Alt + 0182
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Symbol Unicode (Hex) ASCII (Decimat)
! 00B9 followed by Alt + Alt + 0185
2 00B2 followed by Alt + Alt + 0178
s 00B3 followed by Alt + Alt+0179
Table 1-19 Business and Math Symbols
Symbol Unicode (Hex) ASCIl (Decimal)
© 00A9 followed by Alt + X Alt + 0169
Zrlt +Ctrl+C
® 00AE followed by Alt + X Alt+ 0174
Z\rlt +Ctrl+R
™ 2122 followed by Alt + X Alt + 0153
Zlit +Ctrl + T
° 02DA followed by Alt + X Alt + 0176
+ 00B1 followed by Alt + X Alt + 0177
n 03BC followed by Alt + X Alt + 0181
Y 00BC followed by Alt + X Alt + 0188
% 00BD followed by Alt + X Alt + 0189
% 00BE followed by Alt + X Alt + 0190
Table 1-20 Accented Characters
Symbol Unicode (Hex) ASCII (Decimal)
A 00EO followed by Alt + X Alt + 0224
A 00E1 followed by Alt + X Alt + 0225
c 00E7 followed by Alt + X Alt + 0231 ci‘;‘,',fe'ﬂ
E 00ES followed by Alt + X Alt + 0232
E 00E9 followed by Alt + X Alt + 0233 =
£ 00EA followed by Alt + X Alt + 0234 B
U 00FB followed by Alt + X Alt + 0251 g
2
General keyboard shortcuts z

Think retro. Almost everything a mouse can do, you can do from the key-
board, including manipulate text. Tables 1-21 through 1-23 show some of the
most useful commands.
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Table 1-21 Selecting, Copying, and Moving Text

Function Command
Select all Ctrl + A
Select range of text in a document. (Press and hold Shift

while using any arrow key)

Press and hold with any of the arrow keys to highlight Ctrl + Shift

a block of text

Copy selected text or image to the Clipboard Ctrl+C

Cut selected text or image Ctrl +X
Paste selected text or image Ctrl+V
Undo the previous action. Some programs have multiple Ctrl +Z
levels of Undo

Delete selected text or image Delete
Delete selected item permanently without placing the Shift + Delete
item in the Recycle Bin

Rename the selected filename by typing in a new name F2

from the keyboard

Table 1-22 Moving the Insertion Point

Function Command
Move the insertion point to the beginning of the next word Ctrl + —
Move the insertion point to the beginning of the previous word Ctrl + «
Move the insertion point to the beginning of the next paragraph Ctrl +
Move the insertion point to the beginning of the previous paragraph  Ctrl+ T
Table 1-23 Working with Programs in Open Windows
Function Command
Switch between open items Alt + Tab
Switch to the previous open program Alt + Shift + Tab
Cycle through items in the order they had been opened Alt + Esc
Open the shortcut menu for the active window Alt + spacebar
Display the shortcut menu for the selected item Shift + F10

Display the System menu for the active window

Alt + spacebar

Display the Start menu

Ctrl + Esc or &
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Function

Command

Display the corresponding pull-down menu

Alt + underlined letter

Perform a command from an open pull-down menu

Underlined letter of a
command name

Open the next menu to the right, or open a submenu

—

Open the next menu to the left, or close a submenu

«—

Book IV
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Chapter 2: Crunching Data with
Spreadsheets

In This Chapter

* Going inside a spreadsheet
v Operating as if formulas and functions are your friends
v~ Entering data on a worksheet

1 Making your work fit to be printed

If electronic spreadsheets had been available in the Victorian Era of 150
years ago, one of the first buyers would have been Ebenezer Scrooge. No
matter that he would have had to invest in a computer and software: Even
the most miserly of bosses can quickly see how valuable a product like
Microsoft Excel is.

Way back at the dawn of time — about 1980 — the first spreadsheet (not
the first word processor) was the “killer application” that suddenly made
buying a personal computer a no-brain decision. The first computer spread-
sheet was VisiCalc, which helped move the Apple Il from hobbyist’s toy

to business tool. By the time IBM released the first official PC in 1981,

the concept had won the attention of accountants, financial officers, and
entrepreneurs: the people with the authority to sign the purchase orders.

Think of an electronic spreadsheet as a data processor. Note that I didn’t
call a spreadsheet a number processor. One of the strengths of an elec-
tronic spreadsheet is that, right from the start, it went way past the simple
accounting books that Bob Cratchit worked with by candlelight in Scrooge’s
counting house.

Starting the Incredible What-1f Machine

An electronic spreadsheet uses the computer’s power to create, organize,
and format data: numbers, words, and symbols. Then it adds computerized
formulas that you can apply to that data in a multitude of ways. At its most
basic level, then, you can look at an electronic spreadsheet as an automated
calculating and accounting machine: Enter the number of widgets in one
cell, the price in another, the sales tax rate in a third, and look for the sum.
See Figure 2-1.
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Figure 2-1:
Asimple
Microsoft
Excel
spreadsheet
calculating
travel
expenses, a
common
and useful
tool for road
warriors
with
laptops.
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But in the hands of a creative user, electronic spreadsheets are a what-if?
machine. What if you decrease the price by 5 percent but increase shipping
costs by 50 cents a unit? Based on your experience over the past 12 years of
business, what'’s the expected effect of increasing the discount rate to your
biggest customers while raising prices for small orders? And one other thing:
Spreadsheets are marvelous tools for creating lists and tables. They can
function as a basic database for information that you can sort, format,
search, and change.

I’'m a word guy, myself. | leave the accounting to my accountant. But I do use
spreadsheets all the time to help keep track of stuff. I have one Excel spread-
sheet that [ use to track my investments in mutual funds, bonds, and stocks;
I feed it numbers once a week so I can watch my progress toward becoming
a billionaire. (I'm not quite there yet.)

[ also have a spreadsheet that includes the artist name, album title, and
inventory number for my substantial collection of music on CDs. The inven-
tory number correlates to the slot number in my automated CD player. [ can
search for any CD, or sort the list by genre based on the codes I've assigned
each disc.
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Spreading out an Excel 2007 Sheet

In this chapter I use Microsoft Excel, in its most current version, as the
example of how a spreadsheet works. Excel is by far the market leader in
this category, although — just as with other Microsoft Office components —
you can find shareware and even free software (freeware) that come close in
their range of offerings.

Working the books

A spreadsheet is structured like a huge assemblage of boxes. Here’s the
organizing principle:

4+ The vertical lines that descend from the top of the page define columns.
(Think of the columns that support the roof of a great building.) Each
column is topped by an identifying letter; the first column is A, the
second is B, and so on.

4+ The horizontal lines that move from one side of the page to the other
define the rows. (Think of rows of books on a shelf.) At the left side of
each row is an identifying number, starting with 1 at the top-left corner
and increasing in value heading down the page.

4+ The box created by an intersecting column and a row is called a cell.
Each cell is identified with a label consisting of the column letter and
row number. Therefore, the first cell on the page is Al; if you move four
rows in and four rows down, you're at cell E5.

In Microsoft’s implementation of an electronic spreadsheet, an Excel file is
called a workbook. Each workbook can then contain one or more worksheets.
Figure 2-1 shows these elements. It’s not quite as confusing as it sounds. The
advantage of this design is that you can create multiple spreadsheets on the
same subject and switch among them by clicking the tabs at the bottom. You
could devote one worksheet to one product, to one customer, or to one
employee. They can exist as independent entities, or you can link the con-
tents of one sheet (or one or more cells on one sheet) to a cell on

another sheet.

Book IV
Chapter 2

It’s the sort of thing that would have given Bob Cratchit — or you or me — a
tremendous headache if we had to maintain it in a handwritten book or even
on a set of word-processing files. But with a computer and spreadsheet soft-
ware in charge, it’s an organized thing of beauty.

sjaayspeasdg yum
ejeq Buiyouniy

The contents of any cell in a spreadsheet can be one of four types of data:



302 Spreading out an Excel 2007 Sheet

A\

4 Text. This includes labels for columns or rows, names of individuals or
products, or any other characters with no numerical value.

4 Values or constants. Any number with a specific value. This includes
prices, costs, and counts, as well as dates and times.

4+ Logical values. A determination of whether a particular proposition or
calculation is true or false, correct or incorrect, valid or invalid.

4+ Formulas. A mathematical calculation or expression that you can apply
to a constant to yield a new value, a logical value, or text.

Counting on simple formulas

The basic mathematical operators (slightly updated from Bob Cratchit’s
time) are still used in a spreadsheet. All of the symbols are directly available
from the computer’s keyboard. They include those in Table 2-1.

Table 2-1 Mathematical Operators

Symbol Function Result

+ Addition If you ask the system to work on 2+2, it returns a
calculated value of 4.

- Subtraction The returned value of 63-27 is 36.

* Multiplication The asterisk is for multiplication; 45*32 returns a
value of 1440.

/ Division The slash symbol is for division; 1440/32 yields a
value of 45.

You must take one extra step, though: You must indicate to Excel (or any
other spreadsheet program) that what you entered is a mathematical for-
mula and not just some text. In Excel, you do this by preceding the entry
with an equal sign, as in =2+4.

You can apply the same formulas to the contents of a cell. Say you want to
apply a 75 percent markup to the wholesale price of the product included in
Cell F26. The formula would be F26*1.5 or 1.5*F26. (Again, though, you need
to precede the formula by an equal sign, as in =F26+*1.5.)

Showing compunction with functions

How about instructing the system to calculate the sum of all the values in
cells from A10 through A25? What if you want to sum A10 through A22 and
add that value to the sum of cells B36 through B72? Perhaps instead of the
sum, you’d rather average all the values?



A\

Spreading out an Excel 2007 Sheet 303

The sum and average of all fears
For many users, the most commonly used function is SUM, which adds the
values of specified cells or a range of cells. The basic syntax is thus:

=SUM(first value, second value)

In a SUM function, blank cells return a value of 0. If you include a text cell in
a SUM function, the spreadsheet refuses to go along and proclaims an
ERROR.

The values can be a constant, an individual cell, or a range of cells. You can
sum up a range of cells these ways, among others:

4+ =sum(B1:B20). Adds the sum of all cells from B1 through B20.

4+ =sum(B1:B20, C5). Adds the sum of cells from B1 through B20 plus the
value of C5.

4+ =sum(B1:B20, C4:C16, 1250). Sums the range of cells from B1 to B20, plus
the range of cells from C4 to C16, and adds 1,250 to the total.

Excel’s Average function works in the same way. A formula that averages
a range of cells sums them all up and then divides the total by the number
of cells.

The function follows:
=Average(first value, second value)
4+ The Max function examines a range of cells and returns the largest
(maximum) value it finds.

4 The Min function locates the smallest (minimum) value in the range.

4+ The Count function reports the number of cells that contain numerical
data in a specified range of cells. Blank cells or text aren’t included in
the result.

Weird science (and math and logical functions)
You could let the computer apply complex functions built into its library.

Here’s a random sampling of some financial functions:
4 ACCRINT. Accrued interest for a security that pays periodic interest.

4+ DB. Depreciation of an asset for a specified period using the fixed-
declining balance method.

4+ YIELDMAT. The annual yield of a security that pays interest at maturity:.

Book IV
Chapter 2

sjaayspeasdg yum
ejeq Buiyouniy



30 4 Spreading out an Excel 2007 Sheet

Figure 2-2:
The
statistical
functions
pull-down
menu of the
Functions
Library is
one of the
key
improve-
ments in
Microsoft
Excel 2007.

You can directly enter a financial function like one of those just listed. If
you're a pro, you could rattle this one off in your sleep: =YIELD-
MAT(1012008,1012009,12152007,7.5,95,2).

However, for the rest of us, help is available just a few clicks away. In previous
versions of Excel, you could go to the Help system to see available functions
with instructions on using them. With the arrival of Excel 2007, a Function
Library has been installed in the ribbon bar at the top of the screen.

1. To use the library, click the Formulas tab.

2. Locate the Function Library.

See Figure 2-2.
3. Click the pull-down button to display installed functions.

4. Choose from the following options:

¢ Financial. Banking, loans, investments, amortization, and similar
functions.

e Math and Trig. Mathematical and trigonometric calculations.

e Statistical. Average, median, percentile, and correlation calculations.

¢ Engineering. Binary, decimal, and octal conversions as well as
specialized features.
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On the logical side you can also choose from functions for AND, OR, IF,
TRUE, FALSE, and others. Date and time functions calculate the number
of days between dates, to insert the current or a future date, and even
to calculate hours, minutes, and seconds between specified moments
in time.

Entering data in a cell

To directly enter numbers, text, or a formula into a cell use the pointer to
click on a location. Type the numbers of text and then press Enter (to enter
the text and move down a cell in the same column) or Tab (to enter the text
and move one column over to the right).

To enter more text data on a new line within the same cell, enter a line break
by pressing the key combination Alt-Enter.

To enter dates in a cell, use the pointer to click a location. To enter a date,
use a slash or a hyphen to separate the parts of a date. For example, type
8/19/1946 or 19-August-1946.

To enter times, follow along:

4+ Type a time in the form of hours:minutes or hours:minutes:seconds as in
9:23 or 9:23:03.

4+ To distinguish between a.m. or p.m., type an a or p after the time, as in
10:23 a to display 10:23 AM.

To enter the current date and time, type Ctrl + Shift + ; (semicolon). To enter
a date or time that updates and stays current when you reopen a worksheet,
use the TODAY and NOW functions.

Printing Excel Spreadsheets

A\

If you need to print an Excel spreadsheet, a few moments spent choosing an
efficient and attractive design go a long way. The key to getting the best
output is to click Print Preview before printing. Then click Page Setup to
make custom choices.

From the Sheet tab of Page Setup you can instruct Excel to print gridlines
to outline cells and make other choices. The Page tab includes the ability to
set Scaling, which can adjust a larger page to fit a smaller-size page. See
Figure 2-3.

Book IV
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Figure 2-3:
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Introducing New File Formats of Excel 2007

In the previous chapter of this book, I discuss the new file-format options that
were introduced with Microsoft Office 2007. The new file formats are more
compact (compared to previous formats, they require less space to hold the
same amount of information) and they offer some advanced features.

The new Excel 2007 formats follow:

4+ xlsx. The default filename extension for Excel Workbook is a ZIP com-
pressed archive. It substitutes for the former binary .xls format, although
support for Excel macros has been removed for security reasons.

4 xIsm. The new filename extension for Excel Workbooks with macros
enabled.

4+ xlIsb. A new filename extension and format for Excel workbooks with
macros but in binary form, allowing quicker document opening and
saving. This format is to be used with very large documents with tens of
thousands of rows or several hundred columns, or both.

4 xltm. A template document for workbooks, with macro support.
4+ xlam. Excel add-ins for extra functionality and tools. By its nature, it
includes support for macros.

See Book IV, Chapter 1 for information on how to add the ability to inter-
change Excel files between current and older versions of the spreadsheet
program.
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Taking Excel Shortcuts

Mice are nice, but not always easy to control . .

. especially on a laptop, and

especially in the tight confines of a tiny desk in a hotel room. One solution is
to use the extensive set of keyboard shortcuts. Tables 2-2 to 2-12 tell the tale.

Table 2-2 Navigating within Excel
Function Command
Close the selected workbook window Ctrl + W
or
Ctrl + F4
Restore the window size of the selected Ctrl + F5
workbook window
Switch to the next pane in a worksheet that F6
has been split
Switch to the previous pane in a worksheet that Shift + F6
has been split
Switch to the next workbook window when Ctrl + F6

more than one workbook window is open

Switch to the previous workbook window

Ctrl + Shift + F6

Minimize a workbook window to anicon Ctrl + F9
Maximize or restore the selected workbook window Ctrl + F10
Copy a picture of the screen to the Clipboard PrtScr
Copy a picture of the selected window to the Clipboard  Alt + PrtScr
Table 2-3 Managing Worksheets
Function Command
Insert new worksheet Shift + F11

or

Alt + Shift + F1

Move to next sheet in workbook

Ctrl + Page Down

Move to previous sheet in workbook

Ctrl + Page Up

Select current and next sheet

Shift + Ctrl + Page Down

Select current and previous sheet

Shift + Ctrl + Page Up

Book IV
Chapter 2
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Table 2-4 Moving within Worksheets

Function

Command

Move one cell up, down, left, or right

arrow keys

Move to edge of the current data region

Ctrl + arrow key

Move to beginning of row Home
Move to beginning of the worksheet Ctrl + Home
Move to last cell on the worksheet, in the Ctrl + End
bottom-most used row of the rightmost used column

Move down one screen Page Down
Move up one screen Page Up

Move one screen to right

Alt + Page Down

Move one screen to left Alt + Page Up
Display the Go To dialog box F5
Display the Find dialog box Shift + F5
Repeat last Find action (same as Find Next) Shift + F4
Move between unlocked cells on a protected worksheet Tab
Table 2-5 Entering, Formatting, and Calculating Data
Function Command
Complete a cell entry and select the cell below Enter
Start a new line in the same cell Alt + Enter
Fill the selected cell range with the current entry Ctrl + Enter
Complete a cell entry and select the previous cell above  Shift + Enter
Complete a cell entry and select the next cell to the right ~ Tab
Complete a cell entry and select the previous cell Shift + Tab
to the left
Cancel a cell entry Esc
Move one character up, down, left, or right arrow keys
Move to beginning of the line Home
Repeat last action F4

or

Ctrl+Y

Create names from row and column labels

Ctrl + Shift + F3

Fill down Ctrl+D
Fill to the right Ctrl +R
Define a name Ctrl + F3
Insert a hyperlink Ctrl + K
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Function Command
Enter the date Ctrl +;
Enter the time Ctrl + Shift +:
Display a drop-down list of the values in the Alt+l
current column of a list

Undo the last action Ctrl+Z
Table 2-6 Editing Data

Function Command
Edit the active cell and position the insertion F2

point at the end of the cell contents

Start a new line in the same cell Alt + Enter
Edit the active cell and then clear it, or delete Backspace

the preceding character in the active cell as you
edit cell contents

Delete the character to the right of the Delete
insertion point, or delete the selection

Delete text to the end of the line Ctrl + Delete
Display the Spelling dialog box F7

Edit a cell comment Shift + F2
Complete a cell entry and select the next cell below Enter

Undo the last action Ctrl+Z
Cancel a cell entry Esc

Undo or redo the last automatic correction Ctrl + Shift+Z

(when AutoCorrect Smart Tags is displayed)

Table 2-7 Inserting, Deleting, and Copying Cells

Function Command

Copy selected cells Ctrl+C

Display the Microsoft Office Clipboard for multiple Ctrl + C, Ctrl + C (Same

copy and paste actions command, twice in quick
succession)

Cut selected cells Ctrl + X

Paste copied cells Ctrl +V

Clear contents of the selected cells Delete

Delete selected cells Ctrl + -

Insert blank cells Ctrl + Shift + +

Book IV
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Table 2-8 Formatting Data

Function Command
Display the Style dialog box Alt+’

Apply the General number format Ctrl + Shift + ~
Apply the Currency format with two decimal Ctrl + Shift + $

places (negative numbers in parentheses)

Apply the Percentage format with no decimal places

Ctrl + Shift + %

Apply the Exponential number format with Ctrl + Shift + A
two decimal places

Apply the Date format with the day, month, and year Ctrl + Shift + #
Apply the Time format with the hour and minute, Ctrl + Shift+ @
and AM or PM

Apply the Number format with two decimal Ctrl + Shift + !
places, thousands separator, and minus sign (-)

for negative values

Apply or remove bold formatting Ctrl +B

Apply or remove italic formatting Ctrl +1

Apply or remove underlining Ctrl+U

Apply or remove strikethrough Ctrl +5

Hide the selected rows Ctrl +9
Unhide any hidden rows within the selection Ctrl + Shift + (
Hide the selected columns Ctrl +0
Unhide any hidden columns within the selection Ctrl + Shift +)
Apply the outline border to the selected cells Ctrl + Shift + &
Remove the outline border from the selected cells Ctrl + Shift + _

Table 2-9

Selecting Data, Cells, Rows, and Columns

Function

Command

Select entire column

Ctrl + spacebar

Select entire row Shift + spacebar
Select entire worksheet Ctrl + A
Select only the active cell (with multiple cells selected) Shift + Backspace

Select all objects on a sheet (with at least one object
already selected)

Ctrl + Shift + spacebar

Alternate between hiding objects, displaying
objects, and displaying placeholders for objects

Ctrl +6
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Table 2-10 Extending a Selection

Function Command

Turn extend mode on or off. In extend mode, EXT F8

appears in the status line, and the arrow keys

extend the selection

Add another range of cells to the selection; or use Shift + F8

the arrow keys to move to the start of the range you

want to add, and then press F8 and the arrow keys

to select the next range

Extend the selection by one cell Shift + arrow key

Extend the selection to the last nonblank cell in the
same column or row as the active cell

Ctrl + Shift + arrow key

Extend the selection to the beginning of the row

Shift + Home

Extend the selection to the beginning of the worksheet

Ctrl + Shift + Home

Extend the selection to the last used cell on the
worksheet (lower-right corner)

Ctrl + Shift + End

Extend the selection down one screen

Shift + Page Down

Extend the selection up one screen Shift + Page Up

Extend the selection to the last nonblank cell in the End + Shift + arrow key
same column or row as the active cell

Extend the selection to the last used cell on the End + Shift + Home

worksheet (lower-right corner)

Extend the selection to the cell in the
upper-left corner of the window

scroll lock + Shift + Home

Extend the selection to the cell in the
lower-right corner of the window

scroll lock + Shift + End

Table 2-11 Setting Up a Chart
Function Command
Create a chart of the data in the current range F11

or

Alt+F1

Select the next sheet in the workbook; press
repeatedly until the chart sheet you want is selected

Ctrl + Page Down

Select the previous sheet in the workbook; press
again until the chart sheet you want is selected

Ctrl + Page Up

Select the previous group of elements in a chart

Select the next group of elements in a chart

Select the next element within a group

Select the previous element within a group

T\L—)%
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Table 2-12 Previewing and Printing
Function Command
Display the Print dialog box Ctrl+ P

or

Ctrl + Shift + F12
Displays Print Preview screen Alt+FV
Move around the Print Preview page when zoomed in arrow keys
Move by one page in Print Preview when zoomed out Page Up

or

Page Down
Move to the first page in Print Preview when zoomed out Ctrl+ T

or

Ctrl + «
Move to the last page in Print Preview when zoomed out Ctrl +

or

Ctrl + —




Chapter 3: Presenting Vourself
with PowerPoint Professionalism

In This Chapter

+~ Understanding the point of a presentation program
v Designing and editing a PowerPoint show

» How do you get to Carnegie Hall? Rehearse!

ou don’t need to study Sigmund Freud to understand one of the most

common dreams: You're up on stage before an audience of your peers
or your professors or the people you most want to impress . . . and you're
naked, undressed, nude: what the Brits call starkers.

By most analyses, it indicates a fear of being unprepared. All eyes are upon
you and you’ve got nothing to say or show.

Now if you’re a well-trained actor, you've no fear here. I've seen some mar-
velous one-man or one-woman shows that feature masterful soliloquies that
seem to fill an empty stage with spectacular scenery and clothe the actor in
the most evocative of costumes.

But for the rest of us, myself included, anytime I go up on stage [ want to

be fully dressed . . . and fully prepared. Actually, [ give lectures pretty often
these days: on cruise ships, at libraries and bookstores, and just about any-
where that gives me an invitation (and an LCD projector for my laptop).

Therein lies the not-so-secret path to success for most modern-day,
presentation-giving road warriors: Bring your own scenery, costumes,
music, special effects, and script. And for many people the best way to
do that is to use presentation software; Microsoft PowerPoint is the most
commonly used and, by most judgments, the best of breed.

The program is to be viewed on a large screen using an LCD projector or

other technology. You can also merely gather a handful of colleagues around
your laptop for an up-close and personal presentation.

Pointing out Vour Power Spots

Several work areas open up when you start PowerPoint:
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Figure 3-1:
An empty
PowerPoint
presenta-
tion, in

the Normal
view of
PowerPoint
2007.

4+ Normal view is fittingly named for what is the normal, new, opening

PowerPoint presentation screen. It presents a blank canvas, along with a
full suite of power tools on standby in the ribbon or menu bar at the top.
See Figure 3-1.

Slides tab Main pane

ey

Shapes Amange Quick

Click to add title

Click to add subtitle

Click to add notes

Slide1 of1 | “Office theme™ | English (U.S)

Notes pane

4+ The main slide pane (on the right side of the view within the area

marked by the horizontal and vertical rulers) is where you create, edit,
and refine individual slides. Depending on the style you chose, the main
pane may include predefined locations where you can add a title or sub-
title or insert a drawing, photograph, or chart.

The slides tab (on the left side of the screen) shows a thumbnail minia-
ture version of each slide already created. You can see how the current
slide relates to those that precede and follow it, and you can also drag
thumbnails into a different order or delete them.

The Notes pane (at the bottom of the Normal view) is where you enter
comments or a script; the information here will not be projected onto

the screen at a presentation, but if you work in Presenter view you can
see them on the laptop. Notes can also be printed out as handouts for
your audience.
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When you first start, the Notes pane is just one-line deep. To increase
the available space to read notes, point to the pane’s top border and
wait a moment until the pointer changes into a two-faced arrow; keep
the mouse button pressed down and drag the border up. The slide you
see on your laptop gets smaller to accommodate the growing Notes
pane, but changes you make to the Notes pane size don’t affect the size
of the slide when it projects.

A\

QQ,\I\BEI? The best presentations are those that keep the information displayed

& onscreen to just the essential points, and use the notes for your background
information. You can fill the Notes pane with material cut and pasted from a
word processor, from slides created in PowerPoint, or just about anywhere
else on your system.

Designing and Refining a PowerPoint Presentation

Presentations have no official prescription, but most experts follow the same
structure that speechwriters often do: Tell them what you’re going to tell
them, tell them, and then tell them what you told them.

Structuring a presentation

You could try this basic structure:

4 Main title slide. You can display a summary title (accompanied by an
attractive piece of art, if possible) as attendees arrive for your presenta-
tion. It’s a good way to be sure the equipment works properly, and it
gives you a jumping-off spot for your show.

4+ Introduction. This slide tells the audience what you’re going to tell
them: the major points or subjects of your presentation.

4 Detail slides. One or more slides expand upon and develop the points
you seek to make. The structure should follow basic outlining: major
point, minor point, details, and then back to a new major point. Don’t
bore your audience by leaving one slide on display too long; try to
have enough slides to make changes every few minutes during your
presentation.

4 Summary slide. Here’s where you tell them what you told them. This rein-
forces your message and gives you talking points for your summation.

When you add a slide to your presentation, you can continue with the same
slide layout used in the previous slide or you can choose a layout for the
new slide. To add a new slide of the same design
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Outlines

A quick aside into how to give the verbal side then deliver your comments from the outline. It
of a presentation: Write out a speech, break it comes out much more naturally and is more
down into as spare an outline as you can, and interesting than if you read from a script.

1. Click the Home tab.
2. Locate the Slides section.
3. Click the small icon of a slide at the left side of the ribbon.

To add a slide with a different layout, click New Slide. The Slides Gallery
appears in a drop-down window. See Figure 3-2. (In older versions of
PowerPoint, click File > New Slide.)
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The placeholders shown in each slide can be used for text, or you can click
the icons to insert objects including clip art, art from your own collection,
and SmartArt graphics generated within the program.

Adapting the Normal template

The Normal view in PowerPoint 2007 uses a blank presentation template.
Nothing fancy, but easy to work with, you can readily customize it.

To create a new presentation based on the Blank Presentation template,
follow along:
1. Click the Microsoft Office Button.
2. Click New = Blank and Recent.
Blank and Recent is in the Templates section.

3. Double-click Blank Presentation.

Copying a slide to use as a template

One of the most efficient ways to plow your way through a complex presen-
tation is to use a successful slide as the model for another; an easy way to
build one off the other is to copy a slide and then modify to the second
version.

1. In the Slides tab, find a slide you want to duplicate.

2. Right-click the slide and then click Copy.

3. Release the mouse button and then use the pointer to go where you
want to place the copy.

4. Right-click and click Paste.

You can copy a slide into your laptop’s memory and then place it in
another presentation open within PowerPoint.

Applying a new layout to an existing slide

You can take one of several tactics:

4+ Concentrate on the layout of slides before entering text and art.

4+ Lay out the basic material and then come back and apply a new layout
to a set of existing slides.

4+ Return to a finished presentation months or years after finishing it and
refresh it with a new look for a new audience, or give it a new look when
presenting it again with new information.

Book IV
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To change the layout of an existing slide, follow these steps:

1. Open a presentation in PowerPoint.

2. In the Slides tab, click the slide whose layout you want to change.
The Slides tab is on the left side of the screen.

3. Click the Home tab = Slides.

4. Click Layout and choose the new layout to apply.

In older versions, click the Layout menu item and then choose a new
layout.

Themes like an attractive presentation

Separate and apart from slide layout (the location of titles, images, and
notes) is your presentation’s design. Your goal is to create an attractive look
(or use a predefined design) that communicates information well. I'm talking
about using fonts that are

4+ Easytoread

4+ In colors that viewers can easily see

4+ In combinations that engage the viewer
Office PowerPoint 2007 automatically begins with a basic design called the
Office theme anytime you begin a project based on the Blank Presentation
template. Hover your pointer over an example or click one to see what it

looks like to change a theme. As long as you don’t save your file, any brows-
ing you do here doesn’t make permanent changes.

However, changing the theme is as easy as pointing and clicking:

1. Click the Design tab => Themes.
2. Click the down arrow at the right side of the first group of themes.
The display expands into the full set of built-in designs. See Figure 3-3.

In older versions of PowerPoint, click the Formatting toolbar, then click
Design = Color Schemes.

By default, PowerPoint 2007 applies theme changes to all the slides in a
presentation. If you want to change the appearance of one slide only, or a
selected group of slides, hold down the Ctrl key as you click a slide (in the
Slides pane on the left side of the page); continue holding Ctrl as you select
other slides. When you have finish choosing slides, right-click the theme you
want to apply, and then click Apply to Selected Slides.



Figure 3-3:
You can
experiment
with
changing
any of the
built-in
themes
(called Color
Schemes in
previous
versions of
Power-
Point).

319

Designing and Refining a PowerPoint Presentation

@ B %-" i [ %- @~ o0 ° LECTUREDI PPT Henry Hudson Voyage 1 and 2 Dreams and Obsession 100707 - Microsoft PowerPoint

Home  Insert Design Animations Slide Show Review  View Add-Ins

i

Page Slide
Setup Orientation

¥ Background Styles -

Hide Background Graphics

More Themes on Microsoft Office Online.
(=) Browse for Themes...

Save Curent Theme...

Slide 14 0f 52 | "Apex” | & English U5}

Rearranging slides

You have two ways to change slides around in a presentation. The most
direct way — but not always the easiest — is to click a slide in the Slides
pane and hold the mouse button while you drag it within the pane to a new
location. This works well when you want to move a slide a few positions in
the presentation structure.

A much better tool for dealing with large and complex presentations is to
open the Slide Sorter window. This button is available from the ribbon bar of
PowerPoint 2007 or as a menu item in earlier versions. (See Figure 3-4.) You
can click any slide and drag it to a new spot or delete it from the show. Using
either method, you can select multiple slides to move, delete, or copy by
pressing and holding the Ctrl key while clicking slides.

Adding and formatting text

Bulleting or numbering your text can help make it much more readable.

4+ Prepare your text in a word processor or other program, copy it to com-
puter memory, and then paste it into place.

4+ To add text to any slide, click the placeholder where you want to add
text; type or paste text.
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4+ To switch between a bulleted list and unbulleted text, select the text and
click the Bullets text or icon.

4+ To change the bullet characters, click the arrow next to Bullets, and then
choose the style you want.

4 From the ribbon bar in the Home tab of PowerPoint 2007 (or the Layout
menu of previous versions), you can change fonts, type sizes, type
styles, colors, and other attributes.

Figure 3-4:

The Slide

Sorter

window

allows a

global view &E 31 ﬂ
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slidesina %3

presentation

(in this case

a photo

travel

essay).
Checking spelling
By default, PowerPoint checks the spelling of all text you enter onto slides.
Look for words underlined with a squiggly red line; that indicates that the
system hasn’t found the word in the spelling dictionary. Make any necessary
changes as you create the slides. If you prepare your text in a word proces-
sor or other program, you can spell-check it there before copying and past-
ing it into place in PowerPoint.

<® Once you complete the presentation, have PowerPoint go back and re-

examine the entire presentation. Not only does this help you check one more
time for spelling errors, but it also helps you discover inconsistencies: Did
you spell labor in the American style in some places and use the English
spelling labour elsewhere?

To initiate a spell-check on a document, follow these steps:
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1. Press Ctrl + Home.

You're taken to the first slide in your presentation.
2. Click the Review tab and locate the Proofing group.
3. Click Spelling.

If the program discovers any words it believes are misspelled,
PowerPoint displays a dialog box with the word indicated. As a compo-
nent of Microsoft Office, the spell-checking process uses the same
engine (and the same dictionary) used in Microsoft Word and other ele-
ments of the suite.

4. Choose one of the following:

¢ Ignore All instances of the particular word (thereby declaring it to
correct).

e Add the word to the built-in dictionary so that it isn’t flagged as
incorrect again

¢ Change the spelling of the word

If you change the word, select from one of the selected spellings shown
in the box or enter your own fix. (If you choose Change All, the program
alters all instances of the word it finds in the current presentation.)

Adding clip art to a slide

Why do PowerPoint presenters insist on including a Halloween goblin, a
Thanksgiving turkey, a Christmas tree, or Uncle Sam in a top hat? The
answer, I'm afraid, speaks to the power of symbols — no matter how over-
used or cheesy.

When you use a very familiar icon, you receive quick recognition and little
chance of misunderstanding. On the other hand, you’re not demonstrating a
great deal of creativity. Does it sound as if 'm not a big fan of clip art? (Cue
the picture of exploding fireworks, accompanied by a sound effect of an audi-
ence delivering an ovation. You know exactly what [ mean, because you’ve
seen the combination a thousand times.)

PowerPoint, as well as other components of Microsoft Office and certain other
applications come equipped with a collection of colorful, familiar, and easily
recognized clip art drawings. You can add clip art you’ve purchased from com-
mercial collections, downloaded from free sources, or drawn by yourself.

Here’s how to insert clip art:

1. Click a slide.

If the slide has a placeholder for clip art, click there; otherwise the
image is inserted in the center of the slide.

Book IV
Chapter 3
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322 Designing and Refining a PowerPoint Presentation

2. Click the Insert tab and locate the Illustrations group.
3. Click Clip Art.

The Clip Art task pane opens.
4. Locate the drawing you want to insert.

You can

¢ Move through the collection by pulling down on the scroll bar on the
right side of the pane.

e (lick an icon that allows you to organize clips on your system. (See
Figure 3-5.)

¢ Connect to the Internet to search for clip art in Office Online.

5. Once you've found the clip art you want to use, click on it to insert it
into your slide.

Once it is in place, it can be stretched to resize it and it can be
rotated. You can also add text to help make your point even more
obvious.

Clip Art task pane

Figure 3-5:
The Clip Art
task pane is
shown at
the right; the
Microsoft
Clip
Organizerin
the middle
of the 5 Sornbimai
screen :
searches art
by category
or location.

Microsoft Clip Organizer
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Adding SmartArt graphics

SmartArt is art that is, well, a heck of a lot smarter than mere clip art. Do
you want to illustrate the fact that the company’s revenues are falling off the
cliff? You could show picture of a cliff . . . or you could present real numbers
from your presentation tumbling down a slope. (The numbers are tumbling,
that is; you’re not tumbling while presenting.)

PowerPoint includes layouts in the SmartArt catalog. To convert existing
text to a SmartArt graphic, you can either enter text and apply a graphic to
it, or choose a graphic and enter text that fills it out.

To convert text to a SmartGraphic in PowerPoint 2007, do these steps:

1. Click the placeholder.
2. On the Home tab, locate the Paragraph group.
3. Click Convert to SmartArt Graphic.

You can experiment with any of the SmartArt graphics by hovering your
pointer over the thumbnails. The initial set shows layouts intended to
spruce up bulleted lists; to see the entire set, click More SmartArt
Graphics.

4. Complete the customization.
Edit the text or add new material, resize it, rotate it, or apply a different
Quick Style to set its color palette.

Figure 3-6 shows a simple SmartArt graphic I created to explain the manufac-
ture cost of our company’s best widget.

To insert a piece of SmartArt to a blank slide, follow these steps:

1. Click the Insert tab and locate the Illustrations group.
2. Click SmartArt.

The Choose a SmartArt Graphic dialog box appears on the left side of
the PowerPoint frame.

3. Click the type of SmartArt graphic you want to use.

If you hover your pointer over a graphic, it displays a preview.
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Figure 3-6:

| created
this
SmartArt
graphic by
entering text
into a dialog
box
associated
with the
graphic.
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Setting smooth (or flashy) transitions

One of the arts that make watching a movie enjoyable comes in the form of
editing between scenes. Very rarely do you see a “jump cut” that switches
from one location to another, one actor to another, or one annoying product
placement to the next. Instead, editors employ devices including fades,
wipes, and dissolves; these make one scene morph smoothly into the next.
When done well, viewers barely notice they’re happening.

You can apply the same sort of effects between slides in a PowerPoint presen-
tation. One slide can fade out while a new one fades in. That often is the best
way to move from slide to slide in a professional boardroom presentation.

If you're making a sales presentation or entertaining an audience, you can
choose flashier transitions — effects impossible to miss. These include
starbursts, animated wipes from corner to corner, and other attention-
demanding devices. In addition to the transition type, you can set the speed
at which it unfolds as well as the frigger (keyboard, mouse click, or a particu-
lar period of time) that sets it in motion.

You can apply a transition to a slide as you create it, or you can go back and
edit slides in a completed presentation. You can also apply the same transi-
tion to all the slides in a show.
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1. Click the Animations tab and locate the Transitions to the Slide group.
2. Click the transition you want to use.

An example appears in Figure 3-7. As with most other effects, you can
see a preview by hovering the pointer over the transition’s icon.
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Going out on the Web from PowerPoint

We live in a connected society, and increasingly, a wireless world. So why not
reach out from your laptop to the Internet for a live link that pops up in the
middle of your presentation? You can if you embed a hyperlink in your show.

Think about something like this: You're lecturing about investment strate-
gies and, with a click of a button on a PowerPoint slide, you go to an up-to-
the-moment report on the Dow Jones Industrials or an individual equity. Or
perhaps you have an extended video stored on a server back in your office
that someone else is updating for you; a link to the office network could
bring it to PowerPoint. And if you want to get really fancy, you could add a
link to a video feed from the CEO’s desktop.

As you're sitting at your desk, doing these things and more is quite easy. Just
connect your laptop to your network or the Internet via a wired or wireless
link.
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Vgs\\""?! Beware: If you're taking your show on the road, some serious headaches

S could easily ruin it. Are you certain the conference room or stage has a high-
speed Internet connection? Are there firewalls or other security measures
that could block access to live feeds? This is the sort of presentation I give
only after testing it in the place where it is to be delivered. And I'm in the
room an hour before the scheduled presentation time to test everything, and
am prepared to switch to an alternate show that doesn’t depend on going
out on the Web.

Hyperlinks can take you
4+ From one slide to another (allowing a sort of freeform jump that you can

adjust based on changing conditions as you give your presentation)

4+ To a network, an Internet location, or another PowerPoint presentation
on your computer

4+ To another program and file on your laptop, such as a spreadsheet or
graphics program

Follow along to add a hyperlink:

1. Select the item that you want to enable as a hyperlink.
The item can be text or another object, such as a graphic.
2. Click the Insert tab and locate the Links group.
3. Click Hyperlink.
The Insert Hyperlink dialog box appears.
4. Click the button in the My Places box that identifies the link target.
The choices include
¢ Existing File or Web Page
¢ Place in This Document
¢ (Create New Document
e E-mail Address

Naming and saving a presentation

Files created in this format can only be opened in Office PowerPoint 2007 or
a current version of the PowerPoint Viewer.

Take these steps to save your presentation in PowerPoint 2007:
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1. Click the Microsoft Office Button and point to Save As.

2. Choose one of the following:

e PowerPoint Presentation: To save the file in the most current, most
efficient file format.

e PowerPoint 97-2003 Presentation: To save a copy of the presenta-
tion in a format that can open in either PowerPoint 2007 or earlier
versions. If you save your file in the older format, you lose any spe-
cial features accessible only in PowerPoint 2007; this affects features
only, not the content of your show.

In earlier versions of the program, click File => Save As. You can save files
in the default format called PowerPoint 97-2003.

Your other options for saving files from PowerPoint 2007, shown in Figure 3-8,
include:

4+ PowerPoint Show. Files saved in this format always open within
PowerPoint in Slide Show view, ready for projection. In other words,
choosing this option launches directly into presentation mode, as
opposed to editing mode. That doesn’t mean you can’t switch to editing;
it’s just a question of how the program starts.

4+ PDF or XPS. You can save your file as a PDF or XPS presentation for use
on any machine that has permitting software; this is a good way to send
someone a copy of your presentation for easy viewing and difficulty
changing.

4 Other Formats. You can modify PowerPoint 2007 with add-ins so you
can save files in other file formats.

Name your presentation and save it as soon as you begin working on it;
this helps you recover work in case the software, the operating system, or
the hardware freezes or crashes. What? You thought Windows Vista was
crash proof? Please contact me for details of the bridge I am selling in
Brooklyn.

Once you give a file a name and type, you can quickly save versions as you
work on them by clicking the Microsoft Office Button and then clicking Save
(or, in older versions, by clicking the File menu and then Save). Users of any
version can press Ctrl + S.
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Figure 3-8:
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You can do hundreds of things to create and format content in your presen-
tation; I've touched on just a few dozen. But eventually it’s showtime.

But wait: Before you take your presentation up on stage or into the board-
room, perform a full set of tests, tryouts, practice sessions, and rehearsals.
In other words, don’t let the first time you make your presentation be the
first time PowerPoint has operated outside of editing mode.

Testing in Slide Show view

Slide Show view displays your presentation as closely as possible to the way
it will appear when your audience sees it. Editing features are turned off,
notes are hidden away, and all that appears is the show itself.

Why do [ say “as closely as possible”? Because many modern laptops offer
widescreen LCDs that don’t match precisely the image that you see if you
use an LCD projector or a large-screen projection television for your
PowerPoint presentation. Many widescreen laptops tend to show ovals
(wider than they are tall) on built-in screens, but the image is correct when
projected on an external screen.



Putting on at the Ritz 3 29

You're also going to want to check that all the transitions between slides are
working properly and that slides advance when you want them to change —
on a mouse click or a keyboard command. If you're going to work with a
wireless remote control — a nifty addition to any speaker’s toolkit — you
should test that out in Slide Show view as well.

To turn on the view in PowerPoint 2007, follow these steps:

1. Click the Slide Show tab and locate the Start Slide Show group.
2. Click one of the following:
¢ From Beginning: To start with the first slide of the presentation.

e From Current Slide: To start with the slide currently highlighted in
the Slide pane.

The presentation opens in Slide Show view.

3. Click the mouse or keyboard or use your remote control to advance to
the next slide.

To return to Normal view at any time, press the Escape key.

Preparing for external projectors or screens

Assume nothing. Here’s a checklist of questions you need to have answered
before you send your PowerPoint presentation out on the road:

4+ Will the presentation be delivered from the laptop computer you used to
create it, or do you need to use another computer at your destination?
4+ Where will the presentation be stored:
e On the laptop you bring with you?
¢ On an external storage device such as a flash memory key, a CD, or
DVD?
¢ On an external hard disk drive?
Will it be made available over the Internet or an office network?

4+ Will you, the person who developed the presentation and knows it
inside and out, deliver the presentation? Or will someone else run the
laptop and speak to the audience? Will the presentation be designed to
run itself?

The answers to each of these questions can send you off in a different direc-
tion or require a different type of preparation.

Book IV
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Handouts and notes

You can use speaker’s notes as a script for your
presentation, and you can consider using them
as leave-behinds for audience members. The
notes display one slide at the top of each
printed page; at the bottom is any text in the
Notes pane.

Handouts don't include the contents of the
Notes pane. You can print one, two, three, four,
six, or nine slides per page. The three-slides-
per-page handout includes a section of ruled
space for handwritten notes.

\\3

Rehearsing the show

The first level of rehearsal should take place at your own desk.

4+ Close the door, shut off your phone, start a clock or timer, and then pres-

ent the show.

Most people have a different speaking voice and can project more
energy when standing up; perform at least one of your rehearsals in a

position close to the one you’ll use when delivering the presentation to a

live audience.

4+ Keep a notepad on your desk to jot down comments about things
that need fixing or changing. Look for slides that seem out of place or

unnecessary.

4 After completing the first run-through, check the clock to see how
closely your presentation fits your allotted time. Make sure you leave
some extra time for questions.

Make one of your final run-throughs using equipment identical to (or at
least similar to) the hardware you’ll use when making your actual pres-
entation. Make sure you know how to turn on the external video output
from your laptop, and test that it works with an LCD projector.

Packaging for distribution

If you're preparing your presentation to send to another location, one excel-
lent solution is to “package” the show. This brings together the presentation
in finished form, along with any files linked to it (such as videos or sound
effects), as well as a copy of Microsoft Office PowerPoint Viewer 2007.

About the Viewer: This software is available free through the Microsoft web
site and, as part of most Microsoft Office packages, allows you to view, read,
and print PowerPoint presentations but not to edit or change them.
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[ always include in my traveling case a copy of the PowerPoint Viewer on CD,
along with a current copy of my various lectures and presentations, just in
case my laptop goes bad or goes missing. It’s never happened on the road,
but just in case, I'm ready to make my presentation on whatever I could beg,
borrow, or buy at my destination.

You can record a packaged presentation on

+ CD
+ DVD
4+ Flash memory key

You can send it

4 Via e-mail

4 Directly over the Internet

Presenting New PowerPoint 2007 Features

A\

As with the other components of Microsoft Office 2007, the latest version of
PowerPoint can store and use files that employ an improved, compressed
file format. The Open XML Format takes up less space, and components are
segmented within the file so corruption of one part doesn’t render the entire
file unusable.

I've found the new XML file format results in a reduction of about 50 percent
when you compare the same PowerPoint presentation saved in the current
or a previous file format.

Other elements new to PowerPoint 2007 include

4+ The ribbon menu, which brings together features and commands under
categorized tabs and related groups.

4+ Alarger collection of predefined QuickStyles, layouts, table formats, and
effects that can begin a presentation creation or that you can apply to a
completed one.

4+ Custom layouts that contain as many placeholders as you want. These
markers are for inserting charts, tables, videos, graphics, SmartArt graph-
ics, and clip art. You can save your custom layouts for future presenta-
tions as well.

4+ Text controls, including the most advanced font designs, including small
caps, strikethrough or double strikethrough, and double or color under-
lines. You can also add fills, lines, shadows, glow, kerning (tightening of
spacing between letters), and 3D effects to text.
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Amping Presenter view

Office PowerPoint 2007 improves on Presenter view. Now you can

4+ Run your presentation with notes and thumbnails of later slides from
one monitor — at a podium, for example — while the audience views the
show on a second monitor (or on a screen with an image from an LCD
projector).

4 Preview text that shows the effect of the next click before: Will it move
to the next slide, will it add a graphic or text element, will it begin an
animation?

4+ Black out the screen during a presentation and then resume where it
was halted; this tool might be appropriate during a question-and-answer
period or if you schedule a break in the middle of a presentation.

Pumping up security

If you give copies of your presentation on disc or send it over the Internet,
you might struggle with maintaining the integrity of your work. Also, you
need to prevent unauthorized persons from learning information about you
or your company without your permission.

With PowerPoint 2007, you can do all the following:

4 Hide the author’s name
4+ Delete all comments made in the course of its design

4+ Restrict attempts to change a finished file

Matking a presentation read-only

Using the Mark As Final command on a PowerPoint file allows other users to
read and present it, but blocks attempts to edit or change it. Editing com-
mands, proofing marks, and typing are disabled.

However, the solution isn’t permanent: A user can open your PowerPoint file,
turn off the Mark As Final setting, and change it at will.

To mark a file as final, follow these steps:

1. Open the document.
2. Click the Microsoft Office Button.
3. Choose Prepare > Mark as Final.
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Removing metadata and personal information

The Document Inspector, a component of Office 2007 programs, checks files
for hidden metadata (info about your info), personal information, and con-
tent stored in your presentation. The inspector finds these kinds of things:
comments, document properties (including creation dates and the author
name), document management server information, invisible objects, off-slide
content, presentation notes, and custom XML data.

You can customize the Document Inspector to add checks for additional
types of hidden content. For more information, please read PowerPoint 2007
For Dummies (Wiley).

PowerPoint Shortcuts

As with other power tools for the road warrior, Microsoft PowerPoint can
work in a parallel universe: a full set of commands you can execute from the
keyboard, as well as with a mouse or other pointing device. That’s a very good
thing, because it allows you, the presenter, to concentrate on the show — not
the machine. See Tables 3-1 through 3-22.

Table 3-1 General Commands: Function Keys
Action Keyboard
Display Help; display the Office Assistant F1

Start context-sensitive Help Shift + F1

Select the text box (with text or an object selected F2
inside the text box); select text within a text box
(with the text box selected)

Save As command Alt + F2 or F12

Save command Alt + Shift + F2
or
Shift + F12
Change the case of letters Shift + F3

Repeat the last action F4

Repeat the last Find (Find Next) Shift + F4
Close the window Ctrl + F4

Quit PowerPoint Alt + F4

Quit PowerPoint Alt + Shift + F4
Slide Show command (View menu) F5

Restore the presentation window size Ctrl + F5

Move to the previous pane Shift + F6

(continued)
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Table 3-1 (continued)

Action Keyboard
Restore the program window size Alt + F5
Move to the next pane F6

Move to the next presentation window Ctrl + F6

Move to the previous presentation window

Ctrl + Shift + F6

Spelling command (Tools menu)

F7

Move command (presentation Control menu) Ctrl + F7
Find next misspelling (If Automatic Spell Alt + F7
Checking enabled)
Size command (presentation Control menu) Ctrl + F8
Activate the menu bar F10
Display a shortcut menu Shift + F10
Maximize the presentation window Ctrl + F10
Maximize the program window Alt+ F10
Activate the menu bar Ctrl + Shift + F10
Display Visual Basic code Alt+F11
Open command (File menu) Ctrl + F12

Print command (File menu)

Ctrl + Shift + F12

Table 3-2

Controlling a Slide Show’

Action

Keyboard

Perform the next animation or advance to the
next slide (same as if the mouse button had
been clicked)

Any of the following:

Enter Page Down
%

\2

spacebar
Perform the previous animation or return to the Any of the following:
previous slide P

Page Up

e

T

Backspace
Go to slide <number> number + Enter
Display a black screen, or return to the slide show B
from a black screen or

. (period)
Display a white screen, or return to the slide show w
from a white screen or

, (comma)




Taking PowerPoint Shortcuts

335

Action Keyboard
Stop or restart an automatic slide show S
or
+ (plus sign)
End a slide show Any of the following:
Esc
Ctrl + Break
- (hyphen)
Erase on-screen annotations E
Go to next hidden slide H
Set new timings while rehearsing T
Use original timings while rehearsing 0
Use mouse-click to advance while rehearsing M

Return to the first slide

Both mouse buttons for 2 seconds

Redisplay hidden pointer and/or change the pointer
to a pen

Ctrl+P

Redisplay hidden pointer and/or change the pointer Ctrl + A
to an arrow
Hide the pointer and button immediately Ctrl+H
Hide the pointer and button in 15 seconds Ctrl+ U
Display the shortcut menu Shift + F10
?i;ht-click
Go to the first or next hyperlink on a slide Tab
Go to the last or previous hyperlink on a slide Shift + Tab
Perform the mouse-click behavior of the selected Enter while a hyperlink is
hyperlink selected

Perform the mouse-over behavior of the selected
hyperlink

Shift + Enter while a hyperlink is
selected

*These keyboard shortcuts work while a PowerPoint slide show is being presented in full-screen mode. You can press F1

during a slide show to see a list of controls.

Table 3-3 Creating and Editing Presentations
Action Keyboard
Create a new presentation Ctrl + N
Insert a new slide Ctrl+ M
Make a copy of the selected slide Ctrl+D
Open a presentation Ctrl+0
Save a presentation Ctrl+S

(continued)
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Table 3-3 (continued)

Action Keyboard
Close a presentation Ctrl + W
Print a presentation Ctrl + P
Run a presentation F5

Quit PowerPoint Alt + F4
Find text, formatting, and special items Ctrl + F
Replace text, specific formatting, and special items Ctrl+H
Insert a hyperlink Ctrl + K
Check spelling F7

Cancel an action Esc

Undo an action Ctrl +Z
Redo or repeat an action Ctrl+Y
Switch to the next pane (clockwise) F6

Switch to the previous pane (counterclockwise) Shift + F6
Table 3-4 Deleting and Copying Text and Objects
Action Keyboard
Delete one character to the left Backspace
Delete one word to the left Ctrl + Backspace
Delete one character to the right Delete
Delete one word to the right Ctrl + Delete
Cut selected object Ctrl + X
Copy selected object Ctrl +C
Paste cut or copied object Ctrl+V
Undo the last action Ctrl +Z
Table 3-5 Moving around in Text
Action Keyboard
Move one character to the left «—

Move one character to the right -

Move one line up T

Move one line down l

Move one word to the left Ctrl + «

Move one word to the right Ctrl + —
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Action Keyboard
Move to end of a line End

Move to beginning of a line Home
Move up one paragraph Ctrl+ T
Move down one paragraph Ctrl+ 4
Move to end of a text box Ctrl + End
Move to beginning of a text box Ctrl + Home
Move to the next title or body text placeholder* Ctrl + Enter
Repeat the last Find action Shift + F4

*When the last placeholder on a slide is selected, press Ctrl + Enter to insert a new slide in the presentation.

Table 3-6 Selecting Text and Objects
Action Keyboard
Select one character to the right Shift+ —
Select one character to the left Shift + «
Select to the end of a word Ctrl + Shift + —
Select to the beginning of a word Ctrl + Shift + «
Select one line up Shift + T
Select one line down Shift+ 4
Select an object (with text selected inside the object) Esc
Select an object (with an object selected) Tab

or

Shift + Tab until the object you
want is selected

Select text within an object Enter

Select all objects in the slide pane Ctrl + A
Select all slides in the slide sorter view Ctrl + A
Select all text in the outline pane Ctrl+ A

Table 3-7 Changing or Resizing the Font
Action Keyboard
Change font Ctrl + Shift + F
Change font size Ctrl + Shift + P
Increase font size Ctrl + Shift + >
Decrease font size Ctrl + Shift + <

Book IV
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Table 3-8 Applying Character Formats
Action Keyboard
Change formatting of characters (Font command, Ctrl+T
Format menu)

Change case of letters Shift + F3
Apply bold formatting Ctrl+B

Apply underline Ctrl +U

Apply italic formatting Ctrl +1

Apply subscript formatting (automatic spacing) Ctrl + =

Apply superscript formatting (automatic spacing) Ctrl + Shift + +

Remove manual character formatting

Ctrl + spacebar

Table 3-9 Copying Text Formats

Action Keyboard
Copy formats Ctrl + Shift+ C
Paste formats Ctrl + Shift +V
Table 3-10 Aligning Paragraphs and Indents
Action Keyboard
Center a paragraph Ctrl +E
Justify a paragraph Ctrl +J
Left-align a paragraph Ctrl + L
Right-align a paragraph Ctrl +R

Table 3-11 Working in an Outline or Slide Pane
Action Keyboard
Promote a paragraph Alt + Shift + «
Demote a paragraph Alt + Shift + —
Move selected paragraphs up Alt + Shift + T
Move selected paragraphs down Alt + Shift + |
Show heading level 1 Alt + Shift + 1
Expand text below a heading Alt + Shift + +
Collapse text below a heading Alt + Shift + -
Show all text or headings Alt + Shift + A
Turn character formatting on or off /
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Table 3-12 Working in Windows Boxes
Action Keyboard
Switch to the next program in the window Alt + Tab
Switch to the previous program in the window Alt + Shift + Tab
Display the Windows Start menu Ctrl + Esc
Close the active presentation window Ctrl + W
Restore the active presentation window Ctrl + F5
Switch to the next presentation window Ctrl + F6
Switch to the previous presentation window Ctrl + Shift + F6
Switch to the next window pane in the clockwise F6

direction

Switch to the next window pane in the Shift + F6

counterclockwise direction

Move the window pane split in a maximized presentation
window

Alt, <, |, P to select the splits,
arrow keys to position the split,
then Enter

Move the window pane splitin a presentation window
that is not maximized

Alt, -, P to select the splits, arrow
keys to position the split, then
Enter

Carry out the Move command (Presentation icon Ctrl + F7
menu, menu bar)

Carry out the Size command (Presentation icon menu, Ctrl + F8
menu bar)

Minimize the presentation window Ctrl + F9
Maximize the presentation window Ctrl + F10

Select a toolbar button in the Open or Save As dialog
box (File menu)

Alt + number (1 for the leftmost
button, 2 for the next, and so on)

Update the files visible in the Open or Save As dialog
box (File menu)

F5

Table 3-13 Working in Dialog Boxes

Action Keyboard
Switch to next tab in dialog box Ctrl + Tab
Switch to previous tab in dialog box Ctrl + Shift + Tab
Move to next option or option group Tab

Move to previous option or option group Shift + Tab
Move between options in selected drop-down list box arrow keys

or between some options in a group of options

(continued)
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Table 3-13 (continued)

Action

Keyboard

Perform action assigned to selected button; select or
clear the check box

spacebar

Move to option in a selected drop-down list box

first letter of the option name

Select option; select or clear a check box

Alt + letter underlined in the

option name
Open selected drop-down list box Alt+d
Close selected drop-down list box; cancel command Esc
and close dialog box
Perform action assigned to default button in dialog box Enter

Table 3-14 Working in Text Boxes

Action Keyboard
Move to beginning of the entry Home

Move to end of the entry End

Move one character to the left «—

Move one character to the right -

Move one word to the left Ctrl + «

Move one word to the right Ctrl + —
Select from insertion point to the beginning of the entry ~ Shift + Home
Select from insertion point to the end of the entry Shift + End
Select or cancel the selection one character to the left Shift + «
Select or cancel the selection one character to the right ~ Shift + —
Select or cancel the selection one word to the left Ctrl + Shift + «
Select or cancel the selection one word to the right Ctrl + Shift + —

Table 3-15 Using the Open and Save As Dialog Boxes
Action Keyboard

Go to previous folder Alt+1

Open the folder up one level from the open folder Alt+2

Open Web search page Alt+3

Delete selected folder or file Alt+4

Create new subfolder in the open folder Alt+5

Switch between List, Details, Properties, Alt+6

and Preview views

Show the Tools menu

Alt+7
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Table 3-16

Action

Working with Menus*
Keyboard
Shift + F10

Display a shortcut menu that shows a list of
commands relevant to the selected object

Display the program Control menu Alt + spacebar

Select the next or previous menu command N
or
T

Select the menu to the left or right, or switch «—

between a submenu and its main menu or
_)

*To choose any menu command from the keyboard, press Alt followed by the letter underlined in the menu name to display
the menu. Then press the letter underlined in the command name. As an example, to check spelling, press Alt + T to open
the Tools menu, and then press S.

Table 3-17 Working with Toolbars
Action Keyboard
Make the menu bar active F10
Select the next toolbar Ctrl + Tab
Select the previous toolbar Ctrl + Shift + Tab
Select the next or previous button or menu Tab
on the active toolbar or

Shift + Tab
As appropriate: Enter
Open the selected menu;
Perform the action assigned to the selected button;
Select an option in a list box or on a menu;
Enter text in the selected text box.
Move through options in a list box or on a menu arrow keys

Table 3-18 Browsing Web Presentations*
Action Keyboard
Move forward through the hyperlinks in a Web Tab
presentation, the address bar, and the links bar

Move back through the hyperlinks in a Web Shift + Tab
presentation, the Address bar, and the Links bar

Perform the assigned “mouse click” behavior of the Enter
selected hyperlink

Go to the next slide spacebar
Go to the previous slide Backspace

*These keyboard shortcuts can be used to view a Web presentation using Microsoft Internet Explorer 4.0 or later.
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Table 3-19 Browsing Hyperlinks in a Slide Show

Action Keyboard

Go to the first or next hyperlink Tab

Go to the last or previous hyperlink Shift + Tab

Perform the mouse-click behavior of the selected Enter while a hyperlink is
hyperlink selected

Perform the mouse-over behavior of the selected Shift + Enter while a hyperlink
hyperlink is selected

Table 3-20 E-mail Messages*

Action Keyboard

Send current presentation as an e-mail message Alt+S

Open the Address Book Ctrl + Shift + B

Check names on the To, Cc, and Bcc lines against the Alt+K

Address Book

Select the next box in the e-mail header or the body Tab

of the message

Select the previous field or button in the e-mail header Shift + Tab

*To send the fpreserzta(/on as the body of a message, activate the E-mail header by pressing Shift + Tab as many times as
necessary. If text within a text box is selected, press F2 to select the text box before pressing Shift + Tab.

Table 3-21 Getting to Help

Action Keyboard
Move between the navigation pane and topic pane F6

Display the Options menu in Help Alt+0
Display the program control menu Alt + spacebar
In navigation pane, switch to the next tab Ctrl + Tab
In navigation pane, switch to the Contents tab Alt+C

In navigation pane, switch to the Answer Wizard tab Alt+A

In navigation pane, switch to the Index tab Alt +1

In navigation pane, open a selected book or Help topic Enter

In navigation pane, select the next book or Help topic l

In navigation pane, select the previous book or Help topic T

In the topic pane, go to the next Help topic Alt+—
In the topic pane, go to the previous Help topic Alt + «

In the topic pane, go to the first or next hyperlink Tab

In the topic pane, go to the last or previous hyperlink Shift + Tab
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Action Keyboard
In the topic pane, follow a selected hyperlink Enter

In the topic pane, display a topic from a thumbnail F6, Tab, Enter
In the topic pane, scroll toward the beginning of a T

Help topic

In the topic pane, scroll toward the end of a Help topic l

In the topic pane, scroll toward the beginning of a Help Page Up
topic in larger increments

In the topic pane, scroll toward the end of a Help topic Page Down
in larger increments

In the topic pane, go to the beginning of a Help topic Home

In the topic pane, go to the end of a Help topic End

In the topic pane, print the current Help topic Ctrl + P

In the topic pane, select the entire Help topic Ctrl + A

In the topic pane, copy the selected items to the Ctrl+C

Clipboard

Table 3-22

Using the Office Assistant*

Action

Keyboard

Display the Assistant balloon

F1, if the Assistant balloon is
showing

Select a Help topic from the list the Assistant displays

Alt + number (Alt + 1 is the first
topic, Alt + 2 is the second, and
so on)

See more Help topics Alt+l
See previous Help topics Alt+ T
Close an Assistant message Esc

Get Help from the Assistant

F1 (Assistant must be turned on)

Close a tip

Esc

Show the Assistant in a wizard, or turn off Help
with the wizard

Tab, spacebar

clic

*To ferform most of these actions, the Office Assistant must be turned on and visible. To turn on the Assistant at any time,
-k Show the Office Assistant on the Help menu. To temporarily hide the tool, go to the Help menu and click the Hide the
Office Assistant. Note: Not all wizards have Help provided by the Assistant.
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Chapter 4: Checking Vour Calendar

In This Chapter

~ Keeping a calendar
1 Contacting others
v~ Filing data into your address book

Flird-party software companies used to offer a number of calendar
products, as well as components that come with hardware (like smart
cell phones and personal data assistants [PDAs]). Microsoft offered calendar
features as part of free MSN or Hotmail accounts. And Microsoft’s Outlook
program has included a calendar function for many years, although it has
mostly been used in office settings, not by individual users.

With each new version of Windows and Office, Microsoft has expanded its
offerings with creativity and adaptation. So it is with the Calendar function,
a software feature that’s floated around for a long time but only just arrived
as a full-fledged, official component of the operating system with the
introduction of Windows Vista.

Picking a Calendar

Which calendar to use? If your office or organization employs Microsoft
Outlook (which isn’t the same as Outlook Express), then you may have
that calendar system set up and running on your machine.

4+ Enable Outlook, although some of its features are rather heavy-duty
tools — kind of like using a backhoe to excavate a flower pot.

4 Buy and install a third-party calendar program.

<+

Employ the facilities of Hotmail, Yahoo, Google, or other online services.

4 Use Microsoft’s Windows Calendar. This came about with the
introduction of the Windows Vista operating system.
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Figure 4-1:
The main
screen of
Windows
Calendar
stores
events,
appoint-
ments,
reminders,
and a
connection
to the
Windows
Contacts

utility.

Windows Calendar

The

<+

Windows Calendar has several components:

An electronic appointment scheduler is the program’s heart. Once you
enter an event, the system can alert you however many days, hours, or
minutes ahead of time. You can also set up recurring appointments:
weekly meetings, or rent or mortgage payment dates, and the like.

Reminders can pop up on your laptop, or you can integrate your calen-
dar with your lists of contacts so e-mail messages go to invitees or con-
firmed meeting participants. See Figure 4-1.

Another core component is the personal task list. With this you can
create a list of things to do, along with deadlines for accomplishing each
task, and priority rankings for each event. The to-do list is integrated
with your calendar, and it can send you reminders. When you finish a
task, you can check it off as completed.

You can set up multiple calendars for everyone who uses your laptop —
family members or workgroup members. Users of the same computer
can coordinate their personal schedules with anyone else who grants
them permission to see their calendar.

\[|+] Windows Calendar - Corey Sandler’s Calendar
File Edit View Share Help

Date

Calen

&

Tasks

January, 2008 Details
January, 2008 ' Sun  Mon Tue Wed Thu  Fi  Sat | (g qugnter backto grad school i
Su Mo Tu We Th sl e L 2 3 i 3
N 1 2 3 Pice | | [Brie: |
6 7 8 9 107
1314 15 16 17 Location: | Euclid Street
NN 2B N
7B 203 & 7] 8 9 10 i1 12
34 5 6 = =
: oy en.. Calender: | Corey Sandler's Calendar =
ars
771 Corey Sandler's Calendar URL:
13 14 15 16 7 18 19 | Appointment Information E
[¥] All-day appointment
Start: 17112008 [+
20 21 2 2 24 2 26 End: 1/12/2008 [@+ 1200
Recurrence: [None -
Reminder
27 28 29 30 31 1 5 Reminder: [None -

Participants

3 4 5 & 7 F g {Anendm;” Select to enter attendees ‘

\E‘ Janice Keefe <Janice Keefe>
Corey Sandler <Corey Sandler>




\\J

Picking a Calendar 3 4 7

Consider a set of family calendars stored on the same machine. Mom or
dad can check out the kids’ schedules (at least the information the kids are
willing for share with parents) and can add events to their own or to their
children’s calendar. Appointments from each calendar are color coded so
you can easily see who “owns” an event.

As you move deeper into the bells and whistles, it is important to under-
stand that Microsoft has made Windows Calendar fully compatible with the
industry-standard iCalendar format, which a number of other hardware and
software makers, including Apple, also support. This allows you to easily
exchange information from your personal calendar with other Windows
Calendar users or with people who use a piece of software compatible with
iCalendar data.

You can also subscribe to free or fee-based web sites that accept data in the
iCalendar format. However, just because an application accepts data in the
iCalendar format doesn’t mean it uses all the data you collected or that the
information is presented the way you intend. Proceed carefully.

Here are some of the ways iCalendar sharing can work:

4+ Two or more individuals, or an entire group, can publish their personal
calendars to an online site that merges the information into a single
calendar.

4+ Someone can download another person’s information (with permission)
so their events and data can be displayed alongside your own in your
Windows Calendar on your laptop.

4+ You can set up a shared calendar for a group such as a fundraising
committee, a soccer league, a poker club, or a carpool. Publish to the
Web and others can see.

4 You can merge commercially prepared event information into your
own Web-based or laptop-based calendar. For example, you could down-
load the Boston Red Sox season schedule so every game appears on
your personal calendar, along with less-important events like dental
appointments, meetings at work, and mortgage payment due dates.

Calendar information published online can be made open to anyone, or you
can grant permission to anyone (or only to those with a password) to read
or make changes. Be sure you understand the security process for published
calendars before putting any sensitive information online.

From the View menu, you can examine your calendar by day, entire week,
work week, or month. From the same menu, click the Details Pane to see all
the information you entered; click again to minimize the clutter.
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Knowing where the time goes

| remember being in Taiwan in the early 1980s
and observing how much of the nation was
gearing up to build its economy around building
for the world market their own versions of com-
puter monitors, keyboards, motherboards, and
other technological essentials. They said it was
an honor to make an improvement to someone
else’s product.

To Microsoft's credit . . . or to its detriment,
depending on how you choose to view the soft-
ware giant...the company has a long history of
watching the marketplace and bringing into its
own products the best of Other People’s
Inventions. The time-honored practice didn't
start there; think of the automobile industry.
Within days after the first car hit the road, hun-
dreds of companies were coming up with their
own version of the same thing: faster, better,
cheaper, or flashier. You can't copyright or
patent an idea (the car, the computer, the elec-
tronic calendar); all you can attempt to protect
is your own particular expression of that idea.

Microsoft's very first product, MS-DOS, was an
adaptation of another company's operating
system. Windows was produced in admiration of
Apple’s Macintosh operating system, which itself
came from an idea that came out of a Xerox lab.

For many people, calendars came to the com-
puter by way of PDA (personal data assistant)
like the original Palm Pilot and its more sophisti-
cated cousins, BlackBerry and Apple’s iPhone.
(I long ago gave up using my Palm Pilot but still
use its PC-based calendar function on my laptop
and desktop.)

The calendar has evolved thusly:

v The original product was an electronic
version of a wall calendar. You could enter

appointments on particular dates and at
specific times and the computer kept track
of all of your appointments in a database;
you could also print out a schedule for the
day or for a week or month. | can still go
back at least ten years in my Palm calendar
to find out much of the details of my life — at
least those | recorded on the calendar. See
the accompanying figure.

The next step was a relatively minor one that
rang a bell with many users: adding an alarm
clock. If you had an appointment for a phone
conference on January 7 at 10:30 a.m., you
could assign your calendar to remind you a
day before, an hour before, or as a fancy
French cook might say, “a la minute,” which
means at the exact moment you need it.

From there, telephone began integrating
with the calendar. Before the advent of VolP
(voice over Internet protocol) telephony,
some makers began connecting a calendar
to an advanced dial-up modem that could
call over the POTS (plain old telephone
system) wires. That particular feature
wasn't much used.

The fourth generation of calendars, now
current on most laptops, includes integra-
tion with your office network as well as
Internet services. When you start planning
a meeting, you can check the calendars of
all of the people you want to invite (assum-
ing they've granted you permission to do so),
and you can place an appointment on their
calendar. Further, the software can send out
reminders by e-mail, instant message, or by
cell phone text message.
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To create an entry, follow along:

1. Click the New Appointment item.
A mini window opens.
2. Enter a description of the event.

You can also enter a location. Any information you add here can be
searched for from within the program; it’s a great way to jump to an old
calendar entry or on the schedule for an upcoming date.

3. Set a starting and ending time for an event.
On the other hand, an event can occupy the entire day.

4. Enter a potential attendee’s e-mail address in the Attendees list.
This invites someone to attend the event.

5. Click Invite.

Book IV
Chapter 4
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35 0 Making Contact

Microsoft Office Outlook 2007 Calendar

Microsoft Outlook may not work so well for individuals and small groups. 1
don’t mean to scare you away, but in my opinion, of all the programs in the
Microsoft Office suites, Outlook is one of the least user-friendly software
applications.

The Microsoft Office Outlook 2007 Calendar connects just about everything
in the Microsoft suite to each other. The calendar is integrated with
4 Your address book (also called Contacts in Windows Vista)
4 E-mail settings
4 The Internet
4+ Most applications (including word processors, spreadsheets, graphics
programs, and databases)

You can

4 Customize the calendar a number of ways with color coding
4 Select a time slot on the calendar

4+ Determine participant availability based on their calendars (with
automatic warnings of conflicts)

4+ Create a meeting description

4 Send invitations

Invitation recipients can accept, tentatively accept, or decline your
invitation online, and you can track responses.

You can share and merge Outlook calendars on a Windows SharePoint
Services 3.0 site, a facility used by some large businesses and institutions.
Changes you make on your laptop are automatically synchronized with
the online calendar the next time you connect to the Internet.

Making Contact

Does your personal address book have contact names, or does your contact
list constitute your address book? This question has no right or wrong
answer, although Microsoft introduced a change in terminology with the
arrival of Windows Vista.

In previous editions of Windows, the e-mail client (either Outlook Express
or Outlook) maintained a database that was called the Address Book. With
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Windows Vista, a very similar — but not identical — utility is now called
Windows Contacts.

As a user, the changeover doesn’t much matter to you. If you upgraded your
system from Windows XP to Windows Vista, your address book automati-
cally became a contacts list in the process. You can export the contacts list
to a previous version of Windows or other programs that are set up to work
with Microsoft’s earlier utility.

Do these steps to export Windows Contacts to a version that an earlier
Microsoft Address Book utility or another program:
1. Click Export in the Contacts taskbar.
2. Choose between formats:
¢ CSV (comma separated values)
e vCards
Use CSV for Address Book in Windows XP.

3. From the program where you want to use the file, click Import
and specify the data location.

See Figure 4-2.

In addition to being a simple database for information about 